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Introduction

Important

To the maximum extent permitted by applicable laws, in no event will the manufacturer be liable for any
damages whatsoever arising out of failures of this product, losses of documents or data, or the use or
non-use of this product and operation manuals provided with it.

Make sure that you always copy or have backups of important documents or data. Documents or data
might be erased due to your operational errors or malfunctions of the software. Also, you are
responsible for taking protective measures against computer viruses, worms, and other harmful software.

In no event will the manufacturer be responsible for any documents created by you using this product or
any results from the data executed by you.

Cautions regarding this guide

• Some illustrations or explanations in this guide could differ from your product due to improvement or
change in the product.

• The contents of this document are subject to change without notice.

• No part of this document may be duplicated, replicated, reproduced in any form, modified, or
quoted without prior consent of the supplier.

• Throughout this publication, references to directory paths indicate the default paths only. If you
install InfoPrint Manager or any of its components in a different location, including a different drive,
you must adjust the paths accordingly.
For example, if you install InfoPrint Manager on the D: drive of a computer running a Windows
operating system, replace C: with D: in the directory paths.

Guides for this application

This publication provides information about RICOH InfoPrint Manager™ for AIX, Linux, and Windows,
Version 4.13 (Program Number 5648-F40).

This publication includes an overview of InfoPrint Manager and installation and configuration
information about the product.

Instruction manuals

These instruction manuals are included:

For information about InfoPrint Manager, see these documents:

• RICOH InfoPrint Manager for Windows: Planning Guide , G550-1071

• RICOH InfoPrint Manager for Windows: Getting Started , G550-1072

• RICOH InfoPrint Manager for Windows: Procedures , G550-1073

• RICOH InfoPrint Manager for Linux: Planning Guide, G550-20262

• RICOH InfoPrint Manager for Linux: Getting Started, G550-20263

• RICOH InfoPrint Manager for Linux: Procedures , G550-20264

• RICOH InfoPrint Manager for AIX and Linux: Configuring and Tuning Guide, S550-1062



• RICOH InfoPrint Manager for AIX: Planning Guide, G550-1060

• RICOH InfoPrint Manager for AIX: Getting Started, G550-1061

• RICOH InfoPrint Manager for AIX: Procedures, G550-1066

• RICOH InfoPrint Manager: High Availability Guidelines, G550-20261

• RICOH InfoPrint Manager: Reference, S550-1052

• RICOH InfoPrint Manager: PSF, Server, and Transform Messages, G550-1053

• RICOH InfoPrint Manager: Secure Print: Installing and Configuring, G550-20129

• RICOH InfoPrint Manager: SAP R/3 Planning and Configuring Guide, S550-1051

• RICOH InfoPrint Manager: Dictionary of Keywords, S550-1188

• AFP Conversion and Indexing Facility: User’s Guide, G550-1342

• Page Printer Formatting Aid for Windows: User’s Guide and Reference, S550-0801

• RICOH InfoPrint Manager AFP2PDF Transform Feature: Installing and Using , G550-1057

• RICOH InfoPrint Manager: Installing InfoPrint Manager Transform Feature, G550-20160

Help

Property help is available on many screens to provide information for specific tasks and settings.

In addition, the Help menu provides access to the HTML version of the instruction manual directly from
the user interface.

• A PDF reader, such as Adobe Reader, must be installed to view the PDF documentation.

For more information about RICOH printing products, see:

RICOH Commercial and Industrial Printing website at https://www.ricoh-usa.com/en/products/
commercial-industrial-printing.

RICOH Software Information Center at https://help.ricohsoftware.com/swinfocenter.

How to read the documentation

Displaying the instruction manual

Use this procedure to view the instruction manuals.

Displaying the instruction manual in PDF format

• InfoPrint Manager includes publications in PDF format on the DVD-ROM supplied with the product.

Displaying the instruction manual in HTML format

• The HTML version of the instruction manual is available directly from the user interface. Start the

application, and then click button at the right of the banner and select Help.
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Displaying property help

Click the button next to a property on the user interface to display the property help for that item.

Symbols

The following symbols are used in this manual to help you to identify content quickly.

• This symbol indicates points to pay attention to when using the product. Be sure to read these
explanations.

• This symbol indicates helpful supplementary information that is not essential to completing a task.

Bold
Bold type indicates the names of dialogs, menus, menu items, settings, field labels, buttons, and
keys.

IIttaalliicc
Italic type indicates the titles of manuals and variables that you must replace with your own
information.

MMoonnoossppaaccee

Monospace type indicates computer input and output.

Abbreviations

AFP
Advanced Function Presentation

IP
Internet Protocol

PDF
Portable Document Format

PCL
Printer Command Language

GIF
Graphical Interchange Format

JPEG
Joint Photographic Experts Group

TIFF
Tagged Image File Format
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Trademarks

RICOH InfoPrint Manager™ and RICOH ProcessDirector™ are trademarks of Ricoh Company, Ltd. in
the United States, other countries, or both.

These terms are trademarks or registered trademarks of International Business Machines Corporation in
the United States, other countries, or both:

• AIX

• DFS

• IBM

• MVS

• OS/390

• POWER

• Print Services Facility

• pSeries

• S/390

• z/OS

Adobe, the Adobe logo, PostScript, and the PostScript logo are registered trademarks or trademarks of
Adobe Systems Incorporated in the United States and/or other countries.

CUPS and macOS are trademarks or registered trademarks of Apple, Inc. in the United States, other
countries, or both.

Fiery is the registered trademark of Fiery, LLC in the U.S. and/or certain other countries.

Linux is the registered trademark of Linus Torvalds in the U.S. and other countries.

Microsoft, Microsoft Edge, Windows, the Windows logo, and Active Directory are trademarks of
Microsoft Corporation in the United States, other countries, or both.

Okta is a registered trademark of Okta, Inc. in the U.S. and other countries.

UNIX is a registered trademark of The Open Group in the United States and other countries.

Thales Group code: The license management portion of this Licensee Application is based upon one or
more of the following copyrights:

Sentinel RMS
Copyright 1989-2024 Thales Group
All rights reserved.

Sentinel EMS
Copyright 2008-2024 Thales Group
All rights reserved.

Sentinel is a registered trademark of Thales Group.

Other company, product, or service names may be trademarks or service marks of others.
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PPrreeppaarriinngg ttoo iinnssttaallll IInnffooPPrriinntt MMaannaaggeerr ssooffttwwaarree
Before you perform any of the steps documented in this publication, you must understand the general
features and requirements of InfoPrint Manager for Windows. You can find this information in RICOH
InfoPrint Manager for Windows: Planning Guide. Consult this publication before proceeding with your
installation.

You must do all network configuration before installing and configuring InfoPrint Manager. See
Configuring TCP/IP, p. 11 for procedures for TCP/IP configuration.

When you use InfoPrint Manager for Windows to drive one or more high-speed printers, performance
can be improved if you install it in a separate partition, on a separate hard drive, or with a SCSI drive.

Configuring TCP/IP

You might need to configure your Windows system to communicate with other computers or printers on
one or more networks. These worksheets are designed to help you with this configuration.

Planning for a LAN connection

First, connect your Windows systems to your local area network (LAN). You can do this task when you
install Windows or after you finish the installation. In either case, you might find it useful to complete this
worksheet ahead of time for each system that is new to your LAN.
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LLAANN TTCCPP//IIPP ccoonnffiigguurraattiioonn wwoorrkksshheeeett

Control Panel Prompt Description Value

Computer Name The (NetBIOS) name of this
computer on the Windows
network.

Domain/Workgroup The group of Windows
computers to which this computer
belongs.

Adapter The physical card used to
connect this system to the
network. An appropriate driver
for this card might need to be
added.

Obtain IP address from DHCP
server?

The Dynamic Host Configuration
Protocol (DHCP) provides a new
IP address for this system each
time it is restarted. If DHCP is not
in use, a static IP address must be
assigned.

__ yes __ no

It is strongly recommended
that you specify no for
DHCP.

IP Address An IPv4 address (for example,
9.99.178.17) statically assigned
to this system. Not needed if
DHCP is in use.

Subnet Mask (IPv4) Identify a range of IP addresses
that are on the same network.
Not needed if DHCP is in use.Subnet Prefix Length (IPv6)

Default Gateway The system used by default to
allow this network to
communicate with other networks.
Not needed if DHCP is in use.

DNS Host Name The (Internet) name of this system
recognized by the Domain Name
System (DNS). If possible, this
name should be the same as the
Windows computer name.

DNS Domain The Internet domain to which this
computer belongs.

DNS Service Search Order An ordered list of IP addresses of
DNS servers. These systems are
queried to resolve Internet names
into IP addresses.

Domain Suffix Search Order An ordered list of TCP/IP
domains to search for a given
host name.

1 Getting started with server systems
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Control Panel Prompt Description Value

Primary WINS Server The first Windows Internet Name
Service (WINS) system to query
to resolve a Windows (NetBIOS)
system name into an IP address.

Secondary WINS Server The second WINS system to
query.

Enable DNS for Windows
Resolution?

DNS can be used to resolve
Windows (NetBIOS) names into
IP addresses.

__ yes __ no

Enable LMHOSTS Lookup? LMHOSTS files statically
associate Windows system names
to IP addresses.

__ yes __ no

Scope ID The set of IP addresses
assignable for a Windows
domain is a called a scope.

Enable IP Forwarding? IP Forwarding allows data to be
forwarded on a multi-homed
system.

__ yes __ no

Planning for a printer network connection

You might want to create a separate network of printers with higher bandwidth connectivity. In this case,
you must configure an additional network adapter on each InfoPrint Manager server system that
controls printers on the independent printer network. Use this worksheet to assist in this configuration. For
additional information about setting up a separate printer network, see “Using Multiple Network
Adapter Cards” in the RICOH InfoPrint Manager for Windows: Procedures.

PPrriinntteerr NNeettwwoorrkk TTCCPP//IIPP ccoonnffiigguurraattiioonn wwoorrkksshheeeett

Control Panel Prompt Description Value

Adapter The physical card used to
connect this system to the printer
network. An appropriate driver
for this card might need to be
added.

IP Address A dotted-decimal address (for
example, 9.99.178.17)
statically assigned to this system
on the printer network. Required
for printer network participation.

Preparing to install InfoPrint Manager software
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Control Panel Prompt Description Value

Subnet Mask A dotted-decimal number (for
example, 255.255.255.0)
indicating which part of the IP
address identifies the network
and which part identifies the
system. Required for printer
network participation.

Default Gateway The printer network should not
require communication with
another network. All
communication with the printers
is mediated by InfoPrint
Manager.

none

Server software prerequisites

You can find information on the server software prerequisites in the “Verifying prerequisites” chapter,
RICOH InfoPrint Manager for Windows: Planning Guide.

InfoPrint Manager supports English, French, German, Italian, Spanish, and Japanese.

Before migrating to InfoPrint Manager 4.13

If you are migrating from a previous level of InfoPrint Manager, it is strongly recommended that you
back up your InfoPrint Manager for Windows install directories, any directories that have been moved
out from under the install directory since the initial installation of the product, and the Windows registry.
Directories that have been moved out from under the install directory can be identified through the
InfoPrint Manager Management Console (Start→ Programs→ InfoPrint Manager→
Management Console). From the Management Console, go to Edit→ Service Configuration.
Check all paths listed on the displayed panel to determine if any are not in the base install directory.
Make note of any paths that are not in the base install directory.

This backup is required to remove the new version from your system and restore InfoPrint Manager to its
previous state.

We suggest that you test the migration on a non-commercial system before installing it in a commercial
environment.

Backing up your InfoPrint Manager for Windows install directories

To back up your system, complete these steps:

1 Getting started with server systems
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1. Stop job submissions to the InfoPrint Manager server from all of your locations.

2. Complete printing all jobs, if possible, or delete them.

3. Close the InfoPrint Manager Administration and Operations GUIs, including those on your remote
systems, if they are open.

4. Shut down the InfoPrint Manager Server. Using the InfoPrint Manager Management Console, go to
File→ Stop Server.

5. Clean up segment files. Using the InfoPrint Manager Management Console, go to Debug→ Clean
Up Leftover Input Manager Files, and close the Management Console.

6. Use your local backup procedures to backup the install directories, any directories that have been
moved out from under the install directories, and the Windows registry. This key and sub-keys must
be restorable: HKEY_LOCAL_MACHINE\SOFTWARE\RICOH\Infoprint Manager.

In a multi-server environment, all servers must be backed up and upgraded at the same time, including
AIX servers.

After migrating to the latest version of InfoPrint Manager

Once you have completed the installation, you can update your transform configuration files and
migrate any desired optional features.

The lpdmap.txt file included

InfoPrint Manager for Windows now includes a lpdmap.txt file that is installed in install_path\var
\pd\lpd. Before the file is installed, InfoPrint Manager makes a backup copy of the existing lpdmap.
txt file. If you have modified your version of the lpdmap.txt file, you must merge the changes from
the backup copy into the lpdmap.txt file.

Updating transform configuration files

As part of the install process, your existing transform configuration files and user exits are automatically
zipped and backed up into the path <install path>\var\pdbk\ipm.bak_MM-DD-YYYY.zip.

• C:\Program Files\RICOH\Infoprint Manager\pcl2afp\pcl2afp.cfg

• C:\Program Files\RICOH\Infoprint Manager\pcl2afp\pcl2afpd.cfg

• C:\Program Files\RICOH\Infoprint Manager\ps2afp\ps2afp.cfg

• C:\Program Files\RICOH\Infoprint Manager\ps2afp\ps2afpd.cfg

• C:\Program Files\RICOH\Infoprint Manager\ps2afp\3160d.cfg

After installing the latest InfoPrint Manager version, you can edit the newly-installed files to add your
customized changes into the new configuration files that reside in the installation directory.

Preparing to install InfoPrint Manager software
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Because the new configuration files might have different source material, you should not copy the
backed-up files over the new configuration files.

Migrating optional InfoPrint Manager features

Any optional features of earlier versions of InfoPrint Manager that are installed on the system are
removed when the base server software is migrated to Version 4.13. This is done because optional
features of earlier versions might be incompatible with the Version 4.13 server. The use of previous
version options with a Version 4.13 server is not supported. To load Version 4.13 options, insert the
DVD-ROMs that contain features you want to install.

The previous versions of InfoPrint Manager for Windows require the User Account Control (UAC) to be
turned off. If you have migrated to the latest version of InfoPrint Manager and you want to use the
InfoPrint Manager software with the UAC turned on, contact you local service representative.

Preparing to reinstall

At some point, you might need to reinstall InfoPrint Manager. You might be upgrading to a new version
or reinstalling the current version because of a problem. Try to install without uninstalling first, so that
your configuration information is not lost. If that does not work, uninstall and reinstall using the same
installation directory. When you do, the objects you created will still exist, but any post-installation
configuration, especially in multi-server environments, will probably be lost.

1. You must have Administrative Privilege to install or uninstall InfoPrint Manager for Windows. If
you try to uninstall the product without administrative privilege, this message is issued:

Setup Installation Error: Setup has detected Uninstallshield is
in use, please close Uninstallshield and
restart setup (Error 432).

A similar message is issued at install if you do not have administrative privilege.

2. You must use the same user ID to reinstall InfoPrint Manager for Windows as was used to install it
initially.

3. Be sure to close the InfoPrint Manager Administration GUI, the InfoPrint Manager Operations GUI,
and the InfoPrint Manager Management Console before installing any service update or reinstalling
InfoPrint Manager to avoid problems with files that need to be replaced.

1 Getting started with server systems
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IInnssttaalllliinngg IInnffooPPrriinntt MMaannaaggeerr ssooffttwwaarree sseerrvveerr

Start here for a new installation

This section describes how to complete an installation of the InfoPrint Manager product. If you are
upgrading from an older InfoPrint Manager version, begin by first following the instructions in: Before
migrating to InfoPrint Manager 4.13, p. 14 Return to this section after you have completed those
instructions.

The InfoPrint Installer lets you install InfoPrint Manager for Windows and the combination of features
that meet the needs of your print environment.

After purchasing the product and feature licenses that you have chosen, Ricoh sends an email with EMS
- Entitlement Certificate in the subject line to the email address provided when the order was placed.
This email contains your Entitlement ID (EID). Generate your license keys needed for product
registration at https://dl.ricohsoftware.com, using the EID and the fingerprint of the machine you intend
to run InfoPrint Manager on. The EID is only used to identify what you have purchased. Register your
license keys for the product each time you receive an email with an EID for InfoPrint Manager
components that you have purchased.

InfoPrint Manager is automatically installed in trial mode on your server. Get the fingerprint of your
server where InfoPrint Manager was installed using the License Key Management Application (LKMA)
and then use the fingerprint together with your EID on the self-service website at https://dl.
ricohsoftware.com to generate your license key. Download the license key from the self-service website
and register the product using the LKMA. For more information about LKMA, see Managing trial and
perpetual licenses using the License Key Management Application (LKMA), p. 27.

To get the fingerprint of the system where you plan to install InfoPrint Manager, before you start the
installation you can run the utility available on the root of the base product DVD-ROM or ISO called
ggeettffiinnggeerrpprriinntt..eexxee.

Download the license key from the self-service website and copy it on the server where you are about
to install InfoPrint Manager. Start the installation process and continue to the installer panels. When you
are asked for the license key, input the path to where you copied it on the server. Continue the
installation and complete the registration and installation process.

How to Generate and Download the Product License Key

1. To get the fingerprint for the machine where you are about to install InfoPrint Manager, log in to
the server using the Administrator user.

2. Double-click getfingerprint.exe available on the DVD-ROM or ISO of the product and your
system fingerprint is displayed.

3. Open the EMS - Entitlement Certificate email and find the EID.

4. Go to the Ricoh Production Print Software website https://dl.ricohsoftware.com and click the
Software Activation button.

5. Type or paste the EID into the Enter your EID field.

Installing InfoPrint Manager software server
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6. Type or paste the server fingerprint into the Enter your System Fingerprint field. Make sure to
include the asterisk (*) at the beginning of the system fingerprint.

7. Click Confirm Content. The Activation Content Confirmation dialog is displayed.

8. Click Activate. The Activation confirmed dialog is displayed. The license key has been
generated and sent in a file to the email address provided when the purchasing order was
placed.

If you see an error message that the license could not be generated because checksum validation
failed, you entered an incorrect system fingerprint.

9. If you want the license key file to be sent to a different email address, click Email License Key.
Then type the email address and click Send.

10. If you want to download the license key file to your computer, click Download License Key.

11. If you want to copy the license key, click Copy License Key to Clipboard.

12. Retrieve the license key file from the email (or from your computer) and transfer it to the server.

13. Give the license key file a name that identifies your server.

14. Store the license key file in a convenient location on your server. You select this file when the
installer or LKMA asks for the license key path.

Information about updates to this release of InfoPrint Manager is available online, where it is updated
as necessary. The RICOH InfoPrint Manager for Windows: Base Server DVD-ROM, contains a version of this
documentation, but for the most recent information about InfoPrint Manager, go to the RICOH Software
Information Center at https://help.ricohsoftware.com/swinfocenter.

• You must always check that the license key you download matches the current server version and
release. For example, if you have installed an older version but a new license code is available for
the latest version, the new license code does not apply to the older version already installed.

• Make sure that you keep a list of EIDs you own and the servers that correspond to these EIDs.

• Not all supplied keys actually unlock specific features. Many keys are supply order features that are
used for other purposes.

• Maintenance upgrade licenses purchased after the expiry of the initial one year software
maintenance are shipped without any keys to unlock the base version. You must install keys from
both EIDs on all systems to extend the Maintenance license.

Preparing to use the InfoPrint Manager Installer

Before mounting your DVD-ROM, make sure that you have this information available to reference as
you install InfoPrint Manager for Windows:

1. Important configuration information such as:

• Approximate disk space that is available. If you plan to process numerous large print jobs, you
might want to consider increasing the size of the allocated disk space during the installation.
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• Features, if any, that you will be installing.

• If this will be a secondary server, you will need the name of the primary server.

• How many printers will this configuration support?

• What are the speeds of the printers that this configuration will support: high, medium, or low?

2. The invoice shipped with your software or package list.

3. The Entitlement ID, fingerprint, and the license key file received by e-mail or downloaded. The
license key file can be generated using the self-service website. For more information about the
Entitlement ID and license keys, see How to Generate and Download the Product License Key, p.
17.

4. The completed communications worksheet that you received from your service representative.

Installing InfoPrint Manager

These are the steps for the initial installation of InfoPrint Manager for Windows on your server. For
instructions on applying service, see Installing service updates for InfoPrint Manager clients, p. 25.

1. Log in as the Administrator user. You must have Administrative Privilege to install or uninstall
InfoPrint Manager for Windows.

2. Disable your antivirus software. Installing InfoPrint Manager for Windows on a system running an
antivirus software is not recommended.
If your IT department does not let you disable antivirus software, set up exceptions within your
antivirus software for these paths:

• C:\Program Files\Ricoh\InfoPrint Manager

• C:\ProgramData\RICOH

3. If you have the installation DVD-ROM, insert the InfoPrint Manager for Windows Base Server DVD-ROM,
LCD4-5659, into your DVD-ROM drive. The install program starts automatically. You can select to
view a readme file before starting the install.

If you have the installation ..iissoo file, double-click it and then double-click the sseettuupp..hhttmmll file.

If your install program does not start automatically or if your browser stops responding:

1) Select Start ->Run.

2) Enter E:\setup.html, where E is your DVD-ROM drive.

3) Click OK.

4. Click Install RICOH InfoPrint ManagerTM server and choose the destination for
InfoPrintManager.exe.

5. Go to the location of InfoPrintManager.exe and double-click it.

6. In the InstallShield Wizard for InfoPrint Manager dialog, click Next.

7. In the License Agreement dialog, select I accept the terms of the license agreement and click
Next.
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8. In the Software Maintenance Agreement dialog, select I accept the terms of the license
agreement and click Next.

9. In the Select Options dialog, choose between Standard and HA installation and then click Next.

• If you choose Standard installation, InfoPrint Manager installs on a standalone Windows
Server.

• If you choose HA installation, InfoPrint Manager installs on a Windows Server Cluster for High
Availability.

– If you choose HA primary, InfoPrint Manager installs on the primary node.

– If you choose HA failover, InfoPrint Manager installs on any of the secondary nodes.

For more information, see RICOH InfoPrint Manager: High Availability Guidelines.

10. In the Choose Destination Location dialog, select the folder where Setup will install the files and
then click Next.

11. In the Select Program Folder dialog, click Next. The License Key Management Application is
being installed.

12. Select the feature or features you want to install with InfoPrint Manager Base Server and then click
Next.
These features are available to be installed with the InfoPrint Manager Base Server installer:

• InfoPrint Manager AFP2PDF Feature

• InfoPrint Manager SAP Print Feature

• InfoPrint Manager Pull Print Feature

These features are available on separate DVD-ROMs and can be installed if you purchase a feature
license:

• InfoPrint Manager PPFA Feature

• InfoPrint Manager 4247 Feature

13. In the Ready to Install the Program dialog, click Install if you are ready to begin installation. If
your installation program does not respond, close all other applications, restart your system, and
install the program again.

Do not use special characters in the destination directory name.

14.After you have installed InfoPrint Manager for Windows, the installation program asks to reboot
your system. The default is Yes because InfoPrint Manager does not function properly until the
system is rebooted. When you click Finish or press Enter, your system reboots, and the InfoPrint
Manager service starts automatically.

15. If you are installing optional features, see Installing optional features on an InfoPrint Manager
system, p. 24 for instructions.

16. Install the most recent service update if appropriate. Refer to Accessing the latest information and
fixes, p. 24 for information and instructions about where to find product updates. Then follow the
installation steps in Installing service updates for InfoPrint Manager clients, p. 25.
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These software components are now installed on your system:

• InfoPrint Manager server

• InfoPrint Manager Management Console

• InfoPrint Manager Administration GUI

• InfoPrint Manager Operations GUI

• InfoPrint Notifications Server

• InfoPrint TCP/IP Network Port Monitor

• InfoPrint Manager LPD service

• InfoPrint Manager Web Interface

• InfoPrint Manager Web Server

• MVS Download

The InfoPrint Manager installation program creates a new local user account used for service account
login. The default user starting InfoPrint Manager is ipm1 with the following user rights set by the
InfoPrint Manager installation program: Act as part of the operating system, Create permanent
shared objects, and Log on as a service. The ipm1 user account is part of the Administrators group
and the default password is Inf0PrintManager.

We strongly recommend that you verify the connection from your InfoPrint Manager for Windows
server system to an actual destination. To do this, you must first create an actual destination as
described in Creating actual destinations, p. 65.

Installing on non-English operating systems

InfoPrint Manager for Windows detects what language your operating system runs in by checking the
Regional Settings of your system. When possible, message files, such as server and destination log
messages and error messages, that match that language are loaded. When the messages are not
available in the same language, English message files are installed. However, if non-English message
files are installed and you change the Regional Settings to English (U.S.), you will receive some, but not
all, of your messages in English. We recommend that you do not change the Regional Settings after you
have installed InfoPrint Manager.

• To display the correct characters in the Windows command prompt terminal for supported West
European languages (French, Italian, German, Spanish), change the code page 850 to code page
1252. To determine the current code page from the command prompt, use the chcp command
(without any parameter). To change the terminal code page to 1252, run the command chcp
1252.
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Running InfoPrint Manager with double-byte languages

If you want to run InfoPrint Manager with a double-byte language, you must configure your multi-
lingual system so that the double-byte language is the default language.

Specifying your language for the InfoPrint Manager server with a Windows
Multi-Language Version system

Use this procedure to specify your country's language for the InfoPrint Manager Server when you are
using a Windows Multi-Language Version (MLV) System:

1. On the system that your InfoPrint Manager Server runs on, open the InfoPrint Manager
Management Console and select File→ Stop Server.

To start the InfoPrint Manager Management Console, open the Start menu and click
Programs→ InfoPrint Manager→Management Console.

2. Set up a new domain user account that the InfoPrint Manager service will run under:

1. Log on to the domain that InfoPrint Manager operates in as a domain administrator.

2. Use User Manager for Domains to create a domain user account that InfoPrint Manager
will run under.

Make the user a member of the Domain Administrators group and change the user's
primary group from Domain Users to Domain Administrators. It is recommended that you
select Password never expires so you do not have to change the password and update all
of your servers on a regular basis.

3. Give the domain user these user rights: Act as part of the operating system, Create
permanent shared objects, and Log on as a service.

3. Log off the domain.

4. Grant the same user rights to the new domain user on the system that InfoPrint Manager is
installed on:

1. Log on the system that the InfoPrint Manager is installed on as a user who is a member of the
Domain Administrators group.

2. Use the local User Manager to give the domain user that you created in step 2 these user
rights on that system: Act as part of the operating system, Create permanent shared
objects, and Log on as a service.

5. Log off the system.

6. Change the regional settings for the new domain user to the appropriate language:

1. Log on the system as the domain user you created above.

2. Select Start→ Settings→ Control Panel.

3. Double-click Regional Settings.

4. Select the appropriate language.
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5. Click OK.

7. Log off the system.

8. Log on as a user who is a member of the Administrators group for that system and complete
these steps:

1. Open the InfoPrint Manager Management Console and select Edit→ Service Account/
Domain.

2. Enter the name of the domain that the InfoPrint Manager is installed on and the user name
and password from above.

3. Click OK.

9. On the system that your InfoPrint Manager Server runs on, open the InfoPrint Manager
Management Console and select File→ Start Server.

Uninstalling InfoPrint Manager for Windows

To remove InfoPrint Manager from a system:

1. Determine all directory paths where the product is installed under:

1. Click the Windows Start button and select Programs→ InfoPrint Manager→
Management Console to start InfoPrint Manager Management Console.

2. In the Management Console, click Edit→ Service Configuration.

3. Note all paths listed on the displayed panel to determine all path where the product was
installed.

4. To find the path where the IJT working directory is located, go to %ALLUSERSPROFILE%
\RICOH\Infoprint Manager\ipmws\ and open the setenv.bat file using a text editor. The
path is associated with the IJT_WORKDIRECTORY variable.

5. Note as well the following directory %ALLUSERSPROFILE%\RICOH\Infoprint Manager\.

6. Make list of all paths locations identified in the steps above.

2. Uninstall the product:

1. Click the Windows Start button and select Settings→ Control Panel.

2. Double-click Add or Remove Programs.

3. Select InfoPrint Manager for Windows.

4. Click Remove and follow all instructions as directed.

3. Restart the computer.

4. Delete all directories from the paths locations listed on step 1.6).
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Installing InfoPrint Transform Manager Feature

For more information on the installation procedure, go to "Installing and logging in to InfoPrint Manager
Transform Feature " in Installing InfoPrint Manager Transform Feature, G550-20160.

Installing optional features on an InfoPrint Manager system

After installing InfoPrint Manager on your server, you can install additional optional features, such as
the PPFA Feature. Each feature DVD has an installation program similar to the InfoPrint Manager server
installer. Insert the appropriate InfoPrint Manager for Windows feature DVD into the DVD-ROM drive.
The install program starts automatically; follow the instructions to complete the installation.

If you have already installed a service update to InfoPrint Manager and you are now installing a non-
triable optional feature, install it from the DVD-ROM for that feature first, and then install the service
update for the feature from the DVD-ROM.

Accessing the latest information and fixes

You can find download fixes for InfoPrint Manager for Windows on the RICOH website at https://dl.
ricohsoftware.com/.

You can find updated documentation for InfoPrint Manager for Windows in the RICOH Software
Information Center at https://help.ricohsoftware.com/swinfocenter.

In order to obtain additional support for InfoPrint Manager for Windows, you need to purchase a
support contract. Please contact your local marketing team for more information about how to obtain
this support. Terms and conditions for support vary by country and geography.

If you are in the U.S., you can call 1-888-426-4343 to set up a SupportLine contract for InfoPrint
Manager for Windows. After a SupportLine contract is established, you can request technical assistance
by calling 1-800-237-5511. When you call this number, you will be asked to provide your customer
number, operating system, name of the failing product (InfoPrint Manager for Windows), and a brief
description of the problem. Please have this information available when you place a call for technical
assistance.

Installing service updates for InfoPrint Manager and optional features

Before installing any service update, it is strongly recommended that you back up your InfoPrint
Manager for Windows install directories, any directories that have been moved out from under the
install directory since the initial installation of the product, and the Windows registry. Refer to Backing
up your InfoPrint Manager for Windows install directories, p. 14 for a description of the steps involved
in backing up your system.

Follow these steps to install a service update to the InfoPrint Manager server:
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1. Log in as the Administrator user.

2. Insert the InfoPrint Manager for Windows service update DVD-ROM into your DVD-ROM drive. The
install program will start automatically.

3. Click Install InfoPrint Manager server.

4. The license agreement displays. Read the license agreement and then click Accept.

5. Follow the instructions on the installation screens to install the update. The destination directory
and other necessary settings will be obtained automatically based on your initial installation.

The service update install program might ask to update additional features at this time. If you click
Yes to continue, you can follow the window prompts to install the updates when the features
install are complete, the InfoPrint Manager service update installation resumes. If you choose not
to install the update at this time, you can install it later from the main installation menu on the
DVD.

6. After you have installed InfoPrint Manager for Windows, the installation program asks to reboot
your system. The default answer to this question is Yes because InfoPrint Manager will not
function properly until the system is rebooted. When you click OK or press Enter, your system
reboots, and the InfoPrint Manager service will start automatically.

To access all changes as they are released in service updates, make sure that the InfoPrint Manager
server is at the same level or at a higher level of service than the InfoPrint Manager Administration GUI
and the InfoPrint Manager Operations GUI. Otherwise, you might receive error messages like: 5010-
625 Cannot recognize attribute.... For this to occur, the InfoPrint Manager Administration GUI or
the InfoPrint Manager Operations GUI would have to be running on a different workstation than the
InfoPrint Manager server. This might occur if you install a new version of a GUI on a workstation and
point to a downlevel InfoPrint Manager server.

To install a service update to the PPFA Feature or the SAP Print or the Pad Features:

1. Log in as the Administrator user.

2. Insert the InfoPrint Manager for Windows service update DVD-ROM into your DVD-ROM drive. The
install program will start automatically.

3. Select Product Feature Updates button.

4. Select the feature you want to update and follow the instructions on the installation screens. The
destination directory and other necessary settings will be obtained automatically based on your
initial installation.

Installing service updates for InfoPrint Manager clients

To install a service update to an InfoPrint Manager client component:

1. Insert the InfoPrint Manager for Windows Common Clients service update DVD-ROM, into your DVD-
ROM drive. The install program starts automatically.

2. Select the client program you want to update.

3. Follow the instructions on the installation screens to install the update. The destination directory
and other necessary settings will be obtained automatically based on your initial installation.
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Uninstalling a service update

To remove a service update from a system and restore InfoPrint Manager to an unconfigured state,
follow these steps:

1. Determine if any directories have been moved out from under the install directory since the initial
installation. You can do this through the InfoPrint Manager Management Console (Start→
Programs→ InfoPrint Manager→Management Console). From the Management Console,
go to Edit→ Service Configuration. Check all paths listed on the displayed panel to determine
if any are not in the base install directory. Make note of any paths that are not in the base install
directory.

2. Uninstall the product. Go to Start→ Programs→ InfoPrint Manager→ Uninstall InfoPrint
Manager. Follow all instructions as directed.

3. Restart the computer.

4. Delete the install directory. If any directories were moved out from under the InfoPrint Manager
install directory (as identified in step 1), delete those as well.

5. Install the InfoPrint Manager product. Follow the directions as specified.

6. Install any required service update to get the product to the desired level.

MMaannaaggiinngg IInnffooPPrriinntt MMaannaaggeerr lliicceennssiinngg
There are several license types available for InfoPrint Manager:

Trial
The trial license expires after 60 days from the installation of InfoPrint Manager.

Perpetual
The perpetual license has an unlimited period of usage.

Subscription
The subscription license has a defined period of usage.

Maintenance
The maintenance license expires after 1, 2, 3, 4, or 5 years, depending on which license you
purchased.

Enterprise
The enterprise license allows you to make multiple installations on different machines using the same
license key. To find out if you are eligible for the enterprise license, contact your Ricoh
representative.
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1. The initial purchase of the InfoPrint Manager product gives you a free one year maintenance
license. Under normal circumstances for a purchased product, you receive a perpetual plus one
year maintenance license.

2. If you have a perpetual license and the system fingerprint used for generating a license key is
changed, the InfoPrint Manager software continues to run in grace mode for a period of 7 days.
You must contact your local representative to receive a new license key before the period expires,
otherwise the InfoPrint Manager software stops running on this system when the grace period ends.

3. If you make changes to the system configuration of the InfoPrint Manager host that can affect the
system fingerprint, you must stop all the InfoPrint related processes before.

4. InfoPrint Manager does not check for feature maintenance keys during runtime.

Managing trial and perpetual licenses using the License Key Management
Application (LKMA)

The License Key Management Application (LKMA) comes with the InfoPrint Manager base installation
and handles the license types for your InfoPrint Manager server software. You can select or switch
between the license types available using the License Key Management Application.

If the UAC is turned on, you can add new licenses using the License Key Management Application only
when using the "Run as Administrator" option. To do this, right click on the application icon and select
"Run as Administrator".

Using the License Key Management Application

To start the application:

1. Start the License Key Management Application by double-clicking the icon from the desktop.

2. From the InfoPrint Manager Licenses main window, click Add... to continue the registration
process:

1) Choose which type of license you want to use for your installation and then click Next.

• If you choose to try the product, it will run in trial mode for the time period shown (60 days).
Before the trial period is over, you must buy the product to continue using it.

• You can choose to register your product manually using the self-service website.

If a license is added on top of an already installed license of the same type, the application
deletes the previously installed license and installs the new license. This allows renewed
maintenance licenses to be installed without manually deleting previously installed licenses.
Always make sure you install a valid license for your product.

2) The next screen displays the License Agreement. Select I accept the terms of the license
agreement and click Next.
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Depending on the type of license chosen, one of the next options will be displayed:

1. Trial license
Select the trial license file you want to install.

2. Perpetual license

• In the Register manually using the self-service website window, complete the
entries:

Entitlement ID
The Entitlement ID is only used to identify what you purchase.

System fingerprint
The system fingerprint is used for generating a license key. It is automatically
generated.

If the system fingerprint used for generating a license key is changed, the InfoPrint
Manager software continues to run in grace mode for a period of 7 days. You must
contact your local representative to receive a new license key before the period
expires, otherwise the InfoPrint Manager software will stop running on this system
when the grace period ends.

License key
Click Browse to select the folder where the license key was saved after you
received it by e-mail or downloaded from the self-service website.

3) Click Next or Register to display the next screen.

4) If Register is selected, the following message appears:

• Registration successful if the registration process is successful.

• Registration failed if the registration process fails.
If the registration process fails, a pop-up message is displayed to indicate why the
registration failed.

If the license management application fails to install the license, the InfoPrint Manager
installer will not proceed with the installation.

3. From the InfoPrint Manager Licenses main window, click Delete... to open the dialog box.
The dialog box opens on the screen asking you the following: Do you want to delete the
License?

• Select:

– yes the license is deleted

– no the license is not deleted

The graphical interface of the license management application displays the currently installed
licenses with options to delete and to add licenses.
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Using the License Key Management Application from command line

You can access the License Keys Management Application (LKMA) from the command line using
pdlicmgm. For more information, see RICOH InfoPrint Manager: Reference.

Revoking the License Key

The Self-service License Key Revoke System (SSR) is designed to permit Ricoh customers a method to
move license keys between systems and recover from system failures. If you must revoke more than 2
keys from the same EID, contact your local Ricoh Support team for assistance.

To revoke the license key:

1. Go to https://dl.ricohsoftware.com/.

2. Click the Self-Service Revoke button.

3. Select one of the 3 available revoke methods from the Revoke By list:

Entitlement ID (EID)
The EID that you must revoke for the software reporting a license violation condition.

Activation ID (AID)
The AID is necessary when you only must revoke a single set of keys for 1 EID. For example,
if you accidentally activated using the wrong system fingerprint and have the AID string
available.

License Key File Upload (license.key file or lservrc file)
Best general-purpose option for resetting all EIDs installed for a specific product on a given
server. You can select a license.key file or lservrc file.

4. Depending on your selection from the Revoke By list, enter the EID, AID, or upload the key file
in the Enter your EID, Enter your AID, or Upload Your License File (Max file size, 2 MB)
fields.

5. Enter your company name in the Company Name field. Make sure to use the same the
company name used in the original EID email.

6. To receive the revoke details, enter your valid business email address in the Business Email
Address field.

7. Agree that you have removed any infringing copies of the software and are compliant with
product licensing terms.

8. Click Submit.

After 30 seconds, you receive a notification on the website. If your request could not be approved
automatically and requires review, you receive an email from the reviewer within the next few business
days.

• Depending on the network speed or processing time, it may last up to 90 seconds until you receive
the notification.
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Managing subscription licensing

A subscription is a type of license that allows you to maintain access and usage of RICOH InfoPrint
Manager and its features for a defined period of time in exchange of a fee.

• For more information about what you need to do before you install a subscription license, see
https://help.ricohsoftware.com/accountadministration/ricoh-account-administration/en-us/raa_
AccountAdminstration_project.ditamap/$/raa_HelpTitle.

To install a subscription license:

1. Go to https://dl.ricohsoftware.com/trial_request, the InfoPrint Manager trial page, and request
a trial.

2. Once the trial has been approved, download and install the latest InfoPrint Manager version.

• You can try the product for a period of 60 days, after which the product stops functioning.

• The InfoPrint Manager Base Server and the following features are available for your
evaluation:

– InfoPrint Manager AFP2PDF Feature

– InfoPrint Manager Pull Print Feature

– InfoPrint Manager SAP Print Feature

– InfoPrint Transform Manager Feature

• For features that are not available for trial, but you have purchased using the subscription
license, contact your Ricoh sales representative.

3. If you are using a subscription license for the first time:

1. Open the License Key Management Application (LKMA) and delete all the trial licenses. For
more information about the License Key Management Application, see Using the License Key
Management Application , p. 27.

2. Restart the InfoPrint Manager system.

4. Open a web browser and enter http://localhost:14080/wmi to open the Web
Management Interface. The RICOH Cloud Connector setup dialog displays.

5. Click the Setup Cloud Connector button.

6. Follow the instructions at https://help.ricohsoftware.com/accountadministration/ricoh-account-
administration/en-us/raa_AccountAdminstration_project.ditamap/$/rcc_Setup to set up RICOH
Cloud Connector and install your subscription license.

7. Restart the InfoPrint Manager system.

1 Getting started with server systems

https://help.ricohsoftware.com/accountadministration/ricoh-account-administration/en-us/raa_AccountAdminstration_project.ditamap/$/raa_HelpTitle
https://help.ricohsoftware.com/accountadministration/ricoh-account-administration/en-us/raa_AccountAdminstration_project.ditamap/$/raa_HelpTitle
https://dl.ricohsoftware.com/trial_request
https://help.ricohsoftware.com/accountadministration/ricoh-account-administration/en-us/raa_AccountAdminstration_project.ditamap/$/rcc_Setup
https://help.ricohsoftware.com/accountadministration/ricoh-account-administration/en-us/raa_AccountAdminstration_project.ditamap/$/rcc_Setup


1

31

• To log in to RICOH Account Administration, click the RICOH Account Administration link on the
RICOH Cloud Connector Setup page.

• For more information about managing users, see https://help.ricohsoftware.com/dev_
accountadministration/dev-account-administration/en-us/raa_AccountAdminstration_project.
ditamap/$/raa_AddingAUser and https://help.ricohsoftware.com/dev_accountadministration/
dev-account-administration/en-us/raa_AccountAdminstration_project.ditamap/$/raa_
ModifyingUserInformation.

• For more information about managing accounts and subscriptions, see https://help.ricohsoftware.
com/dev_accountadministration/dev-account-administration/en-us/raa_AccountAdminstration_
project.ditamap/$/raa_ViewingSubscriptions and https://help.ricohsoftware.com/dev_
accountadministration/dev-account-administration/en-us/raa_AccountAdminstration_project.
ditamap/$/raa_ManagingAccountDetails.

TThhee WWiinnddoowwss FFiirreewwaallll
The Windows operating systems include a Windows Firewall that provides a protective boundary that
monitors and restricts information that travels between your computer and a network or the Internet. This
provides a line of defense against someone who might try to access your computer from outside the
Windows Firewall without your permission. Windows Firewall considers an “unsolicited request” any try
to connect to your computer from the Internet or from the network. Every time your computer gets an
“unsolicited request”, the Windows Firewall blocks that connection. If you choose to unblock a
connection, Windows Firewall keeps track of it by creating an exception, so you will not be notified
about it in the future.

When Windows is installed on your system and the Windows Firewall is turned on, most programs will
not be allowed to accept unsolicited communications unless you choose to list those programs as
exceptions. Because firewalls restrict communication between your computer and network, you might
need to adjust settings for some other programs that prefer an open connection. You can make an
exception for these programs or services, so that they can communicate through the Windows Firewall.

If you are running the InfoPrint Manager server on a Windows operating system, you can configure
your Windows Firewall in one of two ways:

• Turn the Windows Firewall off.

• Define an exception for a program or service, in this case, one of the supported InfoPrint Manager
components.

1. Turning the Windows Firewall off can cause security issues in your network.

2. Defining an exception for a program or a service is recommended over opening a port.

Working with the Windows Firewall

To work with the Windows Firewall on the InfoPrint Manager for Windows server:

The Windows Firewall
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1. Go to Start→ Control Panel→Windows Firewall, and theWindows Firewall dialog
appears.

1) When the Windows Firewall is active, the Firewall pop-up windows appears every time an
unsolicited request is received by your computer from the network or Internet. These pop-up
windows ask you to allow access to programs or services that are not yet on the Exceptions list.
If you choose to allow them access, the exception is saved in the exception list, and from that
moment, all requested from that program or service are accepted.

2) Microsoft recommends that you define a program or service exception, rather than opening a
port.

2. Leave the On (recommended) radio button selected to use the Windows Firewall, or click Off (not
recommended) to turn off the Windows Firewall.

3. Click Exceptions to add or remove the programs and services for which you want to change the
access to your computer through the Internet or a network. Make sure that you deselect Do not
allow exceptions.

1) You can either use the Windows Firewall pop-up windows or theWindows Firewall
Exceptions tab to give these programs or services access:

• If you are running the InfoPrint Manager server, define an exception for the pdservice.exe
and the notifyd.exe.

• If you are running the InfoPrint Manager IPP Gateway, define an exception for the ippgw.
exe.

• If you are running the InfoPrint Manager LPD service, define an exception for the lpd.exe.
• If you are running InfoPrint Manager MVS Download receivers, define an exception for the

mvsprsd.exe.
• If you are running DPF Host Receivers, define an exception for the aindpfhr.exe.
• If you have installed the InfoPrint Manager SAP Print feature:

– And you are running the SAP Callback processes, define an exception for the sapcbd.
exe.

– And your SAP system is running on HP-UX or Sun Solaris, define an exception for rshd.
exe.

2) Define an exception for File and Printer Sharing for these situations:

• If you are using Hot Folders or the Windows Gateway to accept jobs from other machines.

• If you are using the Submit Express client from the InfoPrint Manager Common Client DVD.

• If you are using interoperating InfoPrint Manager servers.

4. After a program or a service is added to the Exceptions list, you can edit and change the scope of
the exception to use IP trust and allow clients to connect to the server from any computer, subnet
network, or specific IP/mask by clicking the appropriate radio button.

5. To create a security log from the Windows Firewall, click Settings on the Security Logging section
of theWindows Firewall Advanced tab.

6. The Log Settings dialog appears.
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The default log is C:\Windows\pfirewall.log, and it identifies what connections were dropped
or successful, depending on the custom settings that you select.

7. To restore the default settings of the firewall, go to Advanced Tab on theWindows Firewall
dialog and click Restore Defaults.

SSoollvviinngg pprroobblleemmss ccaauusseedd bbyy aannttiivviirruuss ssooffttwwaarree
Programs that scan and lock files, such as antivirus products, often cause installation, functioning, and
performance problems.

In some situations, antivirus software has caused InfoPrint Manager to:

• Fail to install.

• Fail when running a custom step.

• Experience degraded performance.

• Block network traffic on some ports.

You may need to exclude some directories from scanning in order to avoid these consequences.

Suggested directories include:

• C:\Program Files\Ricoh\InfoPrint Manager

• C:\ProgramData\RICOH

If you experience any of these symptoms while running InfoPrint Manager on a server with antivirus
software installed, contact your Ricoh support representative.

IInnffooPPrriinntt MMaannaaggeerr UUsseerr IInntteerrffaacceess
This section lists the tasks you can complete with the InfoPrint Manager Administration and Operations
GUIs and the InfoPrint Manager Management Console. You use the InfoPrint Manager Administration
and Operations GUIs for most of your day-to-day InfoPrint Manager tasks, while you use the InfoPrint
Manager Management Console for tasks that must be done on the InfoPrint Manager server system.

For more information about the tasks listed here, see the online help systems in the InfoPrint Manager
Administration and Operations GUIs and the InfoPrint Manager Management Console. The InfoPrint
Manager Administration GUI and the InfoPrint Manager Operations GUI help systems also include
tutorials to help you become acquainted with the GUIs and the tasks you might need to do. To access
the tutorials, launch one of the InfoPrint Manager GUIs and select Help→ Tutorials.

For information about installing and starting the InfoPrint Manager Administration and Operations GUIs,
see InfoPrint Manager GUI software , p. 99.

Tasks you do using the InfoPrint Manager Administration interface

Printer tasks:

• Create or copy a printer (except Windows Gateway printers)

• Move a printer
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• Delete a printer

• Create, copy, and modify job and document defaults

• Change logical destinations

• Check the status of a printer

• Show the printer web page

• Enable a printer

• Disable a printer

• Space a PSF printer

• Resume a printer

• Stop or pause a PSF or InfoPrint Color printer

• Change media for a PSF, BSD, InfoPrint Color, or Passthrough printer

• Change the AFP resource information

• Change AFP color options

• Interrupt the printing of a current job

• Change job batch

• Change job routing

• Change tuning

• View or change printer properties

• Determine the media supported in the server

• Associate a medium with a physical printer

• Set or modify notification for an actual destination

• Set or modify notification for default jobs

• Specify the default form definition for a PSF printer

• Specify the default input tray and output bin for a PSF printer

• Map output-bin names to output-bin numbers

• Force messages from a printer

• Configure BSD printers that do not support the -Z flag

• Filter on actual destinations

• Display actual destinations

• Monitor printers

• Specify job batches ready for a printer

• Associate resource-context objects with an actual destination

• Associate auxiliary sheets with a PSF printer

• Activate auxiliary sheets for accounting or auditing information

• Associate input and output data user-exit programs with an actual destination

• Change the job classes that the printer can accept
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• Change the job forms that the printer can use2

Other Destination tasks:

• Create an actual destination (email)

• Move a destination

• Delete a destination

• Create, copy, and modify job and document defaults

• Change logical destinations

• Check the status of a destination

• Enable a destination

• Disable a destination

• Resume a destination

• Stop or pause a destination

• Change the AFP resource information

• Change job batch

• Change job routing

• View or change destination properties

• Set or modify notification for a destination

• Set or modify notification for default jobs

• Force messages from a destination

• Filter on actual destinations

• Display actual destinations

• Monitor actual destinations

• Specify job batches ready for a destination

• Associate resource-context objects with an actual destination

• Activate auxiliary sheets for accounting or auditing information

• Associate input and output data user-exit programs with an actual destination

• Change the job classes that the destination can accept

• Change the job forms that the destination can use2

Job tasks:

• Check the status of a queued or retained job

• Hold a job

• Release a job1

• Pause a job

• Resume a job

• Change the media for a job
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• Change the number of copies to print

• Change the priority of a job

• Change the requested destination of job

• Select the sheets of a job that you want to print

• Change the retain time for a job

• Make a job first (promote a job)

• Move a job to a destination (reorder a job)

• Move a job to an actual destination

• Move a job while ignoring the default object values

• Delete (cancel) a job

• Delete and retain a job

• View a job log

• View a job ticket

• Search for a job

• View or change job properties

• Display queued or retained jobs in the server

• Request a specific actual destination for a job

• Set or modify notification for a job

• Monitor jobs

• List all jobs for an actual destination or a queue

• Adjust the print quality of a job

• Set a job-batch value for a job

• Resubmit a retained job

• Select the pages of a job that you want to print

• Change the AFP resource information

• Change the AFP color options

• Change the job class

• Change the forms used for the job2

Queue tasks:

• Create a queue

• Delete a queue

• Check status of a queue

• Filter on queues

• Monitor queues

• Pause and resume a queue
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• Keep failed jobs

• View or change queue properties

Logical destination tasks:

• Create or copy a logical destination

• Move a logical destination

• Delete a logical destination

• Copy and modify job and document defaults

• Change the actual destinations fed by a logical destination

• Enable a logical destination

• Disable a logical destination

• View or change logical destination properties

• Filter on logical destinations

• Display logical destinations

• Associate a default job or default document

• Monitor logical destinations

• Specify the location of resources

• Specify printer driver names

• Adjust print quality in a default document

• Set or modify notification for default jobs

Server tasks:

• Show all servers currently running in the namespace

• View or change server properties

• Set or modify notification for a server

Transform tasks:

• Create a transform

• Copy a transform

• Show transforms in all servers currently being monitored

• Delete a transform

• View or change transform properties

• Associate a sequence of transforms with an actual destination

Miscellaneous tasks:

• Open windows (Main Window, Printers Window, Other Destinations Window, Logical Destinations
Window, Jobs Window, Retained Jobs Window, Queues Window)

• Check error messages

• Update interface windows
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• Customize the appearance of the interface

• Add and remove menu items and toolbar buttons

• Sort details views and tree views

• Change primary InfoPrint server connection

• Filter your view (destinations, queues, or servers)

• Access Help topics and tutorials

• When you want to copy a logical destination without the associated initial value jobs and initial
value documents, select the Copy command from the Logical menu in the InfoPrint Manager
Administration GUI. The new logical destination is associated with a new initial value job object and
all the attributes are set to default values. If you want to copy the logical destination with all the
objects associated to it, select Logical -> Job and Document Defaults -> Copy. The new logical
destination objects contain the job and document defaults as the original logical destination.

• Selected jobs are released in the same order that they are listed in the interface.

• When you add a form in the interface, it only shows up in the list of available forms after a job has
been run with that specific form.
For example, if you associate the form Letter with Job 1, Letter will not display in the Printer→
Change Forms or Job→ Change Forms drop-down lists until after Job 1 has completed.

Tasks you do using the InfoPrint Manager Operations interface

Printer tasks:

• Check the status of a printer

• Show the printer web page

• Specify job batches ready for a printer

• Enable a printer

• Disable a printer

• Space a PSF printer

• Resume a printer

• Stop or pause a PSF or InfoPrint Color printer

• Change media for a PSF, BSD, or InfoPrint Color printer

• Change job routing

• Interrupt the printing of a current job

• Monitor printers

• Change the job classes that the printer can accept

• Change the job forms that the printer can use2

Other Destination tasks:
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• Check the status of a destination

• Enable a destination

• Disable a destination

• Resume a destination

• Stop or pause a destination

• Change job routing

• Display actual destinations

• Monitor destinations

• Change the job classes that the destination can accept

• Change the job forms that the destination can use2

Job tasks:

• Check the status of a queued or retained job

• Hold a job

• Release a job1

• Pause a job

• Resume a job

• Change the media for a job

• Change the number of copies to print

• Change the priority of a job

• Change the requested destination of job

• Select the sheets of a job that you want to print

• Change the retain time for a job

• Make a job first (promote a job)

• Move a job to a destination (reorder a job)

• Move a job to an actual destination

• Move a job while ignoring the default object values

• Delete (cancel) a job

• Delete and retain a job

• View a job log

• View a job ticket

• Search for a job

• View or change job properties

• Display queued or retained jobs in the server

• Display retained jobs in the server

• Request a specific actual destination for a job
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• Set or modify notification for a job

• Monitor jobs

• List all jobs for an actual destination or a queue

• Adjust the print quality of a job

• Set a job-batch value for a job

• Resubmit a retained job

• Select the pages of a job that you want to print

• Change the AFP resource information

• Change the AFP color options

• Change the job class

• Change the forms used for the job2

Queue tasks:

• Filter on queues

• Monitor queues

• Pause and resume a queue

Server tasks:

• Show all servers currently running in the namespace

Miscellaneous tasks:

• Open windows (Main Window, Printers Window, Other Destinations Window, Jobs Window,
Retained Jobs Window, Queues Window)

• Check error messages

• Update interface windows

• Customize the appearance of the interface

• Add and remove menu items and toolbar buttons

• Sort details views and tree views

• Change primary InfoPrint server connection

• Filter your view (destinations, queues, or servers)

• Access Help topics and tutorials

1. Selected jobs are released in the same order that they are listed in the interface.

2. When you add a form in the interface, it only shows up in the list of available forms after a job has
been run with that specific form.
For example, if you associate the form Letter with Job 1, Letter will not display in the Printer→
Change Forms or Job→ Change Forms drop-down lists until after Job 1 has completed.
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Tasks you do using the InfoPrint Manager Web Interface

Printer tasks:

• Associate a media with a physical printer

• Check the status of a printer

• Show the printer web page

• Specify job batches ready for a printer

• Enable a printer

• Disable a printer

• Space a PSF printer

• Resume a printer

• Stop or pause a PSF or InfoPrint Color printer

• Change media for a PSF, BSD, or Passthrough printer

• Change job routing

• Interrupt the printing of a current job

• Monitor printers

• Favorite printers

• Change the job classes that the printer can accept

• Change the job forms that the printer can use

Other Destination tasks:

• Check the status of a destination

• Enable a destination

• Disable a destination

• Resume a destination

• Stop or pause a destination

• Change job routing

• Display printers

• Monitor destinations

• Change the job classes that the destination can accept

• Change the job forms that the destination can use

Job tasks:

• Check the status of a queued or retained job

• Hold a job

• Release a job1
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• Pause a job

• Resume a job

• Change the media for a job

• Change the number of copies to print

• Change the priority of a job

• Change the requested destination of job

• Select the sheets of a job that you want to print

• Change the retain time for a job

• Make a job first (promote a job)

• Move a job to a destination (reorder a job)

• Move a job to a printer

• Move a job while ignoring the default object values

• Delete (cancel) a job

• View a job log

• View a job ticket

• View a job

• Search for a job

• View or change job properties

• Display queued or retained jobs in the server

• Display retained jobs in the server

• Request a specific printer for a job

• Set or modify notification for a job

• Monitor jobs

• List all jobs for a printer or a queue

• Adjust the print quality of a job

• Set a job-batch value for a job

• Resubmit a retained job

• Select the pages of a job that you want to print

• Change the AFP resource information

• Change the AFP color options

• Change the job class

• Change the forms used for the job

Queue tasks:

• Filter on queues

• Monitor queues
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• Pause and resume a queue

Server tasks:

• Show all servers currently running in the namespace

Miscellaneous tasks:

• LDAP and Federated authentication login

• Opening panels: Objects Panel, Jobs Panel, Main Panel

• Customizing the appearance of the interface

• Sorting tables and panels

• Filtering your view (destinations, queues, or servers)

• Accessing Help topics

• Adding, modifying, deleting a connection

• Activating and deactivating a connection

• Filtering objects

• Viewing objects

• Adding favorite objects

• Viewing the media catalog

• Creating, copying, modifying, deleting media objects

• Viewing a job document

• User management: creating, modifying, deleting users

• Logging in and out of InfoPrint Manager Web Interface

1. Selected jobs are released in the same order that they are listed in the interface.

2. When you add a form in the interface, it only shows up in the list of available forms after a job has
been run with that specific form.
For example, if you associate the form Letter with Job 1, Letter will not display in the Printer→
Change Forms or Job→ Change Forms drop-down lists until after Job 1 has completed.

3. If you are restricting read access to InfoPrint Manager objects to specific users or groups, you must
add the wsClient user to the list of users allowed to access the objects in order to view them in the
Web Interface.

Tasks you perform using the InfoPrint Manager Web Management Interface

• Create New or Start/Stop existing pdservers

• Create New or Start/Stop existing IPP Gateway services

• Create New or Start/Stop existing MVS Download daemons

• Create New or Start/Stop existing SAP Callback daemons
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• Restart the Web Server

• Configure the Web Server settings

• Configure the Web GUI settings

• Configure the Pull Print Feature settings

• View server logs

• Control server log information

• Control ACL Security for Objects, Operations, Users or Groups

• Configure LDAP security

• Enable/Disable LDAP security

• Configure federated authentication

• Enable/Disable federated authentication

Tasks you do using the Management Console

Server tasks:

• Create, delete, start, or stop an InfoPrint Manager server

• Check server status

• View or filter the server log

• Save the view of the server log that is currently displayed as a text file

• Check the percentage of server filespace used

• Set an InfoPrint Manager server to start automatically when the system starts up

Servers Configuration tasks:

• Change the user account that the servers run under

• Change the password associated with the user account that the servers run under

• Change the domain that the InfoPrint Manager servers operate in

• View or modify InfoPrint Manager directory structure, resource search path information, and the
shared file folder location

• View or modify the ports that the servers communicate on

Web Server tasks:

• Start or stop the InfoPrint Manager Web Server

DPF tasks:

• Create, view, modify, or delete a DPF host receiver

• Start, stop, pause, or resume a DPF host receiver

• Cancel a DPF print job that is currently downloading

• Obtain printer characteristics
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• Find a specific DPF resource in the DPF Resource database

• Delete a DPF resource

Destination tasks:

• View the status and attributes of InfoPrint destinations

• Migrate a Windows printer into an InfoPrint destination

• Create, view, modify, or delete a Windows Gateway Printer

• Prevent some users or groups from submitting jobs to a particular destination

MVS Download tasks:

• View MVS Download receiver information

• Create or delete MVS Download receivers

• Start or stop MVS Download receivers

• Delete orphaned files

• Open the destination control file so you can edit it

SAP Callback Process tasks:

• View SAP Callback Process

• Add SAP Callback Process

• Change SAP Callback Process

• Delete SAP Callback Process

• Start SAP Callback Process

• Stop SAP Callback Process

Troubleshooting tasks:

• Capture system information to provide to InfoPrint Service

• Manage server tracing

• Manage PSF destination tracing

• View PSF destination logs

• Reset communications between the InfoPrint Manager server and other servers

• Create or clear namespace

• Manage DPF host receiver tracing

• Show DPF host receiver drive information

• Recreate DPF resources database

• ControlMVS Download Tracing

• Export configuration

• Import configuration

Security tasks:
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• View InfoPrint Access Control Lists (ACLs) and the InfoPrint users and groups who have permissions
associated with them

• Add or delete InfoPrint member/group of InfoPrint ACL

• Modify InfoPrint member/group permissions in InfoPrint ACL

• Create, view, modify, or delete InfoPrint security groups and their members

• Enable/Disable LDAP security

• Configure LDAP security

• Clear LDAP cache

Input Manager tasks:

• Change Input Manager settings

• Clean up leftover Input Manager files

Pull Print Feature tasks:

• Add or change the Pull Print Feature settings

• Configure the Pull Print Feature settings

Miscellaneous tasks:

• Start up one of the other InfoPrint Manager GUIs

• Specify which view of the InfoPrint Manager GUI to launch from the Management Console

• Print a test job

• Enable or disable IPP Gateway

• Enable or disable notification server

• Add a Windows port

• Specify how often you want the information displayed in the Management Console to be updated

• Update the information currently displayed in the Management Console

• View help for error and informational messages

• Enable/disable the InfoPrint Manager LPD

• Export configuration

• Import configuration

– For more information on which configuration settings can be exported and imported, see ”Using
the InfoPrint Manager System Migration (ISMU) Utility” from the RICOH InfoPrint Manager for
Windows: Procedures publication.

– You cannot use any multi-byte or special characters, such as: ~!@#$%^&*_-+=`|\(){}
[]:;""'<>,.?/ in the name of the folder in the Import/Export dialogs in the Management
Console.

1 Getting started with server systems



1

47

Starting the InfoPrint Manager Management Console

To start the InfoPrint Manager Management Console, click the Windows Start button and select
Programs→ InfoPrint Manager→Management Console.

UUnnddeerrssttaannddiinngg pprriinntteerr ddrriivveerrss,, ppoorrtt mmoonniittoorrss,, wwiinnddoowwss ggaatteewwaayy
pprriinntteerrss,, aanndd ppaasssstthhrroouugghh pprriinntteerrss
Before you decide which type of InfoPrint actual destination to create, you should first understand these
terms and concepts. Figure 1: InfoPrint Manager print data stream flow, p. 48 illustrates how these items
can fit into your InfoPrint Manager system.

Printer driver
Software that accepts the output of your applications and converts it into a data stream that the
printer can understand. Most printers come with one or more drivers that you can install and use; the
printer documentation provides more specific information about the capabilities of the drivers. The
driver you use determines what data stream is sent to the printer. In InfoPrint Manager, the driver
might process the data before it is placed on the print spool.

Port monitor
Software that controls how the data stream that is generated by the printer driver gets to the printer.
If your printer is local- or parallel-attached to your system, you use a local port monitor; if your
printer is attached over TCP/IP, you can use a TCP/IP port monitor. InfoPrint Manager includes
these port monitors:

InfoPrint port monitor
Use this port monitor to send print data to the InfoPrint Manager spool.

InfoPrint TCP/IP Network Port Monitor
Use this port monitor to send print data with PJL to the Windows spool.

To use the InfoPrint TCP/IP Network Port Monitor, the printer must support the PJL USTATUS
command.

InfoPrint TCP/IP Network Port Monitor is distributed with the InfoPrint Manager server.

When you use the InfoPrint TCP/IP Network Port Monitor with the Passthrough DSS,
InfoPrint Manager provides accurate page completion information.

If a job is printing and another job is sent to the same printer from a different machine when
you use the InfoPrint TCP/IP Network Port Monitor, the page count shown in the server
accounting log might not be accurate. The PJL implementation in the printer causes this
situation. This does not happen for jobs sent from the same machine.

When you use Class drivers (type 4 printer drivers), InfoPrint port monitor and InfoPrint
TCP/IP Network Port Monitor are not supported. Use V3 print drivers either shipped with
the Windows installation base or downloaded from the manufacturer's website.

Port
A Windows entity that represents a particular output device or target. The data stream that the driver
creates is sent to the printer through a port. A port is always created with and controlled by a
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specific port monitor. InfoPrint Manager creates ports that use the InfoPrint port monitor when it
needs them. You might have to create some ports yourself (such as a port that uses the InfoPrint
TCP/IP Network Port Monitor), but you should never have to create an InfoPrint port.

Windows printer
The combination of a printer driver and a port. You can create a Windows printer using the
Windows Add printer wizard. A Windows printer receives print data, sends it through the printer
driver to create the data stream that you want to use, then sends the data stream to an output device
(printer) or target through the port. InfoPrint Manager sometimes creates Windows printers under
the covers and names them IPM-<actual destination name>. You will be able to see these printers
in the Windows Printers window, but you should never open and modify them from there.

Windows shared printer
A Windows printer that is defined so that a remote Windows user can send print jobs to it. When a
user on the network uses the Windows Add printer wizard to create a network printer on his or her
desktop, the wizard provides a list of the Windows shared printers that are available. In InfoPrint
Manager, a Windows gateway printer is a type of Windows shared printers.

InfoPrint Manager print data stream flow
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Windows gateway printer

A Windows gateway printer is a Windows shared printer that you create on your InfoPrint Manager
system. Then, users can add that printer to their desktops and submit jobs to it. The gateway submits the
jobs to the specified InfoPrint Manager destination to be printed.

InfoPrint Manager manages this Windows shared printer for you; you should never modify the port
monitor or port configuration of this printer by opening it from the Start→ Settings→ Printers
window.

You create a Windows gateway printer on the InfoPrint Manager server system using the Management
Console. Select Edit→ New→Windows Gateway Printer to open the Create Gateway Printer
dialog. In the dialog:

• Specify a share name for the Windows gateway printer. The share name is the name that users will
see in the Add Printer wizard when they look for the printer.

• Select the InfoPrint Manager destination that the gateway will send jobs to.

You must create this destination before you create the Windows gateway printer. Refer to
Understanding Destination Support Systems (DSS), p. 53 and Creating actual destinations, p. 65 for
more information about creating destinations.

• Select the printer driver that generates a data stream that corresponds to the destination or
destinations that the jobs can be printed on.

InfoPrint Manager associates the selected driver with the InfoPrint Manager port monitor to create a
Windows printer.

Passthrough printers

When you want to create a Passthrough printer, you first use the Management Console to create a port
that the Passthrough printer will use. When you create this port, you must select a port monitor that
supports the attachment type for your printer. For example, if your printer is local or parallel-attached,
select the Local Port; if your printer is TCP/IP attached, use a TCP/IP port monitor designed for that
printer.

For most TCP/IP attached printers, you can use the InfoPrint TCP/IP Network Port Monitor. However, to
send PDF jobs to a printer that accepts the PDF data stream, you will have to use a different port
monitor.

Then you use the InfoPrint Manager Administration GUI to create the Passthrough printer, specifying the
port you just created.

To see a list of ports that are available on your system, complete these:

1. Click the Windows Start button and select Settings→ Printers.
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2. In the Printers window, select File→ Server Properties, and in the Print Server Properties
window, click Ports.

InfoPrint Manager automatically creates a Windows printer (named IPM-<actual destination name>)
that uses the port you named, along with the Generic / Text Only printer driver. The Generic / Text
Only driver is considered a passthrough driver because it does not change the data stream it receives.
If you send PostScript to it, it sends the same PostScript to the printer.

InfoPrint Manager manages this Windows printer for you; you should never modify it directly by
opening it from the Start→ Settings→ Printers window.

UUnnddeerrssttaannddiinngg IInnffooPPrriinntt MMaannaaggeerr SSeeccuurriittyy
InfoPrint Manager Security, a feature that you administer through the InfoPrint Manager Management
Console (MMC), lets you protect your printing system by associating an Access Control List (ACL) with
an InfoPrint Manager object or operation. An ACL is the list of users and groups who have permission to
do something to or with an object. The ACL also refers to the type of permission.

Types of permission
In InfoPrint Manager, users can have three levels of permission: read, write, and delete. The levels
provide these types of access:

Read
For operations, the user can do the operation. For servers and queues, the user can view the
attributes. If you restrict access to a server or queue, access to all objects contained by that
server or queue is automatically restricted, even if the objects are not explicitly protected. For
destinations, the user can view attributes and submit jobs to that destination.

• To access an object contained by a server or a queue, you must have at least read
permission for the higher-level object.

Write
For all objects, the user can view and modify attributes.

Delete
For all objects, the user can view and modify attributes and can delete the object.

FST Users and Groups
When InfoPrint Manager is running in FST mode, the FST users and FST groups are required to
manage the security of your printing system.

When InfoPrint Manager is first installed, three groups are created for you by default: acl_admin,
admin, and oper. The user selected as authorized user during InfoPrint Manager installation is
placed in the acl_admin group. To have the access necessary to modify the security characteristics,
the user must be a member of the acl_admin group.

The users in the admin group have more default privileges from the users in the oper group: the
possibility to create and delete InfoPrint Manager objects, and clean all the jobs associated with an
InfoPrint Manager object.
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Federated Authentication Overview
Federated authentication is a method of granting users secure access to InfoPrint Manager Web
Management Interface and the InfoPrint Manager Web Administration Interface by relying on
external identity providers (IdPs). Instead of managing separate user credentials within our system,
federated authentication allows users to log in using their existing accounts from trusted third-party
services.

• InfoPrint Manager federated authentication implementation is mapped on existing FST security
groups.

• When enabling federated authentication, FST or LDAP security continue to work as before.

• Federated authentication can be used only for the Web Management Interface or the Web
Administration Interface.

• Federated authentication works only if you enabled https for the InfoPrint Manager web
applications.

InfoPrint Manager supports the following federated authentication servers:

• Active Directory Federation Services™ (AD FS)

• Common Approach to Identity Assurance (CAIA)

• Okta®

Mapping Federated Authentication groups to FST groups
When logging in through federated authentication, the groups passed by the federated
authentication server for the user must match existing InfoPrint Manager FST groups. Those groups
identify the access rights that the user will have in the system.

• If you decide to bypass the standard (FST or LDAP) login for the web applications, make sure
that at least one user has the acl_admin group attached in the federated authentication server.
This setting allows the user to log in to Web Management Interface.

LDAP Security Overview
Lightweight Directory Access Protocol (LDAP) is an application that allows the secure use and
administration of distributed users. As an LDAP administrator, you create groups that have certain
permissions.

• InfoPrint Manager LDAP implementation is an extension of the FST security. When enabling
LDAP security, the FST security continues to work as before. To use only the LDAP security, see
Convert FST security to LDAP security, .

InfoPrint Manager supports these LDAP implementations:

• Active Directory

• IBM Tivoli Directory Server

• OpenLDAP

• NetIQ eDirectory 8.8 SP8 (Novell eDirectory)
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Communication with the LDAP system can be done without encryption, using StartTLS encryption, or
SSL encryption. This offers you flexibility, depending on your implementation of LDAP.

To be able to take full advantage of the LDAP security features, InfoPrint Manager allows 2 methods
of authentication: Simple and Digest. In addition, you can do Anonymous or Authenticated
searches in the LDAP system. To be able to do an Authenticated search, you have to provide
InfoPrint Manager with a Bind DN and a password for an LDAP user allowed to run searches
against the LDAP system.

On the client side, InfoPrint Manager supports 2 ways of authentication:

1. The client determines if it is running under an LDAP (PAM)/Active Directory system
authentication session and no more credential checks are done. The LDAP user taken from the
LDAP(PAM)/Active Directory system authentication session is used for the InfoPrint Manager
user-related attributes.
Clients using this method: InfoPrint Select without LDAP, Java GUI, SAP Clients, Command Line
Clients.

2. The client asks for the LDAP credentials and uses them to authenticate to the LDAP server. After
the authentication, the client uses the LDAP user for InfoPrint Manager user-related attributes.
Clients using this method: Web GUI and InfoPrint Select with LDAP.

Clients not using LDAP authentication: Command Line Clients for HP-UX and Sun OS, Submit
Express, MVS Download, DPF Receiver, LPD, and hot folders.

• The default Windows logon does not support LDAP, only Active Directory. This means that
InfoPrint Select, CLC, Java GUI, and SAP clients work as LDAP-enabled clients on Windows
only when you are using the Active Directory implementation of LDAP.

• When InfoPrint Manager clients are using LDAP for authentication, the following InfoPrint
Manager attributes contain the LDAP login attribute instead of the username@computername
information:

– user-name

– job-owner

– job-originator

– name-of-last-accessor

– results-profile

For more information on how to configure your LDAP security settings, see: “Managing security
for InfoPrint Manager for Windows” in RICOH InfoPrint Manager for Windows: Procedures.

LDAP Users and Groups
When InfoPrint Manager is running in LDAP mode, adding LDAP users and/or LDAP groups is
required to manage the security of your print system.

An LDAP user/group can be added to any of the FST groups or directly in the ACLs for enhanced
security. Once the user/group is defined in the InfoPrint Manager security, any client using LDAP
authentication is verified against the LDAP system. This means that you can have two users with the
same name, one using FST security and the other one using LDAP security. If you add LDAP groups
to the IPM security, the LDAP client login is checked for group membership in the LDAP system.

LDAP caching mechanism
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To minimize the number of LDAP queries run, InfoPrint Manager has an LDAP caching mechanism.
This cache is unique per machine and contains information about users, groups, and LDAP login
attributes. When a user first connects to any InfoPrint Manager server, the server checks the user
credentials against the cache. If the user exists in the cache, the server uses the local information for
security purposes. If the user does not exist, the LDAP system is queried and the user information is
stored in the cache for future usage.

There are two important advantages of using a caching mechanism:

• The number of LDAP searches is minimized, thus the InfoPrint Manager performance is not
affected.

• The LDAP connection can be interrupted for short periods of time without losing functionality
(users are able to work with the system)

You can manually purge the cache using MMC (Debug→ Clean LDAP Cache).

The LDAP caching mechanism can be manually enabled by editing the /etc/rc.lcd.

• If multiple InfoPrint Manager servers are started on the system where the cleanup command is
run, the cache of all servers is cleaned.

• If the servers are interoperated, a cleanup command cleans all server cache.

Convert FST security to LDAP security
To convert from FST security to LDAP only security, it is recommended that you create two LDAP
groups: pd_admin and pd_operator and map these groups to the admin and oper FST groups.
You can also use existing LDAP groups, if they suit your needs. The pd_admin and pd_operator
groups are sufficient for your needs. Members of these two groups can do all the administrator and
operator tasks for your system. You might need to create more LDAP groups with different
permissions depending on the access rights you need for each group and map them to the
corresponding InfoPrint Manager FST groups or directly in the InfoPrint Manager ACLs. Once you
have created and mapped the LDAP groups to the InfoPrint Manager security system, enable the
LDAP security for InfoPrint Manager. The final step in the FST to LDAP security conversion is to
remove any FST users from the FST groups or InfoPrint Manager ACLs. This operation restricts the
access of any FST users to the InfoPrint Manager objects.

Convert LDAP security to FST security
To convert from LDAP security to FST only security, you must add FST users (in the form of
username@hostname) to the admin and oper FST groups. To restrict the access level, you can add
specific users directly to the InfoPrint Manager ACLs. Once you have added all the FST users to the
InfoPrint Manager security system, disable the LDAP security for InfoPrint Manager. The final step in
the LDAP to FST security conversion is to remove any LDAP users or groups from the FST groups or
InfoPrint Manager ACLs. This restricts the access of any LDAP users to the InfoPrint Manager objects.

UUnnddeerrssttaannddiinngg DDeessttiinnaattiioonn SSuuppppoorrtt SSyysstteemmss ((DDSSSS))
The software that the actual destination uses to send jobs to the output device is called the destination
support system (DSS). InfoPrint Manager for Windows supports these DSSs:

PSF DSS
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The PSF DSS permits InfoPrint Manager to use the Print Services Facility (PSF) printing subsystem.
You can use the PSF DSS to submit print jobs to output devices that accept the Intelligent Printer Data
Stream (IPDS) or the PCL data stream. The PSF DSS accepts print jobs in a variety of data streams
and transforms them into IPDS or PCL before sending them to the output device. The PSF DSS is the
most flexible DSS. It provides a single point of control and tracking for print jobs.

The way InfoPrint Manager communicates with the output device depends on the type of actual
destination. For PSF DSS actual destinations, it also depends on the attachment type. (See
Understanding attachment types for PSF actual destinations, p. 57.)

Passthrough DSS
The Passthrough DSS permits InfoPrint Manager for Windows to use the Windows print-spooling
subsystem. This DSS supports non-IPDS (such as PostScript or PCL) printers using standard Windows
ports and port monitors.

Before you create an InfoPrint Manager Passthrough printer (also known as a Passthrough actual
destination), you must do these tasks:

• Attach the printer device as specified by its documentation

• Use the InfoPrint Manager Management Console to create a Windows port to communicate
with the printer device (see Passthrough printer, p. 76 for details)

• Install the Windows Generic/Text Only Driver from the Windows DVD

BSD DSS
The BSD DSS permits InfoPrint Manager to use remote printers or printing subsystems. InfoPrint
Manager sends jobs submitted to BSD physical printers as separate print requests to a remote print
queue.

InfoPrint Manager typically uses the lpr command to send jobs to a printer device or to another
system. The target can be any device or system that supports the lpd protocol and that connects to
the network with TCP/IP.

See the printer configuration documentation of the remote device or system for details on how to set
up a remote queue.

IPP DSS
InfoPrint Manager uses the IPP DSS to communicate with printers that are Internet Print Protocol (IPP)
enabled. This DSS allows InfoPrint Manager to access a printer by means of a Uniform Resource
Indicator (URI) string.

InfoPrint Manager does not support SSL/TLS encryption using the IPP DSS.

Anyplace DSS
InfoPrint Manager uses the Anyplace DSS to securely pull print jobs from a printer. When requested
at the printer console, the print job is processed by an Anyplace DSS before being handed off to
Streamline NX. You must configure the actual destination on the processing logical destinations to
gain control over the job flow. The Anyplace DSS print jobs take their attributes from the Anyplace
logical destination and not from the processing logical destination. All Anyplace actual destinations
have the same configuration, especially for attributes which are reflected in the datastream.

InfoPrint Manager transforms jobs submitted to Anyplace destinations to PCL before sending them to
the Streamline NX.

1 Getting started with server systems



1

55

With the Anyplace DSS, you can submit jobs to an InfoPrint Manager logical destination assigned
to an Anyplace queue that would print the jobs to an Anyplace actual destination.

DFE DSS
The DFE DSS lets InfoPrint Manager send jobs to Ricoh color engines through a DFE (Digital
FrontEnd) print server, using its added performance and advanced workflow tools.

If you send intelligent printer data stream (IPDS) to your printer, you should create PSF printers. Check
Selecting an attachment type for PSF actual destinations, p. 58 to see which attachment type to create.
Otherwise, the type of destination you create primarily depends on where your print jobs are coming
from. The appropriate DSS is different for each of these job submitters:

• PC-based applications

• Both PC-based applications and a host system (through DPF or MVS Download)

See these sections for assistance in making the decision.

Selecting a DSS for printing from PC-based applications or a host system using IP
Printway

If you do not use DPF or MVS Download to submit jobs, use Selecting a DSS for printing from PC-based
applications, p. 55 to see which type of destination fits your needs.

SSeelleeccttiinngg aa DDSSSS ffoorr pprriinnttiinngg ffrroomm PPCC--bbaasseedd aapppplliiccaattiioonnss

If the data
stream that
your
applications
send to
InfoPrint
Manager is:

PostScript, PCL, or any non-IPDS data stream PostScript, PCL (versions 4, 5,
5c and 6), or any non-IPDS
data stream

and the data
stream that
you send to
this printer is:

the same that the application sends to InfoPrint
Manager

PCL4, PCL5, PCL5c, PCL6,
PPDS¹, IPDS

and your jobs
are going to
be sent to a
printer:

through a
Windows
defined port

using a
command such
as lpr

that is IPP
enabled

that is attached to your
InfoPrint Manager system in
any of the ways listed in
Selecting an attachment type
for PSF actual destinations, p.
58.
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Create this
kind of actual
destination:

Passthrough² BSD IPP PSF

1. You can only print PPDS on a non-Windows system, for example, by sending the PPDS data
stream to an AIX system.

2. If you are printing PCL data to a Windows-defined printer, you might want to consider creating a
PSF (other-driver or command) destination instead. A Passthrough destination uses fewer
processing resources, but a PSF destination provides much more functions, such as accounting
and automatic data stream transforms.

Selecting a DSS for printing using MVS Download, DPF, or from a combination
of PC-based applications and host systems

If you send jobs to this destination from both PC-based applications and host systems using DPF or MVS
Download, use Selecting a DSS for printing using MVS Download, DPF, or from a combination of PC-
based applications and host systems, p. 56 to see which type of destination fits your needs.

SSeelleeccttiinngg aa DDSSSS ffoorr pprriinnttiinngg uussiinngg MMVVSS DDoowwnnllooaadd,, DDPPFF,, oorr ffrroomm aa ccoommbbiinnaattiioonn ooff PPCC--
bbaasseedd aapppplliiccaattiioonnss aanndd hhoosstt ssyysstteemmss

If the data
stream that your
host system and
applications
send to InfoPrint
Manager is:

AFP, ASCII, DBCS ASCII, line data,
PCL4, PCL5, PCL5c, PCL6, PS, PDF,
IPDS (through DPF)1

PCL4, PCL5,
PCL5c and PCL6

PS only

and the data
stream that you
send to your
printer is:

IPDS PCL4, PCL5, or
PCL5c, PCL6 or
PPDS2

PCL PS
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Create this kind
of actual
destination:

PSF (TCP/IP) PSF (other driver
or command)

PSF (other driver
or command) OR
any of the
destination types
listed in Selecting
a DSS for printing
from PC-based
applications, p.
55.

One of the
destination types
listed in Selecting
a DSS for printing
from PC-based
applications, p.
55.

1. DPF can only submit jobs to PSF printers. MVS Download can submit jobs to any of the printer
types listed.

2. You can only print PPDS on a non-Windows system, for example, by sending the PPDS data
stream to an AIX system

Understanding attachment types for PSF actual destinations

The attachment type for an actual destination defines how the printer device attaches to the Windows
system and communicates with InfoPrint Manager for Windows. Based on the printer device, the
attachment type is one of these:

TCP/IP
The printer device communicates using IPDS and attaches to the Windows system through the TCP/
IP network. To create the actual destination, you must specify the Internet Protocol (IP) address of the
printer device and the port number through which InfoPrint Manager communicates with the device.
The port number for TCP/IP-attached printers is an integer from 5001 to 65535.

Command
Before you create a PSF command actual destination, you must attach the printer device as
specified by its documentation. If you are using this device for converting data to PCL to print on a
PCL printer, make sure that you review Processing concerns when using the PCL Secondary, p. 61.

Other-Driver
The PCL printer device communicates using TCP/IP or attaches directly to the Windows system
through a parallel or serial port. To create the actual destination, you must specify the port
associated with a port monitor needed to operate the PCL printer. If you are using this device for
converting data to PCL to print on a PCL printer, make sure that you review Processing concerns
when using the PCL Secondary, p. 61.

Use Selecting an attachment type for PSF actual destinations, p. 58 to determine the appropriate
attachment type for PSF actual destinations.

Understanding Destination Support Systems (DSS)



1

58

SSeelleeccttiinngg aann aattttaacchhmmeenntt ttyyppee ffoorr PPSSFF aaccttuuaall ddeessttiinnaattiioonnss

If you are sending this data stream
to the printer:

IPDS PCL4, PCL5,
PCL5c, PCL6 or
PPDS

PCL4, PCL5,
PCL5c, PCL6 or
PPDS

and you are going to attach the
printer to the system where
InfoPrint Manager is running this
way:

over the TCP/IP
network

over the TCP/IP
network OR
directly attaching
it through a
parallel or serial
port

over the TCP/IP
network using a
command such as
lpr to submit jobs
to it

Select this attachment type: TCP/IP Other-driver Command

To configure a PSF-other Driver printer to not transform certain input data formats, you use the InfoPrint
Manager Administration GUI to do this configuration task. After you create the PSF Other-Driver
attached printer with the Create Printer Wizard, you must go into the Printer Properties notebook for
the printer and modify the Formats to RIP at destination field to configure your actual destination for
passthru PCL and PostScript jobs. The Formats to RIP at destination field can be found on the
Document tab of the Printer Properties notebook when all the available properties are displayed. It
might be necessary to click Show More to display all the printer properties.

Highlight both PCL and the PostScript (or only one of the two, depending upon what data types your
actual destination supports natively) from the Formats to RIP at destination list of possible values, and
click on the Add>> button.

You can specify other values besides PCL and PostScript because you might have a destination that
can accept them directly. For example, your printer might accept PDF or ASCII.

You must avoid specifying particular InfoPrint Manager attributes to make sure that jobs are not
transformed.

Document attributes that cause a job to be transformed

The following document attributes negate the Document Formats Ripped at Destination setting and
force jobs to be transformed:

• base-printer
• carriage-control-type
• chars
• color-mapping-table
• convert-to-ebcdic
• data-fidelity-problem-reported
• default-printer-resolution
• document-finishing
• explicit-page-placement
• font-fidelity-action
• font-processing-messages
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• font-resolution
• form-definition
• halftone
• image-fit
• image-length
• image-out-format
• image-width
• input-exit
• input-tray-select
• job-terminate-message-count
• jog-between-job-copies
• maximum-messages-printed
• maximum-transform-pages-ahead
• mvs-segment-id
• new-line-option
• new-line-option-data-encoding
• number-up
• other-transform-options
• output-appearance
• output-bin
• output-format
• overlay
• overlay-back
• overlay-front
• page-definition
• page-media-select
• page-select
• plex
• resource-context
• resource-context-font
• resource-context-form-definition
• resource-context-overlay
• resource-context-page-definition
• resource-context-page-segment
• resource-context-user
• resource-exit
• reverse-page-order
• scanner-correction
• screen-frequency
• segment-file-size
• shared-formdef
• shift-out-shift-in
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• sides
• start-on-new-sheet
• table-reference-characters
• transform-message-file-name
• transform-output-file-name
• x-image-shift
• x-image-shift-back
• y-image-shift
• y-image-shift-back

For more information about these attributes, see RICOH InfoPrint Manager: Reference.

Job attributes that cause a job to be transformed

These job attributes negate the Document Formats Ripped at Destination setting and force the jobs
to be transformed. For more information about these attributes, see RICOH InfoPrint Manager: Reference.

• delete-segment-list
• job-finishing
• job-rip-action
• optimize-for-multiple-copies

PSF header sheet attributes that cause a job to be transformed

These attributes could affect header sheet generation, so they also negate the Document Formats
Ripped at Destination setting and force jobs to be transformed. For more information about these
attributes, see RICOH InfoPrint Manager: Reference.

• account-text
• address1-text
• address2-text
• address3-text
• address4-text
• building-text
• department-text
• mvs-class
• mvs-destination
• mvs-forms
• name-text
• node-id-text
• programmer-text
• room-text
• subject-text
• title-text
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• user-id-text

Processing concerns when using the PCL Secondary

InfoPrint Manager uses the PCL Secondary when PSF receives data and converts it to PCL for printing on
a PCL printer. You use the PCL Secondary whenever you submit jobs through either a PSF Other-driver
printer that does not set the document-formats-ripped-at-destination attribute or through a PSF
Command printer. This section describes concerns that are specific to jobs sent through the PCL
Secondary.

There are specific limitations that must be observed when sending jobs through the PCL Secondary:

• InfoPrint Manager only supports printing the following data streams as output of the PCL Secondary:

– PPDS

– PCL4

– PCL5

– PCL5c

– PCL6

• The PCL Secondary only:

– Produces PCL image data when there is image in the data sent to it.

– Converts on a job basis and does not save AFP resources (whether fonts, overlays, or page
segments) from previous jobs on the PCL printer.

• PCL Secondary level of support based on Intelligent Printer Data Stream Reference:

– Bar Code Support (BCOCA):Most barcode commands are supported, except for orientation
degrees. However, some orientation degrees are supported: 0, 90, 180, and 270.

– Color Management Support (CMOCA): Not supported.

– Graphic Support (GOCA):Most graphic commands are supported, except for mapping
options and orientation degrees. However, the mapping option position-and-trim and some
orientation degrees are supported: 0, 90, 180, and 270.

– Image Support (IOCA):Most image commands are supported, except for Bi-level color,
JBIG2 compression algorithm, and orientation degrees. However, some orientation degrees are
supported: 0, 90, 180, and 270. Any color related functions are only supported for PCL6.

– Object Container Support:Most Object Container commands are supported, except for Bi-
level color, grayscale, and orientation degrees. However, some orientation degrees are
supported: 0, 90, 180, and 270. PCL Secondary depends on the transforms to convert image
into AFP. Therefore, any limitations imposed by the transform also apply to the PCL Secondary.

– Text Support (PTOCA):Most text commands are supported, except for: glyph layout controls,
Unicode complex text, Write Text Controls, and orientation degrees. However, some orientation
degrees are supported: 0, 90, 180, and 270.

• The PCL Secondary does not support:

– Finishing Operations.

– Saved Pages.
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– Alternate Offset Stacker.

– Control Edge Marks.

– Running parallel PCL Secondaries to transform jobs into PCL format, unless you create and print
to different actual destinations.

– Using any printer-resident resources (see How the PCL Secondary uses fonts, p. 64).

– Reusing printer resources (including fonts) in subsequent jobs.

– Full range for units per unit base additional function of BCOCA BCD2 subset.

– Output bin switching between pages. The first printed output bin is used for all pages.

– Full IS/3.

• When printing with double byte fonts, the value for the printer-memory actual destination attribute
must be 65535 kilobytes.

Configuring trays for PCL Secondary printers

Mapping input tray numbers between the PCL Secondary and the printer is different than mapping input
trays between IPDS printers and the printer. For an IPDS printer, InfoPrint Manager gets the available
trays from the printer. For the PCL Secondary, you must configure the trays you want to use because
InfoPrint Manager cannot query the printer and must mimic an IPDS printer to capture formatting
information:

SSaammppllee iinnppuutt ttrraayy mmaappppiinnggss

AFPDS tray #1 tray #1

AFPDS tray #2 tray #4

SSaammppllee iinnppuutt bbiinn mmaappppiinnggss ffoorr PPCCLL66

BBiinn## LLooccaattiioonn

1 Auto Select, based on paper size

2 Manual Feed

3 Multiple Purpose Tray

4 Upper Cassette

5 Lower Cassette

6 Envelope Tray

7 Third Cassette

The PCL Secondary has limitations that apply to input trays that might limit your ability to do certain
tasks. Because it supports an older version of the IPDS Load Copy Control (LCC) command, the PCL
Secondary is limited in what it can do with copies. When printers support the older version of the LCC
command, IPDS uses an Execute Order Homestate Select Input Media Source (XOH-SIMS) command
each time a medium map changes. The PCL Secondary's older version of the LCC command limits you
to specifying one input tray for each LCC command. Because each XOH-SIMS command overrides the
previous one, you cannot specify multiple copies of each page from different trays on the PCL printer.
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For a complete example of how this works, see the psf-tray-characteristics actual destination attribute
description in RICOH InfoPrint Manager: Reference.

For example, if you were to try and print a job with a form definition that specifies multiple input trays for
each page, you might be able to print successfully using an IPDS printer that supports these
specifications, but be unable to print that same job to a PCL printer through the PCL Secondary. With the
printer using the PCL Secondary, InfoPrint Manager uses an XOH-SIMS command each time the form
definition changes the medium map.

Configuring output bins for PCL Secondary

In the InfoPrint Manager GUI in the Printer Properties window onMedia/Bin/Trays label, you
can select a default output bin for the printer and modify theMap output bin to number table. The
Bin name corresponds to the output bin number specified in the AFP data stream and the Bin number
corresponds to the PCL output bin number. The maximum number of entries in the table is 6.

The PCL Secondary takes the value from the Bin number and places it in the PCL command to select
the output bin as appropriate. Because the PCL printer manufacturers do not necessarily use a one-to-
one matching between the value specified in the appropriate PCL command for output bin selection and
physical output bin, you must know what value for output bin number set in the PCL command
corresponds to what physical output bin.

To do the correct mapping, look into the printer manufacturer specifications to find the number value for
each physical input tray on the printer.

Smarter IPDS Input tray

In an AFP data stream, you can select a media source using the name of the media. The MO:DCA
reference defines standard media names to be used. This is done by specific construction of a
FORMDEF that is later used to print the job. To use this feature for a new defined Custom media type,
set the name specified when creating the new Custom media in the appropriate place in the FORMDEF.

Media sizes for Input tray

The PCL Secondary process supports the following media sizes:

• 3.87 x 7.50 Env-Mon, HP

• 3.87 x 8.87 Com-9

• 3.94 x 5.83 JPOST

• 4.14 x 5.83 A6

• 4.12 x 9.50 Com-10

• 4.33 x 8.66 Int-DL

• 5.04 x 7.17 JIS B6

• 5.50 x 8.50 Invoice

• 5.85 x 8.27 A5

• 5.83 x 7.87 JPOSTD

• 6.38 x 9.02 Int-C5

• 6.93 x 9.85 Int-B5
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• 7.16 x 10.12 JIS B5

• 7.25 x 10.50 Executive

• 8.27 x 11.70 A4

• 8.50 x 11.00 Letter

• 8.50 x 13.00 Folio

• 8.50 x 14.00 Legal

• 10.12 x 14.33 JIS B4

• 11.00 x 17.00 Ledger

• 11.69 x 16.54 A3

Except these, you have the possibility to specify additional media size within the GUI by defining a
custom media size. InfoPrint Manager always sets the media to Letter if an unsupported PCL media size
is specified (other than a custom size). Media defaults to Letter only if an unsupported PCL media size
(not listed above) is selected and it is not defined as custom.

For more information on how to create a custom media size, see "Configuring media" in the RICOH
InfoPrint Manager for Windows: Procedures.

How the PCL Secondary uses fonts

The PCL Secondary supports only these types of fonts:

1. 300 pel AFP fonts

2. Relative-Metric AFP fonts

3. AFP Outline fonts

4. TrueType/OpenType fonts

You must install one of these font types on your system so they can be used by the PCL Secondary.

Because the PCL Secondary transfers data to the PCL printer character-by-character during job
processing, you cannot examine the PCL data the same way you might examine standard text or PCL
data. As a result, you cannot scan the output data for certain text strings.

Also, the PCL Secondary can neither communicate with the printer to see if the job completes printing
nor query fonts on the printer after the print command has been issued.

Since each TrueType, Type1, and CID-Key fonts are written to disk, make sure that enough disk space is
available; otherwise, jobs will fail to print. Here is the disk location: Install Path/var/psf/Printer
Name/TempFont.

Troubleshooting printing to the PCL Secondary

Potential answers to problems that can result from using the PCL Secondary through InfoPrint Manager:

The graphics in my PCL file do not print, and I receive errors with the output.
You might have submitted a file with graphics as either PCL4 or PPDS output. Neither of these data
streams support graphics. To make sure that the Sense Type Model (STM) IPDS command created
by the PCL Secondary generates the Graphics Command-Set Vector, you should print the output as
either PCL5, PCL5c, or PCL6 data.
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CCrreeaattiinngg aaccttuuaall ddeessttiinnaattiioonnss
For help in selecting the type of actual destination to create, see Understanding Destination Support
Systems (DSS), p. 53.

The InfoPrint Manager Administration and InfoPrint Manager Operations Graphical User Interfaces
(GUIs) are applications that let you easily manage your InfoPrint objects. Both GUIs are installed with
the InfoPrint Manager server and can also be installed on remote systems that use the Windows
operating systems.

The printer driven by InfoPrint Manager Administration GUI, p. 103 provides wizards to help you
create several types of actual destinations to be driven by InfoPrint Manager, p. 65. The wizard also
provides support for creating InfoPrint gateways, which allow users to submit jobs to InfoPrint Manager
even if they do not have InfoPrint Select installed.

This chapter assumes that you have started the InfoPrint Manager interfaces and you are comfortable
using them. See InfoPrint Manager User Interfaces, p. 33 for information about the tasks you can
perform with the InfoPrint Manager interfaces.

Creating a destination driven by InfoPrint Manager

Use the InfoPrint Manager Administration GUI to create these types of actual destinations. The InfoPrint
Manager Administration GUI provides wizard support for creating these types of printers:

• PSF TCP/IP printer, p. 71

• PSF Command printer, p. 72

• PSF Other-Driver printer, p. 74

• Passthrough printer, p. 76

• BSD printer, p. 79

• IPP printer, p. 81

• DFE printer, p. 82

When you use the wizard to create any of the PSF printers (PSF TCP/IP, PSF Command, or PSF Other),
the wizard sets default values for some of the attributes of the printer. The attributes and their associated
default values are listed below.

media-supported
Only set when the printer is not an SNMP printer. Default values vary depending on the printer
model you select.
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DDeeffaauulltt pprriinntteerr vvaalluueess uussiinngg tthhee wwiizzaarrdd

Printer Values

InfoPrint 70
• letter (8.5 x 11 inch)
• legal (8.5 x 14 inch)
• ledger (11 x 17 inch)
• executive (7.25 x 10.5 inch)
• folio (8.5 x 13 inch)
• statement (5.5 x 8.5 inch)
• A3 (297 x 419 mm)
• A4 (210 x 297 mm)
• A5 (148 x 210 mm)
• jis-b4-white (257 x 364 mm)
• jis-b5-white (182 x 257 mm)
• 8.5 x 12.4 inch versus 9 x 11 inch
• 12 x 18 inch

InfoPrint 1585
• A3 (297 x 419 mm)
• A4 (210 x 297 mm)
• A5 (148 x 210 mm)
• jis-b4-white (257 x 364 mm)
• jis-b5-white (182 x 257 mm)
• letter (8.5 x 11 inch)
• legal (8.5 x 14 inch)
• tabloid (11 x 17 inch)
• executive (7.25 x 10.5 inch)
• folio (8.5 x 13 inch)
• statement (5.5 x 8.5 inch)
• Universal
• 7¾ Envelope
• 10 Envelope
• DL Envelope
• C5 Envelope
• Other Envelope

InfoPrint 1532, InfoPrint 1552, InfoPrint 1572,
InfoPrint 1572 MFP, InfoPrint Color 1534,
InfoPrint 1570 MFP, InfoPrint Color 1634,
InfoPrint 1650 MFP, InfoPrint Color 1654,
InfoPrint Color 1664, InfoPrint Color 1664
MFP

• A4 (210 x 297 mm)
• A5 (148 x 210 mm)
• jis-b5-white (182 x 257 mm)
• letter (8.5 x 11 inch)
• legal (8.5 x 14 inch)
• executive (7.25 x 10.5 inch)
• folio (8.5 x 13 inch)
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Printer Values

• statement (5.5 x 8.5 inch)
• Universal
• 7¾ Envelope
• 9 Envelope
• 10 Envelope
• DL Envelope
• B5 Envelope
• C5 Envelope
• Other Envelope

InfoPrint 1540 MFP, InfoPrint 1560 MFP,
InfoPrint 1580 MFP • A3 (297 x 419 mm)

• A4 (210 x 297 mm)
• A5 (148 x 210 mm)
• jis-b4-white (257 x 364 mm)
• jis-b5-white (182 x 257 mm)
• letter (8.5 x 11 inch)
• legal (8.5 x 14 inch)
• tabloid (11 x 17 inch)
• executive (7.25 x 10.5 inch)
• folio (8.5 x 13 inch)
• statement (5.5 x 8.5 inch)
• Universal
• 7¾ Envelope
• 10 Envelope
• DL Envelope
• C5 Envelope
• Other Envelope

InfoPrint Color 1567
• A3 (297 x 419 mm)
• A4 (210 x 297 mm)
• A5 (148 x 210 mm)
• jis-b4-white (257 x 364 mm)
• jis-b5-white (182 x 257 mm)
• letter (8.5 x 11 inch)
• legal (8.5 x 14 inch)
• ledger/tabloid (11 x 17 inch)
• RA3 super tabloid
• executive (7.25 x 10.5 inch)
• folio (8.5 x 13 inch)
• statement (5.5 x 8.5 inch)
• Universal
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Printer Values
• 7¾ Envelope
• 9 Envelope
• 10 Envelope
• B5 Envelope
• DL Envelope
• C4 Envelope
• C5 Envelope
• Other Envelope
• Banner (297 x 914 mm)
• Banner (297 x 1219 mm)

InfoPrint 1612, InfoPrint 1622
• A4 (210 x 297 mm)
• A5 (148 x 210 mm)
• A6 (105 x 148 mm)
• jis-b5-white (182 x 257 mm)
• letter (8.5 x 11 inch)
• legal (8.5 x 14 inch)
• executive (7.25 x 10.5 inch)
• folio (8.5 x 13 inch)
• statement (5.5 x 8.5 inch)
• Universal
• 7¾ Envelope
• 9 Envelope
• 10 Envelope
• DL Envelope
• B5 Envelope
• C5 Envelope
• Other Envelope

InfoPrint 2190, InfoPrint 2210, InfoPrint 2235
• A3 (297 x 419 mm)
• A4 (210 x 297 mm)
• A5 (148 x 210 mm)
• A6 (105 x 148 mm)
• B4 (257 x 364 mm)
• B5 (182 x 257 mm)
• B6 (128 x 182 mm)
• letter (8.5 x 11 inch)
• legal (8.5 x 14 inch)
• ledger (11 x 17 inch)
• executive (7.25 x 10.5 inch)
• folio (8.5 x 13 inch)
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Printer Values

• statement (5.5 x 8.5 inch)
• 8.25 x 13 inch
• 8.25 x 14 inch
• 8 x 10 inch
• 8 x 13 inch
• 10 x 14 inch
• 11 x 14 inch
• 11 x 15 inch
• 12 x 18 inch
• 8 kai (267 x 390 mm)
• 16 kai (195 x 267 mm)
• Custom (148 x 210 mm to 305 x 458 mm)

InfoPrint Color 1754, InfoPrint Color 1764,
InfoPrint Color 1764 MFP • A4 (210 x 297 mm)

• A5 (148 x 210 mm)
• jis-b5-white (182 x 257 mm)
• letter (8.5 x 11 inch)
• legal (8.5 x 14 inch)
• executive (7.25 x 10.5 inch)
• folio (8.5 x 13 inch)
• statement (5.5 x 8.5 inch)
• Universal
• 7¾ Envelope
• 9 Envelope
• 10 Envelope
• DL Envelope
• B5 Envelope
• C5 Envelope
• Other Envelope

InfoPrint Color 1767, InfoPrint Color 1759
MFP, InfoPrint Color 1769 MFP • A3 (297 x 419 mm)

• A4 (210 x 297 mm)
• A5 (148 x 210 mm)
• jis-b4-white (257 x 364 mm)
• jis-b5-white (182 x 257 mm)
• letter (8.5 x 11 inch)
• legal (8.5 x 14 inch)
• executive (7.25 x 10.5 inch)
• folio (8.5 x 13 inch)
• statement (5.5 x 8.5 inch)
• tabloid (11 x 17 inch)
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Printer Values
• Universal
• 7¾ Envelope
• 10 Envelope
• DL Envelope
• C5 Envelope
• Other Envelope

InfoPrint EMP156
• A3 (297 x 419 mm)
• A4 (210 x 297 mm)
• B4 (257 x 364 mm)
• B5 (182 x 257 mm)
• 12 x 18 inch
• letter (8.5 x 11 inch)
• legal (8.5 x 14 inch)
• ledger (11 x 17 inch)
• executive (7.25 x 10.5 inch)
• folio (8.5 x 13 inch)
• Custom (203.2. x 177.8 mm to 355.6 x

457.2 mm)

All other printer models
• letter (8.5 x 11 inch)
• legal (8.5 x 14 inch)
• tabloid (11 x 17 inch)
• ledger (11 x 17 inch)
• A3 (297 x 419 mm)
• A4 (8.27 x 11.69 inch)
• jis-b4-white (257 x 364 mm)
• jis-b5-white (182 x 257 mm)

sides-supported
Only set when the printer is not an SNMP printer. Set to 1 and 2.

plexes-supported
Only set when the printer is not an SNMP printer. Set to simplex and tumble.

printer-resolutions-supported
Set to 240, 300, 480, and 600.

If you are running with the Basic InfoPrint Manager GUI, InfoPrint Manager sets the defaults shown in
the following table also.
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BBaassiicc IInnffooPPrriinntt MMaannaaggeerr AAddmmiinniissttrraattiioonn GGUUII ddeeffaauullttss ffoorr PPSSFF pprriinntteerrss

Attribute Default values

printer-resolutions-ready 600

booklet-fold (set only for InfoPrint 4000) down

optimize-for-multiple-copies (set only for
printers which support this)

true

start-sheets-supported job-ticket

printer-start-sheet job-ticket

form-definition F100D

accounting-exit accounting-log

PSF TCP/IP printer

Create a PSF actual destination to represent an Intelligent Printer Data Stream (IPDS) printer. Use the
TCP/IP attachment type for an IPDS printer that PSF controls directly through TCP/IP.

Before creating a PSF TCP/IP printer, complete this worksheet.

PPSSFF TTCCPP//IIPP pprriinntteerr wwoorrkksshheeeett

Wizard Prompt Description Value

Name The name for the actual
destination object (64 character
limit).

This name is case-sensitive.

Server The InfoPrint server that controls
this actual destination. By
default, the server name is the
same as the name of the system
where the server is installed.

This name is case-sensitive.

Model Select the printer model from the
pull-down list in the InfoPrint
Manager Administration GUI. If
the printer you are working with
is not in the pull-down list, enter
the name as it appears on the
printer.
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Wizard Prompt Description Value

TCP/IP address The IP address used to access
this printer.

TCP/IP port The port used by the printer for
communication. The InfoPrint
1000 family of printers uses
port 9100. Most other printers
default to port 5001. The value
you use here must match the
value set at the printer.

Logical destination The logical destination that
directs jobs to this actual
destination.

This name is case-sensitive.

__ Default __ Other:

Logical destination's server The InfoPrint server that contains
the logical destination.

This name is case-sensitive.

Queue The queue that holds jobs
destined for this actual
destination.

This name is case-sensitive.

__ Default __ Other:

To create this type of printer, use the Create Printer Wizard in the InfoPrint Manager Administration
GUI. (On the menu bar, click Printer→ Create→ PSF→ TCP/IP.)

If TCP/IP is not shown in the Printer→ Create→ PSF menu, use Printer→ Add/Remove Menu
Items to add it.

PSF TCP/IP printer worksheet, p. 71 provides the information that the wizard prompts for. For
assistance, see the InfoPrint Manager Administration GUI online help.

If you did not enable the printer with the Create Printer Wizard, use the InfoPrint Manager
Administration GUI to enable it.

PSF Command printer

Use the command attachment type for a PCL printer that receives data streams transformed by PSF from
a print command.

Before creating a PSF Command printer, complete this worksheet.
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PPSSFF ccoommmmaanndd pprriinntteerr wwoorrkksshheeeett

Wizard Prompt Description Value

Name The name for the actual
destination object (64 character
limit).

This name is case-sensitive.

Server The InfoPrint server that controls
this actual destination. The
server name is the same as the
name of the system where the
server is installed.

This name is case-sensitive.

Model Select the printer model from the
pull-down list in the InfoPrint
Manager Administration GUI. If
the printer you are working with
is not in the pull-down list, enter
the name as it appears on the
printer.

SNMP TCP/IP address The IP address used to access
this printer. This value is used
only for SNMP printers.

Device The AIX device name. This is not
applicable for Windows.

Leave blank.

Printer command The command string used to
send a job to the appropriate
Windows printer. For example,
lpr -S serverName -P
printerName.

This command is case-sensitive.

Data stream The data stream expected by
the printing device (for
example, PCL5 or PCL 6).

Logical destination The logical destination that
directs jobs to this actual
destination.

This name is case-sensitive.

__ Default __ Other:
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Wizard Prompt Description Value

Logical destination's server The InfoPrint server that contains
the logical destination.

This name is case-sensitive.

Queue The queue that holds jobs
destined for this actual
destination.

This name is case-sensitive.

__ Default __ Other:

Prior to using this worksheet to create your InfoPrint Manager actual destination, you can use the
standard Windows Add Printer Wizard to make the printer available.

To create this type of printer, use the Create Printer Wizard in the InfoPrint Manager Administration
GUI. (On the menu bar, click Printer→ Create→ PSF→ Command.)

If the Command is not shown in the Printer→ Create→ PSF menu, use Printer→ Add/Remove
Menu Items to add it.

PSF command printer worksheet, p. 73 provides the information as prompted by the wizard. For
assistance, see the InfoPrint Manager Administration GUI online help.

If you did not enable the printer with the Create Printer Wizard, use the InfoPrint Manager
Administration GUI to enable it.

PSF Other-Driver printer

Create a PSF other-driver actual destination to represent a PCL printer that receives data streams
transformed by PSF through a Windows port monitor.

The InfoPrint Manager Administration GUI calls a PSF other-driver actual destination or printer, a PSF
other printer.

Before you create a PSF other-driver printer, you must create a Windows port that InfoPrint Manager
will use to communicate with the printer. Use the InfoPrint Manager Management Console to create a
Windows port with these steps:

1. Click the Windows Start button and select Programs→ InfoPrint Manager→Management
Console.

2. Select Edit→ New→Windows Port.

3. In the Create Windows Port dialog, select the appropriate port monitor for your printing
environment from the pull-down list and click OK.
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For example, if you are using an InfoPrint network-attached workgroup printer, such as the InfoPrint
2190, as a non-IPDS printer, you should use the InfoPrint TCP/IP Network Port Monitor.

The port monitor that you select determines the next dialog to appear.

Before creating a PSF other-driver printer, complete this worksheet.

PPSSFF ootthheerr--ddrriivveerr pprriinntteerr wwoorrkksshheeeett

Wizard Prompt Description Value

Name The name for the actual
destination object (64 character
limit).

This name is case-sensitive.

Server The InfoPrint server that controls
this actual destination. The
server name is the same as the
name of the system where the
server is installed.

This name is case-sensitive.

Model On either a Windows or an AIX
server, select the printer model
from the pull-down list in the
InfoPrint Manager
Administration GUI.

If the printer you are working
with is not in the pull-down list,
enter the name as it appears on
the printer; or if the printer is
SNMP-enabled, you can select
Set by SNMP printer.

SNMP TCP/IP address The IP address used to access
this printer. This value is used
only for SNMP printers.

Device or Windows port name The name of the output device
that the selected actual
destination represents.

Printer command The printer command that
submits a job to this remote
destination.

On a Windows system, leave
this column blank.

Data stream The data stream output by PSF
when a job is transformed.
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Wizard Prompt Description Value

Logical destination The logical destination that
directs jobs to this actual
destination.

This name is case-sensitive.

__ Default __ Other:

Logical destination's server The InfoPrint server that contains
the logical destination.

This name is case-sensitive.

Queue The queue that holds jobs
destined for this actual
destination.

This name is case-sensitive.

__ Default __ Other:

To create this type of printer, use the Create Printer Wizard in the InfoPrint Manager Administration
GUI. (On the menu bar, click Printers→ Create→ PSF→ Other.)

If Other is not shown in the Printer→ Create→ PSF menu, use Printer→ Add/Remove Menu
Items to add it.

PSF other-driver printer worksheet, p. 75 provides the information that the wizard prompts for. When a
PSF Other-Driver printer is created, a Windows Passthrough printer is created automatically. Therefore,
the Windows Generic/Text printer driver is required. If you have not installed the Windows Generic/
Text Printer driver before, you must install it by following the installation instructions in "Passthrough
printer", .

See the InfoPrint Manager Administration GUI online help for more assistance.

If you did not enable the printer with the Create Printer Wizard, use the InfoPrint Manager
Administration GUI to enable it.

Passthrough printer

Create a Passthrough actual destination to represent a printer that receives untransformed data streams
through a Windows port monitor; for example, to send PostScript data to a PostScript printer or to send
PCL data to a PCL printer without transforming it. When creating a Passthrough printer, the sides actual
destination attribute must be set to the default duplexing value set on the printer.
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By default, the Passthrough DSS supports only these data streams:

• ASCII

• iso-6429

• PCL

• PostScript

• PPDS

• simple-text (text)

To create a Passthrough actual destination, complete these steps.

1. Install the Windows Generic/Text Only printer driver.

1) Use the Windows Add Printer Wizard to create a local printer.

2) When you have to select a port, select FILE:.

3) When you have to select the manufacturer and model of the printer, select Generic from the list
of manufacturers and Generic/Text Only from the list of models.

4) Finish the wizard, selecting not to share the printer and not to print a test page.

5) When you are finished, you can delete the printer; the driver will still be installed.

2. Attach the printer device as specified by its documentation.

3. Define a Windows port.
If you already have a Windows port defined, you are ready to create your Passthrough printer. If
you need to create a Windows port, use the InfoPrint Manager Management Console to create a
Windows port to communicate with the printer device as follows:

1) Open the Start menu and click Programs→ InfoPrint Manager→Management Console.

2) Select Edit→ New→Windows Port.

3) In the Create Windows Port dialog, select the appropriate port monitor for your printing
environment from the pull-down list and click OK.
If you are using another InfoPrint network-attached workgroup printer, such as the InfoPrint
2190, use the InfoPrint TCP/IP Network Port Monitor.

The port monitor that you select determines the next dialog to appear.

4) Fill in the information that the dialog requires and click OK.

4. Create a Passthrough printer by completing the worksheet Passthrough destination worksheet, p. 78
and using the Create Printer Wizard in the InfoPrint Manager Administration GUI. (On the menu
bar, click Printer→ Create→ Passthrough.)

If Passthrough is not shown in the Printer→ Create menu, use Printer→ Add/Remove Menu
Items to add it.
Passthrough destination worksheet, p. 78 provides the information as prompted by the wizard. For
assistance, see the InfoPrint Manager Administration GUI online help.
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If you did not enable the printer with the Create Printer Wizard, use the InfoPrint Manager
Administration GUI to enable it.

To print a test page, see Printing a test job, p. 94.

PPaasssstthhrroouugghh ddeessttiinnaattiioonn wwoorrkksshheeeett

Wizard Prompt Description Value

Name The name for the actual
destination object. For example,
the name you will use for the
passthrough printer you just
attached.

This name is case-sensitive.

Server The server that controls this
actual destination. The server
name is the same as the name of
the system where the server is
installed.

This name is case-sensitive.

Windows port name The name of the Windows port
to assign to this destination. Enter
the Windows port name that you
want to use exactly as it
appears to Windows. To
determine what ports exist on
your server, open the Start
menu and click Settings→
Printers. On the Printers
dialog, click File and click
Server Properties. The Print
Server Properties dialog box
appears where you can click
Ports to display the list of
available ports.

TCP/IP address The IP address used to access
this printer. This value is used for
SNMP printers only.

Logical destination The logical destination that
directs jobs to this actual
destination.

This name is case-sensitive.

__ Default __ Other:
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Wizard Prompt Description Value

Logical destination's server The InfoPrint server that contains
the logical destination.

This name is case-sensitive.

Queue The queue that holds jobs
destined for this actual
destination.

This name is case-sensitive.

__ Default __ Other:

BSD printer

Create a BSD actual destination when you need to configure a terminating transform at the actual
destination or when no other DSS is suitable. The BSD DSS gives you less control of the printer and
reports less accurate job status than the other DSSs.

Before creating a BSD printer, complete this worksheet.

BBSSDD pprriinntteerr wwoorrkksshheeeett

Wizard Prompt Description Value

Name The name for the actual
destination object.

This name is case-sensitive.

Server The InfoPrint server that controls
this actual destination. The
server name is the same as the
name of the system where the
server is installed.

This name is case-sensitive.

SNMP TCP/IP address The IP address used to access
this printer. This value is used
only for SNMP printers.

Printer command The command to issue to submit
a job to this remote destination.
Typically, this is a call to the lpr
command. For example, lpr -S
serverName -P printerName.
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Wizard Prompt Description Value

This command is case-sensitive.

Data stream The data stream expected by
the printed device (for example,
PCL5 or PCL6).

Logical destination The logical destination that
directs jobs to this actual
destination.

This name is case-sensitive.

__ Default __ Other:

Logical destination's server The InfoPrint server that contains
the logical destination.

This name is case-sensitive.

Queue The queue that holds jobs
destined for this actual
destination.

This name is case-sensitive.

__ Default __ Other:

To create this type of printer, use the Create Printer Wizard in the InfoPrint Manager Administration
GUI. (On the menu bar, click Printer→ Create→ BSD.)

If BSD is not shown in the Printer→ Create menu, use Printer→ Add/Remove Menu Items to add
it.

BSD printer worksheet, p. 79 provides the information as prompted by the wizard. For assistance, see
the InfoPrint Manager Administration GUI online help.

When you use the lpr command with a BSD actual destination, the printer prints only single-document
jobs. If you send a BSD actual destination a multiple-document job, only the last document in the job
prints.

If you did not enable the printer with the Create Printer Wizard, use the InfoPrint Manager
Administration GUI to enable it.
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IPP printer

Create an IPP actual destination to represent a printer that supports the Internet Printing Protocol (IPP).
The printer must have an assigned uniform resource indicator (URI). When creating an IPP printer, the
sides actual destination attribute must be set to the default duplexing value set on the printer.

Before creating an IPP printer, complete this worksheet.

IIPPPP ddeessttiinnaattiioonn wwoorrkksshheeeett

Wizard Prompt Description Value

Name The name for the actual
destination object. This is the
printer URL, for example, np17.
prtrm4.bldr.infoprint.com.

This name is case-sensitive.

Server The server that controls this actual
destination. The server name is the
same as the name of the system
where the server is installed.

This name is case-sensitive.

URL The universal resource locator
(URL) for this destination.

TCP/IP address The IP address used to access this
printer. This value is used for
SNMP printers only.

IP Address An IPv4 and/or IPv6 address
statically assigned to this system.
Not needed if DHCP is in use.

Logical destination The logical destination that directs
jobs to this actual destination.

This name is case-sensitive.

__ Default __ Other:
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Wizard Prompt Description Value

Logical destination's server The InfoPrint server that contains
the logical destination.

This name is case-sensitive.

Queue The queue that holds jobs
destined for this actual
destination.

This name is case-sensitive.

__ Default __ Other:

To create this type of printer, use the Create Printer Wizard in the InfoPrint Manager Administration
GUI. (On the menu bar, click Printer→ Create→ IPP.)

If IPP is not shown in the Printer→ Create menu, use Printer→ Add/Remove Menu Items to add
it.

IPP destination worksheet, p. 81 provides the information as prompted by the wizard. For assistance,
see the InfoPrint Manager Administration GUI online help.

If you did not enable the printer with the Create Printer Wizard, use the InfoPrint Manager
Administration GUI to enable it.

DFE printer

Create a DFE actual destination to represent a DFE print server driving a Ricoh printer.

Before creating a DFE printer, complete this worksheet.

DDFFEE pprriinntteerr wwoorrkksshheeeett

Wizard Prompt Description Value

Name The name for the actual
destination object (64 character
limit).

This name is case-sensitive.

Server The InfoPrint server that controls
this actual destination.

This name is case-sensitive.

Model Allow the DFE print server to set
this information or enter the

__Set by DFE printer
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Wizard Prompt Description Value

name as it appears on the
printer.

TCP/IP address The IP address used to access
the DFE print server.

User The user name that the DFE DSS
actual destination will use to
connect to the Digital Front End
(DFE) server, such as a Fiery
DFE.

Password The password the DFE DSS
actual destination will use to
establish authorized access to
the Digital Front End (DFE)
server, such as a Fiery DFE.

To create this type of printer, use the Create Printer Wizard in the InfoPrint Manager Administration
GUI. (On the menu bar, click Printer→ Create→ DFE.)

If TCP/IP is not shown in the Printer→ Create→ PSF menu, use Printer→ Add/Remove Menu
Items to add it.

DFE printer worksheet, p. 82 provides the information that the wizard prompts for. For assistance, see
the InfoPrint Manager Administration GUI online help.

If you did not enable the printer with the Create Printer Wizard, use the InfoPrint Manager
Administration GUI to enable it.

WWoorrkkiinngg wwiitthh ffiilleess llaarrggeerr tthhaann 22 ggiiggaabbyytteess
With InfoPrint Manager, a file that is larger than 2 gigabytes is considered a large file.

This section includes:

• Which job submission clients are supported

• Which output methods are supported

• Which document formats are supported

• Which output formats are supported

Working with files larger than 2 gigabytes
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Job submission clients supported

Client Windows AIX Linux
pdpr with AIX, Linux,
macOS and Windows

Supported Supported Supported

Download for z/OS Supported Supported Supported

Hot folders Supported Supported Supported

InfoPrint Select Not supported Not supported Not supported

Submit Express Not supported Not supported Not supported

IPP Gateway Not supported Not supported Not supported

Windows Gateway Not supported Not supported Not supported

Output methods supported

The PSF DSS is the only DSS that supports large files. PSF DSS attachments that support large files
include:

Client Windows AIX Linux

TCP/IP Supported Supported Supported

Command Supported Not supported Not supported

Other Supported Not supported Not supported

1. The reverse-page-order actual destination and document or default document attributes are not
supported for large files.

2. Jobs that are processed by the Transform subsystem support files greater than 2 gigabytes in size if
the command that is being called has support for files greater than 2 gigabytes in size.

InfoPrint Manager document formats support for greater than 2 gigabyte files

Document format Windows AIX Linux
MOD:CA Supported Supported Supported

PostScript (see Notes 1
and 2)

Supported Supported Supported

PCL (see Note 1) Supported Supported Supported

1 Getting started with server systems
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Document format Windows AIX Linux
PDF Supported Supported Supported

Line data Supported Supported Supported

XML Not supported Not supported Not supported

Xerox Not supported Not supported Not supported

SAP Supported Supported Supported

TIFF, JPEG, GIF Not supported Not supported Not supported

ASCII Not supported Not supported Not supported

1. Embedded PostScript and PCL objects in AFPDS are not supported if the ps2afp or pcl2afp
transform produces AFP output that is greater than 2 gigabytes.

2. If you use the ps2afp transform stand-alone (command line with the -o option), it does not
support files that are greater than 2 gigabytes in size.

InfoPrint Manager output format support for greater than 2 gigabyte files

Output format Windows AIX Linux

Booklet print Not supported Not supported Not supported

Booklet print with
integrated cover

Not supported Not supported Not supported

Side-by-side copies Not supported Not supported Not supported

Slit-and-merge Supported Supported Supported

Simple-n-up Supported Supported Supported

PPrreeppaarriinngg IInnffooPPrriinntt MMaannaaggeerr ttoo ccoonnnneecctt ttoo yyoouurr hhoosstt ssyysstteemm
InfoPrint Manager provides various methods to configure printing from host systems. The most powerful
methods are: Distributed Print Function (DPF) and MVS Download. If you have not decided which
method is best for your operation, see the InfoPrint Manager for Windows: Planning Guide for descriptions
and comparisons of the methods. You need to know which method to use before you can create the
connection between InfoPrint Manager and the host.

Both InfoPrint Manager host printing options use host receivers to link the server to the host. There are
two types of host receivers, one for each host printing method. Each type of receiver performs different
functions.

• DPF host receiver

Preparing InfoPrint Manager to connect to your host system
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Downloads print jobs and its resources from a PSF on your host system and submits them to an
InfoPrint Manager PSF printer to be printed. On the host PSF, the DPF host receiver is like a TCP/IP-
attached IPDS printer. You can submit jobs to the DPF host receiver using the methods used to send
jobs to a TCP/IP-attached IPDS printer.

If your host operating system is MVS or VSE, the DPF host receiver stores all of the DPF Resources it
receives in the DPF Resources database. If you have the Save resources function of the receiver
turned on, all resources that are marked public on the host are shown in the DPF Resources view of
the Management Console. Additional information about the Save resources function is available in
the online help in the Management Console and in the RICOH InfoPrint Manager for Windows: Planning
Guide.

• MVS Download receiver
Receives print files and JCL parameters from the MVS host. The receiver applies a Destination
Control File (DCF) to the JCL parameters and generates a corresponding list of InfoPrint parameters.
The list of InfoPrint parameters is then passed to the MVS Download Exit Program (or Exit) so
InfoPrint Manager can process the job.

The Exit performs actions on the received file. A sample exit is provided with InfoPrint Manager:
written in Microsoft Visual C++ Version 6.0. This sample submits the file to InfoPrint Manager using
pdpr and logs any errors. The sample exit also stops the MVS Download receiver if the pdpr fails.

MVS Download receivers do not download AFP resources with print jobs. AFP resources must be
available to InfoPrint Manager.

After you have created your actual destinations, use the procedure below to create the right type of host
receivers on your InfoPrint Manager server.

• Before you create a DPF host receiver, p. 86

• Before you create an MVS Download host receiver, p. 91

Troubleshooting host receivers

All host receivers write their error messages to the server message log. If you start to have trouble with
host printing, check the server error log for host receiver problems first. To see the server message log,
open the Management Console and click Server Log in the left pane.

Before you create a DPF host receiver

When you create a DPF host receiver, you have to specify which InfoPrint Manager actual destination
the host receiver will send jobs to. If you have not already created the actual destinations you need, see
Creating actual destinations, p. 65.

1 Getting started with server systems
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1. You must use the PSF DSS with DPF.

2. If you have interoperating InfoPrint Manager servers, the actual destination that the host receiver
submits jobs to and the logical destination that the actual destination is associated with must reside
on the same server.

3. If you currently use DPF in PSF for OS/2, see the RICOH InfoPrint Manager for Windows: Planning Guide
for instructions on collecting the information from your OS/2 system. You can use the printer and
spool information that you collect to configure your InfoPrint Manager actual destination.

DPF working directories

Each DPF host receiver must have two working directories associated with it; one for jobs and one for
resources. These directories can only be used by one host receiver and should be reserved exclusively
for that host receiver; they should not be used by any other programs or for any other purpose.

When you create a DPF host receiver, InfoPrint Manager will fill in default directory paths for the
working directories. If you accept those directories, InfoPrint Manager will create them for you.
However, to store your resources somewhere else (for example, on a different hard drive or a different
partition), you must create the directory yourself, before you create the host receiver.

If you create your own directories, it is recommended that you create one directory named after the
receiver, then two subdirectories inside it, one named Jobs and one named Resources. For example,
to name your host receiver hr_ip4000, you would create a directory named hr_ip4000, then create
the Jobs and Resources subdirectories under it. When you create your host receiver, you would type
E:\hr_ip4000\Jobs for the Jobs directory and E:\ hr_ip4000\Resources for the Resources
directory.

Creating a DPF host receiver

1. Complete these configuration worksheets. Only the PSF actual destination and Port number
values are required to create a receiver; if you're not sure what to fill in for the rest of the items, you
can accept the defaults and change the values in the receiver later.

If you currently use DPF in PSF for OS/2, see the RICOH InfoPrint Manager for Windows: Planning Guide
for instructions on collecting the information you need from your OS/2 system.

Preparing InfoPrint Manager to connect to your host system
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DDPPFF hhoosstt rreecceeiivveerr wwoorrkksshheeeett

Management Console
Prompt

Description Value

Logical unit alias name Because DPF connects to
InfoPrint Manager over TCP/
IP, you will not use the LU
alias, however, knowing it will
help you figure out the TCP/IP
connection.

PSF actual destination The name of the actual
destination object that this
receiver will send jobs to.

This name is case-sensitive.

Port number The port that the host receiver
will use to communicate with
the host system.

Description Text to describe this receiver
(optional).

Submission priority The relative importance of jobs
submitted by this receiver. 1 is
the highest priority; 100 is the
lowest priority.

Default: 50

Inactivity limit Number of seconds to wait for
jobs from a connected host
before disconnecting. When
the inactivity timer runs out, the
receiver drops the connection
with the host system. If the timer
is set to 9999, it will never run
out.

Default: 9999

Save resources If Save resources is selected,
the DPF host receiver
acknowledges the public/
private settings on the DPF
resources that are
downloaded with print jobs.
Resources that were marked
public on the host are stored in
the DPF Resources Database
for reuse later. Resources that
were marked private cannot
be reused. If Save resources is
not selected, all DPF resources
that are downloaded are
considered private.

__ yes __ no

1 Getting started with server systems
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Management Console
Prompt

Description Value

Obtain printer characteristics
at start up

If selected, the receiver checks
the printer settings every time
the receiver connects to a host
PSF and communicates any
changes to the host system.

__ yes __ no

Enable SSL/TLS If selected, the DPF receiver
communicates with the
mainframe through the SSL/
TLS protocol.

__ yes __ no

Suppress start sheets Select to turn off the start
sheets that InfoPrint Manager
generates.

__ yes __ no

Suppress end sheets Select to turn off the trailer
sheets that InfoPrint Manager
generates.

__ yes __ no

Suppress separator sheets Select to turn off the separator
sheets that InfoPrint Manager
generates.

__ yes __ no

Jobs directory The directory that the host
receiver stores print jobs in
until they are printed. For more
information, see DPF working
directories, p. 87.

Resources directory The directory that the host
receiver stores job resources
in. For more information, see
DPF working directories, p. 87.

DDPPFF hhoosstt rreecceeiivveerr ccllaassss sseett uupp wwoorrkksshheeeett

Receiver

Class Copies Start page Disposition Retention Period

• Print
• Retain
• Print then Retain

• ___ Forever
• ___ Days
• ___ Hours

• Print
• Retain
• Print then Retain

• ___ Forever
• ___ Days
• ___ Hours

• Print • ___ Forever

Preparing InfoPrint Manager to connect to your host system
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Receiver
• Retain
• Print then Retain

• ___ Days
• ___ Hours

• Print
• Retain
• Print then Retain

• ___ Forever
• ___ Days
• ___ Hours

• Print
• Retain
• Print then Retain

• ___ Forever
• ___ Days
• ___ Hours

2. Open the InfoPrint Manager Management Console and select Edit→ New→ DPF Host
Receiver.

3. Use the information from the worksheet to complete the dialog. Make sure you click Class Set Up
to configure your receiver classes with the information from DPF host receiver class set up worksheet,
p. 89. Click OK when you are finished.
For further information, see the Management Console help system.

The first time you try to start this receiver and connect to your host system, make sure that the printer
that it will submit jobs to is powered ON and is available.

4. See Settings on your host system, p. 90 to create a printer that will submit jobs to this host receiver
from your host system.

Settings on your host system

To your host system, the DPF host receiver looks like a PSF TCP/IP printer. Use the appropriate
guidelines below to define a TCP/IP printer in your host PSF. Before you begin, make sure you know:

• The IP address of the system that your InfoPrint Manager server is installed on.

• The port number that you assigned to the DPF host receiver when you created it.

Keep in mind that various PSF and TCP/IP settings will affect the performance of your printing system.
See the documentation for your host PSF to learn more about the parameters and settings that are
available.

PSF for z/OS

See Print Services Facility for z/OS: Customization (S544-5622) for information and instructions about
defining a TCP/IP printer. When you have to enter the IP address of the printer, enter the IP address of
your InfoPrint Manager server instead. When you define the printer, the port defaults to 5001; if your
host receiver uses port 5001, you will not have to change it on your host system.

1 Getting started with server systems
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PSF/VM

Define a Group 4 printer, using the IP address of your InfoPrint Manager server for the IPADDR
keyword value and the port number of the DPF host receiver for the PORTNO keyword value.

Additional information about TCP/IP support and defining a Group 4 printer is available at https://
www-01.ibm.com/servers/resourcelink/svc00100.nsf/pages/zOSV2R3S5500427/$file/apss000_
v4r6.pdf.

PSF for VSE

Edit the PSF Startup job so that you use the IP address of your InfoPrint Manager server for the IPADDR
parameter and the port number of the DPF host receiver for the PORTNO parameter. If your DPF host
receiver uses port 5001 (the default port in PSF for VSE), you do not have to specify a value for the
PORTNO parameter.

Additional information about TCP/IP support for PSF for VSE is available at https://www-01.ibm.com/
servers/resourcelink/svc00100.nsf/pages/zOSV2R3S5500427/$file/apss000_v4r6.pdf.

PSF for iSeries

Use the CRTDEVPRT (Create Device Description (Printer)) command to define a TCP/IP printer on your
iSeries system. Use the IP address of your InfoPrint Manager server for the RMTLOCNAME value and
the port that your DPF host receiver uses for the PORT value. For example, this command defines a
printer that can send IPDS data to a DPF host receiver using the TCP/IP protocol, assuming that the DPF
host receiver uses port 5005, and the IP address of the InfoPrint Manager server is 9.34.946.882.

CRTDEVPRT DEVD(IPMDPF) DEVCLS(*LAN) TYPE(*IPDS) MODEL(0)
LANATTACH(*IP) AFP(*YES) PORT(5005) FONT(11)
RMTLOCNAME('9.34.946.882')
TEXT('Sample InfoPrint Manager DPF printer writer')

Before you create an MVS Download host receiver

When you create an MVS Download receiver, you have to specify which InfoPrint Manager actual
destination the host receiver will send jobs to. If you have not already created the actual destinations,
see Creating actual destinations, p. 65.

Creating an MVS Download receiver

1. Complete this configuration worksheet.

Preparing InfoPrint Manager to connect to your host system
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Once you create an MVS Download receiver, you cannot change any of its attributes. If you are
not certain which options to select or which DCF and Exit to use, skip to step 4, p. 93. Create your
MVS Download receivers after you have reviewed the rest of the MVS Download configuration
information.

MMVVSS DDoowwnnllooaadd hhoosstt rreecceeiivveerr wwoorrkksshheeeett

Management Console
Prompt

Description Value

Port Number The port assigned for
communication with z/OS or
MVS. This value must be the
same as the port assigned
during configuration of the host
system.

Target Destination Name The InfoPrint Manager logical
destination to which jobs are
routed from this receiver by
default. This default can be
overridden with the
appropriate z/OS or MVS job
parameters and printer control
file settings. In sample
destination control file supplied
with InfoPrint Manager, the
value of MVS keyword DEST
overrides whatever value you
specify here.

This name is case-sensitive.

Print Control File The file that contains the
appropriate attributes for jobs
submitted to this receiver. You
can use the default file, or you
can point to a customized
version of this default file.

Exit Program Name The program that processes
jobs submitted to this receiver
from the host and passes the
jobs to the requested InfoPrint
Manager destination.
Typically, the default program
o390dsubm.exe is used.

1 Getting started with server systems
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Management Console
Prompt

Description Value

Retain command files Indicate whether to save the
command files for jobs that do
not print correctly.

__ yes __ no

Process one file at a time Indicate whether InfoPrint
Manager should wait for a
previous job to complete
before starting to process the
next job.

__ yes __ no

2. Open the InfoPrint Manager Management Console and select Edit→ New→MVS Download
Receiver.

3. Use the information from the worksheet to complete the dialog and click OK.
For more information, see the Management Console help system.

4. To complete your MVS Download configuration, see RICOH InfoPrint Manager for Windows:
Procedures, available on your Publications DVD-ROM, and in the RICOH Software Information
Center at https://help.ricohsoftware.com/swinfocenter.

SSyynncchhrroonniizziinngg IInnffooPPrriinntt MMaannaaggeerr wwiitthh aann IInnffooPPrriinntt 44000000 oorr aann
IInnffooPPrriinntt 44110000
The cutter-trimmer-stacker (CTS) is a post-processing device used with high speed printers for paper
handling. Perform this procedure with the help of your InfoPrint service engineer (SE) to make sure that
your InfoPrint 4000 or InfoPrint 4100 and the CTS support the same media.

1. Use either InfoPrint Manager GUI to specify the media that the actual destination representing the
InfoPrint 4000 or the InfoPrint 4100 supports.

1) Open the InfoPrint Manager GUI.

2) Click the InfoPrint 4000 or InfoPrint 4100 printer object in the tree window to select it.

3) Select Printer→ Change Media to open the Change Media dialog.

4) Associate each tray with an appropriate media. Click Help for more information.

2. On the printer, define forms that correspond to the media you specified in the previous step.
Consider the settings in this table as an example:

Medium Name Printer_Form Name Printing_Form Description

letter na letter 2–up letter (8.5 by 11)

legal na legal 2–up legal (8.5 by 14)

ledger ledger 1–up (11 by 17)

3. Set up the CTS for the dimensions required by the supported media. For example, to support ledger-
sized paper, set up the CTS for an 11–inch cut width and a 14–inch cut length. The CTS can
support a limited set of cut lengths and only one center slitting option.

Synchronizing InfoPrint Manager with an InfoPrint 4000 or an InfoPrint 4100
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PPrriinnttiinngg aa tteesstt jjoobb
To submit a test job to a printer driven by InfoPrint Manager, you must first run the InfoPrint Manager
Management Console. Then:

1. Select Print Test Job from the Debug menu. The Print Test Job dialog box opens.

2. Select the type of test job (AFP, PCL, PostScript, or ASCII) and the target destination.

3. Click OK.

This should produce printed output on the destination device. If it does not, you might want to check the
status of the job in the InfoPrint Manager Administration GUI.

All versions of PSF include suitable test jobs. See the host PSF documentation for details on submitting
test jobs.

SSuubbmmiittttiinngg pprriinntt jjoobbss tthhrroouugghh tthhee IInnffooPPrriinntt MMaannaaggeerr LLPPDD
The InfoPrint Manager Line Printer Daemon (LPD) is a utility that lets you submit print jobs from other
operating systems using a Line Printer (LPR) client. The InfoPrint Manager LPD replaces the LPD that is
supplied with the Windows operating system (TCP/IP Print Services), however, it submits the files it
receives directly to an InfoPrint destination, not to a Windows printer. It also supports the -o options that
are available with some LPR clients (-o options allow you to specify advanced InfoPrint print options
such as formdefs and pagedefs).

Only one LPD can run on your InfoPrint Manager server system at a time. If you have TCP/IP Print
Services installed, InfoPrint Manager disables it and enables the InfoPrint Manager LPD. If you would
prefer to use TCP/IP Print Services, use the Management Console to change the service configuration.
For further instructions, see the Management Console help.

If you have a different LPD installed, InfoPrint Manager does not disable it, but installs and starts the
InfoPrint Manager LPD. You must stop one of the LPDs before you try to submit a print job using an LPR
client.

To submit print jobs to the InfoPrint Manager LPD, you can use any LPR client. However, to be able to
specify advanced InfoPrint options on the –o flag, you should use the lprafp sample code package.
lprafp is an LPR client that is available for free download at https://dl.ricohsoftware.com/downloads/
375bc3fe-3080-401f-91c4-2b8adb607f89. The package includes executable forms of the lprafp
client for the Windows and AIX (version 6.1 and later) platforms. You can compile this code to use it on
other platforms as well. Ricoh does not provide support for the package.

The Microsoft LPR client supports a –o flag, but it is not the same as the InfoPrint –o flag. Any values you
pass to InfoPrint Manager using the Microsoft –o flag will be lost. In addition, some LPR clients provide
print control functions, such as landscape print. The InfoPrint Manager LPD does not support these
options.

1 Getting started with server systems
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Install and configure lprafp for Windows from the Web

For Windows operating system clients, the lprafp sample code package is available for free download
at https://dl.ricohsoftware.com/downloads/375bc3fe-3080-401f-91c4-2b8adb607f89.

Preparing to submit print jobs

When you submit jobs to the InfoPrint Manager LPD, it uses a mapping file to match the keywords you
specify on the -o option with InfoPrint attributes. A sample mapping file comes with InfoPrint Manager
for Windows; before you submit any print jobs to the InfoPrint Manager LPD, you should modify this file
to meet your needs.

To modify the mapping file:

1. Open the file <install path>\var\pd\lpd\lpdmap.txt (where <install path> is the
directory where InfoPrint Manager is installed) in a text editor such as Notepad.

2. Read all of the instructions in the mapping file before you make any changes.

3. Edit the mappings as necessary and save the file using the same name.

Because all LPR clients use different keywords, it is impossible to list them all. The mappings listed are
"best guess" mappings and might not generate the results you need. The best way to see what values
you need to add or change is to uncomment the line that reads: ** DDEEBBUUGG and save the file. (To
uncomment the line, delete the *.) Submit a print job through the LPD and check the output. If the job
fails or if it prints incorrectly, check the error messages in the server log in the Management Console.
Use them to help determine which keywords are missing or mapped incorrectly. When you are finished,
be sure to open the mapping file and comment the DEBUG line out again.

Submitting print jobs

When you submit print jobs using the LPR client, all you need to specify is the InfoPrint Manager server
and the name of an InfoPrint destination (logical or actual). The InfoPrint Manager LPD submits the job
to the InfoPrint print spool.

EEnnaabblliinngg SSeeccuurree SSoocckkeettss LLaayyeerr ((SSSSLL)) iinn tthhee WWeebb SSeerrvveerr ffoorr HHTTTTPPSS
pprroottooccooll
Secure Socket Layer (SSL) is a protocol that provides security for communications between browsers
and the web server by implementing encrypted data and certificate-based authentication.

You can activate SSL in the Web server component and link it to a digital certificate. It has an existing
digital certificate, self-sign certificates, which should be replaced with personalized certificates
generated by customers.

Before you configure the SSL, you must obtain a digital certificate and store it on the computer that the
base product is installed on. Follow the instructions provided by the certificate authority (CA) for

Enabling Secure Sockets Layer (SSL) in the Web Server for HTTPS protocol
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installing the certificate. You must also know where the keystore is located on the server and the
password for the keystore to configure them to the <workspace_path>\ipmws\conf\server.xml file.

In addition, save copies of these files in a safe location so you can find them easily if you need to
restore them in the future.

To generate a key and keystore, use the Java keytool command. For details about using keytool,
consult your CA or Java documentation.

Your private key password and keystore password must be the same. If they are not the same, you
receive a java.io.IOException error.

To configure SSL:

1. Purchase a digital certificate from a reputable certificate authority (CA).

2. Follow the instructions provided by the CA to install the certificate on the computer where the
InfoPrint Manager server is installed.

3. Use the Java keytool command to generate a key and keystore. For details about using the
keytool command, refer to Java documentation. Write down the location of the keystore and the
password for the keystore. You need them later.

4. Log in to the computer as the InfoPrint Manager administrator.

5. Copy the .keystore file previously created to the C:\Users\Public directory.

6. Navigate to the <workspace_path>\ipmws\conf directory.

7. Open the server.xml file and make these changes:

1) Find this configuration and uncomment it:

<Connector
port="14443"
protocol="org.apache.coyote.http11.Http11NioProtocol"
maxThreads="150"
maxParameterCount="1000"
SSLEnabled="true">
<UpgradeProtocol className="org.apache.coyote.http2.Http2Protocol" />
<SSLHostConfig protocols="TLSv1.2+TLSv1.3"
ciphers="TLS_ECDHE_ECDSA_WITH_AES_128_GCM_SHA256,
TLS_ECDHE_RSA_WITH_AES_128_GCM_SHA256,
TLS_ECDHE_ECDSA_WITH_AES_256_GCM_SHA384,
TLS_ECDHE_RSA_WITH_AES_256_CBC_SHA384,
TLS_ECDH_RSA_WITH_AES_256_GCM_SHA384,
TLS_ECDH_RSA_WITH_AES_128_GCM_SHA256,
TLS_ECDH_ECDSA_WITH_AES_128_GCM_SHA256,
TLS_ECDH_ECDSA_WITH_AES_256_GCM_SHA384,
TLS_ECDHE_RSA_WITH_AES_256_CBC_SHA,
TLS_ECDHE_ECDSA_WITH_AES_256_CBC_SHA,
TLS_ECDH_RSA_WITH_AES_256_CBC_SHA384,
TLS_ECDH_ECDSA_WITH_AES_256_CBC_SHA384,
TLS_ECDH_RSA_WITH_AES_256_CBC_SHA,
TLS_ECDH_ECDSA_WITH_AES_256_CBC_SHA,
TLS_ECDHE_RSA_WITH_AES_128_CBC_SHA256,
TLS_ECDHE_ECDSA_WITH_AES_128_CBC_SHA256,
TLS_ECDHE_RSA_WITH_AES_128_CBC_SHA,
TLS_ECDHE_ECDSA_WITH_AES_128_CBC_SHA,
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TLS_ECDH_RSA_WITH_AES_128_CBC_SHA256,
TLS_ECDH_ECDSA_WITH_AES_128_CBC_SHA256,
TLS_ECDH_RSA_WITH_AES_128_CBC_SHA,
TLS_ECDH_ECDSA_WITH_AES_128_CBC_SHA">

<Certificate
certificateKeystoreFile="etc/InfoPrint.keystore"
certificateKeystorePassword="changeit"
type="RSA"/>
</SSLHostConfig>
</Connector>

2) Replace the value for keystoreFile with the path to your .keystore file.

3) Replace the keystore_password by changing keystorePass value with the password to your
keystore.

4) Save and close the file.

8. If you use another port than the default one (14000), run the pdwsinitports utility.

9. Restart the InfoPrint Manager Web server.

10.Verify the secure connection by opening a Web browser and typing this address, replacing server_
name with the host name or IP address of the computer where InfoPrint Manager is installed:
https://server-name:14443/IPM.

If you use a self-signed certificate or if the certificate is not specifically tied to the server, the Web
browser issues a warning that the certificate is not trusted.

If you install service updates or a new version of the InfoPrint Manager, you must activate SSL again
because the installation process clears the SSL settings in the Web Server component.

If you need to update or replace your digital certificate, install the new certificate into the keystore and
remove the old certificate. You do not have to do this task again because InfoPrint Manager can find
the new certificate in the keystore.

CCoonnffiigguurriinngg TToommccaatt ttoo rreeddiirreecctt aallll HHTTTTPP rreeqquueessttss ttoo HHTTTTPPSS
To force the Web server redirect all calls to a secure connection:

1. Use a self-signed certificate or a certificate generated by a Certificate Authority (CA).
InfoPrint Manager Web server already provides a sample self-signed certificate. The certificate must
be signed by the trusted third party so that it can work in the visitors browsers without warnings. To
obtain a signed certificate, choose a CA and follow its instruction.

2. Install and configure the Web server so that you can use your certificate. For more information, see
Enabling Secure Sockets Layer (SSL) in the Web Server for HTTPS protocol, p. 95. To use the
sample certificate, enable the SSL connector in <workspace_path>\ipmws\conf directory
\server.xml file.

3. Go to <workspace_path>\ipmws\conf directory\web.xmlfile, scroll to the bottom of the file
and add the following just above the </web-app> entry:

<!-- Force HTTPS, required for HTTP redirect! -->
<security-constraint>
<web-resource-collection>
<web-resource-name>Protected Context</web-resource-name>
<url-pattern>/*</url-pattern>
</web-resource-collection>

Configuring Tomcat to redirect all HTTP requests to HTTPS
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<!-- auth-constraint goes here if you require authentication -->
<user-data-constraint>
<transport-guarantee>CONFIDENTIAL</transport-guarantee>
</user-data-constraint>
</security-constraint>

4. Save the web.xml file and restart the web server from MMC for these changes to take effect.

• If you have multiple web servers running, make sure that they all use the same HTTP or HTTPS
protocol.

1 Getting started with server systems
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22.. Getting started with client systems

•InfoPrint Manager GUI software
•Using InfoPrint Select for Windows
•Using InfoPrint Select for Linux
•Using InfoPrint Select for macOS
•Windows gateway printer
•IPP gateway printer
•Using the InfoPrint Manager AIX client
•Using the InfoPrint Manager Linux client
•Using the InfoPrint Manager macOS client
•Using the InfoPrint Submit Express Client
•Using the InfoPrint Manager Windows Client
•InfoPrint Manager hot folders
•Installing and configuring the AFP driver
•Configuring client systems to receive automatic updates
•Installing InfoPrint Manager Update

IInnffooPPrriinntt MMaannaaggeerr GGUUII ssooffttwwaarree
When you install the InfoPrint Manager server, you automatically install the standard InfoPrint Manager
Java GUIs: the InfoPrint Manager Administration GUI, the InfoPrint Manager Operations GUI, and the
Web GUI. You can also install two additional GUIs: the Basic InfoPrint Manager Administration GUI
and the Basic InfoPrint Manager Operations GUI. The Operations GUIs provide a subset of the
functions available in the Administration GUIs.

You can also install the Java interfaces on a suitable Windows or Linux systems. The system does not
need to have the InfoPrint Manager server software installed.

The InfoPrint Manager Web Management Interface and the InfoPrint Manager Web Administration
Interface are installed automatically when you install the InfoPrint Manager server. You don’t have to
install the interfaces separately on the remote Windows machines. The InfoPrint Manager Web Interface
can be accessed by browsers anywhere on the network.

The InfoPrint Manager Web Administration Interface supports the same security features as the InfoPrint
Administration and Operations GUIs and any existing FST security settings apply to the Web Interface
as well. However, the read operations taken to display the objects in the Web Administration Interface
web application are performed by a special user, wsClient. This user must be a member of the
WebServices group. The WebServices group needs read access for the List/Query (pdls) operations on
each InfoPrint Manager system the Web Administration Interface connects to. Any other operations are
performed with the specific user@hostname user connecting to the web application. For more
information about the FST security, see RICOH InfoPrint Manager for Windows: Procedures.

The InfoPrint Manager Web Management Interface lets you perform some of the administrative tasks on
the server. You can use the InfoPrint Manager Web Management Interface to configure and administer
your print environment. InfoPrint Manager Web Management Interface supports various tasks, such as
enabling the LDAP security or managing the Web Server, the Web GUI, or the Pull Print environment.

The InfoPrint Manager Web Administration Interface contains a login panel where you can use the
Web Administration or the LDAP credentials. The InfoPrint Manager administrator must define users in
the web application using the User Management function. The user name defined for login is mapped
with a FST user based on which InfoPrint Manager commands are executed. Use these credentials for
accessing the Web Interface Administrator: DefaultUser for user name and password for password.
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The InfoPrint Manager Web Management Interface contains a login panel where you can use these
credentials for accessing the Web Management Interface: DefaultUser for user name and password
for password.

Follow the procedures in this section to use InfoPrint Manager GUI software to administer or control
your InfoPrint Manager server from a remote system.

Using the basic view of the GUI

The basic view of the InfoPrint Manager GUI is a simplified version of the GUI that shows jobs assigned
to printers without displaying queues. The basic printing environment is generally appropriate for
commercial print shops printing large runs of image data (usually in PostScript or TIFF format).

In a basic printing environment, InfoPrint Manager assigns jobs to printers through early binding. Early
binding is much like standing in a checkout line at a supermarket. Once you pick a line, you “bind”
yourself to it, no matter what happens. Whether the cashier has a problem with the cash register (much
like a paper jam occurring in the physical printer) or the customer in front of you requires a few price
checks (much like adding new forms to the server), the only way to change your position is to physically
move to another line (much like manually moving a job from one print queue to another).

If you want to use the basic view of the InfoPrint Manager GUI, complete these steps in the standard
view of the GUI:

• Create a queue named <servername>-default-queue, where <servername> refers to the name of
the server you are using, and attach up to ten printers.

1. Select Queue→ Create.

2. Enter <servername>-default-queue in the Name field.

3. Click OK to create the queue.

• Specify early binding as the default.

1. Select the <servername>-default-queue.

2. Select Queue→ Properties to open the Queue Properties notebook.

3. In the General tab, click Yes in the Preassign jobs to actual destination field.

4. Click OK or Apply to make the change.

By default, the basic server saves the output files from jobs converted to raster image patterns. If you
want this behavior, use the GUI to set the value of the attribute to true by selecting Server→
Properties. In the General tab of the Server Properties notebook, make sure that the Save ripped files
field is set to Yes.

Installing the Operations GUI

If you are reinstalling or updating an existing version of the InfoPrint Manager Operations GUI, close all
instances of the InfoPrint Manager Administration GUI and InfoPrint Manager Operations GUI that are
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running on this system before you continue with the installation to avoid problems with files that need to
be replaced.

Make sure that the InfoPrint Manager server is at the same level or at a higher level of service than the
InfoPrint Manager Operations GUI. Otherwise, you might receive error messages like: 5010-625
Cannot recognize attribute....

To install the InfoPrint Manager Operations GUI software:

1. Insert the InfoPrint Manager: Common Clients DVD-ROM, LCD4-5642, into the drive. The install
program starts automatically.

If your install program does not start automatically or if your browser stops responding:

1) Select Start→ Run.

2) Enter D:\setup.html, where D is your DVD-ROM drive.

3) Click OK.

2. Select Install InfoPrint Manager Clients→ InfoPrint Manager GUIs, and then click
Operations GUI.

3. Follow the instructions on the installation screens, paying attention to these guidelines:

• The InfoPrint Manager Operations GUI is the recommended version. You can also choose to
use the Basic version. For more information, see Using the basic view of the GUI, p. 100.

• The InfoPrint Manager Operations GUI requires approximately 24 MB of space on your hard
drive, whether you install one view or both.

• If you are installing over a previous version of InfoPrint Manager GUI software or you have
already installed another GUI, a window will appear that gives you the option to modify the
current installation. Select theModify button, and leave the checkboxes checked for the
components that are already installed.

• If you are installing over a previous version of the InfoPrint Manager GUI software, click yes for
any questions about replacing files. If you will be using this GUI to work with an InfoPrint
Manager for Windows server, you do not need to change any of the selections from the default
values.

• If you change your system language, the interface displays properly in the new language.

Installing the Administration GUI on Windows

If you are reinstalling or updating an existing version of the InfoPrint Manager Administration GUI, close
all instances of the InfoPrint Manager Administration GUI and InfoPrint Manager Operations GUI that
are running on this system before you continue with the installation to avoid problems with files that
need to be replaced.

Make sure that the InfoPrint Manager server is at the same or at a higher level of service than the
InfoPrint Manager Administration GUI. Otherwise, you might receive error messages like: 5010-625
Cannot recognize attribute....

Follow these steps to install the InfoPrint Manager Administration GUI software.

InfoPrint Manager GUI software
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1. Insert the InfoPrint Manager Common Clients DVD-ROM, LCD4-5642, into the drive. The install
program will start automatically.

If your install program does not start automatically or if your browser stops responding:

1) Select Start→ Run.

2) Enter D:\setup.html, where D is your DVD-ROM drive.

3) Click OK.

2. Click Install InfoPrint Manager Clients→ InfoPrint Manager GUIs, and then click
Administration GUI.

3. Follow the instructions on the installation screens, paying attention to these guidelines.

• The InfoPrint Manager Administration GUI is the recommended version. You can also choose to
use the Basic version. For more information, see Using the basic view of the GUI, p. 100.

• The InfoPrint Manager Administration GUI requires approximately 24 MB of space on your
hard drive, whether you install one view or both.

• If you are installing over a previous version of InfoPrint Manager GUI software or you have
already installed another GUI, a window will appear that gives you the option to modify the
current installation. Select theModify button, and leave the checkboxes checked for the
components that are already installed.

• If you are installing a more recent version of the InfoPrint Manager GUI software, click yes to
any questions about replacing files. If you use this GUI with an InfoPrint Manager for Windows
server, you can use the default values.

• If you change the system language, the interface displays the new language.

Starting the Administration and Operations GUIs on Windows

When you first run the InfoPrint Manager GUI, you must provide the host name or IP address that the
InfoPrint Manager server communicates with client systems through. You can specify a port number; the
default port number is 6874 if you do not specify one.

For the most recent information about InfoPrint Manager, visit the RICOH Software Information Center
at https://help.ricohsoftware.com/swinfocenter.

If you receive a communication error when using Windows operation systems, you might have to
include java.exe on the Exceptions tab of the Windows Firewall dialog.

Starting from the GUI icons

To launch any of the InfoPrint Manager GUI programs, double-click on the Administration and
Operations icons.

2 Getting started with client systems
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Starting the GUIs

To launch the GUIs, double-click the appropriate icon on your desktop. For example, to launch the
InfoPrint Manager Operations GUI, double-click Operations InfoPrint on your desktop.

If the icon is not on the desktop, click the Windows Start button and select Programs→ InfoPrint
Manager→ Administration InfoPrint to launch the InfoPrint Manager Administration GUI or
Programs→ InfoPrint Manager→ Operations InfoPrint to launch the InfoPrint Manager
Operations GUI.

If you open the GUI and the colors look strange (they might appear in a plaid pattern), minimize the
GUI and then maximize it. The colors should return to normal. This problem is most common on
Windows systems running in 256 colors (8–bit color). To prevent the problem, you can increase the
color depth of your system to 16 or 24–bit color.

Installing the Administration and Operations GUIs on Linux

1. Log into the Linux system as root.

2. Insert the RICOH InfoPrint Manager: Common Clients DVD-ROM into the drive.

3. Mount the file system by typing:

mount /dev/cdrom /media/<mount_point>

4. Type:

cd /media/<mount_point>/linux

5. Install the Java required by the Operations and Administration GUI on Linux typing:

rpm -i ipr-base-java-4.13.m-n.x86_64.rpm
where m and n represent the service update level.

6. Install the Operations and Administration GUI on Linux typing:

rpm -i ipr-base-gui-4.13.m-n.x86_64.rpm
where m and n represent the service update level.

7. Unmount the media/<mount_point>/ file system.

8. Remove the RICOH InfoPrint Manager: Common Clients DVD-ROM.

Starting the Administration and Operations GUIs on Linux

1. Log into the Linux system.

2. On RedHat Enterprise System go to Applications->InfoPrint Manager and select Administration
InfoPrint to start the Administration GUI or Operations InfoPrint to start the Operations GUI.
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3. On SUSE Linux Enterprise Server go to Computer-> More Application-> InfoPrint Manager and
select Administration InfoPrint to start the Administration GUI or Operations InfoPrint to start the
Operations GUI.

You can also start the Administration and Operation GUI from command line by running the
iippgguuiiaaddvvaaddmm or iippgguuiiaaddvv.

To open the InfoPrint Manager Administration GUI using the ipguiadvadm script, add the location
/usr/lpp/pd/bin in the system path.

Starting the special version of the Operations GUI on AIX, Linux, or Windows

The special version of the InfoPrint Manager Operations GUI lets you lock the Operations GUI
configuration file. This means that you can customize the Operations GUI configuration and then make
sure that the configuration remains unchanged from session to session. The changes made during each
session are not saved when the GUI is closed.

The special version is installed when the InfoPrint Manager Operations GUI is installed. However, no
icon will be installed on your desktop.

To invoke the special version from the AIX command line, enter:

ipguiadvs

To invoke the special version from Windows, you must navigate to the path where the GUI is installed
and invoke the StandardOperSBC shortcut. By default, that path is C:\Program Files\RICOH
\Infoprint GUI.

Setting up the InfoPrint Manager Web Administration Interface

Set up and use InfoPrint Manager Web Administration Interface (Web GUI) to create the most common
type of printer, PSF TCP/IP, and submit a job to complete a basic installation.

Configuring the InfoPrint Manager Web Administration Interface

• Make sure that there is an entry for IP address, hostname.domain, and, hostname in the //eettcc//
hhoossttss file on your AIX or Linux server. For example: 172.27.14.118 ironman.bldev.
infoprint.com ironman (Syntax: IIPP--AAddddrreessss FFuullll--QQuuaalliiffiieedd--HHoossttnnaammee SShhoorrtt--
HHoossttnnaammee).

• When adding users to the InfoPrint Manager Access Control Lists (ACLs), the changes suggested in
this section are needed for the FST Mode of security and for using InfoPrint Manager Administration
GUI and InfoPrint Manager Operations GUI. If Active Directory / LDAP implementation is planned
or completed, it is still useful to have the FST admin users in place as backup. However, those user
IDs are not used once LDAP is enabled in InfoPrint Manager. Do not add the DDeeffaauullttUUsseerr for
Web GUI to the admin Group in InfoPrint Manager.
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To add users to the InfoPrint Manager Access Control Lists (ACLs):

1. Go to Applications and start the InfoPrint Manager Management Console.

2. Select Security→ Groups and add your ID for use with InfoPrint Manager Web Administration
Interface.

To allow job submission and full file viewing in the InfoPrint Manager Web Administration Interface:

1. Stop theWeb Server and right-click to select Configure....

2. On theWeb Interface tab, select the Allow Job Submission and View Full File checkboxes.

• If you submit large AFP jobs to InfoPrint Manager, then the conversion of AFP to viewable PDF
takes time. Try the View Full File option, then decide whether to leave it selected.

3. Start theWeb Server.

Starting the InfoPrint Manager Web Administration Interface

To start the InfoPrint Manager Web Administration Interface:

1. Open a compatible browser. For a list of supported browsers, see “Verifying prerequisites” in
RICOH InfoPrint Manager for Windows: Planning Guide.

• When you upgrade from a previous version of InfoPrint Manager, make sure that you clear
your browser cache on each of the connected client systems.

2. In the address bar, enter: hhttttpp::////hhoossttnnaammee::1144008800//IIPPMM where hostname is the InfoPrint
Manager computer name or the IP address where you are running the InfoPrint Manager Web
Administration Interface application.

3. Use these credentials in the login panel: DDeeffaauullttUUsseerr for user name and ppaasssswwoorrdd for
password.

• DDeeffaauullttUUsseerr allows for verification that the InfoPrint Manager Web Administration Interface
can be started and enables the InfoPrint Manager admin to add new InfoPrint Manager Web
Administration Interface users when the FST Security mode is used. Adding users in the InfoPrint
Manager Web Administration Interface is required when using the FST mode of security.

• DDeeffaauullttUUsseerr is not authorized as an InfoPrint Manager admin for creating objects such as
printers. Therefore, a new admin user needs to be added.

Resetting the password for DDeeffaauullttUUsseerr

• If you need to reset the DDeeffaauullttUUsseerr password back to the initial default of ppaasssswwoorrdd and no
other user with admin rights can be logged into, then the only option is to delete the database and force
the Web Server to recreate the DDeeffaauullttUUsseerr with the default ppaasssswwoorrdd.

All the other users along with their preferences and configurations are lost.
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To delete the database:

1. Stop the Web Server.

2. Go to cc::\\PPrrooggrraammDDaattaa\\RRIICCOOHH\\IInnffooPPrriinntt MMaannaaggeerr\\vvaarr\\ppdd\\iippwweebbgguuii\\ddaattaa\\ and delete
the contents of the data folder.

3. Restart the Web Server.

Adding a connection to an InfoPrint Manager server

To add a connection:

1. In the left-hand Objects panel, click the Connections icon.

2. Click the panel menu icon and select Add Connection.

3. In the Add Connection dialog, enter values in the fields as required.

1) Enter the InfoPrint Manager server hosting machine as an IP address or as a DNS host name in
the IP Address or Host Name field.

2) Enter the server port number in the Port field. The default port number is 6874.

3) In the Connection Name field, enter a name for the connection.

4) Save the connection.

• Click ADD to save the connection settings and add it to the connections list in the Objects
panel.

• Click ADD and CONNECT to save the connection settings, add it to the list, and enable
the connection.

Adding an admin user in the InfoPrint Manager Web Administration Interface

• The following instructions only apply if InfoPrint Manager is running in FST mode. They do not apply
if InfoPrint Manager is running in AD/LDAP mode or federated authentication mode.

To add a new admin user:

1. Click Settings and select User Management.

2. Click the + New button.

3. In the Edit User Profile dialog, fill in the fields.

• In the FST Mapping field, map to an exact FST User from the admin or oper group as
displayed in the Security Groups in the Windows Management Console, Linux Management
Interface, or AIX SMIT panels.

• If mapping an administrator user ID to iippmm11 (or the InfoPrint Manager user, if different than the
default of iippmm11), add @@uusseerrnnaammee to differentiate each user. If identifying individual users is
required, then map to the unique user ID.

4. For admins, checkWeb GUI User Manager.

5. Click OK.
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6. Log out and log back in as the new admin user. You will be prompted to add a connection.

• You might need to stop and restart the Web Server in the Windows Management Console,
Linux Management Interface, or AIX SMIT.

Creating a PSF TCP/IP printer from the InfoPrint Manager Web Administration
Interface

To create a PSF TCP/IP printer (Actual Destination) for an IPDS printer, complete these steps:

1. In the left-hand Objects panel, click the Printers icon.

2. Click the menu icon and select Create....

3. For Printer type, select PSF TCP/IP.

4. In the Name field, enter the name of the printer you want to create.

5. For Logical destination, enter a name different from the printer Name.

6. In the TCP/IP Address field, enter the printer hostname or IP address. If you do not have an IPDS
printer available, use 127.0.0.2, to create a sample printer.

7. ForModel, select Set by SNMP printer, as long as you have a connection to a real printer.
Otherwise, choose a model for your sample printer.

8. In the Queue field, enter a new queue name.

9. In the TCP/IP Port filed, enter 55000011.

10. Select CREATE and EDIT.

11. If the printer is shared by another system that can drive IPDS printers (another InfoPrint Manager
server or PSF z/OS) , right-click your printer in the Printers list, go to
Properties→ Configuration, and change the Release Time (Seconds) to 10-60 seconds.

Customizing the InfoPrint Manager Web Administration Interface

Columns, details, actions for jobs, printers, and so on, are customizable.

To modify column headings:

1. Right-click the columns heading row.

2. Click the displayed text (Jobs Columns..., for instance) and select and rearrange the columns as
desired.

• You can also drag and drop the column headings to rearrange the columns.

To modify the details shown in the panels and the actions displayed for jobs or printers, go to
Settings→ Interface Customization.

To see a Queue tree view in the left-hand panel:

1. Click the Queues icon.
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2. Click the menu button and select the Tree View option.

Submitting a test job using the InfoPrint Manager Web Administration Interface

To submit any type of print file:

1. Log into the InfoPrint Manager Web Administration Interface.

2. Click the Submit Jobs icon.

• To submit a job, you must select a printer from the Destination list and add at least one file in
the Document List.

3. Click SUBMIT.

Importing a user configuration file using the InfoPrint Manager Web
Administration Interface

You can import previously saved user configuration to apply to the profile. The configuration file has a
proprietary format, saved as <filename>.cfg.

To import the configuration for a user:

1. Click the Settings button at the right of the banner.

2. Select Configuration→ Import....

3. In the file upload dialog, select the file to import and click Open. You are prompted with a
confirmation message. To continue the import process, click OK.

4. The information dialog notifies you that your configuration was modified; therefore you are logged
out of your account. Click DISMISS. To perform further operations, you need to log in.

Exporting a user configuration file using the InfoPrint Manager Web
Administration Interface

You can export the configuration settings for a user, such as connections, opened tabs, sort criteria,
filters. The configuration data is stored in a proprietary format using the CFG file extension.

To export the configuration for an existing user:

1. Click the Settings button at the right of the banner.

2. Select Configuration→ Export....

3. In the Save as dialog, select the file to export and click Save.

Viewing a Job in the InfoPrint Manager Web Interface

Use this option to view the documents for the selected job.
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• The Job Viewer function in the Web Interface application depends on the correct hostnames. You
might have to add entries to your hosts file on your client computer to correctly resolve the host
name resolution.

• The Web Server needs to run on the system where the actual document is located.

• The View Job option is enabled only when the job is in pending, paused, held, unknown, or
retained status.

• Job Viewer supports these data streams:

– AFP

– PCL

– PDF

– PS

For any other input streams, the view operation only works if the job was pre-ripped.

• To view a document content, you must be added to the JobViewer group and have rights to run the
InfoPrint Manager list commands. The members of the JobViewer group are authorized to view the
job print files if the confidential-job attribute value is set to false or to its default value.
You can add users to the JobViewer group using the command line or the InfoPrint Manager
Management Console. For more information, see the Working with ACLs and groups section in the
RICOH InfoPrint Manager for Windows: Procedures book.

• The View Job option allows you:

– to view the documents for the selected job;

– to go through the pages of the document;

– to jump to a specific page.

– to view the whole document if this option is enabled in InfoPrint Manager Management
Console. Also, if you have the PDF viewer plug-in installed, you can search for information in the
whole document.

• Embedded PDF files can be viewed only when the job is viewed page by page. When viewing the
full document, the embedded PDF files are not supported.

When you select a job, a dialog is displayed containing the document names, IDs, and a statement
indicating if the document can be viewed or not.

You can select only one document at a time.

To view a job:

1. Select the job that you want to view in the main panel or in the Jobs panel.

2. Right-click the job and select View job.

3. In the View Job dialog, select the document you want to view and click View.

4. The document content is displayed in a new browser tab.

5. Use the viewer controls to move through the job.
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• The Job Viewer uses AFP fonts if it can find them in any of these places:

1. Inline with the job

2. In the directories specified by the AFP resource path job property

3. In:

– /usr/lpp/psf/reslib for AIX and Linux

– /usr/lpp/psf/reslib

if no directories are specified in configuration files.

• The Job Viewer uses the embedded form definition from the AFP document. If there is no embedded
form definition, a default form definition is used: F1A10110.

Setting up the InfoPrint Manager Web Management Interface

Set up and use InfoPrint Manager Web Management Interface (WMI GUI) to perform both
configuration and system management tasks.

Use the information in this section as a reference for accessing specific panels in the interface. Use the
online help provided with the interface for instructions and information about performing specific tasks.

Starting the InfoPrint Manager Web Management Interface

To start the InfoPrint Manager Web Management Interface:

1. Open a compatible browser. For a list of supported browsers, see “Verifying prerequisites” in
RICOH InfoPrint Manager for Windows: Planning Guide.

2. In the address bar, enter: hhttttpp::////hhoossttnnaammee::1144008800//wwmmii where hostname is the InfoPrint
Manager computer name or the IP address where you are running the InfoPrint Manager Web
Management Interface application.

3. Use these credentials in the login panel: DDeeffaauullttUUsseerr for user name and ppaasssswwoorrdd for
password.

Changing the DefaultUser password

We recommend that you change the DefaultUser password as soon as possible.

To change the default password for DefaultUser:

1. In the left-hand Security panel, click Default Security.

2. Enter the current password in the Current Password field.

3. Enter the new password in the New Password field.

4. Confirm your new password by entering it again in the Re-type New Password field.

5. Click SAVE.
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Adding a server in InfoPrint Manager Web Management Interface

To add a server:

1. In the left-hand Processes panel, click Server.

2. Click , the create button, on the top right corner of the page.

3. In the New Server dialog, update values as needed. For information about a property, click the ?
button next to it.

4. Click OK.

Configuring InfoPrint Manager Web Management Interface

You can configure the InfoPrint Manager Web Management Interface options and the Web Server,
Web GUI, and Pull Print settings.

1. Go to Configuration and clickWeb Server.

2. On theWeb Server Configuration tab, specify the ports and the tracing level for the web
server.

3. ClickWeb GUI Configuration to set up the connection to an InfoPrint Manager server.

4. Click Pull Print Configuration to set up your Pull Print system.

5. ClickManagement Interface to configure general settings for the current user.

6. Click SAVE to save your settings.

Enabling LDAP/AD Security in InfoPrint Manager Web Management Interface

Specifies how InfoPrint Manager authenticates to the Lightweight Directory Access Protocol Server
(LDAP). The information is used as authentication data for all existing LDAP connections.

To authenticate to the LDAP Server:

1. Click the Security tab in the left panel and select LDAP/AD Security to see all connections.

2. Click , the create button, on the top-right corner of the page.

3. In the New Connection dialog, update values as needed. For information about a property,
click the ? button next to it.

4. Click OK to save the settings and close the dialog.

5. Click the LDAP/AD Security switch to enable the security feature.

Enabling Federated Authentication in InfoPrint Manager Web Management
Interface

The InfoPrint Manager Web Management Interface allows you to enable or disable federated
authentication.

To enable or disable federated authentication:
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1. Go to the InfoPrint Manager Web Management Interface.

2. Click the Security tab in the left pane.

3. Select the Federated Authentication option.

4. Use the switch at the top of the Federated Authentication dialog to enable or disable federated
authentication.

• When you enable federated authentication, the FST or LDAP/AD security continues to work as
before.

• When you enable or disable federated authentication, the web server restarts automatically.

Uninstalling the GUIs

To uninstall the InfoPrint Manager Administration and Operations GUIs:

1. Click the Windows Start button and select Settings→ Control Panel.

2. Double-click Add or Remove Programs.

3. Select InfoPrint Manager Administration GUI or InfoPrint Manager Operations GUI.

4. Click Remove.

5. Follow the instructions on the InstallShield Uninstaller screens that display.

To uninstall the InfoPrint Manager: Web Interface feature:

1. Click the Windows Start button and select Settings→ Control Panel.

2. Double-click Add or Remove Programs.

3. Select InfoPrint Manager Web Interface Feature.

4. Click Remove.

5. Follow the instructions on the InstallShield Uninstaller screens that display.

UUssiinngg IInnffooPPrriinntt SSeelleecctt ffoorr WWiinnddoowwss
InfoPrint Select for Windows lets you submit and track jobs from a Windows workstation to a destination
that is managed by InfoPrint Manager. Through InfoPrint Select for Windows, you can submit jobs to
InfoPrint Manager from word processors, spreadsheets, and other desktop applications. You can print
from applications or from the DOS command line.

InfoPrint Select for Windows lets you:

• Specify AFP and other InfoPrint job attributes when submitting a job to the server

• Cancel and hold jobs in a queue

• Check the status of destinations before submitting jobs

• Print using LDAP authentication for job submission
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For more information about these specific functions, see Printing from applications, p. 130 and consult
the help system provided with InfoPrint Select.

This section contains procedures for using InfoPrint Select on the Windows platform. These topics are
covered:

• Installing InfoPrint Select for Windows, p. 113

• Configuring your InfoPrint Manager server to work with InfoPrint Select, p. 122

• Creating InfoPrint Select printers on Windows, p. 126

• Printing from applications, p. 130

• Commands you can use with InfoPrint Select for Windows, p. 132

• Using custom LDAP job authentication with InfoPrint Select for Windows, p. 118

• Using InfoPrint Select for Windows with Anyplace printing, p. 135

Installing InfoPrint Select for Windows

Before you install InfoPrint Select for Windows, consider these conditions:

• You must have administrative privileges to install InfoPrint Select for Windows.

• If you plan to install one or all of the InfoPrint Manager GUIs as well as InfoPrint Select for
Windows, the sequence of the installs is important. Since InfoPrint Select might require a system
reboot, you might want to install the InfoPrint Manager GUIs first.

• You must adjust the configuration of the InfoPrint Manager server for InfoPrint Select to function
properly. See Configuring your InfoPrint Manager server to work with InfoPrint Select, p. 122.

• If you want to use the LDAP authentication for submitting jobs, you must know your LDAP server
settings.

• If you want your InfoPrint Select for Windows to discover the InfoPrint Manager server available in
the network, you must add a SRV entry to your DNS server. This syntax can be used when you
configure a BIND (Berkeley Internet Name Domain) DNS server:

srvce.prot.domain-name. ttl class rr priority weight port target

This section lists the parameters for this syntax:

srvce
This parameter defines the symbolic service name prepended with a _ (underscore), case
insensitive. The parameter must be set to _ipm.

prot
This parameter defines the protocol name prepended with a _ (underscore), case insensitive.
The parameter must be set to _tcp.

domain-name
This parameter defines the base domain (or zone) name. If you leave this entry blank (without a
dot) substitutes the current zone root (the $ORIGIN). You can add it as in the syntax (with a
dot).
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ttl
This standard parameter is optional.

class
This parameter is optional. Standard CLASS parameter. Normally IN for Internet class.

rr
This parameter defines the SRV RR field.

priority
This parameter defines the relative priority of this service (range 0 - 65535). Lowest is highest
priority.

weight
This parameter is used when more than one service has the same priority (range 0 - 65535).
The value 0 indicates that no weighting should be applied. If the weight is 1 or greater, it is a
relative number in which the highest is most frequently delivered.

port
This parameter defines the port number assigned to the symbolic service but this is not a
requirement. It is possible to define a _ipm service with a port number of 12345 rather than the
more normal port 6874 (a pdserver must listen on that port on host that provide this service).

target
This parameter defines the name of the host that provides this service. The parameter does not
have to be in the same zone (domain). It can be a host name or a FQDN (with a dot).

This is an example for BIND (Berkeley Internet Name Domain) DNS server:

_ipm._tcp.customer.domain-name. IN SRV 0 5 6874 ipmserver.customer.domain-name.

– Other implementations of the DNS (Domain Name System) protocols need the same
parameters, but may be entered in different forms.

– If a host name is set in InfoPrint Select, no DNS record discovery is performed.

If you are using the non-LDAP InfoPrint Select client in a PAM/SSO environment, the LDAP user taken
from the LDAP(PAM)/Active Directory system authentication session is used for the IPM user-related
attributes.

To install InfoPrint Select on a Windows system from the RICOH InfoPrint Manager: Common Clients DVD-
ROM:

1. Insert the RICOH InfoPrint Manager: Common Clients DVD-ROM into the drive.

2. Click Install InfoPrint Select client.

3. Follow the instructions on the installation screens to install the program.

If you plan to install one or both of the InfoPrint Manager GUIs as well as InfoPrint Select, the
sequence of the installations is important. Because InfoPrint Select might require a system reboot,
you might want to install the InfoPrint Manager GUI first.
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4. Select the job submission authentication method: SSO, LDAP, or FST.

1)

SSO
This authentication method uses Single Sign On Active Directory configuration to set the job
owner information. This is the recommended job submission authentication method.

LDAP
This authentication method uses a custom LDAP configuration to set the job owner
information. You can use this option if you need a specific LDAP attribute set as the job
owner information or if you are not using Active Directory.

FST
This authentication method uses the standard FST information (user@host) to set the job
owner information. The user@host information is taken from your local user account.

2) Depending on your selection, you must enter the required information:

SSO
Enter the host name or IP address of an InfoPrint Manager server, the port number it uses,
and the default printer or logical destination you want to print to. The default port number is
6874.
Click Next to continue with the InfoPrint Select installation.

LDAP

1. Enter the host name or IP address of the LDAP server and the port number that it uses for
LDAP authentication in the next screen. The default port number is 389. You can also set
these values later when running the InfoPrint Select LDAP Login application.

Click Next to continue with the InfoPrint Select installation.

2. Select one of the authentication methods: Simple or Digest.

3. Enter the name of the SASL Realm. This option is available when you use the Digest
method.

4. Select if you want to enable No Encryption, Use Start TLS Extension, orUse SSL
Encryption.
Click Next to continue with the InfoPrint Select installation.

5. If you select Simple authentication method, enter the LDAP search base and the search
attributes that you need. If you use anonymous login for the LDAP search, select the
corresponding options. Otherwise, enter the Bind DN and the password used for the
LDAP search. If you cannot save your user credentials, select the Disable Save
Credentials option.
If you select the method Digest, leave the fields blank.

6. Select the letter case for the LDAP Login attribute. You can choose one of these options:
Case Sensitive, Convert to Lower Case, or Convert to Upper Case. The default value is Case
Sensitive.

FST
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Enter the host name or IP address of an InfoPrint Manager server, the port number it uses,
and the default printer or logical destination you want to print to. The default port number is
6874.
Click Next to continue with the InfoPrint Select installation.

5. Select one of the two restart options: Yes, I want to restart my computer now. or No, I will
restart my computer later..

6. Click Finish on the Complete window.

Installing InfoPrint Select in silent mode

InfoPrint Select can be installed using silent mode. Silent mode eliminates the normal user interface and
uses default values or response file values for all required inputs. This mode is generally used by System
Administrators to push the installation onto their users' systems.

Use one of these commands from the command line or an automated script to install InfoPrint Select in
silent mode:

IInnffoopprriinnttSSeelleecctt..eexxee --qquuiieett

This method uses:

• No response file
• All the defaults
• Installs, repairs, or upgrades your installation of InfoPrint Select

This method displays the splash screen and an initial progress bar.

IInnffoopprriinnttSSeelleecctt..eexxee //ss //ff11""cc::\\sseettuupp..iissss""

This method uses a response file named setup.iss, which can be one of the samples provided, a
modified version of a sample, or your own response file created with the /r option.

IInnffoopprriinnttSSeelleecctt..eexxee //ss //ff11""cc::\\sseettuupp..iissss"" //ff22""cc::\\oouuttppuutt..lloogg""

This method uses a response file named setup.iss and logs the activity. If the installation is
successful, this text appears in the output.log: ResultCode=0. The setup.iss can be one of the
samples provided, a modified version of a sample, or your own response file created with the /r
option.
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When installing InfoPrint Select in Silent mode:

1. To create your own response file, invoke the installer in record mode: InfoprintSelect.exe /r
This command produces a response file named setup.iss based on the inputs used during
installation. To locate this newly created response file, search your system for setup.iss.

This setup.iss file is incomplete. You must add these lines at the beginning of the document:

[InstallShield Silent]
Version=v7.00
File=Response File

2. InfoprintSelect.exe is located in the \win\InfoprintSelect folder of the Common Client
DVD-ROM.

After you have installed InfoPrint Select, sample response files can be found in Select_install_dir
\Install_Samples. You can copy and modify these sample files as appropriate:

1. setup.iss, which is a sample response file used to install InfoPrint Select
2. setup_repair.iss, which is a sample response file used to repair an installation of InfoPrint Select
3. setup_upgrade.iss, which is a sample response file used to upgrade a previous version of

InfoPrint Select
4. setup_remove.iss, which is a sample response file used to remove an installation of InfoPrint

Select

When installing InfoPrint Select in silent mode, InfoPrint Select Notification and Open Printer
Selection do not start automatically after the installation is complete. You must log out first and then log
in for InfoPrint Select Notification and Open Printer Selection to start.

Upgrading InfoPrint Select

To upgrade InfoPrint Select on a Windows system from the RICOH InfoPrint Manager: Common Clients
DVD-ROM, LCD4-5642:

1. Insert the RICOH InfoPrint Manager: Common Clients DVD-ROM, LCD4-5642, into the drive to run the
upgrade program.

2. Follow the instructions on the screens to upgrade the program.

3. After upgrading your InfoPrint Select version, the program asks to reboot your system. The default
answer to this question is Yes because the new version of InfoPrint Select will not function properly
until the system is rebooted. When you click OK or press Enter, your system reboots.

4. Upgrading InfoPrint Select can be done only for the currently installed version of InfoPrint Select. If
your current version of InfoPrint Select is supporting LDAP, the upgraded version of InfoPrint Select is
also supporting LDAP. If your current version of InfoPrint Select is not supporting LDAP, the
upgraded version of InfoPrint Select is not supporting LDAP as well.
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Selecting enhanced or standard InfoPrint Select

Once you have successfully installed InfoPrint Select, you must determine whether you want the
enhanced version of the client. If you apply the enhanced InfoPrint Select, users can enter job and
document attributes with print jobs if the printer to which they send the job is an InfoPrint Select printer.
You can decide not to provide this ability to end users since it requires an understanding of how to use
attributes.

To apply the enhanced InfoPrint Select:

Click the Start button on your Windows system and select Programs→ InfoPrint Select→ Activate
Job Settings dialog.

This action ensures that you can access the dialog panels that allow you to specify InfoPrint job
attributes when submitting a job to the server.

Removing enhanced InfoPrint Select

If you activate the enhanced InfoPrint Select and later decide that you would prefer to go back to the
earlier version of InfoPrint Select, you can deactivate the enhanced InfoPrint Select by accessing the
Job Settings window and checking the Do not display this dialog again check box.

Uninstalling InfoPrint Select for Windows

To uninstall InfoPrint Select:

1. From the Start menu, select Settings→ Control Panel.

2. Double-click Add or Remove Programs.

3. Select InfoPrint Select.

4. Click Remove.

Click the button only once, then wait for at least 30 seconds before you do anything else. If you do
not wait for the first panel of the uninstaller to appear, it might get lost behind other windows. If you
do not see the first panel of the uninstaller after 30 seconds, press and hold the AAlltt key, then press
the TTaabb key to bring the window to the front.

5. Follow the instructions on the screen.

Using custom LDAP job authentication with InfoPrint Select for Windows

The InfoPrint Select job submission client requires users to LDAP-authenticate before being allowed to
submit jobs. LDAP authentication support allows only authenticated users to print, and to provide
information about the users that printed a specific job. LDAP authentication allows InfoPrint Select to
provide more accurate accounting information.
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The LDAP-enabled InfoPrint Select client must be configured to use an LDAP server that has the GSS
authentication option enabled. Only one version of the InfoPrint Select client can be installed at a time.
If you install the LDAP version of InfoPrint Select and you want to switch back to the standard non-LDAP
version, you can install it over the LDAP version. The installer allows you to install one version of InfoPrint
Select over the other and automatically removes the old version. Subsequent updates apply to the
current version that is installed.

When the UAC Windows system setting is active, you can change the LDAP configuration settings only
when running as Administrator. To use this option, start the InfoPrint Select Login application by right
clicking on the icon and selecting "Run as Administrator". The Local Security Policy settings could
influence the permission to update the configuration settings. For more information consult the UAC and
Local Security Policy Windows documentation.

If you cannot successfully log in to the LDAP server, the LDAP-enabled InfoPrint Select client does not
allow you to submit jobs. If you are successfully logged in to the LDAP server, you are allowed to submit
jobs to the InfoPrint Manager server. You must log in to the LDAP server the first time you submit a print
job. The LDAP login session expires in any of these situations: when you log off, when you switch users,
or when the session timeout set by the LDAP server administrator expires. That is, you do not have to log
in again for each subsequent print job that you submit. The submitted jobs contain an authenticated-
login attribute with the LDAP username that can be added to the server accounting logs by using the
server or actual destination additional-accounting-log-attributes attribute.

The InfoPrint Select client is LDAP v3 compliant. It only supports an open directory LDAP model. This
means that the LDAP server does not require the clients to establish connections over SSL and it does not
ask clients to be authenticated when and if they connect to an LDAP server over SSL.

The SSL client mutual authentication is enabled when you do not want your directory system to be
opened to the general public. It is a closed directory system where both the SSL and the client
authentication are forced. The SSL client authentication means that the client must have a valid certificate
verified by the server.

LDAP-enabled InfoPrint Select authentication methods

Simple

For Simple authentication, the login name, in the form of the retrieved DN, is sent with the password in
clear text to the LDAP server.

Digest

This method requires a Digest plugin installed on the LDAP server with its own user database. The LDAP
server internally forwards authentication credentials to the Digest plugin (SASLDB). There is no search
mechanism for DN in this case.

Configuring LDAP-enabled InfoPrint Select client settings on Windows

For the InfoPrint Select LDAP client to submit authenticated jobs to InfoPrint Manager properly, you must
configure your InfoPrint Select LDAP settings. Use the InfoPrint Select LDAP GUI as described in this
procedure to configure the InfoPrint Select LDAP settings correctly:

1. Click Start -> Programs -> InfoPrint Select.
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2. Select InfoPrint Select LDAP Login.

3. Enter the user name and password.
Optional: Select Save Credentials.

• The login and password are saved only if the authentication to the LDAP server was successful. After
saving the credentials, the login and password are available in the InfoPrint Select LDAP login
window the next time you log in. If the option Disable Save Credentials from the LDAP settings
panel is selected, the option Save credentials is no longer available.

From the InfoPrint Select LDAP login dialog box, click Settings. This option lets you configure the
credentials, connection, authentication, and search settings from the LDAP Settings window.

• If the User Account Control (UAC) on your Windows machine is active and you want to change the
InfoPrint Select LDAP settings, start the InfoPrint Select Login application using the “Run as
administrator” option. To do this, right-click on the application icon and select "Run as
Administrator".

• These settings, except for the credentials, can also be set at installation time in attended or silent
mode.

Credentials

Login
The login information can be an e-mail address, an employee number, a badge serial number, a
common name, a Lotus Notes canonical name, a user ID, a uid, or other data information.

The login information can be sent to the destination accounting log by adding the authenticated-
login attribute to the list of values used by the additional-accounting-log-attributes attribute.

Password
Enter your password.

Upper/Lower case
Specifies the letter case of the login attribute. You can select one of these values: Case Sensitive,
Convert to Lower Case, or Convert to Upper Case. The default value is Case Sensitive.

Disable Save Credentials
Does not allow users to save credentials. The password from the LDAP settings window is not stored.

The credentials, if available, are copied from/to the InfoPrint Select LDAP login window.

LDAP Server

Host
Enter the host name or IP address of the LDAP server.

Port
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Enter the port number that is used for communication. The default port number is 389. The default
SSL port number is 636.

Authentication

Method
Select the method of authentication: Simple or Digest.

SASL Realm
Enter the name of the SASL Realm. This option is available when you use the Digest method.

Encryption
Enter an encryption method for the LDAP Server. To use the TLS or the SSL protocols, select the Use
Start TLS Extension or the Use SSL Encryption option.

DN Search Options

The Distinguished Name (DN) Search Options is only used for the Simple authentication method.

Search Base
The search base entry is the location in a directory from which the LDAP search begins.

Search Attribute
The search attribute is used for the search of the DN. The DN is used for logging on to the InfoPrint
Select LDAP server.

Example:

• If you want to identify the DN using the intranet e-mail address (for example: john_
smith@example.com) as the LDAP login, the search attribute must be mail. The DN Search
Options are configurable as needed and used only for simple authentication method.

– If you enter your login as your common name (for example: “John Smith”), the search
attribute must be set to cn.

– Other various attributes for the DN search, like: e-mail address, employee number, badge
serial number, common name, Lotus Notes canonical name, user ID, uid, and DN.

Depending on the custom configuration, the specific login attribute is used for the DN search. This
attribute becomes the value of the authenticated-login job attribute in the accounting log.

Click Test Authentication if you want to test the connection to the LDAP server. If the connection is
successful, a confirmation message is displayed: Successfully connected to the LDAP server.

If one of the LDAP settings is not properly configured, you receive one error message for each case:

• “Invalid user login credentials. Check your login credentials.” You see this
message when the authentication bind fails because the credentials are incorrect.

• “Incorrect LDAP host, port, or SSL/TLS settings. Check your host, port, and SSL/
TLS settings.” You see this message when the authentication bind fails because InfoPrint
Select LDAP client cannot contact the LDAP server.

• “Invalid authentication method. Contact your system administrator.” You see this
message when the LDAP server does not recognize the authentication method that the InfoPrint
Select LDAP client used.
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• “LDAP login not found on server. Check your credentials or search options.” You
see this message when InfoPrint Select LDAP does not find the user in the search directory.

You do not see an error message when the LDAP server does not allow anonymous authentication.
In this case, the initial bind fails because no anonymous binding is allowed, and InfoPrint Select
LDAP client authenticates directly with the login credentials that you entered.

Anonymous Login
Enable/Disable anonymous login to the LDAP server.

Bind DN
Enter the Distinguished Name (DN) of the account if the LDAP server does not allow anonymous
queries.

Password
The password for the Bind DN account.

The Bind DN login and password information are stored in the registry. The password is stored in
encrypted form. By default, the search of the DN is done by the anonymous binding to the LDAP
server and it is based on the Search Base, and the Search Attribute values. The DN that results
from the search is used for the authentication together with the specified password. If Anonymous
Search is not enabled on your InfoPrint Select LDAP server, InfoPrint Select attempts to log in with
the Bind DN and password and searches for the specified Login. If the authentication fails, an error
occurs. If the search succeeds, InfoPrint Select attempts to log in with the DN associated with the
Login. If the search fails, InfoPrint Select attempts to log in with the Login and password.

Logging on to an LDAP server

InfoPrint Select lets you authenticate to an LDAP server to allow job submission and command line
requests to an InfoPrint Manager server.

If you have installed the LDAP version of InfoPrint Select, do these steps to authenticate to an LDAP
server:

1. Click to Start -> Programs -> InfoPrint Select.

2. Select InfoPrint Select LDAP Login.

3. Enter the user name and password. If you already have entered these values during the installation
process, the field is automatically filled in.

If you cannot authenticate to an LDAP server, check the credentials that you entered, and try to
authenticate again.

Configuring your InfoPrint Manager server to work with InfoPrint Select

For InfoPrint Select to submit print jobs to InfoPrint Manager properly, you must configure each InfoPrint
Manager logical destination or actual destination to accept jobs from InfoPrint Select. Use the InfoPrint
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Manager Administration GUI as described in this procedure to configure logical and actual destinations
correctly.To use the command line instead of the GUI, use the pdset command to set the client-driver-
names attribute.

To submit jobs to actual destinations, the logical-destinations-assigned attribute must be set for the
actual destination.

1. Log on to a system that has the InfoPrint Manager Administration GUI installed on it as a user with
administrator privileges.

To be able to complete this procedure, you must have the authority to use the pdenable,
pddisable, and pdset commands. If you do not have that authority, your user id must be added to
the access control lists (ACLs) on your InfoPrint Manager server.

2. Launch the InfoPrint Manager Administration GUI.

3. Select one of the actual or logical destinations that will receive print jobs from InfoPrint Select by
clicking on it once.

4. On the menu bar, click Actual or Logical and select Properties.

5. In the Properties notebook, click Drivers.

If you do not see the Drivers tab, click Show more, then click Drivers.

6. In the New value field next toWindows client drivers, type the name of one of the print drivers
that users will use to submit jobs with InfoPrint Select.

7. Click Add >>.

8. Click OK.

InfoPrint Select support for Windows Server versions

Refer to the RICOH InfoPrint Manager for Windows: Planning Guide for a complete list of supported versions.

Using InfoPrint Select in a Windows Terminal Server (WTS) and Citrix
Environment

InfoPrint Select can be used in a Windows Terminal Server and Citrix Environment; however, some
functions should be disabled by the administrator.

InfoPrint Select Notifications

By default, the installation of InfoPrint Select adds the InfoPrint Select Notification program to the
SSttaarrttuupp directory of all users. The default installation of InfoPrint Select Notification does not work on
the WTS and Citrix clients. You can choose to either disable the InfoPrint Select Notification option or
you can configure and manage the InfoPrint Select Notification Port through the Select.ini
configuration file in Select.ini file, , for each user, to allow the use of InfoPrint Select Notification. If you
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want to allow each user to use the InfoPrint Select Notification option, each user needs to be assigned a
unique TCP/IP port on the WTS or Citrix server. The administrator must make sure that each user has a
unique port assigned. If two users are assigned the same port, one user gets all notification messages
for both users. The other user receives no notification messages.

Enhanced InfoPrint Select and InfoPrint Select Error Messages

The administrator should not allow users to connect through the Console, Microsoft RDP, or Citrix ICA at
the same time. The Print Spooler service resides on the Windows server and runs separately from the
user environment. Because of this, InfoPrint Select can run into conflicts while determining the correct
session associated with the user or process that requested to print a job and can encounter problems
displaying the Enhanced InfoPrint Select and InfoPrint Select Error Messages windows.

Select.ini file

Select creates an .ini file for each user ID to store that user's settings. The file is generated the first time
Select is invoked by each user if it does not already exist. The file is stored in \RICOH\InfoPrint
Select\Select.ini within the user application data folder specified by the %APPDATA% environment
variable. The WTS and Citrix administrator should create or modify the existing file for all users. The file
should look like this:

[User Preferences]
Notification Port=5157
Use default .att file=0
Default .att file=
[Submission Window]
Suppress=1
[Job Recovery]
Pause jobs if submission fails=0
Suppress submission errors=1

The key settings are:

• Notification Port=5157 - Must be set to a unique port number if Notifications are being used. If
InfoPrint Select is not being used, it does not need to be changed.

• Suppress=1 - Suppresses the Job Settings Dialog.

• Suppress submission errors=1 - Suppresses error messages found during submission.

• Pause jobs if submission fails=0 - Optionally can set this to 1 to cause failed jobs to be retained on
the WTS Windows spool for resubmission by the administrator.

Windows creates a user profile the first time a user logs on to a computer. At subsequent logons, the
system loads the user's profile, and then other system components configure the user's environment
according to the information in the profile. Administrator should make sure users log on to the Windows
system before logging on through the Citrix client and using the InfoPrint Select.

Working with InfoPrint Select notifications

By default, when you submit a job using InfoPrint Select, a notification profile is sent with the job. If the
InfoPrint Select Notification application is running when you submit a print job using InfoPrint Select,
notifications are requested. These notifications are delivered by email. InfoPrint Select does not use the
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standard email port for notifications to avoid conflict with other SMTP servers. If you have a conflict with
the port that InfoPrint Select is using for notification, you can select another port by going to
Start→ Programs→ InfoPrint Select→ Change the Notification port, and entering another port.

The InfoPrint Select Notification application starts automatically when Windows first loads. To start the
InfoPrint Select Notification application at another time, go to Start→ Programs→ InfoPrint
Select→ InfoPrint Select Notification.

You can access the InfoPrint Select Notification application by clicking the icon in the system taskbar or
by clicking an existing message in the Windows Notification Area. After you click an existing message
in the Windows Notification Area and the InfoPrint Select Notification dialog is displayed, all
InfoPrint Select notifications in the Windows Notification Area are removed.

To clear the existing messages in the InfoPrint Select Notification dialog, click OK. When the
InfoPrint Select Notification dialog is visible, any new notification message is displayed only in the
dialog and no longer in the Windows Notification Area. If you minimize the InfoPrint Select
Notification dialog, you still receive messages in the Windows Notification Area.

To close the InfoPrint Select Notification application, click X in the upper right corner of the InfoPrint
Select Notification dialog and then click OK on the warning message, or right-click the icon in the
system taskbar and then click Quit.

If you receive a communication error when using the InfoPrint Select Notification application with the
Windows operating system, you might have to include iippnnoottiiffyy..eexxee on the Exceptions tab of the
Windows Firewall dialog.

Setting up your own InfoPrint Select notification profile

The InfoPrint Select notification profile overrides any notification settings that you configure in a default
job. If you do not want to use the InfoPrint Select notification profile, use the procedure:

1. On the Windows system that InfoPrint Select is installed on, go to Control Panel and select
System.

2. In the System Properties window, click Advanced system settings.

3. On the Advanced tab, click Environment Variables.

4. In the System variables box on the Environment Variables dialog, click New.

5. In the Variable Name field, type pdnotify and in the Variable Value field, type override_
select.

6. Click OK.

7. Verify that pdnotify appears in the list of System variables and not in the User variables. If it
appears in the list of User variables, delete it and start again from step 4.

8. Click OK in the Environment Variables dialog.

9. Click OK in the System Properties window.

10. Restart your system to make the changes take effect.
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Creating InfoPrint Select printers on Windows

This section describes how to configure InfoPrint Select clients to allow print job submission from
Windows applications to destinations managed by an InfoPrint Manager server.

• Creating InfoPrint Select printers on Windows systems, p. 127

– Adding your first InfoPrint Select printer on Windows systems, p. 127

– Adding an additional InfoPrint Select printer on Windows systems, p. 129

Collecting required information

Before you can print to an InfoPrint Manager destination from a Windows application, you must add an
InfoPrint Select printer to your Windows environment. Collect these information before you begin:

• The host name or IP address of the InfoPrint Manager server.

• The port number that the InfoPrint Manager server uses to communicate with client systems. The
default is 6874.
You can find this port number in the Service Configuration dialog in the Management Console.

• The names of destinations to use.

• The names of the drivers to associate with each destination.

• Where the driver files are located (on a DVD-ROM, on a network server, or on your local system).

• The name of the server where your actual or logical destination is located in (this value is optional).

Verify that the InfoPrint Manager server destinations have been configured correctly. For more
information, see Configuring your InfoPrint Manager server to work with InfoPrint Select, p. 122.

Choosing the Right PPD
If you plan to use InfoPrint Select to print PostScript jobs to an AIX DSS (InfoPrint Manager for AIX
only), BSD DSS, or Passthrough DSS (InfoPrint Manager for Windows only) printer, be sure to use
the PostScript printer driver that came with your printer when you create an InfoPrint Select printer
on your desktop. These drivers include PostScript Printer Definitions (PPDs) that are specific to your
printer.

Drivers and finishing
If you are submitting an AFP job to an IPDS printer, you can use the AFP driver that is described in
Installing and configuring the AFP driver, p. 225.

The automatic data stream transforms that PSF printers use do not always support finishing
(stapling). Some PostScript drivers, however, will support some finishing options. The finishing
options that are supported include saddle and edge stitch, as well as corner stitch in MO:DCA
(Mixed Object Document Content Architecture), using both landscape and portrait modes.

If you are using InfoPrint Select to submit PCL or PostScript jobs to a PSF printer (destination), you
might discover that you cannot specify finishing options when you submit a job, even if the print
driver you use supports those options. It is recommended that you either use a different method to
submit those print jobs or that you submit them to an InfoPrint printer that does not transform the data
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stream (such as a Passthrough printer on InfoPrint Manager for Windows or an AIX printer on
InfoPrint Manager for AIX).

If you cannot use a different submission method and cannot submit your jobs to a different type of
InfoPrint printer, the only way to request finishing options on PCL and PostScript jobs submitted to a
PSF destination is to specify the finishing attributes for the job. You have several options:

• You can create an attributes file for InfoPrint Select to use that contains the finishing attributes for
your job. Then when you submit your job, you designate the file containing your finishing
attributes as your attributes file (see Specifying InfoPrint attributes , p. 130 for more information).

• You can also specify the finishing options separately under the Other tab in the InfoPrint Select
Job Settings dialog using the attributes entry (see Specifying InfoPrint attributes , p. 130 for
more information).

• You can use a default job.
A default job is a list of attributes that is applied to every job that a particular logical destination
receives. You can use the InfoPrint Manager Administration GUI to modify the default job for the
logical destination that InfoPrint Select sends jobs to so that it requests the appropriate finishing
options. However, this method is not recommended for two reasons:

1. Every job that you send to that logical destination will be finished the same way. For
example, if you set the Finishing options attribute of the default job to staple-top-left,
every job that is submitted to that printer will be stapled.

2. A logical destination can only have one default job, and a default job can only have one
finishing option set. To use different finishing options, you must create multiple logical
destinations, each with different options set on the default jobs. Then, you must create a
different printer on your desktop to submit jobs to each logical destination.

Actual destinations do not have default jobs.

Creating InfoPrint Select printers on Windows systems

This section includes:

• Adding your first InfoPrint Select printer on Windows systems, p. 127

• Adding an additional InfoPrint Select printer on Windows systems, p. 129

Adding your first InfoPrint Select printer on Windows systems

Before adding an InfoPrint Select printer to your Windows system, you must:

• Collect the information described in Collecting required information, p. 126.

• Configure the server as described in Configuring your InfoPrint Manager server to work with
InfoPrint Select, p. 122.

To add an InfoPrint Select printer to your Windows system:

1. From the Windows desktop, click Start→ Control Panel→ Devices and Printers.

2. Select Add a printer. The Add Printer window displays. Select Add a local printer.
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3. On the Choose a printer port page, click Use an existing port, then scroll down the list of ports
until you find the port and select it. Click Next.

4. Click Have Disk.

1) Click Browse.

If you are using a printer driver other than those provided with InfoPrint Manager or InfoPrint
Select, specify that printer driver now.

2) Click Open.

3) Click OK to close the Install From Disk window.

5. Select the manufacturer and model of your printer and click Next.

6. If the driver for your printer is already installed, the Use Existing Driver dialog that appears. Click
Next. The Type a printer name dialog appears.

7. Enter a name for the printer in the field provided. This is the name the printer is known to your
Windows applications and the Windows desktop. Click Next.

8. Click Finish.

9. On the menu bar of the Printers window, click Organize and select Properties.

10. In the Print Properties window, click Ports.

11.Highlight the InfoPrint Select port that you want to configure and click Configure Port.

12. In the InfoPrint Port Configuration window, make sure that the Print Server field displays
InfoPrint Manager.

13. In the Host Name field, type the host name of your InfoPrint Manager server.

14. In the Host Port field, type the port number that your InfoPrint Manager server uses to communicate
with client systems. The default port is 6874.

You can find this port number in the Service Configuration dialog in the Management Console.

15. In the Server name field, specify the name of the InfoPrint Manager server (pdserver) where your
destination is located in. If the InfoPrint Manager server name is not known, specify the default value
of * to list all the printers on all the InfoPrint Manager servers. Specifying the server name reduces
the number of printers listed, which reduces the time it takes to configure a port.

If you know the name of the printer to use, type it in the Printer name field and go to step 18 of this
procedure. If you do not know the name of the printer, leave this value blank and you will receive a
list of printers from which to select.

16.Click Refresh Printer Selection List.

17. Select the appropriate printer from the list.

18.Click OK.

19.Click Close.
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To add additional InfoPrint Select printers to your environment, follow the procedure described in
Adding an additional InfoPrint Select printer on Windows systems, p. 129.

Adding an additional InfoPrint Select printer on Windows systems

Before adding an InfoPrint Select printer to your Windows system, you must:

• Collect the information described in Collecting required information, p. 126.

• Configure the server as described in Configuring your InfoPrint Manager server to work with
InfoPrint Select, p. 122.

To print to an additional InfoPrint Select printer, you must add an additional InfoPrint Select port.

To add an additional InfoPrint printer to your Windows system, follow these steps:

1. From the Windows desktop, click Start→ Control Panel→ Devices and Printers.

2. Select Add a printer. The Add Printer window displays. Select Add a local printer.

3. Click Create a new port and highlight InfoPrint Select from the pull-down list. Click Next.

4. In the dialog that opens, type a name for the new port, such as InfoPrint-2, and click OK. (Use a
name that no other port uses.)

5. To configure the new port just added, continue with the procedure documented in Adding your first
InfoPrint Select printer on Windows systems, p. 127.

Changing the InfoPrint Manager target printer

To change the target InfoPrint Manager printer, follow these steps:

1. Access the Select Target Printer dialog by clicking the icon in the system taskbar.

• The Select Target Printer dialog starts automatically when Windows first loads. To start the
InfoPrint Manager Printers dialog at another time, go to Start→ Programs→ InfoPrint
Select→ Open Printer Selection.

2. Select the Windows printer from theWindows Printer list.

3. Select the InfoPrint Manager printer from the Target Printer Selection table.

4. Click OK.

If you have several printers, you can filter them by typing part of the location or name in the Target
Printer Location/Name field. To clear your custom selection and use the default target printer defined
at the Windows printer creation time, select Use default from the Target Printer Selection table.

• The printer chosen through the Select Target Printer dialog is user-specific. If you did not select
any printer, the default printer selected at Windows creation time is used.

• To refresh the InfoPrint Manager printer list, click the Refresh button.
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Printing from applications

Things to be considered when printing from applications with InfoPrint Select:

Printing Considerations
InfoPrint Select works with the print facility of each application, so printing from every program is a
little different. A typical application might allow you to specify a printer other than the default, the
number of copies, or a range of pages.

If the printer selected (or your default printer) is an InfoPrint Manager Select printer, your job is sent
to the InfoPrint server.

Checking printer status

To check the status of your printer before committing a print job:

1. Access the Select Target Printer dialog by clicking the icon in the system taskbar.

• The Select Target Printer dialog starts automatically when Windows first loads. To start the
InfoPrint Manager Printers dialog at another time, go to Start→ Programs→ InfoPrint
Select→ Open Printer Selection.

2. In the Select Target Printer dialog, select the printer that you want to check from the Target
Printer Selection list.

3. Right-click your selection and select View Printer Status.

The Enabled and Status columns reflect the current state of actual and logical destinations that could
be used to process the job. If there is a backup printer defined for your printer, it will be listed in the
Backup Printer column. A backup printer is a backup actual destination. To add a backup actual
destination, your administrator can set the backup-destinations attribute for the printer that you want
to backup. See RICOH InfoPrint Manager: Reference for more information.

Specifying InfoPrint attributes

The enhanced InfoPrint Select client lets you send InfoPrint attributes with your print jobs. Once you
activate the attributes dialog (see Selecting enhanced or standard InfoPrint Select, p. 118), the Job
Settings window appears when you submit a job. By clicking on the Scheduling tab, you can modify
the default scheduling values on the InfoPrint server from your InfoPrint Select client. By clicking on the
Other tab, you can:

• Specify an attribute file that you have created with particular values that will be passed onto the
InfoPrint server (for example, C:\combo.att).

• Specify an individual attribute that will be passed onto the InfoPrint server ( for example, job-
name=Job1).

• Suppress job submission error messages that lets you disable submission error message boxes.
This enables unattended operation.
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• Re-spool jobs if submission fails that lets you automatically re-spool failed job submissions. Re-
spooled jobs will be placed in the windows print queue in a paused state. The reason for the
paused state will be shown in the "Comments" column of the printer dialog if the user has
administrator privileges. To resubmit the print job you need to highlight the job in the printer dialog,
then Restart and Resume the job. This allows the Windows printing mechanism to resend the data
from the beginning.

The combo.att file cited above is a sample file which contains this:

printer-models-requested = InfoPrint4000
printer-locations-requested = 'Building 025'
job-priority = 25
job-retention-period = 01:30

For more information about additional attributes and the syntax for specifying them, see both the
InfoPrint Select online help and the RICOH InfoPrint Manager: Reference manual.

1. Before specifying any InfoPrint attributes, For specific information and syntax rules, see RICOH
InfoPrint Manager: Reference.

2. InfoPrint Select Other tab does not contain a syntax checker, so verify that the format of attributes,
specified in either an attributes file or as individual attributes, are in the correct format. If there are
syntax errors, you will receive the same messages provided for syntax errors on commands sent
from a command line.

3. If you specify the same InfoPrint attribute from different locations with different values, please note
that this hierarchy is how InfoPrint Manager determines what to send with the job:

1) Values specified in the Attributes field on the Other tab.

2) Values specified in the Attributes file field on the Other tab.

3) Any values specified on either the General, Scheduling, orMessages tab.

Viewing and canceling jobs

After you have submitted your job, InfoPrint Select lets you access the InfoPrint Manager server queues
to view the status of jobs and hold, cancel, or release jobs. Use this procedure:

1. Access the Select Target Printer dialog by clicking the icon in the system taskbar.

• The Select Target Printer dialog starts automatically when Windows first loads. To start the
InfoPrint Manager Printers dialog at another time, go to Start→ Programs→ InfoPrint
Select→ Open Printer Selection.

2. In the Select Target Printer dialog, select the printer that you want to check from the Target
Printer Selection list.

3. Right-click your selection and select View Jobs.

4. From the printer_name InfoPrint Manager Jobs dialog, you can hold, cancel, or release jobs in
the queue on the InfoPrint Manager server.
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The InfoPrint Manager Jobs dialog displays a list of all the jobs you have submitted to print. The most
recently submitted job is at the top of the list. For each job, the list includes the job name, the date and
time it was submitted, its global ID, the page count, the job originator, and the LDAP user.

The default is to list only the jobs that you have submitted. If you want all jobs listed, go to the View
menu and select Show all users jobs.

You can also check the properties of a specific job. Click a job to select it, then select Job Properties
from the Job menu or click the Job Properties toolbar button. Information about the selected job is
shown on the six tabs on the dialog. The fields on the Job Properties dialog are not editable.

Commands you can use with InfoPrint Select for Windows

Typically, InfoPrint Select is used to let users print to InfoPrint Manager destinations from existing
Windows applications (usually through the Print option on the File menu). In addition, you can use
several InfoPrint commands that can be issued at a Command Prompt on the client system.

If you are using the InfoPrint commands and want to receive notifications, you can install the
Notification Client from the RICOH InfoPrint Manager: Common Clients DVD-ROM, LCD4–5642.

Information about security and how users can be authorized to InfoPrint Manager is found in the topic
“Managing Security” in the RICOH InfoPrint Manager for Windows: Procedures guide.

InfoPrint Manager lets authorized users (normally all users) use these InfoPrint commands:

pdls
Lists selected attribute values for a job, destination, or other InfoPrint object

pdpr
Submits a job to a logical or actual destination. If LDAP job authentication is enabled, you must
authenticate using your LDAP credentials before submission.

pdq
Queries the status of selected jobs, of all jobs submitted to a logical destination, or of all jobs
assigned to an actual destination

InfoPrint Manager lets authorized users (the job owner is usually authorized) use these InfoPrint
commands:

pdmod
Modifies the attributes of submitted jobs or of the documents in them

pdrm
Deletes jobs

InfoPrint Manager allows only authorized users to use these InfoPrint commands:

pdaccount
Collects summary accounting information for a specified time period in a comma delimited format
about actual destinations on one or more servers. This information can be filed and imported into a
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spread sheet to calculate the cost of consumables, the usage rate of printers, the cost for each user,
and so forth.

pdcreate
Creates logical destinations, queues, actual destinations, default jobs, default documents, media,
auxiliary sheets, and resource contexts.

pdclean
Removes all jobs from a server, logical destination, queue, or actual destination.

pddelete
Deletes servers, logical destinations, queues, actual destinations, default jobs, default documents,
media, auxiliary sheets, resource contexts, and jobs.

pddisable
Prevents destinations from accepting jobs and logs from logging.

pdenable
Enables destinations to accept jobs and logs to log.

pdpause
Pauses a job, actual destination, queue, or all the queues and actual destinations in a server.

pdpromote
Advances a job to the head of the queue.

pdreorder
Reassigns a job to an actual destination or to the unassigned jobs area in the same server or in
another server, and lets you schedule it immediately before or after another job.

pdresubmit
Resubmits a job, all the jobs submitted to a logical destination, or all the jobs in a queue to another
logical destination.

pdresume
Enables paused objects to resume operation.

pdset
Sets or changes the values of attributes describing InfoPrint objects.

pdshutdown
Stops servers or actual destinations.

pdspace
Backspaces or forward spaces a PSF physical printer.

pddeviceop
Perform device operation on device associated with specified actual destination.
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For more information about InfoPrint commands and attributes, see RICOH InfoPrint Manager: Reference.

Querying destination attributes

To determine whether the logical destination london is ready to receive jobs, enter:

pdls -c destination -r "destination-state" london

Submitting a job

To submit the file myjob.ps to the logical destination london and request two-sided printing, enter:

pdpr -d london -x "sides=2" myjob.ps

The RICOH InfoPrint Manager: Reference lists all the attributes and values that you can specify on the pdpr
command.

Querying jobs

To query all the jobs that you submitted to logical destination london, enter:

pdq -d london

InfoPrint returns information similar to this:

Intervening Dest. Dest.
Job ID Name State Jobs Req. Assigned
--- ---------------- --------- -------- ----------- ------ --------
13 Serv1:1104221000 report.ps printing 0 london caxton
14 Serv1:1104221023 myjob.ps pending 8 london morris

Specifying the destination name

To print from the command line to a single destination without having to specify the -p flag or its
argument with each job, you can define the destination name on your system:

1. Click onMy Computer icon and select Properties.

2. On the Advanced tab, click Environment Variables.

3. Click New under System Variables to create a new system variable, and the destination name to
it.

4. In the Variable field, type: PDPRINTER and in the Value field type: destination_name.

5. Click OK.

6. Restart your system to make the changes take effect.
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Using InfoPrint Select for Windows with Anyplace printing

If you use InfoPrint Select for Windows and want to use specific tray, paper, or finishing information
with Anyplace printing, you must install the InfoPrint Manager PDF Driver provided on the RICOH
InfoPrint Manager: Common Clients media.

To install the InfoPrint Manager PDF Driver, make sure that you:

1. Copy InfoPrint Manager PDF Driver from the install media to the local system.

2. Extract the archive on a location of your choice.

3. Use the Windows Add Printer wizard as described here:

1) First, open the Add Printer wizard:

1. Click Start→ Run.

2. In the Open box, type:

control printers

, and then click OK.
The Devices and Printers window opens.

3. Click Add a printer. The Add a Printer wizard opens.

2) Tell the wizard that you want to add a local printer:

1. Click The printer that I want isn't listed.

2. Then, click Add a local printer or network printer with manual settings.

3. Click Next.

3) Select the InfoPrint Select port.

4) Tell the wizard where to find the printer driver files that you extracted:

1. Click Have Disk. The Install From Disk dialog box opens.

2. In the Install From Disk dialog box, click Browse, and then locate the folder to which you
extracted the printer driver files.

3. When you have located the correct folder, click Open.

4. The path of your folder appears in the Copy manufacturer's files from box in the Install
From Disk dialog box. Click OK.

5) Supply the wizard with the last pieces of information that are necessary to install the printer
driver files:

1. The printers that you can install are listed in the Install Printer Software dialog box. Select
the printer that you are trying to connect, and then click Next.

2. If you are prompted to use an existing driver, select Replace existing driver, and then click
Next. When you select to replace the existing driver, Windows tries to replace the current
files on your system with the new ones that you downloaded.
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3. On the next page, click Next if you want to accept the suggested printer name and use the
printer as your default printer. Otherwise, change these settings to what you prefer, and then
click Next.

4. If you see the Printer Sharing page next in the wizard, you can share your printer so that
other computers on your home network can use it to print. Click Share name, and then
specify a name for the shared printer. Otherwise, click Do not share this printer. After you
have made your selection, click Next. You might be asked to enter optional location
information for the printer. Type the location of the printer (for example, Home Office), and
then click Next.

Using InfoPrint Select for Windows with serverless printing

You can use InfoPrint Select to send a job that needs no additional processing to a printer without
passing through the InfoPrint Manager server. This function is known as serverless printing or direct IP
printing. It allows users to print when there is no need to route the jobs through the InfoPrint Manager
server or when the print server is temporarily unavailable. The function provides efficiency by reducing
network traffic via direct print connectivity.

One of the advantages of this function is that accurate accounting is still provided. InfoPrint Select sends
the job directly to the printer. After successfully printing the job, InfoPrint Select sends the information to
the InfoPrint Manager server so that accounting data can be updated. If the InfoPrint Manager server is
temporarily unavailable, then InfoPrint Select stores the accounting information and delivers it when the
server becomes available.

This InfoPrint Select function is activated via the registry key Computer\HKEY_LOCAL_MACHINE
\SOFTWARE\RICOH\InfoPrint Select\Configuration by a local InfoPrint Manager administrator.

1. To enable sending jobs directly to the printer, use the UseServerlessPrint registry key of the
REG_DWORD type, value 1.

2. To enable sending jobs directly to the printer only when the InfoPrint Manager server is
unavailable, set the UseServerlessPrint registry to 0, and use the UseDirectPrint registry key
of the REG_DWORD type, value 1.

• If both UseDirectPrint and UseServerlessPrint registry keys are set to 1, then
UseDirectPrint is ignored.

For more information about setting the registry keys using the Update Server application, see Installing
and Configuring the Update Server on a Windows system, p. 228 and Configuring the automatic
download of registry updates, p. 244.

2 Getting started with client systems



2

137

• To print directly to the printer, InfoPrint Select must retrieve the IP address of the printer from the
properties of the InfoPrint Manager actual destination defined as the target printer. Click the Open
Printer Selection application icon and select the InfoPrint Manager printer from the Target Printer
Selection table.

• Logical destinations are not supported as target printers for serverless printing with InfoPrint Select
for Windows.

• Serverless printing with InfoPrint Select for Windows does not support pull printing jobs.

• Printer devices must support the PJL language.

UUssiinngg IInnffooPPrriinntt SSeelleecctt ffoorr LLiinnuuxx
InfoPrint Select for Linux lets you submit and track jobs from a Linux workstation to a destination that is
managed by InfoPrint Manager. Through InfoPrint Select for Linux , you can submit jobs to InfoPrint
Manager from word processors, spreadsheets, and other desktop applications. You can print from
applications or from the command line.

InfoPrint Select for Linux lets you:

• Specify AFP and other InfoPrint job attributes when submitting a job to the server

• Print using LDAP authentication for job submission

Installing and upgrading InfoPrint Select for Linux

There are two versions of the InfoPrint Select client for Linux: the non-LDAP InfoPrint Select client and the
LDAP-enabled InfoPrint Select client. The LDAP-enabled InfoPrint Select client and the non-LDAP
InfoPrint Select client are packaged in different .rpm packages. The LDAP-enabled InfoPrint Select client
requires LDAP authentication for job submission. You must authenticate with an LDAP server to execute
job submissions from the InfoPrint Select client. If you install the LDAP version of the InfoPrint Select
client, you cannot switch back to the non-LDAP version (except if you uninstall and reinstall the non-
LDAP version).

If you are using the non-LDAP InfoPrint Select client in a PAM/SSO environment, the LDAP user taken
from the LDAP (PAM)/Active Directory system authentication session is used for the InfoPrint Manager
user-related attributes.

Before installing the InfoPrint Select client, make sure you have the following prerequisites installed on
your system:

• libatk-1.0.so.0

• libc.so.6

• libc.so.6(GLIBC_2.0)

• libc.so.6(GLIBC_2.1)

• libc.so.6(GLIBC_2.1.3)

• libc.so.6(GLIBC_2.2)

• libdl.so.2
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• libgcc_s.so.1

• libgcc_s.so.1(GCC_3.0)

• libgdk_pixbuf-2.0.so.0

• libgdk-x11-2.0.so.0

• libglib-2.0.so.0

• libgmodule-2.0.so.0

• libgobject-2.0.so.0

• libgtk-x11-2.0.so.0

• liblber-2.4.so.2

• libldap-2.4.so.2

• libm.so.6

• libpango-1.0.so.0

• libpangox-1.0.so.0

• libpangoxft-1.0.so.0

• libpthread.so.0

• libpthread.so.0(GLIBC_2.0)

• libpthread.so.0(GLIBC_2.1)

• libpthread.so.0(GLIBC_2.1.1)

• librt.so.1

• libstdc++.so.6

• libstdc++.so.6(CXXABI_1.2)

• libstdc++.so.6(GLIBCPP_3.2)

To install the InfoPrint Select clients:

From Terminal:

1. If you are installing from the InfoPrint Manager: Common Clients ISO file:

1) Mount the InfoPrint Manager: Common Clients ISO file.

2) Copy the installer package for the version of the InfoPrint Select client you want to install to
a temporary location. For example: /tmp.

3) Open a command terminal.

4) Install the non-LDAP InfoPrint Select client package by typing:

sudo rpm -i ipr-select-4.13.m-n.x86_64.rpm

or
Install the LDAP-enabled InfoPrint Select client package by typing:

sudo rpm -i ipr-select-ldap-4.13.m-n.x86_64.rpm

Where m and n represent the service update level.
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5) If you are upgrading the non-LDAP InfoPrint Select client from a previous version, you need
to type:

sudo rpm -U ipr-select-4.13.m-n.x86_64.rpm

If you are upgrading the LDAP-enabled InfoPrint Select client from a previous version, you
need to type:

sudo rpm -U ipr-select-ldap-4.13.m-n.x86_64.rpm

Where m and n represent the service update level.

2. If you are installing from the Web:

1) Download the non-LDAP InfoPrint Select client package or the LDAP-enabled InfoPrint Select
client package.

2) Install the non-LDAP InfoPrint Select client package by typing:

sudo rpm -i ipr-select-4.13.m-n.x86_64.rpm

or
Install the LDAP-enabled InfoPrint Select client package by typing:

sudo rpm -i ipr-select-ldap-4.13.m-n.x86_64.rpm

Where m and n represent the service update level.

3) If you are upgrading the non-LDAP InfoPrint Select client from a previous version, you need
to type:

rpm -U ipr-select-4.13.m-n.x86_64.rpm

If you are upgrading the LDAP-enabled InfoPrint Select client from a previous version, you
need to type:

rpm -U ipr-select-ldap-4.13.m-n.x86_64.rpm

Where m and n represent the service update level.

These environment variables must be set for the non-LDAP Linux Command Line client, installed with the
InfoPrint Select client, to work. The install process puts two shell configuration files (ipr-cmd.csh and
ipr-cmd.sh) in the //eettcc//pprrooffiillee..dd directory to set them. Edit these files and provide values for:

PDHOST
The name of the host where the InfoPrint Manager server is located.

PD_SOCKET
The TCP/IP socket number of the port for the InfoPrint Manager server. The default socket is 6874.
Use 6874 unless your system has been specifically set up differently or you have more than one
InfoPrint Manager server running on the host.

PDPRINTER (optional)
The default logical destination in the InfoPrint Manager server that you want to use. The commands
use this value if you do not specify a logical destination on the command line.

Users can override these settings with their own settings.
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1. If you want to use the CUPS (Common Unix Printing System) web interface version 1.1.x, you must
manually set the /usr/lib/cups/backend/selpms rights to 755 using the following command:

chmod 755 /usr/lib/cups/backend/selpms

2. If you want to use KDE libraries, make sure kdelibs 3.5.7 or higher is installed on your machine.

To use InfoPrint Select for Linux, you must create an InfoPrint Select printer using one of the methods
described in Creating InfoPrint Select printers on Linux, p. 145.

Uninstalling InfoPrint Select for Linux

1. Log in as root.

2. To uninstall the InfoPrint Select client:

1. For the non-LDAP version, type:

rpm -e ipr-select-4.13.m-n

2. For the LDAP-enabled version, type:

rpm -e ipr-select-ldap-4.13.m-n

Where m and n represent the service update level.

Using InfoPrint Select with SELinux set in enforcing mode (RHEL only)

This section describes special considerations for working with InfoPrint Select with SELinux set in
enforcing mode on a Red Hat Enterprise Linux (RHEL) system.

Running InfoPrint Select with SELinux set in enforcing mode

To allow InfoPrint Select clients to work when SELinux is set in enforcing mode, you need to complete
the following procedure:

1. Install checkpolicy and policycoreutils rpm files if not already installed:

yum install policycoreutils-python

2. Change InfoPrint Select directories and files SELinux context:

semanage fcontext -a -t cupsd_rw_etc_t '/opt/Ricoh/InfoPrint-Manager/config(/.*)?'
semanage fcontext -a -t cupsd_tmp_t '/opt/Ricoh/InfoPrint-Manager/pipes(/.*)?'
restorecon -RvF /opt/Ricoh/InfoPrint-Manager/config /opt/Ricoh/InfoPrint-Manager/pipes

3. Turn on allow_ypbind SELinux boolean:

setsebool -P allow_ypbind=on

4. Generate SELinux policy module:

cd /tmp
cp /opt/Ricoh/InfoPrint-Manager/selinux/ipmselect.te /tmp
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/usr/bin/checkmodule -M -m -o ipmselect.mod ipmselect.te
/usr/bin/semodule_package -o ipmselect.pp -m ipmselect.mod

5. Install the new SELinux policy module:

semodule -i ipmselect.pp

6. Remove temporary files:

rm -f ipmselect.pp ipmselect.mod ipmselect.te

Reverting the SELinux changes for InfoPrint Select

To revert the SELinux changes for InfoPrint Select, follow the procedure:

1. Restore files and directories SELinux context:

semanage fcontext -d -t cupsd_rw_etc_t '/opt/Ricoh/InfoPrint-Manager/config(/.*)?'
semanage fcontext -d -t cupsd_tmp_t '/opt/Ricoh/InfoPrint-Manager/pipes(/.*)?'
restorecon -RvF /opt/Ricoh/InfoPrint-Manager/config /opt/Ricoh/InfoPrint-Manager/pipes

2. Turn off allow_ypbind SELinux boolean:

setsebool -P allow_ypbind=off

3. Uninstall the SELinux policy module:

semodule -r ipmselect.pp

Configure SELinux to print warnings instead of enforcing

To configure SELinux to print warnings instead of enforcing, set SELinux=permissive in /etc/
selinux/config. For more information, see the web page Security Enhanced Linux.

Using LDAP Job Authentication with InfoPrint Select for Linux

The LDAP-enabled InfoPrint Select client requires users to LDAP-authenticate when they first submit a job.
LDAP authentication support allows only authenticated users to print and provides information about the
users that printed a specific job. LDAP authentication allows InfoPrint Manager to provide more
accurate accounting information.

The LDAP-enabled InfoPrint Select client must be configured to use an LDAP server that has the GSS
authentication option enabled. Only one version of the InfoPrint Select client can be installed at a time,
so if the non-LDAP version has been installed, it must be uninstalled before the LDAP version can be
installed. Subsequent updates apply to the current version that is installed. There is a configuration file
containing the LDAP authentication settings. You can edit the configuration settings only if you have root
privileges. Multiple users are allowed to login and authenticate from the same box.

If you cannot successfully log in to the LDAP server, the LDAP-enabled InfoPrint Select client does not
allow you to submit jobs. If you are successfully logged in to the LDAP server, you are allowed to submit
jobs to the InfoPrint Manager server. You must log in to the LDAP server the first time you submit a print
job. The LDAP login session expires in either of these situations: when you log off or when the session
timeout set by the LDAP server administrator expires. You do not have to log in again for each
subsequent print job that you submit. The submitted jobs contain an authenticated-login attribute with the
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LDAP username that can be added to the server accounting logs by using the server or actual
destination additional-accounting-log-attributes attribute. You can modify the connection settings,
and the application updates the configuration file.

The LDAP-enabled InfoPrint Select client is LDAP v3 compliant. It only supports an open directory LDAP
model. This means that the LDAP server does not enforce the clients to establish connections over SSL,
and it does not ask clients to be authenticated when and if they connect to an LDAP server over SSL.

The SSL client mutual authentication is enabled when you do not want your directory system to be
opened to the general public. It is a closed directory system where both the SSL and the client
authentication are forced. The SSL client authentication means that the client must have a valid certificate
verified by the server.

LDAP-enabled InfoPrint Select for Linux authentication methods

Simple

For Simple authentication, the login name, in the form of the retrieved DN, is sent with the password in
clear text to the LDAP server.

Digest

This method requires a Digest plugin installed on the LDAP server with its own user database. The LDAP
server internally forwards authentication credentials to the Digest plugin (SASLDB). There is no search
mechanism for DN in this case.

Configuring LDAP-enabled InfoPrint Select client settings on Linux

For the LDAP-enabled InfoPrint Select client to submit authenticated jobs to InfoPrint Manager properly,
you must configure your LDAP-enabled InfoPrint Select client settings. The LDAP settings window lets you
configure the credentials, connection, authentication, and search settings. From the LDAP login window,
click Settings to open the LDAP settings window. The Settings button is enabled only if you use the
root account to log in.

Credentials

Login
The login information can be an e-mail address, an employee number, a badge serial number, a
common name, a Lotus Notes canonical name, a user ID, a uid, or other data information.

The login information can be sent to the destination accounting log by adding the authenticated-
login attribute to the list of values used by the additional-accounting-log-attributes attribute.

Password
Enter your password.

Upper/Lower case
Specifies the letter case of the login attribute. You can select one of these values: Case Sensitive,
Convert to Lower Case, or Convert to Upper Case. The default value is Case Sensitive.

Disable Save Credentials
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Does not allow users to save credentials. The login and password from the LDAP settings window
are not stored.

The credentials, if available, are copied from/to the InfoPrint Select LDAP login window.

LDAP Server

Host
Enter the host name or IP address of the LDAP server.

Port
Enter the port number that is used for communication. The default port number is 389. The default
SSL port number is 636.

Authentication

Method
Select the method of authentication: Simple or Digest.

SASL Realm
Enter the name of the SASL Realm. This option is available when you use the Digest method.

Encryption
Enter an encryption method for the LDAP Server. To use the TLS or the SSL protocols, select the Use
Start TLS Extension or the Use SSL Encryption option.

DN Search Options

The Distinguished Name (DN) Search Options is only used for the Simple authentication method.

Search Base
The search base entry is the location in a directory from which the LDAP search begins.

Search Attribute
The search attribute is used for the search of the DN. The DN is used for logging on to the InfoPrint
Select LDAP server.

Example:

• If you want to identify the DN using the intranet e-mail address (for example: john_
smith@example.com) as the LDAP login, the search attribute must be mail. The DN Search
Options are configurable as needed and used only for simple authentication method.

– If you enter you login as your common name (for example: “John Smith”), the search
attribute must be set to cn.

– Other various attributes for the DN search, like: e-mail address, employee number, badge
serial number, common name, Lotus Notes canonical name, user ID, uid, and DN.

Depending on the custom configuration, the specific login attribute is used for the DN search. This
attribute becomes the value of the authenticated-login job attribute in the accounting log.
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Click Test Authentication if you want to test the connection to the LDAP server. If the connection is
successful, a confirmation message is displayed: Successfully connected to the LDAP server.

If one of the LDAP settings is not properly configured, you receive one error message for each case:

• “Invalid user login credentials. Check your login credentials.” You see this
message when the authentication bind fails because the credentials are incorrect.

• “Incorrect LDAP host, port, or SSL/TLS settings. Check your host, port, and SSL/
TLS settings.” You see this message when the authentication bind fails because InfoPrint
Select LDAP client cannot contact the LDAP server.

• “Invalid authentication method. Contact your system administrator.” You see this
message when the LDAP server does not recognize the authentication method that the InfoPrint
Select LDAP client used.

• “LDAP login not found on server. Check your credentials or search options.” You
see this message when InfoPrint Select LDAP does not find the user in the search directory.

You do not see an error message when the LDAP server does not allow anonymous authentication.
In this case, the initial bind fails because no anonymous binding is allowed and InfoPrint Select
LDAP client authenticates directly with the login credentials that you entered.

Anonymous Login
Enable/Disable anonymous login to the LDAP server.

Bind DN
Enter the Distinguished Name (DN) of the account if the LDAP server does not allow anonymous
queries.

Password
The password for the Bind DN account.

The Bind DN login and password information are stored in the registry. The password is stored in
encrypted form. By default, the search of the DN is done by the anonymous binding to the LDAP server,
and it is based on the Search Base and the Search Attribute values. The DN that results from the
search is used for the authentication together with the specified password. If Anonymous Search is not
enabled on your InfoPrint Select LDAP server, InfoPrint select attempts to log in with the Bind DN and
password and searches for the specified Login. If the authentication fails, an error occurs. If the search
succeeds, InfoPrint Select attempts to log in with the DN associated with the Login. If the search fails,
InfoPrint Select attempts to log in with the Login and password.

The password information is not stored. The credentials are copied from the LDAP-enabled InfoPrint
Select client login window if you already set them.

Depending on the custom configuration, the specific login attribute is used for the DN search. This
attribute becomes the value of the authenticated-login job attribute in the accounting log.

Click Test Authentication if you want to test the connection to the LDAP server. If the connection is
successful, a confirmation message is displayed: Successfully connected to the LDAP server.

If one of the LDAP settings is not properly configured, you receive one error message for each case:

• Invalid user login credentials. Check your login credentials. You see this message when the authentication
bind fails because the credentials are incorrect.
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• Incorrect LDAP host, port, or SSL/TLS settings. Check your host, port, and SSL/TLS settings. You see this
message when the authentication bind fails because LDAP-enabled InfoPrint Select client cannot
contact the LDAP server.

• Invalid authentication method. Contact your system administrator. You see this message when the LDAP
server does not recognize the authentication method that the LDAP-enabled InfoPrint Select client
used.

• LDAP login not found on server. Check your credentials or search options. You see this message when the
LDAP-enabled InfoPrint Select client does not find the user in the search directory.

• You do not see an error message when the LDAP server does not allow anonymous authentication.
In this case, the initial bind fails because no anonymous binding is allowed, and the LDAP-enabled
InfoPrint Select client authenticates directly with the login credentials that you entered.

Creating InfoPrint Select printers on Linux

This section describes how to configure InfoPrint Select clients to allow print job submission from Linux
applications to destinations managed by an InfoPrint Manager server.

There are three methods to create InfoPrint Select printers on Linux:

1. Add a printer using the CUPS (Common Unix Printing System) web interface:

1) Open a web browser.

2) To access the CUPS web interface, enter http://localhost:631 in the browser address bar.

3) Enter CUPS administrator credentials and on the Administration tab, click Add Printer.

4) From the Other Network Printers section, select InfoPrint Select and click Continue.

5) Set the correct DEVICE_URI in the Connection field and click Continue, where DEVICE_URI is:

selpms://<server_hostname>[:<port>]/<destination>
Example:

selpms://server.company.domain:6874/IP1107EX

If no port is specified, the default port number is 6874.

6) Set the Name, Description and Location values for the CUPS printer and click Continue.

7) Select the printer manufacturer from the drop-down list and click Continue. Choose the printer
model and click Add Printer.

8) Set the default options for the printer and click Set Default Options.

2. Add a printer using /usr/sbin/lpadmin command:

1) Open a command terminal.

2) Execute the following command:

/usr/sbin/lpadmin -p <cups_printer_name> -v"<DEVICE_URI>"
-m <printer_model.ppd> -D <printer_description> -E

Example:
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/usr/sbin/lpadmin -p myCupsPrinter
-v"selpms://server.company.domain:6874/IP1107EX"
-m InfoPrint-Pro_1107EX.ppd -D "InfoPrint Select" -E

3. Add a printer using the Linux Add a Printer Wizard:

1) Go to System→ Administration→ Printing.

2) Click New.

3) From the list of Devices select Network Printer→ InfoPrint Select and enter the device URI
information: selpms://server_hostname[:port]/destination.

If no port is specified, the default port number is 6874.

4) Click Forward.

5) Select a printer from the database and click Forward.

6) Select a printer model and a driver from theModel and Drivers lists and click Forward.

7) In the Installable Options panel click Forward.

8) In the Describe Printer panel enter Printer Name, Description (optional), and Location
(optional) and click Apply.

Printing from applications

Things to be considered when printing from applications with InfoPrint Select:

Printing Considerations
InfoPrint Select works with the print facility of each application, so printing from every program is a
little different. A typical application might allow you to specify a printer other than the default, the
number of copies, or a range of pages.

If the printer selected (or your default printer) is an InfoPrint Manager Select printer, your job is sent
to the InfoPrint server.

Checking printer status

To check the status of a printer, select View IPM Printer Status from the InfoPrint Select menu. A list of
all the InfoPrint Manager destinations used by the InfoPrint Select printers is displayed.

The InfoPrint Manager Printers dialog displays information about all the InfoPrint Manager destinations
used by the InfoPrint Select printers, including the names of all the printers assigned to the logical
printer, the printer type (logical or physical), whether the printer is enabled or disabled, current status
(for example, printing or needs attention), problem messages (optional), SNMP information, and
backup printers. The default is to not display problem messages. To display problem messages, go to
the View Menu pull-down and select Show problem messages. Note that problem messages might
not appear in your language.
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Depending on the CUPS printer configuration, the same InfoPrint Manager destination can be displayed
multiple times.

The Enabled and Status columns reflect the current state of actual and logical destinations that could
be used to process the job. If there is a backup printer defined for your printer, it will be listed in the
Backup Printer column. A backup printer is a backup actual destination. To add a backup actual
destination, your administrator can set the backup-destinations attribute for the printer that you want
to backup. See the InfoPrint Manager Reference for more information.

Viewing and canceling jobs

You have the ability to query jobs that you have submitted. Select retains the job information and
displays your jobs in the InfoPrint Manager Jobs dialog. To check the status of a print job that you have
submitted for printing, select View IPM Queue from the InfoPrint Select menu. A list of jobs is
displayed. If you want to see just the jobs submitted to a specific printer, go to the View menu bar pull-
down, select Printer Selection, and choose a printer.

The InfoPrint Manager Jobs dialog displays a list of all the jobs you have submitted to print. The most
recently submitted job is at the top of the list. For each job, the list includes the job name, the date and
time it was submitted, its global ID, the page count, the job originator, and the LDAP user.

The default is to list only the jobs that you have submitted. If you want all jobs listed, go to the View
menu bar pull-down and select Show all users jobs.

You can also check the properties of a specific job. Click a job to select it, then select Job Properties
from the Job menu bar pull-down or click the Job Properties toolbar button. Information about the
selected job is shown on the six tabs on the dialog. The fields on the Job Properties dialog are not
editable.

Job Properties dialog

The Job Properties dialog opens when you click Properties on the toolbar or you select Properties
from the Job menu bar pull-down. You can display information about a selected job by selecting one of
the tabs on the dialog. The fields on this dialog are not editable.

Summary

The Summary page displays overall job settings for the print job. These values are not editable.

Job name
Indicates the name of the job. The job name is assigned on the Job Settings dialog.

State
Indicates the state of the job. These job states are possible:

Canceled The job has been canceled.

Held The job is being held in the queue.

Paused The job has been paused.
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Pending The job is waiting in the queue to be printed.

Pre-processing The job is being created.

Processing The job has been scheduled to print on a physical printer.

Retained The job has already printed or was removed from the queue and has a non-
zero retention period.

Terminating The job has been canceled and is in the process of terminating.

Unknown The state is not known.

Reason for job state
Indicates the reasons that this job is in the held, terminating, or retained state. If this field is blank,
this job is not in one of these states.

Position in queue
Indicates the number of jobs in the queue before this job.

Number of pages
Indicates the number of pages in the job.

Originator
Displays an originator name if it was specified in the job-originator attribute. This name can appear
on the start sheet printed with your jobs. If an attribute was not specified, the field will be blank.

Authenticated login
Specifies the LDAP user ID if the job is LDAP authenticated.

Processing

The Processing page displays values for processing the print job. These values are not editable.

Copies
Indicates the number of job copies that have been selected for printing.

Retention period
Displays the period of time following job completion, in hours and minutes, that this job is retained
before being discarded. After this job completes, it is retained until this time limit expires or until the
Discard Time limit expires.

Progress

The Progress page displays information about the progress of the print job. These values are not
editable.

Submission time
Indicates the time at which this job was added to the queue.

Submission complete
Indicates whether information regarding the documents in this job have been received by the server
from the client. The value is either true or false.
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Started printing time
Indicates the time that this job was sent to the printer.

Processing time
Indicates the amount of time (in hours and minutes) that this job has been at the printer device. If
printing has completed, this field displays the total amount of time used to print this job.

Copies complete
Indicates the number of copies that have completed printing. If this value is blank, the job might not
have started to print or this information is not available to Select.

Completion time
Indicates the time when this job completed printing.

Modification time
Indicates the date and time that the job was last modified. It can indicate that an administrator has
performed some action on your job after you submitted it.

Name of last modifier
Indicates the name of the person or the name of the application that most recently modified the job.
If a person submitted or modified the job, the value is the login ID for that user.

Scheduling

The Scheduling page displays the settings for print job scheduling. These values are not editable.

Print After
Indicates the date or time when jobs submitted to this printer will begin to be scheduled.

Discard After
Indicates the date or time when jobs submitted to this printer will be deleted, whether they have
printed.

Job batch
Indicates the value for the job-batch attribute if one was specified.

Priority
Indicates the scheduling priority of this job. A print job can have a priority of 1-100, where 100 is
the highest priority. General users can set a priority of up to 50; administrators can set a priority of
up to 100.

Status

The Status page displays information about print job status. These values are not editable.

Queue assigned
Indicates the name of the queue where this job is located. If this field is blank, the job is not currently
residing in a queue because it is in the retained or timed-out state.

Printers used
Shows a list of the physical printers used to print this job.
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Previous job state
Indicates the previous state of the job.

Owner
Indicates the value of the job-owner attribute. If you did not specify a value for this attribute when
you submitted the job, this field displays the user ID and address of the person who submitted the
job, as determined by Select.

Default job
If you specified the initial-value-job attribute with your job to control job attributes and values, this
field displays the value you specified for that attribute.

Printer's default job
Indicates the name of the initial value job designated by the logical printer to provide default job
attribute values for this job. If you do not specify an initial value job with the job, or if the specified
initial value job does not include a value for the attribute, Select uses the attribute value from the
printer initial value job. If there is no such value, Select uses the system default.

Document summary

The Document summary page displays document settings for the print job. These values are not
editable.

Document format
Indicates the format of the document.

Sides
Indicates the Sides setting for the print job. Possible values are: 1, 2, or use server default.

Plex
Indicates how the output images for this job are placed on the media by the printer. Possible values
are: simplex, duplex, and use server default.

Orientation
Indicates the way job contents will be placed on the output media. Possible values are:

default The data_stream and Select defaults determine the orientation.

portrait Jobs will be printed without additional rotation.

landscape Jobs will be rotated 90 degrees when they are printed.

reverse-portrait Jobs will be rotated 180 degrees when they are printed.

reverse-landscape Jobs will be rotated 270 degrees when they are printed.

Default medium
Indicates the medium on which the documents in this job are printed if a medium is not specified by
other methods. The medium can be specified by document contents, other job attributes or printer
attributes.

Other options
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If you specified attributes to directly pass flags and parameters to the printer device, this field
displays the information you specified.

Printer's default document
Indicates the name of the initial value document designated by the logical printer to provide default
document attribute values for this job. A default attribute value from this initial value document is
used if the attribute value was not specified when the job was submitted or provided by an initial
value document designated by a print file document in the job.

Using the Job Settings dialog

You can change several settings related to the print job by using the Job Settings dialog. The changes
you make in the Job Settings dialog affect only the current job. The Job Settings dialog is disabled by
default. To activate the Jobs Settings dialog, select Activate Job Settings Dialog from the InfoPrint
Select menu. The tabs/pages associated with this dialog are:

General Attributes page

Use this page to choose a job name and display the name and address of the job owner. You can set
these values:

Job name
Indicates the name of the job you are submitting. By default, the application from which you are
submitting the job specifies the job name. To specify a different name for the job, enter the new
name in the field. Depending on the Select configuration, this name can print on the start sheet for
the job.

Owner
Indicates the user name and address of the job sender. This field cannot be changed.

To submit a confidential job, select the Confidential job checkbox. If you select the Confidential job
checkbox, the document cannot be viewed in the JobViewer.

On this page you can check the Do not display this dialog again checkbox to disable this dialog. If
you check this box, the dialog does not display when you send print jobs. The Job Settings dialog is
disabled by default. If you decide that you want to enable this dialog, select Activate Job Settings
Dialog from the InfoPrint Select menu.

Scheduling Attributes

You can use this page to control when your print job is printed. You can set these values:

Print After
Set the date, time or partial time when jobs submitted to this printer will begin to be scheduled. To fill
in the desired date and time:

1. Click in the Print after checkbox to place a check in the box.

2. Select the unit you want to change (year, month, day, hour minute) in the Change pull-down
menu on the right.

3. Use the + and - buttons to adjust the desired Print after time.
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Discard After
Set the date, time or partial time when jobs submitted to this printer will be deleted, whether they
have printed. To fill in the desired date and time:

1. Click in the Discard after checkbox to place a check in the box.

2. Select the unit you want to change (year, month, day, hour minute) in the Change pull-down
menu on the right.

3. Use the + and - buttons to adjust the desired Discard after time.

Retention Period
Set the amount of time that the job will be retained at the server before it is deleted. To fill in the
desired date and time:

1. Select the unit you want to change (hours, 10-minutes, minutes) in the Change pull-down menu
on the right.

2. Use the + and - buttons to adjust the desired retention period.

Priority
Type the desired priority value into the field. The Priority field displays a number representing the
scheduling priority of this job. A print job can have a priority of 1-100, where 100 is the highest
priority. General users can set a priority of up to 50; administrators can set a priority of up to 100.

Hold
When you check the Hold checkbox, the print job is held on the server, and the job-hold attribute
is set to True or Yes.

Messages page

You can use this page to create a job comment or a message for the print operator. You can set these
values:

Job comment
Use this field to record any comments about your print job.

Message to operator
Use this field to include a message that Select sends to an operator when it adds your job to the
queue. You might want to include information that describes any special handling that your job
requires.

Other Attributes page

Use this page to choose additional job and document attributes for a print job. Attributes are used for
advanced printing and production printing to specify how and when jobs submitted to this printer will
print.

Attributes File
Type the name of the file containing additional job and document attributes for the print job. If you
click Browse..., the Open Dialog is displayed and you can search for an attributes file. You can use
one of the sample attributes files as a guide in creating your own customized set of attributes.

Attributes
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You can type additional attributes and their values in this field, in the format attribute = value (for
example, job-priority = 25)

Printer options
Use this field to directly pass flags and options to the printer device. Select appends the information
you supply to the printer-command attribute for the printer. If the printer device is controlled by the
BSD device support system, Select appends the information you supply to the printer-command
attribute for the printer.

Checkboxes
Suppress job submission error messages: Check this box to suppress job submission error
messages to allow unattended operation.

Re-spool jobs if submission fails: Check this box to automatically re-spool failed job submissions.
Re-spooled jobs are placed in the print queue in a hold state.

Example attribute file

printer-models-requested = InfoPrint4000
printer-locations-requested = 'Building 025'
job-priority = 25
job-retention-period = 01:30

1. Before specifying any InfoPrint attributes, for specific information and syntax rules, see RICOH
InfoPrint Manager: Reference.

2. The InfoPrint Manager Select for Linux client Other tab does not contain a syntax checker, so verify
that the format of attributes, specified in either an attributes file or as individual attributes, are in the
correct format. If there are syntax errors, you will receive the same messages provided for syntax
errors on commands sent from a command line.

3. If you specify the same InfoPrint attribute from different locations with different values, InfoPrint
Manager determines what values to send with the job using the following hierarchy:

1) Values specified in the Attributes field on the Other tab.

2) Values specified in the Attributes file field on the Other tab.

3) Any values specified on either the General, Scheduling, orMessages tab.

Working with InfoPrint Select Notifications

By default when you submit a job using InfoPrint Select, a notification profile is sent with the job. If you
have the InfoPrint Manager Message window running when you submit a print job using InfoPrint
Select, notifications are requested. If the InfoPrint Manager Message window is not running,
notifications are not requested.

To change the port SMTP sends notifications to, go to the Settings menu and select Configure
notification port. You see the InfoPrint Manager Message port dialog. In the Notification port field,
type in the number of the new port you want SMTP to use for notifications. The default is 5157.

To activate the InfoPrint Manager Message window, select InfoPrint Select Notifications from the
InfoPrint Select menu.
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To turn off the InfoPrint Manager Message window, click X in the upper right corner of the window and
then click OK on the warning message.

Configuration file

The InfoPrint Manager Select for Linux creates a configuration file for each user ID to store that user's
settings. The file is generated the first time the Select is invoked by each user if it does not already exist.
The file is saved in the home folder under oopptt//RRiiccoohh//IInnffooPPrriinntt--MMaannaaggeerr//ccoonnffiigg//<<uusseerr>>__
sseelleecctt..ccoonnff.

The configuration file

[User Preferences]
Notification Port=5157
Use default .att file=1
Default .att file=
[IPM Printers]
Show problem messages=0
[Submission Window]
Suppress=1
[Job Recovery]
Pause jobs if submission fails=0
Suppress submission errors=1

The key settings are:

• Notification Port=5157 - Must be set to a unique port number if Notifications are being used. If
Select Notifications are not being used, it does not need to be changed.

• Suppress=1 - Suppresses the Job Settings Dialog

• Suppress submission errors=1 - Suppresses error messages found during submission.

• Pause jobs if submission fails=0 - Optionally can set this to 1 to cause failed jobs to be retained for
re-submission by the administrator.

Commands you can use with InfoPrint Select for Linux

Typically, InfoPrint Select is used to let users print to InfoPrint Manager destinations from existing Linux
applications. In addition, you can use several InfoPrint commands that can be issued from the
Command Line on the client system.

Information about security and how users can be authorized to InfoPrint Manager is found in the topic
“Managing Security” in the RICOH InfoPrint Manager for Windows: Procedures manual.

InfoPrint Manager lets authorized users (normally all users) use these InfoPrint commands:

pdls
Lists selected attribute values for a job, destination, or other InfoPrint object

pdpr
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Submits a job to a logical or actual destination. If LDAP job authentication is enabled, you must
authenticate using your LDAP credentials before submission.

pdq
Queries the status of selected jobs, of all jobs submitted to a logical destination, or of all jobs
assigned to an actual destination

InfoPrint Manager lets authorized users (the job owner is usually authorized) use these InfoPrint
commands:

pdmod
Modifies the attributes of submitted jobs or of the documents in them

pdrm
Deletes jobs

InfoPrint Manager allows only authorized users to use these InfoPrint commands:

pdaccount
Collects summary accounting information for a specified time period in a comma delimited format
about actual destinations on one or more servers. This information can be filed and imported into a
spread sheet to calculate the cost of consumables, the usage rate of printers, the cost for each user,
and so forth.

pdcreate
Creates logical destinations, queues, actual destinations, default jobs, default documents, media,
auxiliary sheets, and resource contexts.

pdclean
Removes all jobs from a server, logical destination, queue, or actual destination.

pddelete
Deletes servers, logical destinations, queues, actual destinations, default jobs, default documents,
media, auxiliary sheets, resource contexts, and jobs.

pddisable
Prevents destinations from accepting jobs and logs from logging.

pdenable
Enables destinations to accept jobs and logs to log.

pdpause
Pauses a job, actual destination, queue, or all the queues and actual destinations in a server.

pdpromote
Advances a job to the head of the queue.

pdreorder
Reassigns a job to an actual destination or to the unassigned jobs area in the same server or in
another server, and lets you schedule it immediately before or after another job.

pdresubmit
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Resubmits a job, all the jobs submitted to a logical destination, or all the jobs in a queue to another
logical destination.

pdresume
Enables paused objects to resume operation.

pdset
Sets or changes the values of attributes describing InfoPrint objects.

pdshutdown
Stops servers or actual destinations.

pdspace
Backspaces or forward spaces a PSF physical printer.

pddeviceop
Perform device operation on device associated with specified actual destination.

For more information about InfoPrint commands and attributes, see the RICOH InfoPrint Manager:
Reference .

Filtering destinations

To find a destination near you that can print two-sided PostScript jobs, enter:
pdls -c destination -f "destination-realization==actual

&& document-format-supported==postscript && sides-supported==2"
-r "destination-location" \*:

The -f flag specifies that you want to either filter on or list only actual destinations that support
PostScript format and two-sided printing. The -r flag specifies that you want to request where the actual
destinations are located in. The asterisk means that you want to check every server. The blank after the
colon means that you want to check every destination in every server.

InfoPrint returns information similar to this:
caxton: destination-location = 3rd floor E
elzevir: destination-location =
morris: destination-location = 1st floor W

You decide to print your job on morris. To determine a logical destination that routes jobs to morris,
enter:
pdls -c destination -f

"destination-associated-destinations==morris" \*:

Querying destination attributes

To determine whether morris is ready to receive jobs, enter:

pdls -c destination morris

The enabled and destination-state values indicate whether morris is ready to receive jobs.
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Submitting a print job

To submit the file myjob to the logical destination london, requesting two-sided printing on the actual
destination morris, enter:

pdpr -d london -x "destination-name-requested=morris sides=2" myjob

Querying jobs

To list all the jobs that you submitted to logical destination london, enter:

pdq -d london

InfoPrint Manager returns information similar to this:

Job
ID Name

Intervening
State

Destination
Jobs

Destination
Requested

Destination
Assigned

13 Ser-
v1:1104221000

printing 0 london caxton

14 Ser-
v1:1104221023

pending 8 london morris

Modifying job attributes

After submitting myjob, you decide that you want to print two copies and that you want to retain it for
one hour after it prints. When you queried the jobs submitted to london, you saw that the local Job ID
is 14 and that the job is still pending, so it can be modified. To change the number of copies to two and
add a retention period of one hour, enter:

pdmod -n 2 -x “job-retention-period=1:00” 14

Modifying destination attributes

To restrict the Printer3 actual destination so that it does not accept very large jobs, complete these
tasks:

1. Before you can modify the attributes of the Printer3 actual destination, you must disable it by
entering:

pddisable Printer3

2. To specify a new maximum job size of 5 meg for Printer3, enter:

pdset -c destination -x “job-size-range-ready=0:500000” Printer3

3. To reenable the actual destination, enter:

pdenable Printer3
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Shutting down an actual destination

The printer device represented by the actual destination caxton is out of order. To shut down caxton
until the printer device can be repaired and to associate a message with caxton, enter:

pdshutdown -c destination -m “Service called Tuesday at 3PM” caxton

Using InfoPrint Select for Linux with Anyplace printing

If you use InfoPrint Select for Linux and want to use specific tray, paper, or finishing information with
Anyplace printing, you must install the InfoPrint Manager PDF Driver provided on the RICOH InfoPrint
Manager: Common Clients media.

To install the InfoPrint Manager PDF Driver:

1. Log in to the Linux system as root.

2. If you are installing from the RICOH InfoPrint Manager: Common Clients media:

1) Insert the DVD-ROM into the drive.

2) Mount the file system by typing:

mount /dev/cdrom /media/<mount_point>

3) Type:

cd /media/<mount_point>/linux

4) Install the InfoPrint Manager PDF Driver package.
Type:

rpm -i ipr-base-pdf-driver.m-n.x86_64.rpm

Where m and n represent the service update level.

5) Unmount the mmeeddiiaa//ccddrroomm file system.

6) Remove the DVD-ROM.

3. Test the system.

4. Follow the instructions from Creating InfoPrint Select printers on Linux, p. 145 and InfoPrint
Manager PDF ppd to add an InfoPrint Select printer.

UUssiinngg IInnffooPPrriinntt SSeelleecctt ffoorr mmaaccOOSS
InfoPrint Select for macOS lets you submit and track jobs from a macOS workstation to a destination
that is managed by InfoPrint Manager. Through InfoPrint Select for macOS, you can submit jobs to
InfoPrint Manager from word processors, spreadsheets, and other desktop applications. You can print
from applications or from the command line.

If you are using the non-LDAP InfoPrint Select client in a PAM/SSO environment, the LDAP user taken
from the LDAP (PAM)/Active Directory system authentication session is used for the IPM user-related
attributes.

InfoPrint Select for macOS lets you:
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• Specify AFP and other InfoPrint job attributes when submitting a job to the server

• Print using LDAP authentication for job submission

Installing InfoPrint Select for macOS

There are two versions of the InfoPrint Select client for macOS: the non-LDAP InfoPrint Select client and
the LDAP-enabled InfoPrint Select client. The LDAP-enabled InfoPrint Select client and the non-LDAP
InfoPrint Select client are packaged in different rpm packages. The LDAP-enabled InfoPrint Select client
requires LDAP authentication for job submission. You must authenticate with an LDAP server to execute
job submissions from the InfoPrint Select client. If you install the LDAP version of the InfoPrint Select client
and you want to switch back to the non-LDAP version, you can install it over the LDAP version. The
installer allows you to install one version of the InfoPrint Select client over the other and automatically
removes the old version.

Starting with macOS 10.6, filters and backends are run inside a security sandbox that restricts beyond
the normal UNIX user/group permissions what a filter or backend can do. To use InfoPrint Select on
these operating systems, add Sandboxing Relaxed to the file /etc/cups/cups-files.conf and
restart the CUPS service. Open the Terminal application and run this command:

sudo launchctl stop org.cups.cupsd

If prompted, enter the password for the current user, press the Enter key, and then run:

sudo sh -c 'echo "Sandboxing Relaxed" >> /etc/cups/cups-files.conf'
sudo launchctl start org.cups.cupsd

To install the InfoPrint Select clients:

1. Log in to the macOS system as root.

2. Mount the RICOH InfoPrint Manager: Common Clients ISO file.

3. Copy the installer package for the version of the InfoPrint Select client you want to install to a
temporary location. For example: /tmp.

4. To install the non-LDAP InfoPrint Select client, double-click the ipr-select-4.13.m-n.x86_64.
pkg package to launch the installer.
To install the LDAP-enabled InfoPrint Select client, double-click the ipr-select-ldap–4.13.m-n.
x86_64.pkg package to launch the installer.

If prompted, enter the password for the current user and press the Enter key.
m and n represent the service update level.

If you want to install the InfoPrint Select clients in silent mode:

1) Open a command terminal.

2) Execute the following commands:

sudo -S installer -verbose -pkg /tmp/ipr-select-4.13.m-n.x86_64.pkg -target /

for the non-LDAP InfoPrint Select client.

sudo -S installer -verbose -pkg /tmp/ipr-select-ldap-4.13.m-n.x86_64.pkg -target /

for the LDAP-enabled InfoPrint Select client.
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m and n represent the service update level.

5. Follow the instructions provided in the installer to finish the installation.

6. These environment variables must be set for the non-LDAP macOS Command Line client, installed
with the InfoPrint Select client, to work. The install process puts two shell configuration files (ipr-
cmd.csh and ipr-cmd.sh) in the //eettcc//pprrooffiillee..dd directory to set them. Edit these files and
provide values for:

PDHOST
The name of the host where the InfoPrint server is located.

PD_SOCKET
The TCP/IP socket number of the port for the InfoPrint server. The default socket is 6874. Use
6874 unless your system has been specifically set up differently, or you have more than one
InfoPrint Manager server running on the host.

PDPRINTER
The default logical destination in the InfoPrint Manager server that you want to use. The
commands use this value if you do not specify a logical destination (the -P
DestinationName flag) on the command line.

To perform a correct installation, use a macOS account with admin rights.

To use InfoPrint Select for macOS you must create an InfoPrint Select printer using one of the methods
described in Creating InfoPrint Select printers on macOS, p. 164.

Uninstalling InfoPrint Command Line Client and InfoPrint Select for macOS

1. Log in to the macOS system.

2. Open a command terminal.

3. Type this command:

sudo /opt/Ricoh/InfoPrint-Manager/bin/uninstall

4. If prompted, enter the password for the current user and press the Enter key.
Both InfoPrint Command Line Client and InfoPrint Select are uninstalled.

Using LDAP Job Authentication with InfoPrint Select for macOS

The LDAP-enabled InfoPrint Select client requires users to LDAP-authenticate when they first submit a job.
LDAP authentication support allows only authenticated users to print and provides information about the
users that printed a specific job. LDAP authentication allows InfoPrint Manager to provide more
accurate accounting information.

The LDAP-enabled InfoPrint Select client must be configured to use an LDAP server that has the GSS
authentication option enabled. Only one version of the InfoPrint Select client can be installed at a time.
If you install the LDAP version of the InfoPrint Select client and you want to switch back to the non-LDAP
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version, you can install it over the LDAP version. The installer allows you to install one version of the
InfoPrint Select client over the other and automatically removes the old version. Subsequent updates
apply to the current version that is installed. There is a configuration file containing the LDAP
authentication settings. You can edit the configuration settings only if you have root privileges. Multiple
users are allowed to login and authenticate from the same box.

If you cannot successfully log in to the LDAP server, the LDAP-enabled InfoPrint Select client does not
allow you to submit jobs. If you are successfully logged in to the LDAP server, you are allowed to submit
jobs to the InfoPrint Manager server. You must log in to the LDAP server the first time you submit a print
job. The LDAP login session expires in either of these situations: when you log off or when the session
timeout set by the LDAP server administrator expires. This way each time you log in you are required to
LDAP authenticate. You do not have to log in again for each subsequent print job that you submit. The
submitted jobs contain an authenticated-login attribute with the LDAP username that can be added to
the server accounting logs by using the server or actual destination additional-accounting-log-
attributes attribute. You can modify the connection settings, and the application updates the
configuration file.

The LDAP-enabled InfoPrint Select client is LDAP v3 compliant. It only supports an open directory LDAP
model. This means that the LDAP server does not enforce the clients to establish connections over SSL,
and it does not ask clients to be authenticated when and if they connect to an LDAP server over SSL.

The SSL client mutual authentication is enabled when you do not want your directory system to be
opened to the general public. It is a closed directory system where both the SSL and the client
authentication are forced. The SSL client authentication means that the client must have a valid certificate
verified by the server.

LDAP-enabled InfoPrint Select for macOS authentication methods

Simple

For Simple authentication, the login name, in the form of the retrieved DN, is sent with the password in
clear text to the LDAP server.

Digest

This method requires a Digest plugin installed on the LDAP server with its own user database. The LDAP
server internally forwards authentication credentials to the Digest plugin (SASLDB). There is no search
mechanism for DN in this case.

Configuring LDAP-enabled InfoPrint Select client settings on macOS

For the LDAP-enabled InfoPrint macOS client to submit authenticated jobs to InfoPrint Manager
properly, you must configure your LDAP-enabled InfoPrint Select client settings. The LDAP settings
window lets you configure the credentials, connection, authentication, and search settings. From the
LDAP login window, click Settings to open the LDAP settings window. The Settings button is enabled
only if you use the root account to log in.

Credentials

Login
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The login information can be an e-mail address, an employee number, a badge serial number, a
common name, a Lotus Notes canonical name, a user ID, a uid, or other data information. It is used
to search the LDAP directories for the specific globally unique DN anonymously. The search on the
LDAP directories is always done using the DN Search Options settings. The search is performed only
for the Simple authentication method.

The login information can be sent to the destination accounting log by adding the authenticated-
login attribute to the list of values used by the additional-accounting-log-attributes attribute.

Password
Enter your password.

Upper/Lower case
Specifies the letter case of the login attribute. You can select one of these values: Case Sensitive,
Convert to Lower Case, or Convert to Upper Case. The default value is Case Sensitive.

Disable Save Credentials
Does not allow users to save credentials. The login and password from the LDAP settings window
are not stored.

The credentials, if available, are copied from/to the InfoPrint Select LDAP login window.

LDAP Server

Host
Enter the host name or IP address of the LDAP server.

Port
Enter the port number that is used for communication. The default port number is 389. The default
SSL port number is 636.

Authentication

Method
Select the method of authentication: Simple or Digest.

SASL Realm
Enter the name of the SASL Realm. This option is available when you use the Digest method.

Encryption
Enter an encryption method for the LDAP Server. To use the TLS or the SSL protocols, select the Use
Start TLS Extension or the Use SSL Encryption option.

DN Search Options

The Distinguished Name (DN) Search Options is only used for the Simple authentication method.

Search Base
The search base entry is the location in a directory from which the LDAP search begins.

Search Attribute
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The search attribute is used for the search of the DN. The DN is used for logging on to the InfoPrint
Select LDAP server.

Example:

• If you want to identify the DN using the intranet e-mail address (for example: john_
smith@example.com) as the LDAP login, the search attribute must be mail. The DN Search
Options are configurable as needed and used only for simple authentication method.

– If you enter you login as your common name (for example: “John Smith”), the search
attribute must be set to cn.

– Other various attributes for the DN search, like: e-mail address, employee number, badge
serial number, common name, Lotus Notes canonical name, user ID, uid, and DN.

Depending on the custom configuration, the specific login attribute is used for the DN search. This
attribute becomes the value of the authenticated-login job attribute in the accounting log.

Click Test Authentication if you want to test the connection to the LDAP server. If the connection is
successful, a confirmation message is displayed: Successfully connected to the LDAP server.

If one of the LDAP settings is not properly configured, you receive one error message for each case:

• “Invalid user login credentials. Check your login credentials.” You see this
message when the authentication bind fails because the credentials are incorrect.

• “Incorrect LDAP host, port, or SSL/TLS settings. Check your host, port, and SSL/
TLS settings.” You see this message when the authentication bind fails because InfoPrint
Select LDAP client cannot contact the LDAP server.

• “Invalid authentication method. Contact your system administrator.” You see this
message when the LDAP server does not recognize the authentication method that the InfoPrint
Select LDAP client used.

• “LDAP login not found on server. Check your credentials or search options.” You
see this message when InfoPrint Select LDAP does not find the user in the search directory.

You do not see an error message when the LDAP server does not allow anonymous authentication.
In this case, the initial bind fails because no anonymous binding is allowed, and InfoPrint Select
LDAP client authenticates directly with the login credentials that you entered.

Anonymous Login
Enable/ Disable anonymous login to the LDAP server.

Bind DN
If the LDAP server does not allow anonymous queries, enter the Distinguished Name (DN) of the
account.

Password
The password for the Bind DN account.

Using InfoPrint Select for macOS



2

164

The Bind DN login and password information are stored in the registry. The password is stored in
encrypted form. By default, the search of the DN is done by the anonymous binding to the LDAP server
and it is based on the Search Base, and the Search Attribute values. The DN that results from the
search is used for the authentication together with the specified password. If Anonymous Search is not
enabled on your InfoPrint Select LDAP server, InfoPrint select attempts to log in with the Bind DN and
password and searches for the specified Login. If the authentication fails, an error occurs. If the search
succeeds, InfoPrint Select attempts to log in with the DN associated with the Login. If the search fails,
InfoPrint Select attempts to log in with the Login and password.

Creating InfoPrint Select printers on macOS

There are two methods to create InfoPrint Select printers on macOS:

1. Add a printer using the CUPS (Common Unix Printing System) web interface:

1) Enable first the CUPS web interface.

1. Open the Terminal in the /Applications/Utilities/ folder

2. Run this command:

cupsctl WebInterface=yesb

By default, the CUPS web interface is disabled.

2) Open a web browser.

3) To access the CUPS web interface, enter http://localhost:631 in the browser address bar.

4) Enter CUPS administrator credentials and on the Administration tab, click Add Printer.

5) From the Other Network Printers section, select InfoPrint Select and click Continue.

6) Set the correct DEVICE_URI in the Connection field and click Continue, where DEVICE_URI is:

selpms://<server_hostname>[:<port>]/<destination>
Example:

selpms://server.company.domain:6874/IP1107EX

If no port is specified, the default port number is 6874.

7) Set the Name, Description and Location values for the CUPS printer and click Continue.

8) Select the printer manufacturer from the drop-down list and click Continue. Choose the printer
model and click Add Printer.

9) Set the default options for the printer and click Set Default Options.

2. Add a printer using /usr/sbin/lpadmin command:

1) Open a command terminal.

2) Execute the following command:
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/usr/sbin/lpadmin -p <cups_printer_name> -v"<DEVICE_URI>"
-m <printer_model.ppd> -D <printer_description> -E

Example:

/usr/sbin/lpadmin -p myCupsPrinter
-v"selpms://server.company.domain:6874/IP1107EX"
-m InfoPrint-Pro_1107EX.ppd -D "InfoPrint Select" -E

Printing from applications

These to be considered when printing from applications with InfoPrint Select:

Printing Considerations
InfoPrint Select works with the print facility of each application, so printing from every program is a
little different. A typical application might allow you to specify a printer other than the default, the
number of copies, or a range of pages.

If the printer selected (or your default printer) is an InfoPrint Manager Select printer, your job is sent
to the InfoPrint server.

Checking printer status

To check the status of a printer, go to the Spotlight icon, search for ipmprinters, and open the
application. A list of all the InfoPrint Manager destinations used by the InfoPrint Select printers is
displayed.

The InfoPrint Manager Printers dialog displays information about all the InfoPrint Manager destinations
used by the InfoPrint Select printers, including the names of all the printers assigned to the logical
printer, the printer type (logical or physical), whether the printer is enabled or disabled, current status
(for example, printing or needs attention), problem messages (optional), SNMP information, and
backup printers. The default is to not display problem messages. To display problem messages, go to
the View Menu pull-down and select Show problem messages. Note that problem messages might
not appear in your language.

Depending on the CUPS printer configuration, the same InfoPrint Manager destination can be displayed
multiple times.

The Enabled and Status columns reflect the current state of actual and logical destinations that could
be used to process the job. If there is a backup printer defined for your printer, it will be listed in the
Backup Printer column. A backup printer is a backup actual destination. To add a backup actual
destination, your administrator can set the backup-destinations attribute for the printer that you want
to backup. See the InfoPrint Manager Reference for more information.

Viewing and canceling jobs

You have the ability to query jobs that you have submitted. Select retains the job information and
displays your jobs in the InfoPrint Manager Jobs dialog. To check the status of a print job that you
have submitted for printing, go to the Spotlight icon, search for ipmjobs, and open the application. A
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list of jobs is displayed. If you want to see just the jobs submitted to a specific printer, go to the View
menu bar pull-down, select Printer Selection, and choose a printer.

The InfoPrint Manager Jobs dialog displays a list of all the jobs you have submitted to print. The most
recently submitted job is at the top of the list. For each job, the list includes the job name, the date and
time it was submitted, its global ID, the page count, the job originator, and the LDAP user.

The default is to list only the jobs that you have submitted. If you want all jobs listed, go to the View
menu bar pull-down and select Show all users jobs.

You can also check the properties of a specific job. Click a job to select it, then select Job Properties
from the Job menu bar pull-down or click the Job Properties toolbar button. Information about the
selected job is shown on the six tabs on the dialog. The fields on the Job Properties dialog are not
editable.

Job Properties dialog

The Job Properties dialog opens when you click Properties on the toolbar or you select Properties
from the Job menu bar pull-down. You can display information about a selected job by selecting one of
the tabs on the dialog. The fields on this dialog are not editable.

Summary

The Summary page displays overall job settings for the print job. These values are not editable.

Job name
Indicates the name of the job. The job name is assigned on the Job Settings dialog.

State
Indicates the state of the job. These job states are possible:

Canceled The job has been canceled.

Held The job is being held in the queue.

Paused The job has been paused.

Pending The job is waiting in the queue to be printed.

Pre-processing The job is being created.

Processing The job has been scheduled to print on a physical printer.

Retained The job has already printed or was removed from the queue and has a non-
zero retention period.

Terminating The job has been canceled and is in the process of terminating.

Unknown The state is not known.

Reason for job state
Indicates the reasons that this job is in the held, terminating, or retained state. If this field is blank,
this job is not in one of these states.
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Position in queue
Indicates the number of jobs in the queue before this job.

Number of pages
Indicates the number of pages in the job.

Originator
Displays an originator name if it was specified in the job-originator attribute. This name can appear
on the start sheet printed with your jobs. If an attribute was not specified, the field will be blank.

Authenticated login
Specifies the LDAP user ID if the job is LDAP authenticated.

Processing

The Processing page displays values for processing the print job. These values are not editable.

Copies
Indicates the number of job copies that have been selected for printing.

Retention period
Displays the period of time following job completion, in hours and minutes, that this job is retained
before being discarded. After this job completes, it is retained until this time limit expires or until the
Discard Time limit expires.

Progress

The Progress page displays information about the progress of the print job. These values are not
editable.

Submission time
Indicates the time at which this job was added to the queue.

Submission complete
Indicates whether information regarding the documents in this job have been received by the server
from the client. The value is either true or false.

Started printing time
Indicates the time that this job was sent to the printer.

Processing time
Indicates the amount of time (in hours and minutes) that this job has been at the printer device. If
printing has completed, this field displays the total amount of time used to print this job.

Copies complete
Indicates the number of copies that have completed printing. If this value is blank, the job might not
have started to print or this information is not available to Select.

Completion time
Indicates the time when this job completed printing.
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Modification time
Indicates the date and time that the job was last modified. It can indicate that an administrator has
performed some action on your job after you submitted it.

Name of last modifier
Indicates the name of the person or the name of the application that most recently modified the job.
If a person submitted or modified the job, the value is the login ID for that user.

Scheduling

The Scheduling page displays the settings for print job scheduling. These values are not editable.

Print After
Indicates the date or time when jobs submitted to this printer will begin to be scheduled.

Discard After
Indicates the date or time when jobs submitted to this printer will be deleted, whether they have
printed.

Job batch
Indicates the value for the job-batch attribute if one was specified.

Priority
Indicates the scheduling priority of this job. A print job can have a priority of 1-100, where 100 is
the highest priority. General users can set a priority of up to 50; administrators can set a priority of
up to 100.

Status

The Status page displays information about print job status. These values are not editable.

Queue assigned
Indicates the name of the queue where this job is located. If this field is blank, the job is not currently
residing in a queue because it is in the retained or timed-out state.

Printers used
Shows a list of the physical printers used to print this job.

Previous job state
Indicates the previous state of the job.

Owner
Indicates the value of the job-owner attribute. If you did not specify a value for this attribute when
you submitted the job, this field displays the user ID and address of the person who submitted the
job, as determined by Select.

Default job
If you specified the initial-value-job attribute with your job to control job attributes and values, this
field displays the value you specified for that attribute.

Printer's default job
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Indicates the name of the initial value job designated by the logical printer to provide default job
attribute values for this job. If you do not specify an initial value job with the job, or if the specified
initial value job does not include a value for the attribute, Select uses the attribute value from the
printer initial value job. If there is no such value, Select uses the system default.

Document summary

The Document summary page displays document settings for the print job. These values are not
editable.

Document format
Indicates the format of the document.

Sides
Indicates the Sides setting for the print job. Possible values are: 1, 2, or use server default.

Plex
Indicates how the output images for this job are placed on the media by the printer. Possible values
are: simplex, duplex, and use server default.

Orientation
Indicates the way job contents will be placed on the output media. Possible values are:

default The data_stream and Select defaults determine the orientation.

portrait Jobs will be printed without additional rotation.

landscape Jobs will be rotated 90 degrees when they are printed.

reverse-portrait Jobs will be rotated 180 degrees when they are printed.

reverse-landscape Jobs will be rotated 270 degrees when they are printed.

Default medium
Indicates the medium on which the documents in this job are printed if a medium is not specified by
other methods. The medium can be specified by document contents, other job attributes or printer
attributes.

Other options
If you specified attributes to directly pass flags and parameters to the printer device, this field
displays the information you specified.

Printer's default document
Indicates the name of the initial value document designated by the logical printer to provide default
document attribute values for this job. A default attribute value from this initial value document is
used if the attribute value was not specified when the job was submitted or provided by an initial
value document designated by a print file document in the job.
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Using the Job Settings dialog

You can change several settings related to the print job by using the Job Settings dialog. The changes
you make in the Job Settings dialog affect only the current job. The Job Settings dialog is disabled by
default. To activate the Jobs Settings dialog, go to /opt/Ricoh/InfoPrint-Manager/bin and run in
Spotlight the activateipmjobsettings script. The tabs/pages associated with this dialog are:

General Attributes page

Use this page to choose a job name and display the name and address of the job owner. You can set
these values:

Job name
Indicates the name of the job you are submitting. By default, the application from which you are
submitting the job specifies the job name. To specify a different name for the job, enter the new
name in the field. Depending on the Select configuration, this name can print on the start sheet for
the job.

Owner
Indicates the user name and address of the job sender. This field cannot be changed.

To submit a confidential job, select the Confidential job checkbox. If you select the Confidential job
checkbox, the document cannot be viewed in the JobViewer.

On this page you can check the Do not display this dialog again checkbox to disable this dialog. If
you check this box, the dialog does not display when you send print jobs. The Job Settings dialog is
disabled by default. If you decide that you want to enable this dialog, go to /opt/Ricoh/InfoPrint-
Manager/bin and run in Spotlight the activateipmjobsettings script.

Scheduling Attributes

You can use this page to control when your print job is printed. You can set these values:

Print After
Set the date, time or partial time when jobs submitted to this printer will begin to be scheduled. To fill
in the desired date and time:

1. Click in the Print after checkbox to place a check in the box.

2. Select the unit you want to change (year, month, day, hour minute) in the Change pull-down
menu on the right.

3. Use the + and - buttons to adjust the desired Print after time.

Discard After
Set the date, time or partial time when jobs submitted to this printer will be deleted, whether they
have printed. To fill in the desired date and time:

1. Click in the Discard after checkbox to place a check in the box.

2. Select the unit you want to change (year, month, day, hour minute) in the Change pull-down
menu on the right.

3. Use the + and - buttons to adjust the desired Discard after time.
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Retention Period
Set the amount of time that the job will be retained at the server before it is deleted. To fill in the
desired date and time:

1. Select the unit you want to change (hours, 10-minutes, minutes) in the Change pull-down menu
on the right.

2. Use the + and - buttons to adjust the desired retention period.

Priority
Type the desired priority value into the field. The Priority field displays a number representing the
scheduling priority of this job. A print job can have a priority of 1-100, where 100 is the highest
priority. General users can set a priority of up to 50; administrators can set a priority of up to 100.

Hold
When you check the Hold checkbox, the print job is held on the server, and the job-hold attribute
is set to True or Yes.

Messages page

You can use this page to create a job comment or a message for the print operator. You can set these
values:

Job comment
Use this field to record any comments about your print job.

Message to operator
Use this field to include a message that Select sends to an operator when it adds your job to the
queue. You might want to include information that describes any special handling that your job
requires.

Other Attributes page

Use this page to choose additional job and document attributes for a print job. Attributes are used for
advanced printing and production printing to specify how and when jobs submitted to this printer will
print.

Attributes File
Type the name of the file containing additional job and document attributes for the print job. If you
click Browse..., the Open Dialog is displayed and you can search for an attributes file. You can use
one of the sample attributes files as a guide in creating your own customized set of attributes.

Attributes
You can type additional attributes and their values in this field, in the format attribute = value (for
example, job-priority = 25)

Printer options
Use this field to directly pass flags and options to the printer device. Select appends the information
you supply to the printer-command attribute for the printer. If the printer device is controlled by the
BSD device support system, Select appends the information you supply to the printer-command
attribute for the printer.

Checkboxes
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Suppress job submission error messages: Check this box to suppress job submission error
messages to allow unattended operation.

Re-spool jobs if submission fails: Check this box to automatically re-spool failed job submissions.
Re-spooled jobs are placed in the print queue in a hold state.

Example attribute file

printer-models-requested = InfoPrint4000
printer-locations-requested = 'Building 025'
job-priority = 25
job-retention-period = 01:30

1. Before specifying any InfoPrint attributes, for specific information and syntax rules, see RICOH
InfoPrint Manager: Reference.

2. The InfoPrint Manager Select client Other tab does not contain a syntax checker, so verify that the
format of attributes, specified in either an attributes file or as individual attributes, are in the correct
format. If there are syntax errors, you will receive the same messages provided for syntax errors on
commands sent from a command line.

3. If you specify the same InfoPrint attribute from different locations with different values, InfoPrint
Manager determines what values to send with the job using the following hierarchy:

1) Values specified in the Attributes field on the Other tab.

2) Values specified in the Attributes file field on the Other tab.

3) Any values specified on either the General, Scheduling, orMessages tab.

Working with InfoPrint Select Notifications

By default when you submit a job using InfoPrint Select, a notification profile is sent with the job. If you
have the InfoPrint Manager Message window running when you submit a print job using InfoPrint
Select, notifications are requested. If the InfoPrint Manager Message window is not running,
notifications are not requested.

To change the port SMTP sends notifications to, go to the Settings menu and select Configure
notification port. You see the InfoPrint Manager Message port dialog. In the Notification port field,
type in the number of the new port you want SMTP to use for notifications. The default is 5157.

To activate the InfoPrint Manager Message window, go to the Spotlight icon, search for
ipmnotification, and open the application.

To turn off the InfoPrint Manager Message window, click X in the upper right corner of the window and
then click OK on the warning message.

Configuration file

The InfoPrint Manager Select for macOS creates a configuration file for each user ID to store that user's
settings. The file is generated the first time the Select is invoked by each user if it does not already exist.
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The file is saved in the home folder under oopptt//RRiiccoohh//IInnffooPPrriinntt--MMaannaaggeerr//ccoonnffiigg//<<uusseerr>>__
sseelleecctt..ccoonnff.

The configuration file

[User Preferences]
Notification Port=5157
Use default .att file=1
Default .att file=
[IPM Printers]
Show problem messages=0
[Submission Window]
Suppress=1
[Job Recovery]
Pause jobs if submission fails=0
Suppress submission errors=1

The key settings are:

• Notification Port=5157 - Must be set to a unique port number if Notifications are being used. If
Select Notifications are not being used, it does not need to be changed.

• Suppress=1 - Suppresses the Job Settings Dialog.

• Suppress submission errors=1 - Suppresses error messages found during submission.

• Pause jobs if submission fails=0 - Optionally can set this to 1 to cause failed jobs to be retained for
re-submission by the administrator.

Commands you can use with InfoPrint Select for macOS

Typically, InfoPrint Select is used to let users print to InfoPrint Manager destinations from existing macOS
applications. In addition, you can use several InfoPrint commands that can be issued from the
Command Line on the client system.

Information about security and how users can be authorized to InfoPrint Manager is found in the topic
“Managing Security” in the RICOH InfoPrint Manager for Windows: Procedures guide.

InfoPrint Manager lets authorized users (normally all users) use these InfoPrint commands:

pdls
Lists selected attribute values for a job, destination, or other InfoPrint object

pdpr
Submits a job to a logical or actual destination. If LDAP job authentication is enabled, you must
authenticate using your LDAP credentials before submission.

pdq
Queries the status of selected jobs, of all jobs submitted to a logical destination, or of all jobs
assigned to an actual destination

InfoPrint Manager lets authorized users (the job owner is usually authorized) use these InfoPrint
commands:

pdmod
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Modifies the attributes of submitted jobs or of the documents in them

pdrm
Deletes jobs

InfoPrint Manager allows only authorized users to use these InfoPrint commands:

pdaccount
Collects summary accounting information for a specified time period in a comma delimited format
about actual destinations on one or more servers. This information can be filed and imported into a
spread sheet to calculate the cost of consumables, the usage rate of printers, the cost for each user,
and so forth.

pdcreate
Creates logical destinations, queues, actual destinations, default jobs, default documents, media,
auxiliary sheets, and resource contexts.

pdclean
Removes all jobs from a server, logical destination, queue, or actual destination.

pddelete
Deletes servers, logical destinations, queues, actual destinations, default jobs, default documents,
media, auxiliary sheets, resource contexts, and jobs.

pddisable
Prevents destinations from accepting jobs and logs from logging.

pdenable
Enables destinations to accept jobs and logs to log.

pdpause
Pauses a job, actual destination, queue, or all the queues and actual destinations in a server.

pdpromote
Advances a job to the head of the queue.

pdreorder
Reassigns a job to an actual destination or to the unassigned jobs area in the same server or in
another server, and lets you schedule it immediately before or after another job.

pdresubmit
Resubmits a job, all the jobs submitted to a logical destination, or all the jobs in a queue to another
logical destination.

pdresume
Enables paused objects to resume operation.

pdset
Sets or changes the values of attributes describing InfoPrint objects.

pdshutdown
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Stops servers or actual destinations.

pdspace
Backspaces or forward spaces a PSF physical printer.

pddeviceop
Perform device operation on device associated with specified actual destination.

For more information about InfoPrint commands and attributes, see the RICOH InfoPrint Manager:
Reference .

Filtering destinations

To find a destination near you that can print two-sided PostScript jobs, enter:
pdls -c destination -f "destination-realization==actual

&& document-format-supported==postscript && sides-supported==2"
-r "destination-location" \*:

The -f flag specifies that you want to either filter on or list only actual destinations that support
PostScript format and two-sided printing. The -r flag specifies that you want to request where the actual
destinations reside. The asterisk means that you want to check every server. The blank after the colon
means that you want to check every destination in every server. The backslash prevents the shell from
interpreting the asterisk as a special character.

InfoPrint returns information similar to this:
caxton: destination-location = 3rd floor E
elzevir: destination-location =
morris: destination-location = 1st floor W

You decide to print your job on morris. To determine a logical destination that routes jobs to morris,
enter:

pdls -c destination -f "destination-associated-destinations==morris" \*:

Querying server status

To query the status of the InfoPrint server, enter:

pdls -c server

Querying device status

To query the status of all printers on the InfoPrint server whose hostname is pauper, enter:

pdls -c printer pauper
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Querying a print job

To submit the file myjob to the logical destination london, requesting two-sided printing on the actual
destination morris, enter:

pdpr -d london -x "destination-name-requested=morris sides=2" myjob

Submitting a print job

To submit the file newjob to the logical destination boston , requesting single-sided printing on the
actual destination printer1, enter:

pdpr -d boston -x "destination-name-requested=printer1 sides=1" newjob

Querying jobs

To list the jobs associated with logical destination ld1 on the server newyork, showing detailed
information (-r verbose) and not filtering for particular criteria, such as the job submitter (-F), enter:

pdq -p newyork:ld1 -r verbose -F

Modifying the job name

To change the job name attribute of one of the jobs that was listed in Querying jobs, p. 176, enter:

pdmod -x "job-name=NewJobName" newyork:job_ID

Removing a job

To remove one of the jobs that was listed in Querying jobs, p. 176, enter:

pdrm newyork:job_ID

Using InfoPrint Select for MacOS with Anyplace printing

If you use InfoPrint Select for MacOS and want to use specific tray, paper, or finishing information with
Anyplace printing, you must install the InfoPrint Manager PDF Driver provided on the RICOH InfoPrint
Manager: Common Clients media.

To install the InfoPrint Manager PDF Driver:

1. Log in to the Macintosh system.

2. Copy The InfoPrint Manager PDF Driver from the install media to the local system.

3. Follow the instructions provided in the installer to finish the installation.

4. Follow the instructions from Creating InfoPrint Select printers on macOS, p. 164 and InfoPrint
Manager PDF ppd to add an InfoPrint Select printer.
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WWiinnddoowwss ggaatteewwaayy pprriinntteerr
A Windows gateway printer is a Windows shared printer that you create on your InfoPrint Manager
server system. This allows users anywhere in the network to submit print jobs through InfoPrint Manager.
Users must follow the instructions in Adding a Windows gateway printer to a workstation, p. 177 to add
the Windows gateway printer to their desktops. Use the Management Console to create and administer
a Windows gateway printer. The Management Console help includes instructions.

When InfoPrint Manager is uninstalled, all Windows Gateway printers are deleted. Therefore, you must
have your users manually delete the Windows Gateway printer from their desktops after the uninstall.

Adding a Windows gateway printer to a workstation

To add a Windows gateway printer to a workstation, follow these steps:

1. Locate the share name of the Windows gateway printer.

2. Follow the standard procedure for adding a network printer to your desktop. This procedure
depends on the operating system that you use. For example, on Windows systems, use the Add
Printer Wizard to create a printer that will be managed by network print server. When you are
prompted for the name of the printer to connect to, enter the share name of the Windows gateway
printer.

3. Once the connection to the Windows gateway printer is created, you can print to it just as you
would print to any other printer.

1. This procedure assumes that you have already created the Windows gateway printer on the
InfoPrint Manager server system.

2. When the InfoPrint Manager server is uninstalled, any Windows gateway printer that exists on the
server is deleted. However, connections to those Windows gateway printers that have been added
to workstations are still present; they are still displayed in the Printers window, and you can still try to
print to them from applications. Because the Windows gateway printer on the InfoPrint Manager
server no longer exists, those print jobs will fail. If you try to print to one of these Windows gateway
printer, you will get an application-dependent message that does not identify this problem. To
resolve this problem, delete the Windows gateway printer from your desktop and create a new one
once your print system administrator has created a new one.

IIPPPP ggaatteewwaayy pprriinntteerr
InfoPrint Manager provides an Internet Printing Protocol (IPP) gateway. The IPP gateway allows users
anywhere in the network who have IPP client software installed to submit print jobs through InfoPrint
Manager, even to printers that are not IPP-enabled. Users must follow the instructions provided with the
IPP client to add a printer to their desktops. Use the Management Console to enable the IPP gateway.

An Internet Printing Protocol (IPP) gateway printer is a printer that you create on a client
workstation using IPP client software. Users submit print jobs to that printer, and they are sent to InfoPrint
Manager through the InfoPrint IPP gateway. The IPP gateway can then send the job on to any InfoPrint
printer, even those that are not IPP-enabled.
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Adding an IPP gateway printer to a workstation

Instruct your end users to follow the steps below to add a printer that uses the IPP gateway to their
desktops. This procedure assumes that IPP client software is installed on the workstation. If the IPP client
software is not installed, the Printer Working Group (the organization that is leading the development of
IPP) provides a list of IPP client software that you can use to find an appropriate client at http://www.
pwg.org/ipp/.

1. Locate the address of the printer that you want to print to.

2. Follow the instructions provided with your IPP client software for adding a printer to your desktop.

After you have added the printer to your desktop, you can print to it just as you would print to any other
printer.

UUssiinngg tthhee IInnffooPPrriinntt MMaannaaggeerr AAIIXX cclliieenntt
The InfoPrint Manager AIX client is installed on all InfoPrint Manager AIX servers with the InfoPrint
Manager for AIX Base Server. Do not install InfoPrint Manager AIX client on a system where you
already installed InfoPrint Manager for AIX server. To install InfoPrint AIX client on any AIX servers that
do not have InfoPrint Manager for AIX, you can use either the InfoPrint Manager: Common Clients DVD-
ROM, LCD4–5642 or the InfoPrint Manager for AIX Base Server DVD-ROM, LCD4–5654. This client can
be used to send commands to InfoPrint Manager for AIX or Windows servers. The InfoPrint AIX client
supports files greater than 2 GB in size.

The InfoPrint AIX client lets you enter InfoPrint commands on the AIX command line. It also lets you enter
enq, lp, lpr, and qprt commands. It has no graphical user interface.

If you are using the AIX client in a PAM/SSO environment, the LDAP user taken from the LDAP(PAM)/
Active Directory system authentication session is used for the InfoPrint Manager user-related attributes.

For the latest information about installing the InfoPrint AIX client, see the installation procedures in either
InfoPrint Manager for AIX or InfoPrint Manager for Windows, both available from the RICOH Software
Information Center at https://help.ricohsoftware.com/swinfocenter.
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Installing the InfoPrint Manager AIX client

The InfoPrint Manager AIX client and the InfoPrint Manager server are available in these languages:

• English
• French
• German
• Italian
• Japanese
• Spanish
You should associate the AIX client with an InfoPrint Manager server running in your language.

To install the InfoPrint Manager AIX client on an AIX system where you have not installed the server:

1. Log onto AIX as root.

2. Insert the InfoPrint Manager: Common Clients DVD-ROM, LCD4-5642, into the drive.

3. If this is the first time you are installing software on this AIX system, create the /cdrom file system.

1) Start the System Management Interface Tool (SMIT).

• To start the AIX windows version of SMIT, enter this command:

smit cdrfs

• To start the ASCII version of SMIT, enter this command:

smitty cdrfs

The DVDROM File Systems panel is displayed.

SMIT DVDROM File Systems panel

DVDROM File Systems
Move cursor to desired item and press Enter.
Add a DVDROM File System
Change / Show Characteristics of a DVDROM File System
Remove a DVDROM File System

1=Help F2=Refresh F3=Cancel F8=Image
F9=Shell F10=Exit Enter=Do

2) Select Add a DVDROM File System.

SMIT Add a DVDROM File System panel

Add a DVDROM File System
Type or select values in entry fields.
Press Enter AFTER making all desired changes.

^Entry Fields|
* DEVICE Name +
* MOUNT Point ^|
Mount AUTOMATICALLY at system restart? no +

1=Help F2=Refresh F3=Cancel F4=List
F5=Reset F6=Command F7=Edit F8=Image
F9=Shell F10=Exit Enter=Do
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3) In the DEVICE name field, enter the identifier of your DVD-ROM drive.

4) In the MOUNT POINT field, enter /cdrom.

5) Click OK (AIX and Windows version) or press Enter (ASCII version).

6) Click Cancel (AIX and Windows version) or press F10 (ASCII version) to exit from SMIT.

4. To mount the DVD-ROM, enter:

mount /cdrom

5. Enter this command to install the AIX client:

/cdrom/setup -c -n ServerName
-p PortNumber -P DestinationName -L locale

where:

ServerName

is the name of the host where the InfoPrint Manager server you want to communicate with
(PDHOST) is running.

PortNumber

is the number of the port for the InfoPrint Manager server, usually 6874 (PD_SOCKET).
Remember to select one that is running in your language.

DestinationName

is the default logical destination that the AIX client submits jobs to. The -P
DestinationName flag is optional.

locale

is the locale of the AIX client. The default is en_US (U. S. English). The -L locale flag is
optional.

6. When the command completes processing, you should shutdown and restart your AIX server so that
all changes can take effect.

Commands you can use from the InfoPrint AIX client

InfoPrint Manager lets authorized users (normally all users) use these InfoPrint commands:

pdls
Lists selected attribute values for a job, destination, or other InfoPrint object

pdpr
Submits a job to a logical or actual destination

pdq
Queries the status of selected jobs, of all jobs submitted to a logical destination, or of all jobs
assigned to an actual destination

InfoPrint Manager lets authorized users (the job owner is usually authorized) use these InfoPrint
commands:
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pdmod
Modifies the attributes of submitted jobs or of the documents in them

pdrm
Deletes jobs

InfoPrint Manager allows only authorized users to use these InfoPrint commands:

pdaccount
Collects summary accounting information for a specified time period in a comma delimited format
about actual destinations on one or more servers. This information can be filed and imported into a
spread sheet to calculate the cost of consumables, the usage rate of printers, the cost for each user,
and so forth.

pdcreate
Creates logical destinations, queues, actual destinations, default jobs, default documents, media,
auxiliary sheets, and resource contexts.

pdclean
Removes all jobs from a server, logical destination, queue, or actual destination.

pddelete
Deletes servers, logical destinations, queues, actual destinations, default jobs, default documents,
media, auxiliary sheets, resource contexts, and jobs.

pddeviceop
Performs a device operation on a device associated with a specified actual destination.

pddisable
Prevents destinations from accepting jobs and logs from logging.

pdenable
Enables destinations to accept jobs and logs to log.

pdpause
Pauses a job, actual destination, queue, or all the queues and actual destinations in a server.

pdpromote
Advances a job to the head of the queue.

pdreorder
Reassigns a job to an actual destination or to the unassigned jobs area in the same server or in
another server, and lets you schedule it immediately before or after another job.

pdresubmit
Resubmits a job, all the jobs submitted to a logical destination, or all the jobs in a queue to another
logical destination.

pdresume
Enables paused objects to resume operation.
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pdset
Sets or changes the values of attributes describing InfoPrint objects.

pdshutdown
Stops servers or actual destinations.

pdspace
Backspaces or forward spaces a PSF physical printer.

For more information about InfoPrint commands and attributes, see RICOH InfoPrint Manager: Reference or
the man pages. Command man pages have the same name as the command.

Examples using the InfoPrint AIX client

The RICOH InfoPrint Manager: Reference and the command man pages show several examples of each
command that you can issue from the InfoPrint AIX client. This section contains examples using the
commands to perform some common tasks.

Filtering destinations

To find a destination near you that can print two-sided PostScript jobs, enter:
pdls -c destination -f "destination-realization==actual

&& document-format-supported==postscript && sides-supported==2"
-r "destination-location" \*:

The -f flag specifies that you want to either filter on or list only actual destinations that support
PostScript format and two-sided printing. The -r flag specifies that you want to request where the actual
destinations reside. The asterisk means that you want to check every server. The blank after the colon
means that you want to check every destination in every server. The backslash prevents the shell from
interpreting the asterisk as a special character.

InfoPrint returns information similar to this:
caxton: destination-location = 3rd floor E
elzevir: destination-location =
morris: destination-location = 1st floor W

You decide to print your job on morris. To determine a logical destination that routes jobs to morris,
enter:
pdls -c destination -f

"destination-associated-destinations==morris" \*:

Querying destination attributes

To determine whether morris is ready to receive jobs, enter:

pdls -c destination -r "destination-state" morris
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Submitting a print job

To submit the file myjob to the logical destination london, requesting two-sided printing on the actual
destination morris, enter:

pdpr -d london -x "destination-name-requested=morris sides=2" myjob

Querying jobs

To query all the jobs that you submitted to logical destination london, enter:

pdq -d london

InfoPrint returns information similar to this:

Intervening Dest. Dest.
Job ID Name State Jobs Req. Assigned
--- ---------------- ------ -------- ----------- ------ --------
13 Serv1:1104221000 report printing 0 london caxton
14 Serv1:1104221023 myjob pending 8 london morris

Modifying job attributes

After submitting myjob, you decide that you want to print two copies and that you want to retain it for
one hour after it prints. When you queried your jobs submitted to london, you saw that the local job ID
is 14 and that the job is still pending, so it can still be modified. Enter:

pdmod -n 2 -x "job-retention-period=1:00" 14

Modifying destination attributes

To restrict the Printer3 actual destination so that it does not accept very large jobs, complete these
tasks:

1. Before you can modify the attributes of a destination, you must disable it. Enter:

pddisable Printer3

2. To specify a new maximum job size of 5 MB, enter:

pdset -c destination -x "job-size-range-ready=0:5000000" Printer3

3. To reenable the actual destination, enter:

pdenable Printer3

Shutting down an actual destination

The printer device represented by the actual destination caxton is out of order. To shut down caxton
until the printer device can be repaired and to associate a message with caxton, enter:

pdshutdown -c destination -m "Service called Tuesday at 3PM" caxton
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UUssiinngg tthhee IInnffooPPrriinntt MMaannaaggeerr LLiinnuuxx cclliieenntt
The InfoPrint Manager Linux client enables users of Linux on Intel-based machines to issue InfoPrint
commands over a TCP/IP-connected network to an InfoPrint Manager for AIX or an InfoPrint Manager
for Windows server. Using a UNIX command line or shell script, you can issue a variety of commands
to the InfoPrint server. The Linux client supports files greater than 2 GB in size.

Installing the InfoPrint Manager Linux clients

Before installing the InfoPrint Manager Linux Command Line Client, make sure you have the following
prerequisites installed on your system:

• libc.so.6

• libc.so.6 (GLIBC_2.0)

• libc.so.6 (GLIBC_2.1)

• libc.so.6 (GLIBC_2.1.3)

• libc.so.6 (GLIBC_2.2)

• libgcc_s.so.1

• libgcc_s.so.1 (GCC_3.0)

• libm.so.6

• libstdc++.so.6

• libstdc++.so.6 (CXXABI_1.2)

• libstdc++.so.6 (GLIBCPP_3.2)

To install the InfoPrint Manager: Linux Clients:

1. Log into the Linux system as root.

2. If you are installing from the RICOH InfoPrint Manager: Common Clients DVD-ROM, LCD4-5642:

1) Insert the DVD-ROM into the drive.

2) Mount the file system by typing:

mount /dev/cdrom /media/<mount_point>

3) Type:

cd /media/cdrom/linux

4) Install the Linux Command Line Client package.
Type:

rpm -i ipr-cmd-4.13.m-n.x86_64.rpm

where m and n represent the service update level.

5) If you are upgrading the InfoPrint Manager: Linux Command Line Client from a previous version,
you need to type:

rpm -U ipr-cmd-4.13.m-n.x86_64.rpm
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where m and n represent the service update level.

After the upgrade is complete, you must log off and then log in again.

6) Unmount the mmeeddiiaa//ccddrroomm file system.

7) Remove the DVD-ROM.

3. If you are installing from the Web:

1) Download the Linux Command Line Client package.

2) Install the Linux Command Line Client package.
Type:

rpm -i ipr-cmd-4.13.m-n.x86_64.rpm

where m and n represent the service update level.

4. These environment variables must be set for the InfoPrint Manager: Linux Command Line Client to
work. The install process puts two shell configuration files (ipr-cmd.csh and ipr-cmd.sh) in the
//eettcc//pprrooffiillee..dd directory to set them. Edit these files and provide values for:

PDHOST
The name of the host where the InfoPrint Manager server is located.

PD_SOCKET
The TCP/IP socket number of the port for the InfoPrint Manager server. The default socket is
6874. Use 6874 unless your system has been specifically set up differently or you have more
than one InfoPrint Manager server running on the host.

PDPRINTER (optional)
The default logical destination in the InfoPrint Manager server that you want to use. The
commands use this value if you do not specify a logical destination on the command line.

Users can override these settings with their own settings.

5. Test the system:

1) Log off and log back on to pickup the changes.

2) Issue one of the commands, followed by the -h flag to display the syntax of that command and
verify the installation.
For example:

pdls -h

Uninstalling the InfoPrint Manager Linux client

1. Log in as root.

2. To uninstall the Linux Command Line Client, type: rpm -e ipr-cmd-4.13.m-n, where m and n
represent the service update level.
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Commands you can use from the InfoPrint Linux client

InfoPrint Manager lets authorized users (normally all users) use these InfoPrint commands:

pdls
Lists selected attribute values for a job, destination, or other InfoPrint object

pdpr
Submits a job to a logical or actual destination.

pdq
Queries the status of selected jobs, of all jobs submitted to a logical destination, or of all jobs
assigned to an actual destination

InfoPrint Manager lets authorized users (the job owner is usually authorized) use these InfoPrint
commands:

pdmod
Modifies the attributes of submitted jobs or of the documents in them

pdrm
Deletes jobs

InfoPrint Manager allows only authorized users to use these InfoPrint commands:

pdaccount
Collects summary accounting information for a specified time period in a comma delimited format
about actual destinations on one or more servers. This information can be filed and imported into a
spread sheet to calculate the cost of consumables, the usage rate of printers, the cost for each user,
and so forth.

pdcreate
Creates logical destinations, queues, actual destinations, default jobs, default documents, media,
auxiliary sheets, and resource contexts.

pdclean
Removes all jobs from a server, logical destination, queue, or actual destination.

pddelete
Deletes servers, logical destinations, queues, actual destinations, default jobs, default documents,
media, auxiliary sheets, resource contexts, and jobs.

pddeviceop
Perform device operation on device associated with specified actual destination.

pddisable
Prevents destinations from accepting jobs and logs from logging.

pdenable
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Enables destinations to accept jobs and logs to log.

pdpause
Pauses a job, actual destination, queue, or all the queues and actual destinations in a server.

pdpromote
Advances a job to the head of the queue.

pdreorder
Reassigns a job to an actual destination or to the unassigned jobs area in the same server or in
another server, and lets you schedule it immediately before or after another job.

pdresubmit
Resubmits a job, all the jobs submitted to a logical destination, or all the jobs in a queue to another
logical destination.

pdresume
Enables paused objects to resume operation.

pdset
Sets or changes the values of attributes describing InfoPrint objects.

pdshutdown
Stops servers or actual destinations.

pdspace
Backspaces or forward spaces a PSF physical printer.

For more information about InfoPrint commands and attributes, see RICOH InfoPrint Manager: Reference or
the man pages. Command man pages have the same name as the command.

Examples using the InfoPrint Linux client

The RICOH InfoPrint Manager: Reference contains several examples of each command that you can issue
from the InfoPrint Linux client. This section contains examples using the commands to perform some
common tasks.

Filtering destinations

To find a destination near you that can print two-sided PostScript jobs, enter:

pdls -c destination -f "destination-realization==actual
&& document-format-supported==postscript && sides-supported==2"
-r "destination-location" \*:

The -f flag specifies that you want to either filter on or list only actual destinations that support
PostScript format and two-sided printing. The -r flag specifies that you want to request where the actual
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destinations are located in. The asterisk means that you want to check every server. The blank after the
colon means that you want to check every destination in every server.

InfoPrint returns information similar to this:

caxton: destination-location = 3rd floor E
elzevir: destination-location =
morris: destination-location = 1st floor W

You decide to print your job on morris. To determine a logical destination that routes jobs to morris,
enter:

pdls -c destination -f
"destination-associated-destinations==morris" \*:

Querying destination attributes

To determine whether morris is ready to receive jobs, enter:

pdls -c destination morris

The enabled and destination-state values indicate whether morris is ready to receive jobs.

Submitting a print job

To submit the file myjob to the logical destination london, requesting two-sided printing on the actual
destination morris, enter:

pdpr -d london -x "destination-name-requested=morris sides=2" myjob

Querying jobs

To list all the jobs that you submitted to logical destination london, enter:

pdq -d london

InfoPrint Manager returns information similar to this:

Job
ID Name

Intervening
State

Destination
Jobs

Destination
Requested

Destination
Assigned

13 Ser-
v1:1104221000

printing 0 london caxton

14 Ser-
v1:1104221023

pending 8 london morris

Modifying job attributes

After submitting myjob, you decide that you want to print two copies and that you want to retain it for
one hour after it prints. When you queried the jobs submitted to london, you saw that the local Job ID
is 14 and that the job is still pending, so it can be modified. To change the number of copies to two and
add a retention period of one hour, enter:
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pdmod -n 2 -x “job-retention-period=1:00” 14

Modifying destination attributes

To restrict the Printer3 actual destination so that it does not accept very large jobs, complete these
tasks:

1. Before you can modify the attributes of the Printer3 actual destination, you must disable it by
entering:

pddisable Printer3

2. To specify a new maximum job size of 5 meg for Printer3, enter:

pdset -c destination -x “job-size-range-ready=0:500000” Printer3

3. To reenable the actual destination, enter:

pdenable Printer3

Shutting down an actual destination

The printer device represented by the actual destination caxton is out of order. To shut down caxton
until the printer device can be repaired and to associate a message with caxton, enter:

pdshutdown -c destination -m “Service called Tuesday at 3PM” caxton

UUssiinngg tthhee IInnffooPPrriinntt MMaannaaggeerr mmaaccOOSS cclliieenntt
The InfoPrint Manager macOS client enables users of macOS to issue InfoPrint Manager commands
over a TCP/IP-connected network to an InfoPrint Manager server. Using a UNIX command line or shell
script, you can issue a variety of commands to the InfoPrint Manager server. The macOS client supports
files larger than 2 GB in size.

To install the macOS client on a macOS machine, you can use the RICOH InfoPrint Manager: Common
Clients DVD-ROM, LCD4-5642.

Access to the InfoPrint Manager server and to the InfoPrint Manager commands is controlled on the
system where the server is installed. For information about providing access, see RICOH InfoPrint Manager
for Windows: Procedures .

For the latest information about installing the InfoPrint Manager macOS client, go to the RICOH
Software Information Center at https://help.ricohsoftware.com/swinfocenter.

If you are using the non-LDAP InfoPrint Manager Os X client in a PAM/SSO environment, the LDAP
user taken from the LDAP(PAM)/Active Directory system authentication session is used for the InfoPrint
Manager user-related attributes.

Installing the InfoPrint Manager macOS client

The macOS Command Line Clients and the InfoPrint server are available in these languages:
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• English
• French
• German
• Italian
• Japanese
• Spanish
To use a non-English version of InfoPrint Manager, your AIX system must have installed the file sets for
that language. You should associate the macOS Command Line clients with an InfoPrint server running
in your language.

To install the InfoPrint Manager macOS Command Line clients:

1. Log onto the macOS system as root.

2. Insert the RICOH InfoPrint Manager: Common Clients DVD-ROM, LCD4–5642 into your drive.

3. Copy the installer package for the version of the macOS Command Line Client you want to install to
a temporary location. For example: /tmp.

4. To install the macOS Command Line Client, double-click on the ipr-cmd-4.13.m-n.i586.pkg
package to launch the installer, where m and n represent the service update level.

If you want to install the macOS Command Line Clients in silent mode:

1) Open a command terminal.

2) Execute the following commands:

sudo -S installer -verbose -pkg /tmp/ipr-cmd-4.13.m-n.i586.pkg \
-target

where m and n represent the service update level.

5. Follow the instructions provided in the installer to finish the installation.

6. Remove the RICOH InfoPrint Manager: Common Clients DVD-ROM.

7. Create a shell script in the language of your choice or manually set these environment variables:

PDHOST
The name of the host where the InfoPrint server is located.

PD_SOCKET
The TCP/IP socket number of the port for the InfoPrint server. The default socket is 6874. Use
6874 unless your system has been specifically set up differently, or you have more than one
InfoPrint Manager server running on the host.

PDPRINTER
The default logical destination in the InfoPrint Manager server. The commands will use this value
if you do not specify a logical destination (the -P DestinationName flag) on the command
line.

This example shows a Korn shell script to set the environment variables:

export PDHOST="hostname-of-infoprint-server"
export PD_SOCKET="6874"
export PDPRINTER="name-of-default-logical-destination"

8. Test the system:
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1) Open a command line window.

2) Set the environment variables as directed in step 7, either manually or using a shell script.

3) Issue one of the chosen commands, followed by the -h flag to display the syntax of that
command and verify the installation.
For example:

pdls -h

4) Arrange for all users of the macOS Command Line Clients to set the environment variables as
directed in step 7, whenever they log in. You can use either of these methods:

• Set the environment variables in the default shell configuration file, either individually or by
invoking the shell script.

• Tell each user to set the environment variables in his or her own shell configuration file,
either individually or by invoking the shell script.

To perform a correct installation, use a macOS account with admin rights.

Commands you can use from the InfoPrint macOS client

InfoPrint Manager lets authorized users (normally all users) use these InfoPrint commands:

pdls
Lists selected attribute values for a job, destination, or other InfoPrint object

pdpr
Submits a job to a logical or actual destination.

pdq
Queries the status of selected jobs, of all jobs submitted to a logical destination, or of all jobs
assigned to an actual destination

InfoPrint Manager lets authorized users (the job owner is usually authorized) use these InfoPrint
commands:

pdmod
Modifies the attributes of submitted jobs or of the documents in them

pdrm
Deletes jobs

InfoPrint Manager allows only authorized users to use these InfoPrint commands:

pdaccount
Collects summary accounting information for a specified time period in a comma delimited format
about actual destinations on one or more servers. This information can be filed and imported into a
spread sheet to calculate the cost of consumables, the usage rate of printers, the cost for each user,
and so forth.
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pdcreate
Creates logical destinations, queues, actual destinations, default jobs, default documents, media,
auxiliary sheets, and resource contexts.

pdclean
Removes all jobs from a server, logical destination, queue, or actual destination.

pddelete
Deletes servers, logical destinations, queues, actual destinations, default jobs, default documents,
media, auxiliary sheets, resource contexts, and jobs.

pddeviceop
Perform device operation on device associated with specified actual destination.

pddisable
Prevents destinations from accepting jobs and logs from logging.

pdenable
Enables destinations to accept jobs and logs to log.

pdpause
Pauses a job, actual destination, queue, or all the queues and actual destinations in a server.

pdpromote
Advances a job to the head of the queue.

pdreorder
Reassigns a job to an actual destination or to the unassigned jobs area in the same server or in
another server, and lets you schedule it immediately before or after another job.

pdresubmit
Resubmits a job, all the jobs submitted to a logical destination, or all the jobs in a queue to another
logical destination.

pdresume
Enables paused objects to resume operation.

pdset
Sets or changes the values of attributes describing InfoPrint objects.

pdshutdown
Stops servers or actual destinations.

pdspace
Backspaces or forward spaces a PSF physical printer.

For more information about InfoPrint commands and attributes, see RICOH InfoPrint Manager: Reference or
the man pages. Command man pages have the same name as the command.
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Examples using the InfoPrint Manager macOS client

The RICOH InfoPrint Manager: Reference and the command man pages show several examples of each
command that you can issue from the InfoPrint macOS client. This section contains examples using the
commands to perform some common tasks.

Filtering destinations

To find a destination near you that can print two-sided PostScript jobs, enter:
pdls -c destination -f "destination-realization==actual

&& document-format-supported==postscript && sides-supported==2"
-r "destination-location" \*:

The -f flag specifies that you want to either filter on or list only actual destinations that support
PostScript format and two-sided printing. The -r flag specifies that you want to request where the actual
destinations reside. The asterisk means that you want to check every server. The blank after the colon
means that you want to check every destination in every server. The backslash prevents the shell from
interpreting the asterisk as a special character.

InfoPrint returns information similar to this:
caxton: destination-location = 3rd floor E
elzevir: destination-location =
morris: destination-location = 1st floor W

You decide to print your job on morris. To determine a logical destination that routes jobs to morris,
enter:
pdls -c destination -f

"destination-associated-destinations==morris" \*:

Querying server status

To query the status of the InfoPrint server, enter:

pdls -c server

Querying device status

To query the status of all printers on the InfoPrint server whose hostname is pauper, enter:

pdls -c printer pauper

Querying a print job

To submit the file myjob to the logical destination london, requesting two-sided printing on the actual
destination morris, enter:

pdpr -d london -x "destination-name-requested=morris sides=2" myjob
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Submitting a print job

To submit the file newjob to the logical destination boston , requesting single-sided printing on the
actual destination printer1, enter:

pdpr -d boston -x "destination-name-requested=printer1 sides=1"
newjob

Querying jobs

To list the jobs associated with logical destination ld1 on the server newyork, showing detailed
information (-r verbose) and not filtering for particular criteria, such as the job submitter (-F), enter:

pdq -p newyork:ld1 -r verbose -F

Modifying the job name

To change the job name attribute of one of the jobs that was listed in Querying jobs, p. 194, enter:

pdmod -x "job-name=NewJobName" newyork:job_ID

Removing a job

To remove one of the jobs that was listed in Querying jobs, p. 194, enter:

pdrm newyork:job_ID

UUssiinngg tthhee IInnffooPPrriinntt SSuubbmmiitt EExxpprreessss CClliieenntt

Setting up InfoPrint Submit Express

Make sure the InfoPrint Submit Express being set up is at the same level as the InfoPrint Manager server.

For more details about macOS and Windows requirements, see RICOH InfoPrint Manager for Windows:
Planning Guide, RICOH InfoPrint Manager for Linux: Planning Guide, and RICOH InfoPrint Manager for AIX:
Planning Guide.

Installing InfoPrint Submit Express from the InfoPrint Manager Common Client
DVD-ROM

This section contains information that you need to install InfoPrint Submit Express.

Installing InfoPrint Submit Express on a Windows system

1. Insert the RICOH InfoPrint Manager: Common Clients DVD-ROM into the drive.
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If your install program does not start automatically or if your browser stops responding:

1. Select Start ->Run.

2. Enter D:\setup.html, where D is your DVD-ROM drive.

3. Click OK.

2. Follow the instruction on the screen.

3. Click Install Submit Express to start the install program.

4. Follow the instructions as directed from the installer. The default install directory is c:\Program
Files\RICOH\Infoprint Submit Express.

Installing a service update for InfoPrint Submit Express

To install a service update, insert the service update DVD-ROM into the drive. The install program starts
automatically.

1. Click to install Submit Express.

2. Follow the instructions as directed from the installer.

Installing InfoPrint Submit Express on a macOS system

This section contains information that you need to install InfoPrint Submit Express.

To install the InfoPrint Submit Express clients:

1. Log in to the macOS system.

2. Insert the RICOH InfoPrint Manager: Common Clients DVD-ROM into your drive.

3. Copy the installer package for the version of the InfoPrint Submit Express client you want to install to
a temporary location. For example: /tmp.

4. To install the InfoPrint Submit Express client, double-click the ipr-submit-express-4.13.0.0.
x86_64.pkg package to launch the installer.

5. Follow the instructions provided in the installer to finish the installation.

6. Remove the DVD-ROM.

If you cannot install InfoPrint Submit Express on your macOS system, copy the directory containing the
InfoPrint Submit Express feature directory from the Common Client DVD-ROM to your hard drive and
install the program from there.

Installing associated software and printer drivers

If you wish to create PostScript jobs for InfoPrint Manager, you should install printer drivers and
PostScript Printer Description files (PPDs) on each of the systems that you use for this purpose. Printer
drivers are needed on the workstations that are used to submit jobs to the InfoPrint Manager server to
make sure that the correct driver is used. In addition, if you have users who are producing PostScript
files on their workstations that they want printed on the InfoPrint Manager printers, you need to load
InfoPrint Manager printer drivers onto these workstations.
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To install a PostScript driver, go to the Adobe Systems website and download the correct level of
PostScript driver for your system and PostScript printing needs.

Setting up shared file support

InfoPrint Manager uses a directory or folder called ipdata for sharing files with Submit Express. (With
InfoPrint Manager for Windows, this folder is created automatically.)

The name ipdata comes from InfoPrint or IP and data for the files it will contain. You use ipdata to
provide a two-way connection between the Submit client machine from which the job tickets have been
submitted and the InfoPrint Manager server that sends them to the printer. Sharing files can save time
and money. For example, you can have an InfoPrint Manager server RIP (raster image process) a file
and save the results in ipdata. You can then reprint the ripped file instead of re-ripping the job again.

Working with ipdata is slightly different on the InfoPrint Manager Server on an AIX system, a Linux
system, and a Windows System:

• With InfoPrint Manager for AIX, see Setting up InfoPrint Manager for AIX to use an ipdata file
system, p. 196 and then see Configuring the InfoPrint Submit Express client for InfoPrint Manager
for AIX, InfoPrint Manager for Linux, and InfoPrint Manager for Windows, p. 199.

• With InfoPrint Manager for Linux, see Setting up InfoPrint Manager for Linux to use an ipdata file
system, p. 197 and then see Configuring the InfoPrint Submit Express client for InfoPrint Manager
for AIX, InfoPrint Manager for Linux, and InfoPrint Manager for Windows, p. 199.

• With InfoPrint Manager for Windows, see Setting up InfoPrint Manager for Windows to use the
ipdata folder, p. 198 and then see Configuring the InfoPrint Submit Express client for InfoPrint
Manager for AIX, InfoPrint Manager for Linux, and InfoPrint Manager for Windows, p. 199.

Setting up InfoPrint Manager for AIX to use an ipdata file system

On an InfoPrint Manager for AIX system, NFS or other file sharing is required between workstations and
the InfoPrint Manager server. If you plan to connect your AIX server to Windows workstations and your
InfoPrint Manager AIX server is running on an AIX supported version, the IBM package Samba for AIX
is required. Samba for AIX supports a NetBIOS connection. To access current information supporting
the Samba for AIX package, go to https://developer.ibm.com/articles/au-aix_samba/.

Samba is incompatible with IBM Fast Connect. Any existing version of Fast Connect must be uninstalled.

Setting up Samba for InfoPrint Manager for AIX

1. First, you need to install Samba for AIX. Samba binaries for AIX are available in the IBM AIX
Expansion pack DVD. Follow the installation instructions available with the Samba for AIX
distribution.

2. Samba has two daemons, nmbd and smbd, that need to be running in order for Samba to work
correctly. These can be started from the command line as follows:

• # nmbd

• # smbd

3. To set these daemons to start automatically during system reboot, add the entries into /etc/
inittab, as follows:
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• mkitab nmb:2:once:/usr/sbin/nmbd

• mkitab smb:2:once:/usr/sbin/smbd

Configuring the InfoPrint Manager for AIX Server to support shared files

If you have installed Samba for AIX and you use Submit Express from Microsoft Windows workstations,
you can configure InfoPrint Manager on your AIX system with user access and a shared directory that
InfoPrint Manager will use for saving processed or rasterized files. Where applicable, this directory is
also used when users preview Postscript files from the InfoPrint Manager Submit application.

To configure:

1. From the dtterm window, type SMIT.

2. Select InfoPrint Printing System.

3. Select InfoPrint Utilities.

4. Now select Configure Samba for InfoPrint Manager for AIX.

5. Select Enable Clients Shared File System.
An animated icon of a running man will raise his arms when the setup is complete. Your AIX system
will now have a shared directory (/ipdata) that some InfoPrint applications use for saving files and
sharing data. An AIX userid called ipuser is created with no password. To set a password for
ipuser, use the SMIT panels to modify the password.

6. Now, you need to configure the Submit client (see Configuring the InfoPrint Submit Express client for
InfoPrint Manager for AIX, InfoPrint Manager for Linux, and InfoPrint Manager for Windows, p.
199).

Setting up InfoPrint Manager for Linux to use an ipdata file system

On an InfoPrint Manager for Linux system, NFS or other file sharing is required between workstations
and the InfoPrint Manager server. If you plan to connect your Linux server to Windows workstations and
your InfoPrint Manager Linux server is running on an Linux supported version, the Samba for Linux is
required. Samba for Linux supports a NetBIOS connection. To access current information supporting the
Samba for Linux package, go to https://www.samba.org/samba/docs/.

Setting up Samba for InfoPrint Manager for Linux

1. First, you need to install Samba for Linux.

• For RedHat Enterprise Linux, run as root: yum install samba

• For Suse Enterprise Linux, run as root: zypper install samba

2. To start samba server, run as root: service smb start

3. To automatically start samba daemon during system reboot, run as root: service smb on

Configuring the InfoPrint Manager for Linux Server to support shared files

If you have installed Samba for Linux and you use Submit Express from Microsoft Windows
workstations, you can configure InfoPrint Manager on your Linux system with user access and a shared
directory that InfoPrint Manager will use for saving processed or rasterized files. Where applicable, this
directory is also used when users preview Postscript files from the InfoPrint Manager Submit application.

To configure:
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1. Start the InfoPrint Manager Management Interface (IPMMI), go to Applications→ InfoPrint
Manager→Management Interface on RedHat Enterprise Linux (RHEL) or Computer→More
Applications→ InfoPrint Manager→Management Interface on SUSE Linux Enterprise Server
(SLES).

2. Click Options.

3. Select Enable Clients Shared File System.

4. Specify the Volume group for /ipdata and the Space for /ipdata (Mbytes).

5. Now, you need to configure the Submit client (see Configuring the InfoPrint Submit Express client for
InfoPrint Manager for AIX, InfoPrint Manager for Linux, and InfoPrint Manager for Windows, p.
199).

Setting up InfoPrint Manager for Windows to use the ipdata folder

To work with ipdata on your InfoPrint Manager Server, you need to determine the best location for
ipdata (see Moving the ipdata folder, p. 198) and then you need to set it up for sharing (see Sharing
the ipdata folder, p. 198). You can leave the ipdata folder in its default location, or you can move it to
another location.

Create a user id for ipuser

1. Navigate to the Control Panel.

2. Click Administrative Tools.

3. Click Computer Management.

4. Open the Local Users and Groups and highlight the Users folder.

5. With the Users folder highlighted, open the Action menu and select New user. The New User
dialog appears

6. Enter ipuser in the User name: field, and optionally, complete the other fields on the dialog.

7. Click Create to create ipuser.

8. Close the New User dialog, the Computer Management dialog, the Administrative Tools
dialog, and the Control Panel.

Moving the ipdata folder

1. Skip this procedure to leave the ipdata folder in the default location.

2. Open the InfoPrint Manager Management Console.

3. Stop the InfoPrint Manager Server by clicking Stop Server on the Management Console toolbar.

4. Click Edit→ Service Configuration to open the Service Configuration dialog box. In the
Paths section, change the value for Shared client path to the desired location. For example, f:
\myfiles.

5. Start the InfoPrint Manager Server by clicking Start Server on the Management Console toolbar.

Sharing the ipdata folder

Before you set up the ipdata folder for sharing, check with your system administrator to determine the
sharing policies for your location. Use this procedure to set up the ipdata folder so that it can be shared
between Submit Express and the InfoPrint Manager Server:
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1. UsingWindows Explorer, navigate to the ipdata folder.

2. Highlight the ipdata folder, right-click it, and select Sharing from the drop-down menu.

3. The Folder Properties dialog displays. On this dialog, enter ipdata as the name for the shared
folder in the entry field labeled Share this folder.

4. Click Permissions to open the Permissions for ipdata dialog and set the access between your
server and client machines and select Allow for Full Control.

5. Click OK to enable the sharing for your folder.

6. Now, you need to configure the Submit client (see Configuring the InfoPrint Submit Express client for
InfoPrint Manager for AIX, InfoPrint Manager for Linux, and InfoPrint Manager for Windows, p.
199).

Configuring the InfoPrint Submit Express client for InfoPrint Manager for AIX, InfoPrint Manager for
Linux, and InfoPrint Manager for Windows

This section describes how to configure your InfoPrint Submit Express Client for use with either InfoPrint
Manager for AIX, InfoPrint Manager for Linux, or InfoPrint Manager for Windows servers.

From the client system where you have installed InfoPrint Submit Express, map a network drive to the
directory that your resources are in.

1. Open Windows Explorer.

2. Click Tools→Map Network Drive.

3. In theMap Network Drive dialog, select a drive letter that you are not currently using from the
drop-down menu in the Drive field.

4. In the Folder field, type the path \\servernameipdata where servername is the host name of the
system where InfoPrint Manager is installed.

5. Click Reconnect at logon.

6. Click Connect using a different user name.

7. In the Connect As dialog, type the user name ipuser and password (if required).

8. Click OK in the Connect As dialog.

9. Click Finish in theMap Network Drive dialog.

In addition, in InfoPrint Submit Express you need to change the folders for the shared file system. Follow
these steps:

1. Start InfoPrint Submit Express by clicking on the desktop icon.

2. Go to Options ─→ Settings to open the Settings window.

3. Click Folders to display the Folders page.

4. Specify the fully qualified path name in the Client uses entry field.

Configuring the InfoPrint Submit Express macOS client for InfoPrint Manager for AIX, InfoPrint
Manager for Linux, and InfoPrint Manager for Windows

To configure the InfoPrint Submit Express macOS client, you must map a network drive from the client
system where you installed InfoPrint Submit Express and change the folders for the shared file system.
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Mapping a network drive on a macOS system

1. Click Go→ Connect to Server:

2. In the Address field, type smb://servername/ipdata where servername is the host name
of the system where InfoPrint Manager is installed.

3. Click Connect.

4. Enter “ipuser” in the Username field and the password (if needed) in the Password field of the
SMB/CIFS Filesystem Authentication window.

5. Click OK to finish mounting the server's IPDATA directory in /Volumes/ipdata.

Changing the folders for the shared file system

To change the folders for the shared file system:

1. Start InfoPrint Submit Express.

2. Go to Options→ Settings to open the Settings window.

3. Click Folders to open the Folders page.

4. Specify the fully qualified path name in the Client uses entry field.

Starting Submit Express

1. Click InfoPrint Submit Express that was automatically added to the desktop after installation or,
on Windows, from the Start menu, go to Programs and click InfoPrint Submit Express

2. When you start the program the first time, a message displays.

3. Click OK and InfoPrint Submit Express opens.

4. Go to the Options menu, and select Settings.

5. Enter the name or the IP address for your InfoPrint Manager Server.

6. Let the port number default.

7. Click Preferences.

8. Select your preferences for Decimal notation and Units of measure.

9. Click OK to return to the main InfoPrint Submit Express window.

10. Click Page.

11. Select your preferences for Image Fit, Untrimmed page size, and Finished page size.

Using Submit Express to process a job

Submit Express is used through the life cycle of a job. A print shop uses Submit Express on a Windows
workstation to create a job ticket for the job, submit the job to the InfoPrint Manager server for printing,
and track the job.
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Job tickets

An InfoPrint job consists of a job ticket and all the files associated with that job. A job ticket contains all
the specifications for a job. The job ticket refers to the customer's job data and resources and pulls them
together in a job bundle. You can create a job ticket by using Submit Express.

You can print any part of the data by submitting a print job.

Migrating job tickets from previous versions of InfoPrint Submit

There are two ways to migrate job tickets from previous versions of InfoPrint Submit to the current
version of Submit Express.

Using the Ticket→ Open method:

1. Click Ticket→ Open to open the job ticket that you created with the previous level of Submit. A
dialog will open, asking you to select the language that was used to create the job ticket file.

2. Select a language from the drop-down list.

3. Click OK. The job ticket will be converted to the new format and will be opened.

Using the Ticket→ Reformat job tickets method:

1. Click Ticket→ Reformat job tickets to open the Reformat job tickets dialog box.

2. Click Add Files to select job tickets or groups of job tickets.

3. Click OK. A message appears asking you if you want to overwrite the older version of your job
tickets.

4. Click Yes to reformat the job tickets.

Important notes about migrating job tickets:

1. In previous versions of Submit, job tickets were language-dependent, that is, you had to use the
same language in Submit as the language your job tickets were created in. With Submit Express, the
job tickets you create are language-independent, so you can transfer job tickets among sites using
other languages.

2. To open job ticket files that were created in Japanese or Chinese, you must have installed Submit
Express on the Japanese or Chinese system; otherwise, some characters will not display correctly.

3. At migration, the values are imported from the old job ticket as they existed in the old .jtk file, even if
those values violate some constraints among related fields, as listed below. The first time you access
the newly migrated job ticket and you change any field from the set of related fields, associated
values will be recalculated according to the existing constraints from the current version of Submit.
Job ticket related fields are:

• Layout

• Sides

• Untrimmed page size

• Finished page size

• Front side (vertical and horizontal)
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• Back side (vertical and horizontal)

4. Untrimmed page size values are not saved in the .jtk file in any previous version of Submit, so they
will always be calculated depending on the paper and available dimensions defined on the server
for the appropriate paper.

Working with print jobs

When using Submit Express to create the job ticket, you identify and organize the printable files and
other resources that make up the job. Processing a job ticket includes these steps:

1. Creating a job ticket

2. Adding files, sheets, hardcopy, and documents to the job ticket

3. Selecting the layout of the job, the desired server and printer, and other attributes of the job

4. Setting print options, such as saving the RIP file or holding the job at the printer

5. Submitting the job

6. Tracking the job by displaying messages

Submit Express sets the user@host information for the job (FST mode). It does not use LDAP/ Active
Directory information.

Creating files for printing

You generate the printable files that you submit to InfoPrint Manager, file by file, from the application
that you use for authoring. For example, you can use the Adobe PostScript driver and InfoPrint
PostScript Printer Description files (PPDs) to convert files to PostScript. Or, you can use InfoPrint Scan to
create printable files from hardcopy.

Creating a job ticket

Once you have installed the Submit Express application, you can begin creating job tickets that support
the orders you receive from customers.

When you create a job ticket, at a minimum you must provide these information:

• The server to connect to

• At least one selected item for a document

• A selected printer in the Printer field of the Print page

Describing your job

Using a Submit Express Job Ticket window, you can describe your job. The description can include a
job name, an ID, a specific description of the job, the customer name, and other information that will
assist you as you refer to the job ticket.

To begin working on a new ticket, you start Submit Express. The Job Ticket window displays.

As you create the job ticket, use the Help menu from the Job Ticket window or the Help button on the
dialogs to guide you.
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You can create a new job ticket using the Ticket → New option on the Menu bar, or you can open a
previously created job ticket using the Ticket → Open option on the Menu bar.

You can use the Ticket → Submit option on the Menu bar to print the job or portion of the job as
shown in the tree view of the ticket. (To print just the ticket itself, use the Ticket→ Print Ticket option.

The Ticket menu contains general tasks that you can do as you work with job tickets.

Specifying how you want the job to print

You can describe the layout of your document and specify alignment values. You can use the fields on
the Page tab to adjust the untrimmed and finished page size for a file or document. If the image is
smaller than the page, you use the fields on the Align tab to adjust the position of the image on the
page.

Working with files in a job ticket

You build job tickets by adding documents, files and sheets, that refer to the files that you are printing.
You add these items to the job ticket using the selections from the Item menu. The files you choose might
be printable text files or graphic files. Graphic files might include printable files that were created from
hard copy by using InfoPrint Scan. Files might be on your hard disk or in a shared directory on another
system.

After you add one or more files to the job ticket, the Files tab becomes available on the job ticket
dialog.

Once you have added files and one or more documents to a job ticket, you can choose whether to print
the documents and files by checking or unchecking the boxes that are displayed in the tree view of the
job ticket.

Scheduling your job and setting options

The Schedule tab on the Settings dialog lets you indicate how you want your job to be processed.
Because the time it takes to print a job includes both the processing (RIPing) and the actual printing, you
might want to control these activities separately to optimize the flow of paper through your printers. You
might want your job to be held in the print queue before being RIPed and printed. You might want to RIP
it now, but print it later. You can specify how long you would like your job to be retained on the server
so that it can be printed again.

Submitting a print job

When you select Submit Job from the Ticket menu, the active job ticket is sent to the server for
processing. A progress dialog is shown as files are transferred to the server. You can view the status of
the job at the server by selecting Options→ Job status...

If you select Print in the RIP Options box on the Schedule tab, the job will be added to the
print queue and will RIP and print automatically. An operator will not have to release the job.

Saving the RIP output

The raster image processor (RIP) file is generated during the print process. Because PostScript to RIP
processing can be costly, you might want to save your RIP files for reprinting jobs to avoid having to RIP
them again. To use the Save RIPed file option, you must set up the Shared Folder in Client uses field
on the Folders tab of the Settings dialog.
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When you add a file to your job ticket, click the Save RIPed file check box option on the Advanced
tab to specify that the RIPed file is to be saved. The RIP file is saved in the shared folder location you
previously specified on the server you are currently working on (for example, K:\rip\myjob.jtk\).
When a job is submitted to the server and Save RIPed file is checked, the RIP file is re-RIPed. You can
re-use an already ripped version of the file from the shared folder by checking the Use RIPed on the
Files tab.

If you save your RIPed files, you must manually remove them from the server.

Verifying that PostScript jobs are ready to print

If your InfoPrint server receives a PostScript job from a personal computer system, you must make sure
that the Type 1 fonts required to print are either:

• Contained in the job (inline)

• Available on the server

If the fonts are contained inline, you should have no problem in printing the output. However, if the fonts
are not available on the server, by default a job will be cancelled.

Using Submit Express to send jobs to a continuous forms printer

This topic applies to all InfoPrint continuous forms printers, such as the InfoPrint 4100 and the InfoPrint
5000. It assumes that you have already created a PSF actual destination to represent a continuous
forms printer and printed a test job. It further assumes that you have installed Submit Express, and are at
least somewhat familiar with how to use it.

Many of these procedures use the InfoPrint Manager Administration GUI. If you need additional
information or assistance with the GUI, see the online help system.

General configuration information

There are some settings on the InfoPrint Manager server that you can consider setting based on your
print environment.

• If you will be printing multiple copies of your print jobs, set the Optimize for Copies option on the
actual destination.

1. In the InfoPrint Manager Administration GUI, select the actual destination that represents the
printer.

2. Click Printer→ Change Tuning.

If Change Tuning doesn't appear on the printer menu, use Add/Remove menu items to add
it.

3. Change Optimize for Copies to yes.
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The default value for Optimize for Copies is yes for actual destinations representing these
printer models created using the basic InfoPrint Manager Administration GUI:

destination-model=InfoPrint4100-HD1-HD2

destination-model=InfoPrint4100-HD3-HD4

destination-model=InfoPrint4100-HD5-HD6

destination-model=InfoPrint4100-MD1-MD2

destination-model=InfoPrint4100-PD1-PD2

destination-model=InfoPrint4100-TD1-TD2

destination-model=InfoPrint4100-TD3-TD4

destination-model=InfoPrint4100-TD5-TD6

destination-model=InfoPrint5000-AD1-AD2

destination-model=InfoPrint5000-AD3-AD4

destination-model=InfoPrint5000-AD3-AD4-XR3

destination-model=InfoPrint5000-AS1

destination-model=InfoPrint5000-AS3

destination-model=InfoPrint5000-KM3

destination-model=InfoPrint5000-KM3/MD4

destination-model=InfoPrint5000-MP-MC1-MC2

destination-model=InfoPrint5000-MP-MD3-MD4

destination-model=InfoPrintProC900AFP

• If you are printing to an InfoPrint 5000 and you print mostly small jobs, increase theMaximum
concurrent jobs value for the actual destination to 120. That way, up to 120 jobs can be
processing at the same time, which reduces lag time between jobs and helps to eliminate clutching.

1. In the InfoPrint Manager Administration GUI, select the actual destination that represents the
printer.

2. Click Printer ─→ Change Tuning.

If Change Tuning doesn't appear on the printer menu, use Add/Remove menu items to add
it.

3. ChangeMaximum concurrent jobs to 120.

Configuring media

Preparation

Before you configure any media, make a list of all of the different layout types that jobs will use. In the
list, include the page lengths, n-up specifications, job orientation (portrait or landscape), and any other
information that you have. Give each type of job a name. You will use this name on the printer and in

Using the InfoPrint Submit Express Client



2

206

InfoPrint Manager. Images of some common layout types, along with their specifications, are provided
below to help you create your list.

Simple 1–up, with finished page size ledger

In this layout, the printer form is wider than it is long. Even if you specify a value for Page placement (X
and Y shift) in Submit Express, the form definition will override it.

Ledger-sized document printed 1–up, landscape orientation

Ledger
W

eb
 d

ire
ct

io
n

IInnffooPPrriinntt MMaannaaggeerr aanndd SSuubbmmiitt EExxpprreessss vvaalluueess ffoorr LLeeddggeerr--ssiizzeedd ddooccuummeenntt pprriinntteedd 11––
uupp,, llaannddssccaappee

Option Value

Finished page (document) size 17 x 11 inches

Form size (Untrimmed page size: width and
length)

17 x 11 inches

Media size (in InfoPrint Manager) 17 x 11 inches
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Option Value

Layout Simple 1–up

Form definition F100LAND

PDF orientation Landscape

Postscript orientation Landscape

Simple 1–up, with finished page size poster

In this layout, the printer form size is longer than it is wide. If the finished document size is smaller than
17 x 25 inches (for example, 16 x 24 inches), you should make the finished page size equal to the
document size.

Poster-sized document printed 1–up, portrait orientation

IInnffooPPrriinntt MMaannaaggeerr aanndd SSuubbmmiitt EExxpprreessss vvaalluueess ffoorr 1177 xx 2255 iinncchh ddooccuummeenntt pprriinntteedd 11––uupp,,
ppoorrttrraaiitt

Option Value

Finished page (document) size 17 x 25 inches

Form size (Untrimmed page size: width and
length)

17 x 25 inches or larger
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Option Value

Media size (in InfoPrint Manager) 17 x 25 inches or larger

Layout Simple 1–up

Form definition blank

PDF orientation Portrait

Postscript orientation Portrait

Side-by-side copies 2–up, with finished page size letter

In this layout, the printer form is wider than it is long. Because you do not specify a form definition, you
can use the Page placement (X and Y shift) option in Submit Express.

Letter-sized document printed 2–up, portrait orientation

IInnffooPPrriinntt MMaannaaggeerr aanndd SSuubbmmiitt EExxpprreessss vvaalluueess ffoorr lleetttteerr--ssiizzeedd ddooccuummeenntt pprriinntteedd 22––uupp,,
ppoorrttrraaiitt

Option Value

Finished page (document) size 8.5 x 11 inches

Form size (Untrimmed page size: width and
length)

17 x 11 inches or larger
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Option Value

Media size (in InfoPrint Manager) 17 x 11 inches or larger

Layout Side by side copies 2–up

Form definition blank

PDF orientation Portrait

Postscript orientation Portrait

Side-by-side copies 2–up, with finished page size legal

In this layout, the printer form is wider than it is long. Because you do not specify a form definition, you
can use the Page placement (X and Y shift) option in Submit Express.

This layout looks the same as the layout for side-by-side copies 2–up with finished page size letter. See
Poster-sized document printed 1–up, portrait orientation, p. 207 for an illustration of the layout.

IInnffooPPrriinntt MMaannaaggeerr aanndd SSuubbmmiitt EExxpprreessss vvaalluueess ffoorr lleeggaall--ssiizzeedd ddooccuummeenntt pprriinntteedd 22––uupp,,
ppoorrttrraaiitt

Option Value

Finished page (document) size 8.5 x 14 inches

Form size (Untrimmed page size: width and
length)

17 x 14 inches or larger

Media size (in InfoPrint Manager) 17 x 14 inches or larger

Layout Side-by-side copies 2–up

Form definition blank

PDF orientation Portrait

Postscript orientation Portrait

Side-by-side copies 2–up, with finished page size 9 x 8 inches

In this layout, the printer form size is wider than it is long. Because you do not specify a form definition,
you can use the Page placement (X and Y shift) option in Submit Express.
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Nine by eight inch document printed 2–up, landscape orientation

IInnffooPPrriinntt MMaannaaggeerr aanndd SSuubbmmiitt EExxpprreessss vvaalluueess ffoorr 99 xx 88 iinncchh ddooccuummeenntt pprriinntteedd 22––uupp,,
llaannddssccaappee

Option Value

Finished page (document) size 9 x 8 inches

Form size (Untrimmed page size: width and
length)

18 x 8 inches or larger

Media size (in InfoPrint Manager) 18 x 8 inches or larger

Layout side-by-side copies 2–up

Form definition blank

PDF orientation Landscape

Postscript orientation Landscape

Side-by-side copies 2–up, with finished page size double-high letter

In this layout, the printer form is longer than it is wide. Because you don't specify a form definition, you
can use the Page placement (X and Y shift) option in Submit Express.
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Double–high letter document printed 2–up, portrait orientation

IInnffooPPrriinntt MMaannaaggeerr aanndd SSuubbmmiitt EExxpprreessss vvaalluueess ffoorr ddoouubbllee––hhiigghh lleetttteerr--ssiizzeedd ddooccuummeenntt
pprriinntteedd 22––uupp,, ppoorrttrraaiitt

Option Value

Finished page (document) size 8.5 x 22 inches

Form size (Untrimmed page size: width and
length)

17 x 22 inches or larger

Media size (in InfoPrint Manager) 17 x 22 inches or larger

Layout side-by-side copies 2–up

Form definition blank

PDF orientation Portrait

Postscript orientation Portrait

Side-by-side copies 3–up, finished page size 6 x 11 inches

In this layout, the printer form is wider than it is long. Because you don't specify a form definition, you
can use the Page placement (X and Y shift) option in Submit Express.
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Six by eleven inch document printed 3–up, portrait orientation

IInnffooPPrriinntt MMaannaaggeerr aanndd SSuubbmmiitt EExxpprreessss vvaalluueess ffoorr 66 xx 1111 iinncchh ddooccuummeenntt pprriinntteedd 33––uupp,,
ppoorrttrraaiitt

Option Value

Finished page (document) size 6 x 11 inches

Form size (Untrimmed page size: width and
length)

18 x 11 inches or larger

Media size (in InfoPrint Manager) 18 x 11 inches or larger

Layout Side-by-side copies 3–up

Form definition blank

PDF orientation Portrait

Postscript orientation Portrait

Side-by-side copies 3–up, with finished page size double-high

In this layout, the printer form is longer than it is wide. Because you do not specify a form definition, you
can use the Page placement (X and Y shift) option in Submit Express.
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Six by twenty–two inch document printed 3–up, portrait orientation

IInnffooPPrriinntt MMaannaaggeerr aanndd SSuubbmmiitt EExxpprreessss vvaalluueess ffoorr ddoouubbllee--hhiigghh ddooccuummeenntt pprriinntteedd 33––uupp,,
ppoorrttrraaiitt

Option Value

Finished page (document) size 6 x 22 inches

Form size (Untrimmed page size: width and
length)

18 x 22 inches or larger

Media size (in InfoPrint Manager) 18 x 22 inches or larger

Layout Side-by-side copies 3–up

Form definition blank

PDF orientation Portrait

Postscript orientation Portrait

Side-by-side copies 4–up, with finished paper size 9 x 6 inches

In this layout, the printer form is wider than it is long. Because you do not specify a form definition, you
can use the Page placement (X and Y shift) option in Submit Express.
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Nine by six inch document printed 4–up, landscape orientation

IInnffooPPrriinntt MMaannaaggeerr aanndd SSuubbmmiitt EExxpprreessss vvaalluueess ffoorr 99 xx 66 iinncchh ddooccuummeenntt pprriinntteedd 44––uupp,,
llaannddssccaappee

Option Value

Finished page (document) size 9 x 6 inches

Form size (Untrimmed page size: width and
length)

18 x 12 inches or larger

Media size (in InfoPrint Manager) 18 x 12 inches or larger

Layout side-by-side copies 4–up

Form definition blank

PDF orientation Landscape

Postscript orientation Landscape

Side-by-side copies 4–up, with finished paper size letter

In this layout, the printer form is longer than it is wide. Because you do not specify a form definition, you
can use the Page placement (X and Y shift) option in Submit Express.
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Letter–sized document printed 4–up, portrait orientation

IInnffooPPrriinntt MMaannaaggeerr aanndd SSuubbmmiitt EExxpprreessss vvaalluueess ffoorr lleetttteerr--ssiizzeedd ddooccuummeenntt pprriinntteedd 44––uupp

Option Value

Finished page (document) size 8.5 x 11 inches

Form size (Untrimmed page size: width and
length)

17 x 22 inches or larger

Media size (in InfoPrint Manager) 17 x 22 inches or larger

Layout side-by-side copies 4–up

Form definition blank

PDF orientation Landscape

Postscript orientation Landscape

On the printer

Define snapshots on the printer for each type of job that you identified. Use the names that you created
above. If your list does not include dimensions, add them as you create each snapshot.
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All InfoPrint continuous forms printers round form lengths to the nearest 1/6 inch. Therefore, it is
recommended that you use lengths in increments of 1/6 inch. Use Decimal equivalents of common
fractions, p. 216 as a guide.

DDeecciimmaall eeqquuiivvaalleennttss ooff ccoommmmoonn ffrraaccttiioonnss

Fraction of an inch Decimal equivalent

1/6 0.167

2/6 = 1/3 0.333

3/6 = 1/2 0.5

4/6 = 2/3 0.667

5/6 0.833

In InfoPrint Manager

1. Open the InfoPrint Manager Administration GUI.

2. Verify that all of the menu items and details views columns that you will need are displayed.

1) Click Options→ Customize.

2) On the Printer tab, make sure the Change media check box is selected in theMenu column
and thatMedia ready is listed in the Details to show box.

3) On the Job tab, make sure that the Change media and Change copies check boxes are
selected in theMenu column. Make sure thatMedia is listed in the Details to show box.

3. Define the new media.

1) Click Server→Media→ Create.

2) In the Create Media dialog, fill in the Name, Server, and Untrimmed width and length
(inches) fields as specified below. You can fill in the other fields if you like, but these three are
the only required fields. See the online help for additional information about the other fields.

Name
One of the media types from your list.

Server
The name of the InfoPrint Manager server that sends jobs to your printer.

Untrimmed width and length (inches)
Specify width and length values that are slightly shorter than the ones you gave in the
snapshot on the printer. The PostScript transform and some printers (such as the Infoprint
4100) round off some values, so setting the width and length to slightly shorter values
accommodates that rounding. The values should be at least .02 inches (1 mm) less than the
values in the corresponding snapshot.

3) Click OK.

4) Repeat step 3 for the rest of the media types you need to define.
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4. Set theMedia allowed values for the printer.

1) Select the actual destination in the tree view of the GUI

2) Click Printer→ Change media.

3) In the Change Media dialog, clickMedia Allowed.

4) Add the new media types that you just defined to the Values list.

5) Remove any types that shouldn't be allowed from the Values list.

6) Click OK.

5. Decide whether to have more than one media type ready on the printer at the same time. If you only
have one type ready, only jobs that request that media will be printed. Other jobs will wait in the
queue until you change the media type that is ready. Once you have decided, set theMedia
ready value to the type or types that you want to print on.

1) Select the actual destination in the tree view of the GUI

2) Click Printer→Change media.
3) On theMedia Ready tab, type 1 for the Input bin number, then select theMedia type and

Input tray for each media that you want to make ready.

4) Click OK.

Using Submit Express to send jobs

1. Open Submit Express and build a job ticket as usual.

2. Click Options→ Refresh to update the list of media types from the server.

3. After all of the documents have been added, click Print.

4. Select the appropriate Printer type from the drop-down list, then select the media type that you
want to use from the Paper drop-down list.

5. Click Layout.

6. Select the appropriate page layout (for example, side by side copies 2–up or simple 3–up)
from the Layout drop-down list.

7. Click Align.

8. Set the dimensions in the Finished page size box to the exact dimensions of the pages in the job.

You can set these dimensions in either inches or millimeters. Use Options→ Preferences to
change the unit of measure.

The values in the Untrimmed page size box map to the partition area in the printer's printable
area.

9. By default, the page placement (X and Y offset) value is Upper left, so the document will be
placed in the upper left corner of the form. If you want the document to be positioned differently,
select a different page placement value.

10. Submit the job as usual.
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Troubleshooting

If you submit a job that requests a media type that isn't listed as ready in the server, the job icon will
turn red. To print the job:

1. Change the snapshot on the printer.

2. In the InfoPrint Manager GUI, highlight the printer, then click Printer→ Change Media.

3. On theMedia Ready tab of the Change Media dialog, change the values to the media you
want to use.

4. Click OK.

Once theMedia Ready value is reset, jobs that request the changed media type will start to print.

UUssiinngg tthhee IInnffooPPrriinntt MMaannaaggeerr WWiinnddoowwss CClliieenntt
The InfoPrint Manager Windows command line client enables users of Windows to issue InfoPrint
Manager commands over a TCP/IP-connected network to an InfoPrint Manager server. Using a
Windows command line or batch script, you can issue a variety of commands to the InfoPrint Manager
server. The Windows client supports files larger than 2 GB in size.

To install the Windows client on a Windows machine, you can use the RICOH InfoPrint Manager: Common
Clients DVD-ROM, LCD4-5642.

Access to the InfoPrint Manager server and to the InfoPrint Manager commands is controlled on the
system where the server is installed. For information about providing access, see RICOH InfoPrint Manager
for Windows: Procedures .

For the latest information about installing the InfoPrint Manager Windows client, go to the RICOH
Software Information Center at https://help.ricohsoftware.com/swinfocenter.

Installing the Command Line Client for Windows

Before you install the Command Line Client for Windows, consider these conditions:

• You must have administrative privileges to install InfoPrint Command Line Client for Windows.

• If you plan to install one or all of the InfoPrint Manager GUIs as well as the Command Line Client
for Windows, the sequence of the installs is important. Since the Command Line Client for Windows
might require a system reboot, you might want to install the InfoPrint Manager GUI(s) first.

• You must adjust the configuration of the InfoPrint Manager server for the Command Line Client for
Windows to function properly.

To install InfoPrint Manager Command Line Client on a Windows system from the InfoPrint Manager:
Common Clients DVD-ROM:

1. Insert the InfoPrint Manager: Common Clients DVD-ROM into the drive.

2. Click Install InfoPrintCLC client (64-bit).

3. Follow the instructions on the installation screens to install the program.
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If you plan to install one or both of the InfoPrint Manager GUIs as well as InfoPrint CLC, the
sequence of the installations is important. Because InfoPrint CLC might require a system reboot, you
might want to install the InfoPrint Manager GUIs first.

4. Select one of the two restart options: Yes, I want to restart my computer now. or No, I will
restart my computer later..

5. Click Finish on the Complete window.

Upgrading the Command Line Client for Windows

To upgrade the Command Line Client on a Windows system from the InfoPrint Manager: Common Clients
DVD-ROM, LCD4-5642:

1. Insert the InfoPrint Manager: Common Clients DVD-ROM, LCD4-5642, into the drive to run the
upgrade program.

2. Follow the instructions on the screens to upgrade the program.

3. After upgrading the Command Line Client version, the program asks to reboot your system. The
default answer to this question is Yes because the new version of the Command Line Client does not
function properly until the system is rebooted. When you click OK or press Enter, your system
reboots.

Uninstalling the Command Line Client for Windows

To uninstall the Command Line Client for Windows:

1. From the Start menu, select Settings→ Control Panel.

2. Double-click Add or Remove Programs.

3. Select InfoPrint Command Line Client for Windows.

4. Click Remove.

Click the button only once, then wait for at least 30 seconds before you do anything else. If you do
not wait for the first panel of the uninstaller to appear, it might get lost behind other windows. If you
do not see the first panel of the uninstaller after 30 seconds, press and hold the AAlltt key, then press
the TTaabb key to bring the window to the front.

5. Follow the instructions on the screen.
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Commands you can use with Command Line Client for Windows

Typically, Command Line Client is used to let users print to InfoPrint Manager destinations from existing
Windows applications (usually through the Print option on the File menu). In addition, you can use
several InfoPrint commands that can be issued at a Command Prompt on the client system.

If you are using the InfoPrint commands and want to receive notifications, you can install the
Notification Client from the RICOH InfoPrint Manager: Common Clients DVD-ROM, LCD4–5642.

Information about security and how users can be authorized to InfoPrint Manager is found in the topic
“Managing Security” in the RICOH InfoPrint Manager for Windows: Procedures guide.

InfoPrint Manager lets authorized users (normally all users) use these InfoPrint Manager commands:

pdls
Lists selected attribute values for a job, destination, or other InfoPrint object

pdpr
Submits a job to a logical or actual destination. If LDAP job authentication is enabled, you must
authenticate using your LDAP credentials before submission.

pdq
Queries the status of selected jobs, of all jobs submitted to a logical destination, or of all jobs
assigned to an actual destination

InfoPrint Manager lets authorized users (the job owner is usually authorized) use these InfoPrint
commands:

pdmod
Modifies the attributes of submitted jobs or of the documents in them

pdrm
Deletes jobs

InfoPrint Manager allows only authorized users to use these InfoPrint commands:

pdaccount
Collects summary accounting information for a specified time period in a comma delimited format
about actual destinations on one or more servers. This information can be filed and imported into a
spread sheet to calculate the cost of consumables, the usage rate of printers, the cost for each user,
and so forth.

pdcreate
Creates logical destinations, queues, actual destinations, default jobs, default documents, media,
auxiliary sheets, and resource contexts.

pdclean
Removes all jobs from a server, logical destination, queue, or actual destination.
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pddelete
Deletes servers, logical destinations, queues, actual destinations, default jobs, default documents,
media, auxiliary sheets, resource contexts, and jobs.

pddisable
Prevents destinations from accepting jobs and logs from logging.

pdenable
Enables destinations to accept jobs and logs to log.

pdpause
Pauses a job, actual destination, queue, or all the queues and actual destinations in a server.

pdpromote
Advances a job to the head of the queue.

pdreorder
Reassigns a job to an actual destination or to the unassigned jobs area in the same server or in
another server, and lets you schedule it immediately before or after another job.

pdresubmit
Resubmits a job, all the jobs submitted to a logical destination, or all the jobs in a queue to another
logical destination.

pdresume
Enables paused objects to resume operation.

pdset
Sets or changes the values of attributes describing InfoPrint objects.

pdshutdown
Stops servers or actual destinations.

pdspace
Backspaces or forward spaces a PSF physical printer.

pddeviceop
Perform device operation on device associated with specified actual destination.

For more information about InfoPrint commands and attributes, see the RICOH InfoPrint Manager:
Reference .

IInnffooPPrriinntt MMaannaaggeerr hhoott ffoollddeerrss
An InfoPrint Manager hot folder is a directory that is associated with a logical destination. When you
copy or move a file to the hot folder, InfoPrint Manager automatically submits the file to that logical
destination. The default job and document attributes that are set for that logical destination are applied
to jobs submitted through the hot folder.
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If all of the systems that will be submitting jobs to hot folders are Windows systems, you can use
standard Windows folder sharing to make the hot folder accessible to both the InfoPrint Manager server
and to users. If you will be submitting jobs to hot folders from other systems (such as AIX), you will have
to install and configure separate software to transfer the files. The procedures below assume that jobs
will be submitted only from other Windows systems.

Make sure you know what kinds of files the InfoPrint Manager destination will accept. The files that you
put in the hot folder should already be print data streams (such as PCL or PostScript), not the standard
"working" files that many desktop programs create. For example, if you are writing a report using word
processing software, you cannot simply save the file and copy that file to the hot folder to be printed.
You need to convert it into a print data stream first. One way to do that conversion is to create a printer
on your desktop that uses a PostScript or PCL driver and the FILE: port. If you send a job to that printer,
the output won't be printed; it will be saved in a file (called my_report.ps, for example). Then, you
can copy the new file into the hot folder to be sent to InfoPrint Manager.

Configuring your system to work with hot folders

Use this procedure to configure you system to work with hot folders:

1. Decide what Windows system you want to create the hot folder on. Make sure that the InfoPrint
Manager server and all users who will use it can access that system.

1) It is strongly recommended that you create your hot folder on the same system that your InfoPrint
Manager server is installed on for these reasons:

• Performance will be better because the files have to be transferred over the network only
once.

• The polling traffic created by the InfoPrint Manager server process when it is looking for new
files might cause performance degradation of the remote server hosting the directory, the
InfoPrint Manager system, or the network connection between them.

• If you need to restart the system that the InfoPrint Manager server is installed on, the InfoPrint
Manager server will automatically have access to the hot folder when it restarts. If the hot
folder is on a different system, you must log on to the InfoPrint Manager server system to re-
establish the connection.

2) If you plan to have more than one hot folder, you can create all of them in the same parent
directory. That way, users can access all of them through a single mapped drive.

2. Use the regular Windows process to create a directory (add a folder to an existing directory).
Name the folder something distinctive, so you know that it is a hot folder, and possibly, what logical
destination it submits jobs to or what department should submit jobs to it.

3. Set up sharing on the folder so that the InfoPrint Manager server and users who will submit jobs to it
have write access to it.

4. Open the InfoPrint Manager Administration GUI.

5. Find or create the logical destination that you want the hot folder to submit jobs to and select it.
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6. In the Properties notebook for the logical destination, click General and find the Hot folder
location field. Type the directory path that the InfoPrint Manager server system will use to access
the hot folder.
If the hot folder is in a different partition or on a different hard drive than your InfoPrint Manager
server, this path will include the drive letter for that partition or drive and the directory path to the hot
folder. For example, D:\hotfolders\copy_postscript_here. For further instructions, see the
InfoPrint Manager Administration GUI online help.

A hot folder can be associated with only one logical destination, and a logical destination can be
associated with only one hot folder.

7. Set the default document and default job attributes for the logical destination. Unless the job
submitter overrides them, these attribute values will be used for all jobs submitted through the hot
folder. For instructions, see the InfoPrint Manager Administration GUI online help.

When you tell users how to submit jobs to the hot folder, be sure to tell them what types of files the
InfoPrint Manager destination can accept and how to generate those files.

Mapping a network drive

On the end user system, use the standard Windows method to map a network drive (available in
Windows Explorer) to the InfoPrint Manager hot folder. If there are multiple hot folders in the same
directory, you only have to map one network drive to the parent directory; you will be able to access
all of the subdirectories through it.

Submitting jobs through a hot folder

To submit a job through a hot folder, simply copy or move the print file to the hot folder.

If you experience problems with hot folders submitting incomplete jobs to the InfoPrint Manager server,
use Specifying hot folder poll method, p. 224 when you have multiple-document jobs or single-
document jobs with Network File System shares, else use the method described in Submitting multiple-
document jobs, p. 225.

To save the file, copy it. Files are deleted from the hot folder after submission.

Specifying job attributes

By default, jobs submitted through a hot folder use the attribute values in the default document and
default job associated with the logical destination; and also by default, hot folder jobs are submitted to
InfoPrint Manager with job notifications turned off. To receive notifications about jobs that you submit
through hot folders, you must specify a notification-profile with an explicit delivery-address in the .
att file. To specify other attributes or use different values for existing attributes, complete these steps.
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1. Either on your system or in the hot folder itself, create a text file to use as your attributes file. Name
the attributes file filename.att or filename.att.utf8, where filename is the same as the file
name of the print file. For example, if the print file is report.pdf, the attributes file is report.pdf.
att or report.pdf.att.utf8.

2. In the attributes file, specify the InfoPrint attributes and values to use for this job. For example, to
print three single-sided copies of report.pdf, report.pdf.att looks like this:

copy-count = 3
sides = 1

Use filename.att if the file is saved using ISO88591 or SHIFT-JIS code pages. Use filename.
att.utf8 if the file is encoded using the UTF-8 code page.

The attributes file is in the same format as a –X file passed to a pdpr command.

For information about job and document attributes, see RICOH InfoPrint Manager: Reference.

3. If you created the attributes file on your system, copy or move the file to the hot folder. The InfoPrint
Manager logical destination recognizes the .att file extension as an attributes file and knows not
to try to print it.

4. Copy or move the print file to the hot folder. The InfoPrint Manager logical destination sees the print
file and looks for an attributes file with the same file name. Both of the files are taken and your
attributes are used.

Specifying hot folder poll method

There are two hot folder poll methods. By default, the file access monitoring method is used when
jobs are submitted through a hot folder. This method is used for single or multiple-document jobs. If you
have hot folders with large single or multiple-document jobs, or both, copied over the network in a
Network File Share folder, you need to use the file size monitoring method. This method will check
the file size during the poll interval before submitting the job to InfoPrint Manager. The default method
will not work for files being copied over the network in a NFS folder.

You can specify the hot folder poll method with this procedure:

1. Open the InfoPrint Manager Administration GUI.

2. Find the logical destination that you want the hot folder to submit jobs to and select it.

3. In the Properties notebook for the logical destination, click Hot folder poll method and select the
hot folder poll method suitable for you. If you use the File size monitoring method, key in the poll
interval value in the Hot folder poll interval field. The default value is 30.

4. Copy the documents you want to print into the hot job folder.

If you copy multiple files in a single operation on a Windows system, the order of document
submission will be in alphabetical order. If the print order matters, rename the files according to the
intended submission order or use the Submitting multiple-document jobs, p. 225 method.
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Staging jobs

You can stage jobs to InfoPrint Manager with this procedure:

1. Make a copy of the print file on your local system.
You will end up with 2 files: report.pdf and copy of report.pdf.

2. Rename the copy of the print file so that it has the same name as the original print file and the
extension .stg.
Rename copy of report.pdf to report.pdf.stg.

3. Copy the new file to the hot folder.
Copy report.pdf.stg and paste it in the hot folder.

The InfoPrint Manager logical destination ignores files with the .stg extension.

4. Change the extension back to the original extension when you want the job to print.
Rename report.pdf.stg back to report.pdf. InfoPrint Manager will pick up the renamed file and
send it to print.

Submitting multiple-document jobs

You can use staging to print jobs that contain multiple documents. In this case, you stage an entire
directory. The InfoPrint Manager logical destination prints the documents as one job, in the order that
you copied the files into the directory.

1. Navigate to the hot folder (using Windows Explorer, for example).

2. In the hot folder directory, create a new folder named jobname.stg, where jobname is any name
you choose.

The InfoPrint Manager logical destination ignores directories with the .stg extension.

3. Copy the documents you want to print into the subdirectory in the same order that you want to print
them.

If you copy multiple files in a single operation, they might not be copied in the same order that you
selected them. If the print order matters, copy the files one at a time.

4. To override the default attributes, create an attributes file called jobname.att, where jobname is
the same as the subdirectory name, and copy it into the subdirectory.

5. Rename the subdirectory from jobname.stg to jobname. The InfoPrint Manager logical destination
then accepts all of the files in the subdirectory as a single job.

IInnssttaalllliinngg aanndd ccoonnffiigguurriinngg tthhee AAFFPP ddrriivveerr
The InfoPrint AFP Driver software lets you produce Advanced Function Presentation (AFP) output from
desktop applications so you can use the powerful features of AFP in a wider range of environments.
Used with InfoPrint Select or a Windows gateway printer, the AFP Driver provides a high degree of
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control over the appearance of your printed documents. This section contains procedures for unpacking
and installing the InfoPrint AFP Driver on a Windows system.

English versions of the AFP drivers for all Windows platforms are provided on the InfoPrint Manager:
Common Clients DVD-ROM, LCD4-5642. You can also download the English and other language
versions of the AFP driver from the Ricoh website at https://dl.ricohsoftware.com/downloads/
aa9a248e-101c-4aa6-b109-1cf7403f3b4f. Translated drivers might not be identical to the English
version because they are updated on a different schedule.

Use the procedures below to unpack and install the AFP drivers on your Windows system.

• If you plan to use this driver to submit print jobs using InfoPrint Select, install this driver on the same
system that InfoPrint Select is installed on. If you plan to use this driver to submit print jobs using a
Windows gateway printer, install the driver on the system that your InfoPrint Manager server is
installed on.

Installing the AFP driver files

1. Insert the InfoPrint Manager: Common Clients DVD-ROM, LCD4-5642, that came with your InfoPrint
Manager package into your DVD-ROM drive. The install program starts automatically.

If your install program does not start automatically or if your browser stops responding:

1. Select Start→ Run.

2. Enter D:\setup.html, where D is your DVD-ROM drive.

3. Click OK.

2. Click Install InfoPrint Products and then click AFP Print Driver.

3. Select the appropriate operating system.

4. The License Agreement displays. Click Accept, then click Next.

5. Follow the instructions to unpack the files into the desired directory. We recommend that you
place the driver files in an easy to find directory, such as C:\afpdriver.

Configuring the AFP driver

Once the files have been installed, you must complete the process of configuring the AFP driver by
creating a printer that uses the driver. If you are installing the driver on a client workstation that has
InfoPrint Select installed on it, see the InfoPrint Select readme file for instructions on creating a Select
printer that uses this driver. If you are installing this driver on the system that your InfoPrint Manager
server is installed on, follow the appropriate procedure below.
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1. The Windows printers that result from these procedures do not send print jobs to actual printer
devices; they generate files. To create a Windows printer that sends jobs to one of your printer
devices, change the procedure as necessary.

2. Once you complete this procedure, you can delete the printer that you created. The driver will still
be installed.

Setting up the InfoPrint AFP Driver on a Windows system

To set up the InfoPrint AFP Driver on a Windows system follow these instructions:

1. Click the Windows Start button and select Settings→ Printers and Faxes.

2. In the Printers window, click Add a printer to start the Add Printer Wizard.

3. On the first panel of the wizard, click Next.

4. In the Local or Network printer dialog, select Local and click Next.

5. In the Select Printer Port dialog, select FILE: and click Next.

6. In the next dialog, click Have disk without selecting a printer or a manufacturer.

7. In the Install from disk dialog, type the path to the directory that you copied the AFP driver files
into (for example, C:\afpdriver) and click OK.

8. Select the printer that you plan to use this driver with from the list and click Next.

If your printer does not appear in the list, select InfoPrint AFP nnn, where nnn is the resolution of
your printer.

9. In the next dialog, accept the name of the printer and do not set it to be your default printer. Click
Next.

10. Leave the printer Not shared and click Next.

11.Do not print a test page and click Next.

12.Click Finish.

13. If a dialog displays telling you that the driver has not passed Windows Logo testing, simply select
Continue Anyway to finish installing the driver.

CCoonnffiigguurriinngg cclliieenntt ssyysstteemmss ttoo rreecceeiivvee aauuttoommaattiicc uuppddaatteess
The InfoPrint Manager client systems can be configured to receive automatic updates over the network.

As an administrator, you can set up an update server for multiple client machines to retrieve the
available updates. The updates can be product updates or individual files. After the server system is
configured, the client systems receive notifications when an update is available. The operator can install
these updates immediately or postpone until a later time.

Currently, only InfoPrint Select for Windows and InforPrint Manager PDF driver can be configured to
receive automatic updates.
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Installing and Configuring the Update Server on a Windows system

InfoPrint Manager lets you configure an automatic updating environment for the client systems.

The updating environment consists of two main components: the update and the client systems. When an
update system is configured, all the client machines can connect to the update server to install the
available updates, such as product updates or individual file updates. Setting up an automatic update
system allows all systems to be up to date.
To install the update server.

1. Insert the InfoPrint Manager for Windows Common Clients DVD-ROM into your DVD-ROM drive.

2. Click InfoPrintManagerUpdateServer.exe to install the update server.

3. Select the installation path. The default installation directory is c:\Program Files\RICOH
\InfoPrint Manager Update Server\.

To configure the update server settings:

1. Go to the configuration directory for the update server.

The default configuration directory is c:\ProgramData\RICOH\InfoPrint Manager Update
Server\.

2. Open the ipm_updateserver.cfg file using a text editor to change the parameters.

product-path
Specifies the location of all product kits, file updates and registry updates that can be
automatically downloaded and installed by client machines. The default path is C:
\ProgramData\Ricoh\InfoPrint Manager Update Server\Products.

listen-port
Specifies the port on which the update server communicates with the update client. The
specified port must be opened in the firewall on both server and client machines. For the
server machines, the port number must be configured in the incoming section. For the client
machines, the port number must be configured in the outgoing section. The default port
number is 10000.

client-check-for-updates-interval
Specifies the time interval in seconds that passes between two subsequent checks for new
product updates by the automatic update client machines that communicate with this
automatic update server machine. The default interval is 84600 seconds.

number-postpones-by-user
Specifies how many times the user on the client machine can postpone a product installation
or update (0 means unlimited number of postpones). Once the product installation
postponing number has been exceeded, the update will be silently installed. During the silent
install, InfoPrint Select is not available until installation ends. The default value is 0.

Products Order
Specifies the update order of listed products. Product updates order priority is separated by
comma. The first product in the list has the highest priority.
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Example of ipm_updateserver.cfg file:

[Global Settings]

product-path=C:\ProgramData\Ricoh\InfoPrint Manager Update Server\Products

#the port used by the update server for incoming connections.
listen-port=10000

#the time between the update client checks for updates on the update server machine.
client-check-for-updates-interval=84600

#0 means infinite
number-postpones-by-user=0

#product installation order
products-order = InfoPrint Select, InfoPrint Manager PDF Driver

3. Restart InfoPrint Manager Update Service from Windows Services for configuration settings to
take effect.

4. Create one ore more DNS entries to provide the automatic update service to client machines.

Record Type
Service Location (SRV)

Service
_ipmupdateserver

Protocol
_tcp

Priority
A number between 0 and 65535 that indicates the priority for the host that is specified in host
offering this service. The host with the lowest preference number have a higher priority. The
host with the highest preference number have a lower priority.

Weight
Not used. Use 0.

Port Number
It must be identical to listen-port from ipm_updateserver.cfg

Host Offering this Service
IP address of the update server.

When trying to connect to an InfoPrint Manager Update Server, if more than one _ipmupdateserver
SRV records are found, the Priority field is evaluated for each SRV record. The client machine connects
to the InfoPrint Manager Update Server with the higher priority. If the InfoPrint Manager Update Server
does not respond, the client machine attempts to connect to the next server until one of the configured
InfoPrint Manager Update Servers respond or until the end of the list is reached.
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Configuring the Update Server on a Windows system with SSL/TLS

By default, InfoPrint Manager Update clients communicate with InfoPrint Manager Update Server
without using any encryption. If it is required a secured communication (SSL/TLS), InfoPrint Manager
Update Server can be configured using these steps:

1. Copy the ipmssl.cfg file from <install_dir>\cfg-samples\ssl\ to <configuration_
dir>\ssl directory.

2. Edit the ipmssl.cfg file using a text editor to enable and configure the SSL/TLS communication.

For additional information on how to configure SSL/TLS communication, see chapter Enabling
Transport Layer Security encryption for InfoPrint Manager server for Windows in RICOH InfoPrint Manager
for Windows: Procedures.

3. Restart InfoPrint Manager Update Server.

When configured with TLS/SSL InfoPrint Manager Update Server issues a notification message in
system log every time it starts.

Configuring the update clients on a Windows system with SSL/TLS

When InfoPrint Manager Update Server uses a certificate signed by a globally known third-party
Certificate Authority (CA) and you are not using Mutual Authentication, no configuration is required on
client machines.

If your organization is using a custom CA autority or if Mutual Authentication is enabled on InfoPrint
Manager Update Server, see these steps to update clients with SSL/TLS:

1. Copy the ipmssl.cfg file from <install_dir>\cfg-samples\ssl\ to <configuration_
path>\ssl directory.

2. Edit the ipmssl.cfg file using a text editor.

For additional information on how to configure SSL/TLS communication, see chapter Enabling
Transport Layer Security encryption for InfoPrint Manager clients for Windows in RICOH InfoPrint Manager
for Windows: Procedures.

3. Reboot the computer or restart the Infoprint Manager Update service.

Running InfoPrint Manager Update Server service control utility on Windows

You can control the operation of InfoPrint Manager Update using the ipmupdateserverctl tool.

Only users that have administrator privileges or users in the ipmupdategroup group can issue
commands to InfoPrint Manager Update Server.

The ipmupdateserverctl utility calculates the files checksum and control files and directories
permissions in the InfoPrint Manager Update Server product-path directory. The product-path
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directory is specified in the C:\ProgramData\RICHO\InfoPrint Manager Update Server\ipm_
updateserver.cfg file.

These arguments are allowed for ipmupdateserverctl:

freeze
ipmupdateserverctl notifies ipmupdateserver to temporary stop any requests for Infoprint
Manager Update clients. When ipmupdateserver acknowledges the operation, it removes all
checksums and allows you to modify the files and directories in ipmupdateserver database.

If you freeze ipmupdateserver database and the then restart ipmupdateserver, the service starts
without providing any updates for Infoprint Manager Update clients. You must freeze and unfreeze
the database to continue providing updates.

unfreeze
ipmupdateserverctl calculates the checksum for every file in the ipmupdateserver database
and removes the modify access permissions for files and directories. Then, it notifies
ipmupdateserver to resume any requests for Infoprint Manager Update clients.

status
ipmupdateserverctl queries and displays the status of ipmupdateserver.

If you are running Command Prompt using an administrator account, make sure that you select the Run
as Administrator option.

Configuring the automatic download of InfoPrint Select for Windows

The update server can be configured to download automatically InfoPrint Select for Windows on the
client machines.

1. Start Command Prompt.

You must have administrator privileges or the account you use must be in the ipmupdategroup
group. If you are running Command Prompt using an administrator account, make sure that you
select the Run as Administrator option.

2. Type ipmupdateserverctl freeze and press the Enter key to enterMaintenance mode.

TheMaintenance mode unlocks the product path folder and you can add and remove any files
contained in the product path subdirectories. While inMaintenance mode, the InfoPrint
Manager Update Server does not accept any new connections from the client systems.

3. Copy ipm_select.cfg from <install_dir>\cfg-samples\ to <configuration_dir>.

The default installation directory is c:\Program Files\RICOH\InfoPrint Manager Update
Server and the default configuration directory is c:\ProgramData\RICOH\InfoPrint
Manager Update Server\.
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4. To specify the global settings and create filters, edit the ipm_select.cfg file. See Sample ipm_
select.cfg file, p. 233 for more details about the configuration file.

5. Copy the InfoPrint Select kit from the RICOH InfoPrint Manager: Common Clients DVD-ROM to
<configuration_dir>\Products\InfoPrint Select\Windows\<product_version>\Kit
\.

6. Copy the installation scripts from <install_dir>\cfg-samples\scripts\ to
<configuration_dir>\Windows\<product_version>\Kit\.

• The installation scripts are install_InfoPrint_Select_new.cmd, install_InfoPrint_
Select_repair.cmd, install_InfoPrint_Select_update.cmd.

7. Create the response files with these names: setup_new.iss, setup_update.iss, setup_
repair.iss.

To create your own response files:

1. To create your own response file, invoke the InfoPrint Select installer in record mode:
InfoprintSelect. exe /r . This command produces a response file named setup.iss
based on the inputs used during installation. The setup.iss file is located by default in %
WINDIR% folder.

2. InfoprintSelect.exe is located in the \win\InfoprintSelect folder of the RICOH
InfoPrint Manager: Common Clients DVD-ROM.

setup_new.iss
A sample response file used to install

setup_update.iss
A sample response file used to upgrade a previous version of InfoPrint Select.

setup_repair.iss
A sample response file used to repair an installation of InfoPrint Select.

8. Run ipmupdateserverctl unfreeze to exit theMaintenance mode.

When installing InfoPrint Select in silent mode, InfoPrint Select Notification and Open Printer
Selection do not start automatically after the installation is complete. You must log out first and then log
in for InfoPrint Select Notification and Open Printer Selection to start.
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Sample ipm_select.cfg file

ProductName
The name of the product to be updated.

Platform
The operating system of the product.

Current Version
The version number of the base product.

local-registry-version-key
The registry key of the product.

local-registry-version_value
The registry key value of the product.

install-new-cmdline
Install the update as a new installation of the product.

install-update-cmdline
Install the update as a product patch. The product remains installed.

install-repair-cmdline
Install the update using the repair process. The product remains installed but the core files and
registry files are reinstalled too.

ProductAvailable
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Specifies if the update is available or not for client systems. Can be specified globally or in a
specific filter. The filter section take priority over the global section.

FilterIP
Specifies the IP addresses or ranges of IP addresses selected for the update.

* matches zero or more allowed characters.

? matches any allowed character exactly one time.

When using * or ? globs the IP address strings are compared literally.

For example IPv6 address fc00::100 matches filter fc00::1* but not the filter fc00::01*. Since the
operating system never returns an IPv6 address in the format fc00::0100, but fc00::100, the filter
fc00::01* never matches.

Example: 1.2.3.4;1.2.3.*;1.2.3.1*;1.2.3.1*1;1.2.3.?;1.2.3.1?;1.2.3.1?1;1.2.3.4/32;1.2.3.4/
24;1.2.3.0/255.255.255.0;fc00::100;fc00::*;fc00::1*;fc00::1*1;fc00::?;fc00::1?;fc00::1?1;
fc00::100/64 where:

1.2.3.4
Matches only:

1.2.3.4

1.2.3.*
Matches any IPv4 address from:

1.2.3.0 to 1.2.3.255

1.2.3.1*
Matches only these IPv4 address:

• 1.2.3.1

• 1.2.3.10 to 1.2.3.19

• 1.2.3.100 to 1.2.3.199

1.2.3.1*1
Matches only these IPv4 address:

• 1.2.3.101

• 1.2.3.111

• 1.2.3.121

• 1.2.3.131

• 1.2.3.141

• 1.2.3.151

• 1.2.3.161

• 1.2.3.171

• 1.2.3.181

• 1.2.3.191
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1.2.3.?
Matches the IPv4 range:

1.2.3.0 to 1.2.3.9

1.2.3.1?
Matches the IPv4 range:

1.2.3.10 to 1.2.3.19

1.2.3.1?1
Matches only these IPv4 address:

• 1.2.3.101

• 1.2.3.111

• 1.2.3.121

• 1.2.3.131

• 1.2.3.141

• 1.2.3.151

• 1.2.3.161

• 1.2.3.171

• 1.2.3.181

• 1.2.3.191

1.2.3.4/32
Matches only:

1.2.3.4

1.2.3.4/24
Matches the IPv4 range:

1.2.3.0 to 1.2.3.255

1.2.3.0/255.255.255.0
Matches the IPv4 range:

1.2.3.0 to 1.2.3.255

fc00::100
Matches only:

fc00::100

fc00::*
Match the IPv6 range:

fc00:: to fc00::ffff:ffff:ffff:ffff

fc00::1*
Matches only these IPv6 addresses:
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• fc00::1

• fc00::10 to fc00::1f

• fc00::100 to fc00::1ff

• fc00::1000 to fc00::1fff

fc00::1*1
Matches only :

fc00::1001 to fc00::1ff1

fc00::?
Matches the IPv6 range:

fc00::0 to fc00::f

fc00::1?
Matches only:

fc00::10 to fc00::1f

fc00::1?1
Matches only these IPv6 addresses:

• fc00::101

• fc00::111

• fc00::121

• fc00::131

• fc00::141

• fc00::151

• fc00::161

• fc00::171

• fc00::181

• fc00::191

• fc00::1a1

• fc00::1b1

• fc00::1c1

• fc00::1d1

• fc00::1e1

• fc00::1f1

fc00::100/64
Matches the IPv6 range:

fc00:: to fc00::ffff:ffff:ffff:ffff

FilterHost
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Specifies the host names selected for the update.

* matches zero or more allowed characters.

? matches any allowed character exactly one time.

When using * or ? globs the hostname strings are compared literally.

Example: host.example.org;*.example.org;.example.org;host?.example.org where:

host.example.org
Matches only the hostname host.example.org.

*.example.org
Matches any hostname that ends with .example.org.

.example.org
Matches any hostname that ends with .example.org.

host*.example.org.
Matches any hostname that starts with host, followed by any number of characters (valid for
hostname) and ends with .example.org.

Examples:

• host123.example.org

• host2A.example.org

• host-name.example.org

host?.example.org.
Matches any hostname that starts with host, followed by one character and ends with .example.
org.

Examples:

• host1.example.org

• host2.example.org

• hostM.example.org

Dependencies
Specifies which application is closed during the update process.

Configuring the automatic download of InfoPrint Manager PDF Driver for
Windows

InfoPrint Manager PDF driver can be configured to be downloaded automatically on the client systems.

1. Start Command Prompt.
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You must have administrator privileges or the account you use must be in the ipmupdategroup
group. If you are running Command Prompt using an administrator account, make sure that you
select the Run as Administrator option.

2. Type ipmupdateserverctl freeze and press the Enter key to enterMaintenance mode.

TheMaintenance mode unlocks the product path folder and you can add and remove any files
contained in the product path subdirectories. While inMaintenance mode, the InfoPrint
Manager Update Server does not accept any new connections from the client systems.

3. Copy ipm_driver.cfg from <install_dir>\cfg-samples\ to <configuration_dir>.

The default installation directory is c:\Program Files\RICOH\InfoPrint Manager Update
Server and the default program directory is c:\ProgramData\RICOH\InfoPrint Manager
Update Server\.

4. To specify the global settings and create filters, edit the ipm_driver.cfg file. See Sample ipm_
driver.cfg, p. 239 for more details about the configuration file.

5. Unzip the contents of InfoprintManagerPDFdriver.zip file from the InfoPrint Manager Common
Clients DVD to <configuration_dir>\Products\InfoPrint Manager PDF Driver\Windows
\<product_version>\Kit\

6. Copy Visual Studio Redistributable kit from the InfoPrint Manager Common Clients DVD to
<configuration_dir>\Products\InfoPrint Manager PDF Driver\Windows\<product_
version>\Kit\.

You can skip this step if Visual Studio Redistributable 2013 is already installed on the client
system.

7. Run ipmupdateserverctl unfreeze to exit theMaintenance mode.
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Sample ipm_driver.cfg file

ProductName
The name of the product to be updated.

Platform
The operating system of the product.

Current Version
The version number of the base product.

local-registry-version-key
The registry key of the product.

local-registry-version_value
The registry key value of the product.

install-new-cmdline
Install the update as a new installation of the product.

install-update-cmdline
Install the update as a product patch. The product remains installed.

install-repair-cmdline
Install the update using the repair process. The product remains installed but the core files and
registry files are reinstalled too.

ProductAvailable
Specifies if the update is available or not for client systems. Can be specified globally or in a
specific filter. The filter section take priority over the global section.

FilterIP
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Specifies the IP addresses or ranges of IP addresses selected for the update.

* matches zero or more allowed characters.

? matches any allowed character exactly one time.

When using * or ? globs the IP address strings are compared literally.

For example IPv6 address fc00::100 matches filter fc00::1* but not the filter fc00::01*. Since the
operating system never returns an IPv6 address in the format fc00::0100, but fc00::100, the filter
fc00::01* never matches.

Example:

1\.2\.3\.4;1\.2\.3\.*;1\.2\.3\.1*;1\.2\.3\.1*1;1\.2\.3\.?;1\.2\.3\.1?;
1\.2\.3\.1?1;1\.2\.3\.4/32;1\.2\.3\.4/24;1\.2\.3\.0/255\.255\.255\.0;
fc00::100;fc00::*;fc00::1*;fc00::1*1;fc00::?;fc00::1?;
fc00::1?1;fc00::100/64

where:

1.2.3.4
Matches only:

1.2.3.4

1.2.3.*
Matches any IPv4 address from:

1.2.3.0 to 1.2.3.255

1.2.3.1*
Matches only these IPv4 address:

• 1.2.3.1

• 1.2.3.10 to 1.2.3.19

• 1.2.3.100 to 1.2.3.199

1.2.3.1*1
Matches only these IPv4 address:

• 1.2.3.101

• 1.2.3.111

• 1.2.3.121

• 1.2.3.131

• 1.2.3.141

• 1.2.3.151

• 1.2.3.161

• 1.2.3.171

• 1.2.3.181

• 1.2.3.191

1.2.3.?
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Matches the IPv4 range:

1.2.3.0 to 1.2.3.9

1.2.3.1?
Matches the IPv4 range:

1.2.3.10 to 1.2.3.19

1.2.3.1?1
Matches only these IPv4 address:

• 1.2.3.101

• 1.2.3.111

• 1.2.3.121

• 1.2.3.131

• 1.2.3.141

• 1.2.3.151

• 1.2.3.161

• 1.2.3.171

• 1.2.3.181

• 1.2.3.191

1.2.3.4/32
Matches only:

1.2.3.4

1.2.3.4/24
Matches the IPv4 range:

1.2.3.0 to 1.2.3.255

1.2.3.0/255.255.255.0
Matches the IPv4 range:

1.2.3.0 to 1.2.3.255

fc00::100
Matches only:

fc00::100

fc00::*
Match the IPv6 range:

fc00:: to fc00::ffff:ffff:ffff:ffff

fc00::1*
Matches only these IPv6 addresses:

• fc00::1
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• fc00::10 to fc00::1f

• fc00::100 to fc00::1ff

• fc00::1000 to fc00::1fff

fc00::1*1
Matches only :

fc00::1001 to 1ff1

fc00::?
Matches the IPv6 range:

fc00::0 to fc00::f fc00::1?

fc00::1?
Matches only:

fc00::10 to fc00::1f

fc00::1?1
Matches only these IPv6 addresses:

• fc00::101

• fc00::111

• fc00::121

• fc00::131

• fc00::141

• fc00::151

• fc00::161

• fc00::171

• fc00::181

• fc00::191

• fc00::1a1

• fc00::1b1

• fc00::1c1

• fc00::1d1

• fc00::1e1

• fc00::1f1

fc00::100/64
Matches the IPv6 range:

fc00:: to fc00::ffff:ffff:ffff:ffff

FilterHost
Specifies the host names selected for the update.
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* matches zero or more allowed characters.

? matches any allowed character exactly one time.

When using * or ? globs the hostname strings are compared literally.
Example: host.example.org;*.example.org;.example.org;host?.example.org where:

host.example.org
Matches only the hostname host.example.org.

*.example.org
Matches any hostname that ends with .example.org.

.example.org
Matches any hostname that ends with .example.org.

host*.example.org.
Matches any hostname that starts with host, followed by any number of characters (valid for
hostname) and ends with .example.org.

Examples:

• host123.example.org

• host2A.example.org

• host-name.example.org

host?.example.org.
Matches any hostname that starts with host, followed by one character and ends with .
example.org.

Examples:

• host1.example.org

• host2.example.org

• hostM.example.org

Dependencies
Specifies which application is closed during the update process.

Configuring the automatic download of file updates

You can configure the update server to use a certain package of updated files.

1. Start Command Prompt.

You must have administrator privileges or the account you use must be in the ipmupdategroup
group. If you are running Command Prompt using an administrator account, make sure that you
select the Run as Administrator option.

2. Type ipmupdateserverctl freeze and press the Enter key to enterMaintenance mode.
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TheMaintenance mode unlocks the product path folder and you can add and remove any files
contained in the product path subdirectories. The InfoPrint Manager server is also temporarily
disabled.

3. To copy all the updated files and the installation location file, create a subdirectory under
<configuration_dir>\Products\<product_dir>\Windows\nn.nn.nn.nn\Files
\update_set, where nn.nn.nn.nn is the version number.

• The default configuration directory is c:\ProgramData\RICOH\InfoPrint Manager Update
Server\.

• update_set represents a folder named of your choice. You must create this folder before
copying the files.

Example: <configuration_dir>\Products\<product_dir>\Windows\nn.nn.nn.nn
\Files\Update_Patch_December

4. Copy all the updated files to the new subdirectory. You can create multiple folders, depending on
how many file sets you want to update.

5. Create a plain text file called ipmupdate.path in the new subdirectory. The ipmupdate.path
file must contain only the location, on the client machine, where the new files must be copied.

Example: c:\ProgramData\RICOH\InfoPrint Manager Update Server\Products
\InfoPrint Select\Windows\nn.nn.nn.nn\Files\Update_Patch_December.

6. Run ipmupdateserverctl unfreeze to exit theMaintenance mode.

Configuring the automatic download of registry updates

To facilitate the installation on multiple machines, you can export the registry settings from a correctly
configured system.

1. Start Command Prompt.

You must have administrator privileges or the account you use must be in the ipmupdategroup
group. If you are running Command Prompt using an administrator account, make sure that you
select the Run as Administrator option.

2. Type ipmupdateserverctl freeze and press the Enter key to enterMaintenance mode.

• TheMaintenance mode unlocks the product path folder and you can add and remove any
files contained in the parent folder. The InfoPrint Manager server is also temporarily disabled.

3. Copy the registry file with updated settings to the Registry folder.
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• The correct registry settings can be exported as a .reg file from Computer\HKEY_LOCAL_
MACHINE\SOFTWARE\RICOH\Infoprint Select\Configuration.

• The default registry folder path is <configuration_dir>\Products\<product_dir>
\Windows\<product_version>\Registry\.

4. Run ipmupdateserverctl unfreeze to exit theMaintenance mode.

Installing and Configuring the Update Server on a Linux system

The InfoPrint Manager client systems can be set up to update automatically. For these client systems to
be automatically updated, you must configure an update server.

InfoPrint Manager lets you configure an automatic updating environment for the client systems. The
updating environment consists of two main components: the update server and the client system
configuration. When an update server is configured, all the client machines can connect to the update
server to install the available updates. Setting up an automatic update system allows all systems to be
up to date with the latest patches.
Before starting to configure the update server settings, you need to install the update server.

1. Insert the InfoPrint Manager for Windows Common Clients DVD-ROM into your DVD-ROM drive.

2. Install ipr-ipmupdateserver-nnnn..nnnn..nnnn--nnnn.x86_64.rpm to install the update server, where nn.
nn.nn-nn is the version number.

To configure the update server settings:

1. Go to the installation directory for the update server.

InfoPrint Manager Update Server configuration directory is /etc/ipmupdateserver.

2. Open the ipm_updateserver.cfg file using a text editor to change the parameters.

product-path
Specifies the location of all product kits, file updates and registry updates that can be
automatically downloaded and installed by client machines.

listen-port
Specifies the port on which the update server communicates with the update client. The
specified port must be opened in the firewall on both server and client machines. For the
server machines, the port number must be configured in the incoming section. For the client
machines, the port number must be configured in the outgoing section. The default port
number is 10000.

client-check-for-updates-interval
Specifies the time interval in seconds that passes between two subsequent checks for new
product updates by the automatic update client machines that communicate with this
automatic update server machine. The default interval is 84600 seconds.

number-postpones-by-user
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Specifies how many times the user on the client machine can postpone a product installation
or update (0 means unlimited number of postpones). Once the product installation
postponing number has been exceeded, the update will be silently installed. During the silent
install, InfoPrint Select is not available until installation ends. The default value is 0.

Products Order
Specifies the update order of listed products. Product updates order priority is separated by
comma. The first product in the list has the highest priority.

Example of ipm_updateserver.cfg file:

[Global Settings]

product-path=/etc/ipmupdateserver/ipm_updateserver.cfg

#the port on which the update server listens to.
listen-port=10000

#the time between the update client checks for updates on the update server machine.
client-check-for-updates-interval=84600

#0 means infinite
number-postpones-by-user=0

#product installation order
Products Order = InfoPrint Select, InfoPrint Manager PDF Driver

3. Restart InfoPrint Manager Update Service for configuration settings to take effect.

4. Create one ore more DNS entries to provide the automatic update service to client machines.

Record Type
Service Location (SRV)

Service
_ipmupdateserver

Protocol
_tcp

Priority
A number between 0 and 65535 that indicates the priority for the host that is specified in
Host offering this service. The host with the lowest preference number have a higher priority.
The host with the highest preference number have a lower priority.

Weight
Not used. Use 0.

Port Number
It must be identical to listen-port from ipm_updateserver.cfg

Host Offering this Service
IP address of the update server.
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Configuring the Update Server on a Linux system with SSL/TLS

By default, InfoPrint Manager Update clients communicate with InfoPrint Manager Update Server
without using any encryption. If it is required a secured communication (SSL/TLS), InfoPrint Manager
Update Server can be configured using these steps:

1. Copy the ipmssl.cfg file from /usr/share/doc/ipr-ipmupdateserver-4.13.0/cfg-
samples/ssl/ to /etc/ipmupdateserver/ssl directory.

2. Edit the ipmssl.cfg file using a text editor to enable and configure the SSL/TLS communication.

For additional information on how to configure SSL/TLS communication, see chapter Enabling
Transport Layer Security encryption for InfoPrint Manager servers for Linux in RICOH InfoPrint Manager for
Linux: Procedures.

3. Restart InfoPrint Manager Update Server.

When configured with TLS/SSL InfoPrint Manager Update Server issues a notification message in
system log every time it starts.

Running InfoPrint Manager Update Server service as a different user

The InfoPrint Manager update server can be set up to run as a different user update automatically.

By default, InfoPrint Manager Update Server is run using the ipmupdate user.

To run the service as a different user follow these steps:

1. Create a different user than ipmupdate to run InfoPrint Manager Update Server service, if it is
not already created.

The shell for the user can also be /sbin/nologin, /bin/false not necessarily /bin/bash or any
interactive shell

2. Make sure that ipmupdategroup is the primary group for the new user. If not, execute this
command to change the primary group:
usermod -g ipmupdategroup new-user

Where new-user is the user newly created.

3. Stop the service using this command:
systemctl stop ipmupdateserver

4. Disable the service using this command:
systemctl disable ipmupdateserver

5. Change the owner for directory /var/log/ipmupdateserver:
chown -R new-user:ipmupdategroup /var/log/ipmupdateserver

Where new-user is the user newly created.
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If SSL/TLS is used by ipmupdateserver, make sure that the new user can read the SSL key and
certificate files. Also, make sure that the new user can read configuration files found in /etc/
ipmupdateserver directory.

6. Create directory /etc/systemd/system/ipmupdateserver.service.d using this command:
mkdir /etc/systemd/system/ipmupdateserver.service.d

7. Add the user directive to the /etc/systemd/system/ipmupdateserver.service.d/
override.conf file:

[Service]
User=new-user

8. Reload the system using this command:
systemctl daemon-reload

9. Re-enable the service using this command:
systemctl enable ipmupdateserver

10. To start the InfoPrint Manager Update Server service, run systemctl start ipmupdateserver.

Do not remove the ipmupdate user as it will be created the next time you update InfoPrint Manager
Update Server rpm package.

Running InfoPrint Manager Update Server service control utility on Linux

You can control the operation of InfoPrint Manager Update using the ipmupdateserverctl tool.

Only users in the ipmupdategroup group can run ipmupdateserverctl executable to issue
commands to InfoPrint Manager Update Server.

The ipmupdateserverctl utility calculates the files checksum and control files and directories
permissions in the InfoPrint Manager Update Server product-path directory. The product-path
directory is specified in the /etc/ipmupdateserver/ipm_updateserver.cfg file.

By default, InfoPrint Manager Update Server runs as ipmupdate user. The ipmupdate user has no
password set. To login as ipmupdate user, you must set a password. For security reasons, we
recommend that you do not set a password for ipmupdate user, change the shell for the ipmupdate
user to /sbin/nologin and use a different user to control the InfoPrint Manager Update Server service
using the ipmupdateserverctl utility.

To add a user to group ipmupdategroup, run this command:

usermod -a -G ipmupdategroup another-user

where another-user is the user that controls the InfoPrint Manager Update Server service.

These arguments are allowed for ipmupdateserverctl:

freeze
ipmupdateserverctl notifies ipmupdateserver to temporary stop any requests for Infoprint
Manager Update clients. When ipmupdateserver acknowledges the operation, it removes all
checksums and allows you to modify the files and directories in ipmupdateserver database.
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If you freeze ipmupdateserver database and the then restart ipmupdateserver, the service starts
without providing any updates for Infoprint Manager Update clients. You must freeze and unfreeze
the database to continue providing updates.

unfreeze
ipmupdateserverctl calculates the checksum for every file in the ipmupdateserver database
and removes the modify access permissions for files and directories. Then, it notifies
ipmupdateserver to resume any requests for Infoprint Manager Update clients.

status
ipmupdateserverctl queries and displays the status of ipmupdateserver.

Configuring the automatic download of InfoPrint Select for Windows from a
Linux update server

1. Run ipmupdateserverctl freeze to enterMaintenance mode.

TheMaintenance mode unlocks the product path folder and you can add and remove any files
contained in the parent folder. The InfoPrint Manager server is also temporarily disabled.

2. Copy ipm_select.cfg from /usr/share/doc/ipr-ipmupdateserver-nn.nn.nn/cfg-
samples/ipm_select.cfg to /etc/ipmupdateserver/.

3. Edit the ipm_select.cfg file to specify the global settings and create filters.

4. Copy the InfoPrint Select kit from the InfoPrint Manager Common Clients DVD to /var/lib/
ipmupdateserver/Products/InfoPrint Select/Windows/nn.nn.nn.nn/Kit.

5. Copy the response files and installation scripts from /usr/share/doc/ipr-ipmupdateserver-
nn.nn.nn/cfg-samples/scripts/ to /var/lib/ipmupdateserver/Products/InfoPrint
Select/Windows/nn.nn.nn.nn/Kit, where nn.nn.nn.nn is the version number.

• The installation scripts are install_InfoPrint_Select_new.cmd, install_InfoPrint_
Select_repair.cmd, install_InfoPrint_Select_update.cmd.

• The response files are setup_new.iss, setup_update.iss, setup_repair.iss.

6. Run ipmupdateserverctl unfreeze to exitMaintenance mode.
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Sample ipm_select.cfg file

ProductName
The name of the product to be updated.

Platform
The operating system of the product.

Current Version
The version number of the base product.

local-registry-version-key
The registry key of the product.

local-registry-version_value
The registry key value of the product.

install-new-cmdline
Install the update as a new installation of the product.

install-update-cmdline
Install the update as a product patch. The product remains installed.

install-repair-cmdline
Install the update using the repair process. The product remains installed but the core files and
registry files are reinstalled too.

ProductAvailable
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Specifies if the update is available or not for client systems. Can be specified globally or in a
specific filter. The filter section take priority over the global section.

FilterIP
Specifies the IP addresses or ranges of IP addresses selected for the update.

* matches zero or more allowed characters.

? matches any allowed character exactly one time.

When using * or ? globs the IP address strings are compared literally.

For example IPv6 address fc00::100 matches filter fc00::1* but not the filter fc00::01*. Since the
operating system never returns an IPv6 address in the format fc00::0100, but fc00::100, the filter
fc00::01* never matches.

Example: 1.2.3.4;1.2.3.*;1.2.3.1*;1.2.3.1*1;1.2.3.?;1.2.3.1?;1.2.3.1?1;1.2.3.4/32;1.2.3.4/
24;1.2.3.0/255.255.255.0;fc00::100;fc00::*;fc00::1*;fc00::1*1;fc00::?;fc00::1?;fc00::1?1;
fc00::100/64 where:

1.2.3.4
Matches only:

1.2.3.4

1.2.3.*
Matches any IPv4 address from:

1.2.3.0 to 1.2.3.255

1.2.3.1*
Matches only these IPv4 address:

• 1.2.3.1

• 1.2.3.10 to 1.2.3.19

• 1.2.3.100 to 1.2.3.199

1.2.3.1*1
Matches only these IPv4 address:

• 1.2.3.101

• 1.2.3.111

• 1.2.3.121

• 1.2.3.131

• 1.2.3.141

• 1.2.3.151

• 1.2.3.161

• 1.2.3.171

• 1.2.3.181

• 1.2.3.191
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1.2.3.?
Matches the IPv4 range:

1.2.3.0 to 1.2.3.9

1.2.3.1?
Matches the IPv4 range:

1.2.3.10 to 1.2.3.19

1.2.3.1?1
Matches only these IPv4 address:

• 1.2.3.101

• 1.2.3.111

• 1.2.3.121

• 1.2.3.131

• 1.2.3.141

• 1.2.3.151

• 1.2.3.161

• 1.2.3.171

• 1.2.3.181

• 1.2.3.191

1.2.3.4/32
Matches only:

1.2.3.4

1.2.3.4/24
Matches the IPv4 range:

1.2.3.0 to 1.2.3.255

1.2.3.0/255.255.255.0
Matches the IPv4 range:

1.2.3.0 to 1.2.3.255

fc00::100
Matches only:

fc00::100

fc00::*
Match the IPv6 range:

fc00:: to fc00::ffff:ffff:ffff:ffff

fc00::1*
Matches only these IPv6 addresses:
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• fc00::1

• fc00::10 to fc00::1f

• fc00::100 to fc00::1ff

• fc00::1000 to fc00::1fff

fc00::1*1
Matches only :

fc00::1001 to fc00::1ff1

fc00::?
Matches the IPv6 range:

fc00::0 to fc00::f

fc00::1?
Matches only:

fc00::10 to fc00::1f

fc00::1?1
Matches only these IPv6 addresses:

• fc00::101

• fc00::111

• fc00::121

• fc00::131

• fc00::141

• fc00::151

• fc00::161

• fc00::171

• fc00::181

• fc00::191

• fc00::1a1

• fc00::1b1

• fc00::1c1

• fc00::1d1

• fc00::1e1

• fc00::1f1

fc00::100/64
Matches the IPv6 range:

fc00:: to fc00::ffff:ffff:ffff:ffff

FilterHost
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Specifies the host names selected for the update.

* matches zero or more allowed characters.

? matches any allowed character exactly one time.

When using * or ? globs the hostname strings are compared literally.

Example: host.example.org;*.example.org;.example.org;host?.example.org where:

host.example.org
Matches only the hostname host.example.org.

*.example.org
Matches any hostname that ends with .example.org.

.example.org
Matches any hostname that ends with .example.org.

host*.example.org.
Matches any hostname that starts with host, followed by any number of characters (valid for
hostname) and ends with .example.org.

Examples:

• host123.example.org

• host2A.example.org

• host-name.example.org

host?.example.org.
Matches any hostname that starts with host, followed by one character and ends with .example.
org.

Examples:

• host1.example.org

• host2.example.org

• hostM.example.org

Dependencies
Specifies which application is closed during the update process.

Configuring the automatic download of InfoPrint Manager PDF Driver for
Windows from a Linux update server

1. Run ipmupdateserverctl freeze to enterMaintenance mode.

TheMaintenance mode unlocks the product path folder and you can add and remove any files
contained in the parent folder. The InfoPrint Manager server is also temporarily disabled.

2. Copy ipm_driver.cfg from /usr/share/doc/ipr-ipmupdateserver-nn.nn.nn/cfg-
samples/ to /etc/ipmupdateserver/, where nn.nn.nn is the version number.
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3. Edit the ipm_driver.cfg file to specify the global settings and create filters. See Sample ipm_
driver.cfg, p. 239 for more details about the configuration file.

4. Unzip the contents of InfoprintManagerPDFdriver.zip file from the InfoPrint Manager Common
Clients DVD to /var/lib/ipmupdateserver/Products/InfoPrint Manager PDF Driver/
Windows/<product_version>/Kit/.

5. Copy Visual Studio 2013 Redistributable kit from from the InfoPrint Manager Common Clients
DVD to /var/lib/ipmupdateserver/Products/InfoPrint Manager PDF Driver/Windows/
product_version/Kit/.

6. Run ipmupdateserverctl unfreeze to exitMaintenance mode.

Sample ipm_driver.cfg file

ProductName
The name of the product to be updated.

Platform
The operating system of the product.

Current Version
The version number of the base product.

local-registry-version-key
The registry key of the product.

local-registry-version_value
The registry key value of the product.

install-new-cmdline
Install the update as a new installation of the product.

install-update-cmdline
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Install the update as a product patch. The product remains installed.

install-repair-cmdline
Install the update using the repair process. The product remains installed but the core files and
registry files are reinstalled too.

ProductAvailable
Specifies if the update is available or not for client systems. Can be specified globally or in a
specific filter. The filter section take priority over the global section.

FilterIP
Specifies the IP addresses or ranges of IP addresses selected for the update.

* matches zero or more allowed characters.

? matches any allowed character exactly one time.

When using * or ? globs the IP address strings are compared literally.

For example IPv6 address fc00::100 matches filter fc00::1* but not the filter fc00::01*. Since the
operating system never returns an IPv6 address in the format fc00::0100, but fc00::100, the filter
fc00::01* never matches.

Example:

1\.2\.3\.4;1\.2\.3\.*;1\.2\.3\.1*;1\.2\.3\.1*1;1\.2\.3\.?;1\.2\.3\.1?;
1\.2\.3\.1?1;1\.2\.3\.4/32;1\.2\.3\.4/24;1\.2\.3\.0/255\.255\.255\.0;
fc00::100;fc00::*;fc00::1*;fc00::1*1;fc00::?;fc00::1?;
fc00::1?1;fc00::100/64

where:

1.2.3.4
Matches only:

1.2.3.4

1.2.3.*
Matches any IPv4 address from:

1.2.3.0 to 1.2.3.255

1.2.3.1*
Matches only these IPv4 address:

• 1.2.3.1

• 1.2.3.10 to 1.2.3.19

• 1.2.3.100 to 1.2.3.199

1.2.3.1*1
Matches only these IPv4 address:

• 1.2.3.101

• 1.2.3.111

• 1.2.3.121
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• 1.2.3.131

• 1.2.3.141

• 1.2.3.151

• 1.2.3.161

• 1.2.3.171

• 1.2.3.181

• 1.2.3.191

1.2.3.?
Matches the IPv4 range:

1.2.3.0 to 1.2.3.9

1.2.3.1?
Matches the IPv4 range:

1.2.3.10 to 1.2.3.19

1.2.3.1?1
Matches only these IPv4 address:

• 1.2.3.101

• 1.2.3.111

• 1.2.3.121

• 1.2.3.131

• 1.2.3.141

• 1.2.3.151

• 1.2.3.161

• 1.2.3.171

• 1.2.3.181

• 1.2.3.191

1.2.3.4/32
Matches only:

1.2.3.4

1.2.3.4/24
Matches the IPv4 range:

1.2.3.0 to 1.2.3.255

1.2.3.0/255.255.255.0
Matches the IPv4 range:

1.2.3.0 to 1.2.3.255

fc00::100
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Matches only:

fc00::100

fc00::*
Match the IPv6 range:

fc00:: to fc00::ffff:ffff:ffff:ffff

fc00::1*
Matches only these IPv6 addresses:

• fc00::1

• fc00::10 to fc00::1f

• fc00::100 to fc00::1ff

• fc00::1000 to fc00::1fff

fc00::1*1
Matches only :

fc00::1001 to 1ff1

fc00::?
Matches the IPv6 range:

fc00::0 to fc00::f fc00::1?

fc00::1?
Matches only:

fc00::10 to fc00::1f

fc00::1?1
Matches only these IPv6 addresses:

• fc00::101

• fc00::111

• fc00::121

• fc00::131

• fc00::141

• fc00::151

• fc00::161

• fc00::171

• fc00::181

• fc00::191

• fc00::1a1

• fc00::1b1

• fc00::1c1
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• fc00::1d1

• fc00::1e1

• fc00::1f1

fc00::100/64
Matches the IPv6 range:

fc00:: to fc00::ffff:ffff:ffff:ffff

FilterHost
Specifies the host names selected for the update.

* matches zero or more allowed characters.

? matches any allowed character exactly one time.

When using * or ? globs the hostname strings are compared literally.
Example: host.example.org;*.example.org;.example.org;host?.example.org where:

host.example.org
Matches only the hostname host.example.org.

*.example.org
Matches any hostname that ends with .example.org.

.example.org
Matches any hostname that ends with .example.org.

host*.example.org.
Matches any hostname that starts with host, followed by any number of characters (valid for
hostname) and ends with .example.org.

Examples:

• host123.example.org

• host2A.example.org

• host-name.example.org

host?.example.org.
Matches any hostname that starts with host, followed by one character and ends with .
example.org.

Examples:

• host1.example.org

• host2.example.org

• hostM.example.org

Dependencies
Specifies which application is closed during the update process.
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Configuring the automatic download of file updates from a Linux update server

You can configure the update server to use a certain package of updated files.

1. Run ipmupdateserverctl freeze to enterMaintenance mode.

TheMaintenance mode unlocks the product path folder and you can add and remove any files
contained in the parent folder. The InfoPrint Manager server is also temporarily disabled.

2. Create a subdirectory under /var/lib/ipmupdateserver/Products/InfoPrint Select/
Windows/nn.nn.nn.nn/Files/update_set to copy all the updated files and the installation
location file.

• update_set represents a folder named of your choice. You must create this folder before
copying the files.

• nn.nn.nn.nn represents the version number.

Example: /var/lib/ipmupdateserver/Products/InfoPrint Select/Windows/nn.nn.
nn.nn/Files/Update_Patch_December

3. Copy all the updated files to the new subdirectory. You can create multiple folders, depending on
how many file sets you want to update.

4. Create a plain text file called ipmupdate.path in the new subdirectory. The ipmupdate.path
file must contain only the location, on the client machine, where the new files must be copied.

Example:

C:\WINDOWS\SYSTEM32

5. Run ipmupdateserverctl unfreeze to exitMaintenance mode.

Configuring the automatic download of registry updates from a Linux update
server

To facilitate the installation on multiple machines, you can export the registry settings from a correctly
configured machine.

1. Run ipmupdateserverctl freeze to enterMaintenance mode.

TheMaintenance mode unlocks the product path folder and you can add and remove any files
contained in the parent folder. The InfoPrint Manager server is also temporarily disabled.

2. Copy the registry file with updated settings to the Registry folder.

• The new registry settings can be exported as a .reg file using regedit.exe. Export the registry
key HKEY_LOCAL_MACHINE\SOFTWARE\RICOH\Infoprint Select\Configuration.

• The default Registry directory is /var/lib/ipmupdateserver/Products/InfoPrint
Select/Windows/nn.nn.nn.nn/Registry where nn.nn.nn.nn is the version number.
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3. Run ipmupdateserverctl unfreeze to exitMaintenance mode.

IInnssttaalllliinngg IInnffooPPrriinntt MMaannaaggeerr UUppddaattee
The InfoPrint Manager client systems can be automatically updated using an update application.

InfoPrint Manager Update is installed on all the client machines where any update is required. Installing
the InfoPrint Manager Update application allows the update server to connect to the client machine and
install any available update.

To install the automatic update client:

1. Insert the InfoPrint Manager for Windows Common Clients DVD-ROM into your DVD-ROM drive.

2. Click InfoPrintManagerUpdate.exe to install the update client.

3. Select the destination folder. The default destination folder is C:\Program Files\RICOH
\InfoPrint Manager Update.

4. Click Finish to complete the installation process.

When a product update is available, you are prompted to install or to postpone the update process.
Postponing an update will close the update installer and it will retry after 24 hours. If the update process
fails, contact the system administrator.

Installing InfoPrint Manager Update
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AAcccceessssiibbiilliittyy
Ricoh strives to provide products with usable access for everyone, regardless of age or ability. For more
information about the commitment that we have made to accessibility, see: https://www.ricoh-usa.
com/en/about-us/corporate-responsibility-and-environmental-sustainability/accessibility.

Accessibility features

Accessibility features help users who have disabilities, such as restricted mobility or limited vision, use
information technology products successfully.

The major accessibility features in this product let you:

• Use screen readers, screen magnifiers, and other assistive technologies.

• Use a keyboard instead of a mouse.

• Change attributes such as volume, color, contrast, and font size.

In addition, the information center and the publications for the product are in an accessible format.

Keyboard navigation

This product uses standard Microsoft Windows navigation keys.

GGlloossssaarryy
This glossary defines technical terms and abbreviations used in InfoPrint Manager.

Special Characters

.Guidefaults file
A file created by InfoPrint in the home directory of a person using the InfoPrint GUI. InfoPrint uses
this file to save and reference information about the servers you are monitoring and the windows
you are working in.

A

Access Control List (ACL)
In computer security, a collection of all access rights for one object.

ACL
Access Control List.

acl editor
A command line interface that lets you view, add, update, and delete access authorization records
in an ACL.

action
In the InfoPrint GUI, an icon that represents an operation that you can perform on an InfoPrint
object. You drag and drop the action onto an object to initiate the operation for that object. For
example, using the Enable action to enable a disabled actual destination.

actual destination

https://www.ricoh-usa.com/en/about-us/corporate-responsibility-and-environmental-sustainability/accessibility
https://www.ricoh-usa.com/en/about-us/corporate-responsibility-and-environmental-sustainability/accessibility


In InfoPrint, an object that represents the output device that performs the printing or transmission
function. See email destination; see also physical printer, printer device; contrast with logical destination.

additive color system
A system that reproduces an image by mixing (adding) appropriate quantities of red, green, and
blue light (the additive primary colors) to create all other colors of light, either direct or transmitted.
When the additive primaries are superimposed on one another, they create white light. Contrast
with subtractive color system.

administrator
In InfoPrint, the person who creates and manages one or more components of a printing system,
such as servers and actual destinations. By default, InfoPrint gives administrators authorization to
perform some InfoPrint operations and to access certain information that is not available to the
operators or job submitters.

Adobe Acrobat
An Adobe software program that provides instant access to documents in their original format,
independent of computer platform. With the Adobe Reader, you can view, navigate, print, and
present any Portable Document Format (.pdf) file.

Adobe PageMaker
A desktop publishing program that produces PostScript documents.

Adobe PostScript Raster to Image Transform (RIP)
See raster image processor (RIP).

ADSM/6000
Advanced Distributed Storage Manager.

Advanced Distributed Storage Manager (ADSM/6000)
A program that provides storage management for archived files.

Advanced Function Common Control Unit (AFCCU)
A RISC-based control unit with code common to all printers that use the AFCCU.

Advanced Function Presentation (AFP)
A set of licensed programs, together with user applications, that use the all-points-addressable
concept to print data on a wide variety of printers or to display data on a wide variety of display
devices. AFP includes creating, formatting, archiving, retrieving, viewing, distributing, and printing
information.

Advanced Function Presentation data stream (AFP data stream)
The printer data stream used for printing AFP data. The AFP data stream includes composed text,
page segments, electronic overlays, form definitions, and fonts downloaded from the operating
system to the printer.

A presentation data stream that is processed in AFP environments. The AFP data stream includes
MO:DCA-P-based data streams.

Advanced Interactive Executive (AIX)
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An operating system used with pSeries computers. The AIX operating system is IBM's implementation
of the UNIX operating system.

AFCCU
Advanced Function Common Control Unit.

AFP
Advanced Function Presentation.

AFP data stream
Advanced Function Presentation data stream.

ainbe
The printer input/output backend program used by the PSF DSS to send jobs to printer devices.
Depending on the incoming data stream of the job, the PSF DSS might have transformed the data
stream of the job before the backend program sending it to the printer device.

AIX
Advanced Interactive Executive.

AIX-attached printer
A printer device, attached to an pSeries computer through the network or through a serial or
parallel port that receives jobs from an AIX print queue.

In InfoPrint, a PSF physical printer that represents an AIX-attached printer device. See also direct-
attached printer, TCP/IP-attached printer, upload-TCP/IP-attached printer.

AIX destination support system
In InfoPrint, the destination support system that communicates with the standard AIX print backend
(piobe), or with certain variations of the rembak print backend, to print jobs.

AIX physical printer
In InfoPrint, the object representing a printer device that uses the AIX destination support system.

aliasing
In a digitized image, the creation of diagonal lines by combining short horizontal and vertical line
segments that approximate the path of the desired line.

all-points-addressability (APA)
The capability to address, reference, and position text, overlays, and images at any defined point of
the printable area of the paper or display medium.

alphameric
Synonym for alphanumeric.

alphanumeric
Pertaining to a character set containing letters, digits, and other symbols such as punctuation marks.
Synonymous with alphameric.

AMPV
Average monthly print volume.
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analog
Pertaining to a continuous variable sampling of information between two points that achieves an
even, smooth transition of photographic material.

analog color proof
An off-press color proof made from separation films.

anti-aliasing
The rendering of hard-edged objects so that they blend smoothly into the background. PhotoShop
offers anti-aliasing when rasterizing an EPS file.

Removing the jagged “stairstep” quality in diagonal lines produced on a computer screen by
aliasing. This removal is effected by creating less densely shaded fields parallel to the diagonal line.

APA
All-points-addressability.

API
Application Program Interface.

Application Program Interface (API)
The call interface between a client program and the procedures that implement the printing system,
as defined by the specification. Clients use the API to access servers. (P)

architecture
The set of rules and conventions that govern the creation and control of data types such as text,
image, graphics, font, color, audio, bar code, and multimedia.

archiving
The transfer of digital information from an online system onto floppy disk, compact disc, or other
media for offline storage. The original copy is deleted from the online system. See also retrieval.

array inkjet
An ordered collection of multiple print heads used in an inkjet printer.

ASCII
American National Standard Code for Information Exchange. The standard code, using a coded
character set consisting of 7–bit coded characters (8 bits including a parity check). The ASCII code
is used for information exchange among data processing systems, data communications systems,
and associated equipment. The ASCII character set includes control characters and graphic
characters.

asynchronous
Pertaining to two or more processes that do not depend upon the occurrence of specific events,
such as common timing signals. (T)

In InfoPrint, occurring without a regular or predictable time relationship to a specified action.
Contrast with synchronous.

attachment type

266



Defines the method by which a printer device is attached to the AIX system from which it receives
data. See AIX-attached printer, direct-attached printer, TCP/IP-attached printer, and upload-TCP/IP-attached
printer.

attribute
A defined characteristic of an object, such as the number of copies required of a job, or the
document formats accepted by an actual destination.

attribute name
A string that identifies an attribute. Typically, in InfoPrint attribute names consist of two or more
words separated by hyphens.

attribute value
The element of an attribute that specifies the characteristics relating to the attribute.

authorization
In computer security, verification of the eligibility of a user to access an object.

authorized user
A person with the appropriate permissions to access an object or to issue a command.

automatic recovery
A function of printer logic that permits the printer to reprint a job if the job is misprinted or damaged
or if a component has failed.

auxiliary sheet
In InfoPrint, an object that represents a particular sheet of paper, blank or otherwise, that can
precede a job, separate documents in a job, or follow a job.

auxiliary-sheet selections
A particular combination of start, separator, and end sheets that print with jobs on a particular
printer device.

B

backend
In AIX or Linux, the program that is invoked by the qdaemon process (AIX) or CUPS printing system
( Linux) to run a print or batch job. Synonymous with backend program.

backend program
Synonym for backend.

backlog
In InfoPrint, the amount of time calculated by InfoPrint that is required to print all of the jobs currently
in a queue.

backspace
In InfoPrint, the action used to back up and reprint pages in a job.

bar code
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A code representing characters by sets of parallel bars of varying thickness and separation that are
read optically by transverse scanning.

An array of parallel rectangular bars and spaces that together represent data elements or
characters in a particular symbology. The bars and spaces are arranged in a predetermined pattern
following unambiguous rules defined by the symbology.

BCOCA
Bar Code Object Content Architecture.

Bezier curves
A method of defining curves using anchor points, control handles, and tangent lines. The PostScript
path passes through anchor points. Its approach direction is along the tangent lines that are
controlled by the control handles. Many personal computer programs use this drawing method.
Type 1 PostScript fonts are defined using Bezier curves.

binding
The cover and materials that hold a book together. See edition binding, perfect binding, spiral binding,
wire-o binding.

The process of applying the binding to a book.

In InfoPrint, assigning a job to an actual destination. See early binding, late binding.

bitmapped
Pertaining to an image formed by a rectangular grid of pixels. Each pixel is assigned a value to
denote its color. One-bit images are black and white; 8–bit images have 256 colors (or grays);
24–bit images have full color. CMYK images have 32–bits per pixel to encode 256 levels in each
of four channels. Bitmapped images are also called raster images.

bleed
An extra amount of printed image that extends beyond the trim edge of the sheet. Bleed ensures that
no white gap appears at the edge of the sheet.

boot
To prepare a computer for operating by loading an operating system.

BSD
Berkeley Software Distribution.

BSD destination support system
In InfoPrint, the destination support system that generates a print command string that the shell runs
to print jobs.

BSD physical printer
In InfoPrint, the object representing a printer device that uses the BSD destination support system.

burn
In platemaking, an exposure. Burn is named because of the extremely bright ultraviolet lamps used
to transfer images from film to plate.

In photography, to lengthen the final exposure time to increase the final density of print.
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C

CDE
Common Desktop Environment.

child
See parent/child relationship.

choke
In color printing, an area whose dimensions have been reduced to avoid overlapping another
color. Contrast with spread.

class
Synonym for object class.

clean
In InfoPrint, an action used to remove all the jobs from specified servers, actual destinations, or
queues, or to remove all the jobs submitted to specified logical destinations.

CLI
Command Line Interface.

client
In InfoPrint, the component of the print system that assembles a print request and submits the request
to a server. The client generates the local ID numbers for each job, submits the jobs to the servers,
and keeps track of where each user's jobs have been submitted.

CMR
Color Management Resource.

CMY
Cyan, magenta, yellow.

CMYK
Cyan, magenta, yellow, black.

collator
In some printers a special-purpose hard drive disk array used to store RIPped files and later transfer
them to the LED print heads for imaging.

color balance
The relative levels of cyan, magenta, and yellow channels in an image to produce accurate color
rendition of an original image.

color correction
The adjustment of the color balance in an image to produce accurate color rendition of an original
image. Color correction is used for two- or three-spot-color jobs.

color key
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A color proof similar to Cromalin, but typically not laminated and not necessarily accurate in color.
Color keys are used to verify that breaks or color assignments and traps have been made
accurately.

Color management resource
Color management resource (CMR) is an architected resource that is used to carry all of the color
management information required to render a print file, document, group of pages or sheets, page,
or data object with color fidelity.

Command Line Interface (CLI)
A type of user interface where commands are specified on the command line. Contrast with
Graphical User Interface.

Common Desktop Environment (CDE)
A graphical user interface running on a UNIX operating system.

complex attribute
In InfoPrint, an attribute that can have multiple values with each value containing multiple
components.

constant data
Data that does not change between copies of a document and that is merged with variable data to
produce personalized documents. For example, a form letter (constant data) can be merged with a
customer's name and address (variable data).

contextual help
A type of online help that provides specific information about each selectable object, menu choice,
notebook tab, field, control, and pushbutton in a window.

control strip
A strip of information that can be attached to a print job and used to measure registration and
density.

Cromalin
The Dupont color proofing system. Four layers (CMYK) of light-sensitive material are exposed
through final halftone negative films, then laminated together on an opaque backing to produce a
color- and trap-accurate final proof showing actual halftone dot structure. Cromalin is sometimes
called an analog proof.

crop
To remove unwanted areas of an image, usually indicated by crop marks on the original.

CTS
Cutter-trimmer-stacker.

CUPS
Common Unix Printing System is a modular printing system for Unix-like computer operating systems
which allows a computer to act as a print server. A computer running CUPS is a host that can accept
print jobs from client computers, process them, and send them to the appropriate printer.

CUPS destination support system
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In InfoPrint, the destination support system that communicates with the standard LINUX print system
(CUPS) and that uses InfoPrint Manager pioinfo backend, InfoPrint Manager piorpdm backend
for Ricoh printers or other print backends to print jobs.

cutter-trimmer-stacker (CTS)
A post-processing device attached to a printer device and used for paper handling.

cyan, magenta, yellow (CMY)
The subtractive primary colors.

cyan, magenta, yellow, black (CMYK)
The four basic colors used in offset printing, as opposed to the three basic colors of light: red, green,
and blue. Magenta, yellow, and cyan are the subtractive primaries. Black is added to provide
better density and to produce a true black.

D

daemon
A program that runs unattended to perform a standard service. Some daemons are triggered
automatically to perform their tasks; others operate periodically. Daemon processes generally
provide a service that must be available at all times to more than one task or user, such as sending
data to a printer.

data stream
All information (data and control commands) sent over a data link.

A continuous stream of data that has a defined format.

In InfoPrint, pertaining to the incoming format of the job and the output format required by the
printer device. InfoPrint transforms the incoming format into the output format, as required. See also
document format.

DB2*/6000
DataBase 2/6000.

deadline
In InfoPrint, a queuing technique where the next job assigned to the first position in the queue is the
one whose deadline is closest. Contrast with FIFO (first-in-first-out), job-priority, longest-job-first, and
shortest-job-first.

default document
In InfoPrint, an object that represents default attribute values for a document in a job. Synonymous
with initial value document.

default job
In InfoPrint, an object that represents default attribute values for a job. Synonymous with initial value
job.

default object
In InfoPrint, a general term that refers either to a default document or a default job. Synonymous with
initial value object.

default value

271



A value stored in the system that is used when no other value is specified.

delete
In InfoPrint, an action used to delete default objects, jobs, logical destinations, actual destinations,
or queues from the server.

desktop publishing
Performing print-related activities on a personal computer, including but not limited to layout,
design, photo manipulation, creating fonts, editing text, color separation, scanning, and animation.

destination
See actual destination, logical destination.

destination support system (DSS)
In InfoPrint, the programs that an actual destination uses to communicate with the output device.
Synonymous with device support system. See AIX destination support system, BSD destination support
system, email destination support system, and PSF destination support system.

device
An individual piece of equipment (hardware) that attaches to a computer, such as a printer device.

device address
The identification of an input or output device by its channel and unit number.

device driver
A file that communicates with a specific device such as a printer, disk drive, or display. An
application that sends output to a device controls the actions of the device through the device driver.
See printer driver.

device support system (DSS)
Synonym for destination support system.

DFE
Digital Front End

DFE destination support system
In InfoPrint Manager, the destination support system that communicates with a DFE print server
driving a Ricoh printer.

DFE printer
In InfoPrint Manager, the object representing a DFE print server driving a Ricoh printer.

DFS
Distributed File Service.

digital
Pertaining to data represented by digits, sometimes with special characters and the space character.

digital color proof
An off-press color proof made from a color printer attached to a computer.
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digital printing
A filmless and plateless printing process in which digital data for each page is transferred directly to
a light-sensitive drum and then to paper for a final image.

direct-attached printer
A printer device, attached to an pSeries computer through the network or through a serial or
parallel port.

In InfoPrint, a PSF physical printer that represents a direct-attached printer device. See also AIX-
attached printer, TCP/IP-attached printer, and upload-TCP/IP-attached printer.

disable
In InfoPrint, an action used to stop the acceptance of jobs on destinations, queues, or servers, or to
stop writing information to logs.

distributed print system
A computer system with the ability to interchange print data and controls among different computing
environments with the intent of printing the data on a different system from the one where the print
request was generated. For example, in host-to-LAN distributed printing, data that is located on the
host is printed on printers attached to a local area network.

dithering
A technique of filling the gap between two pixels with another pixel having an average value of the
two to minimize the difference or to add detail to smooth the result.

document
In InfoPrint, an object representing a grouping of data in a job. A job can contain one or more
documents. The documents in a job can differ from each other in some ways. For example, they can
contain different data and can have different document formats. A document in a job can contain
printable data or a resource that is not printable by itself. See file-reference document, printable
document, and resource document.

document element
A portion of a document at least a single page in size.

document format
In InfoPrint, a document format describes the type of the data and control characters in the
document, such as line data or PostScript. The format of the data determines which printer devices
are capable of printing the document and whether InfoPrint must transform the format.

document identifier
A string that identifies a document in a job. It consists of a job ID followed by a period (.) and a
document sequence number. For example, 12.2. Document sequence numbers are integers starting
at 1.

Document Printing Application (DPA)
An ISO/IEC 10175 standard that addresses those aspects of document processing that enable
users in a distributed open systems environment to send electronic documents to shared, possibly
geographically-dispersed printers. InfoPrint supports the DPA standard.

document transfer method
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In InfoPrint, the transfer method describes how documents are transferred to, or acquired by,
servers. See pipe-pull and with-request.

document type
In InfoPrint, the document type describes the kind of data in the document. A printable document can
only contain printable data. A resource document can only contain data such as fonts or form
definitions that are not printable. A file reference document can only contain names of files entered on
separate lines.

dot
The individual elements of a halftone.

dot gain
An increase in the size of a halftone dot during printing, caused by ink spreading. Generally, this
value is known precisely, and the scanning and filming production process is calibrated to
compensate for it. The Cromalin proofing system simulates this effect.

dots per inch (dpi)
A measure of data density per unit distance. Typical values for desktop publishing range from 200
to 300 dpi.

DPA
Document Printing Application.

DPF
Distributed Print Facility.

dpi
Dots per inch.

drag and drop
In graphical user interfaces, a procedure by which you perform actions and tasks. Using the mouse,
you drag (move) an action or object icon to a new position where you want the action or task to
occur.

DSS
Destination support system.

dummy
A rough paste-up or hand-drawn representation of the anticipated finished product. A dummy is
used for basic design and pagination.

duplex printing
Printing on both sides of the paper. Contrast with simplex printing (1).

Printing on both sides of the paper, placing output images on the media in a head-to-head format,
so that the top of one image is at the same edge as the top of the next image. Contrast with tumble
duplex printing; see also simplex printing (2).

E

early binding
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In InfoPrint, assigning a job to an actual destination as soon as it is accepted. Early binding permits
InfoPrint to estimate the time when the job will be completed. Contrast with late binding.

edition binding
A type of book binding in which printed sheets are folded into 16- or 32-page signatures. Four-
page endleaves are pasted on the outside of the first and last signature. The signatures are then
collated by machine and sewn together using special sewing machines. Contrast with perfect
binding, spiral binding, and wire-o binding.

electronic document
A document stored in a computer instead of printed on paper.

electronic mail
Correspondence in the form of messages sent between workstations over a network. Synonymous
with email.

electrophotographic
Pertaining to a type of printer technology that creates an image on paper by uniformly charging the
photoconductor, creating an electrostatic image on the photoconductor, attracting negatively
charged toner to the discharged areas of the photoconductor, and transferring and fusing the toner
to paper.

em
In composition, a unit of measurement exactly as wide and as high as the point size of the font
being set. The name is derived from the fact that the letter M in early typefaces was usually cast on
a square body.

email
Electronic mail.

email destination
In InfoPrint, an actual destination representing an electronic mailing system.

email destination support system
In InfoPrint, the destination support system that supports email destinations.

embellishments
Variable data added to all copies of assembled pages to make the unit appear like a whole; for
example, headers, footers, a table of contents, and chapter separations.

en
In composition, exactly one-half an em.

enable
In InfoPrint, the action that makes a destination, queue, or server able to accept jobs, or a log able
to accept information.

end sheet
The sheet of paper, blank or otherwise, that can follow a job. See also auxiliary sheet.

Enhanced X-Windows
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A tool designed to permit multiple application processes to operate in multiple windows displayed
on a virtual terminal. See X-Windows.

environment variable
Any one of a number of variables that describe the way an operating system runs and the devices it
recognizes.

error log
A data set or file in a product or system where error information is stored for later access.

estimate
The professional cost analysis made by a print shop in response to a customer's request for a price
quotation on a print job.

event
In InfoPrint, an occurrence in the printing system during an operation; for example, the completion
of a command.

event log
In InfoPrint, a collection of messages about events that have occurred.

event notification
The notification that is sent by InfoPrint for an event.

F

Federated Authentication
A technology that grants users secure access to InfoPrint Manager relying on external identity
providers (IdPs). Instead of managing separate user credentials within the InfoPrint Manager system,
federated authentication allows users to log in using their existing accounts from trusted third-party
services.

FIFO (first-in-first-out)
In InfoPrint, a queuing technique where the next job assigned to the first position in the queue is the
job that has been in the queue for the longest time. InfoPrint processes jobs in the order in which
they are received. Contrast with deadline, job-priority, longest-job-first, and shortest-job-first.

file-reference document
In InfoPrint, a file containing the names of other files, each entered on a separate line. Job submitters
can specify this file for printing when they specify a document type of file-reference;
InfoPrint prints each file listed in the reference document.

File Transfer Protocol (FTP)
In TCP/IP, the application protocol that makes it possible to transfer data to and from host
computers and to use foreign hosts indirectly.

finisher
A hardware device attached to a printer that performs such operations as folding or stapling the
printed pages.

finishing
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In a print shop, the final operations on a printed product, such as stapling, trimming, drilling,
folding, embossing, varnishing, gluing, shrink wrapping, perforating, laminating, collating, and so
on.

flag
A modifier of a command that specifies the action of the command. A dash usually precedes a flag.
Synonymous with option. See also keyword.

FOCA
Font object content architecture.

folder
In the InfoPrint GUI, an object that represents a container for a collection of similar objects. For
example, the Retained Jobs folder contains retained jobs.

font
A family of characters of a given size and style; for example, 9-point Helvetica.

One size and one typeface in a particular type family, including letters, numerals, punctuation
marks, special characters, and ligatures.

A paired character set and code page that can be used together for printing a string of text
characters. A double-byte font can consist of multiple pairs of character sets and code pages.

form definition
A resource object used by InfoPrint that defines the characteristics of the form or printed media,
which include: overlays to be used, the paper source (for cut-sheet printers), duplex printing, text
suppression, and the position of composed-text data on the form.

forward space
In InfoPrint, the action used to move ahead and skip the printing of a specified number of pages in a
job.

FPO
Low-quality (sometimes photographic) images placed in a dummy to represent final images.
Desktop publishing software produces images as display-screen resolution FPOs.

front panel
In the CDE, a workspace area containing controls that represent various tasks you can perform and
workspace switches.

FST
Files and Sockets Transport is the local security implementation for InfoPrint Manager. It uses the
local namespace for user credentials, and it is a lightweight security protocol.

FTP
File Transfer Protocol.

G

GCR
Gray component replacement.
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GIF
Graphics Interchange Format.

global change
In the InfoPrint GUI, an action used to make changes to one or more attributes of several objects at
once. You can also perform the same action on several objects of the same object class at the same
time; for example, disabling two or more actual destinations at the same time.

global character
A character or set of characters used to specify an unknown number or set of characters in a search
string. In InfoPrint, a global character is represented by an asterisk (*).

global ID
Global job identifier.

global job identifier
An unambiguous job identifier. In InfoPrint, it is represented as the name of the server managing the
job followed by a colon (:) and a generated integer. This ID uniquely identifies the job in the
InfoPrint server.

glyph
An image, usually of a character, in a font.

GOCA
Graphics object content architecture.

graphic character
A visual representation of a character, other than a control character, that is normally produced by
writing, printing, or displaying.

Graphical User Interface (GUI)
A type of user interface that takes advantage of a high-resolution monitor and includes a
combination of graphics to implement an object-action paradigm, the use of pointing devices, menu
bars, overlapping windows, and icons. Contrast with Command Line Interface.

Graphics Interchange Format (GIF)
A compressed graphics format widely used on the Internet.

gray component replacement (GCR)
Synonym for under color removal (UCR).

gray scale
A strip of standard gray tones, ranging from white to black, placed at the side of the original copy
during photography to measure the tonal range and contrast obtained.

GUI
Graphical User Interface.

gutter
The blank area or inner margin from the printing area to the binding.
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H

halftone
A printing method that simulates continuous-tone shading using dots of varying sizes laid out on a
rectangular grid. Larger dots simulate darker tones and smaller dots simulate lighter tones. Typical
grid spacings are 85 lines per inch (lpi) (newspaper), 133 lpi (low end), 150 lpi (midrange), and
175+ lpi (high quality).

help
In the InfoPrint GUI, an action used to display the online help for a specific template, object, action,
button, control, or area in an application window.

The name of a button used to access the online help.

hold
An indication determined by the job-hold attribute that is used to keep a job in the queue and
prevent InfoPrint from scheduling it.

hostname
The name given to an AIX system.

hot folder
A workstation directory where users copy jobs to submit them to print.

hypertext
A way of presenting information online with connections between one piece of information and
another. These connections are called hypertext links. See also hypertext link.

hypertext link
A connection between one piece of information and another. Selecting a link displays the target
piece of information.

I

icon
A graphic symbol displayed on a screen that a user can click to invoke a function or software
application.

image
Toned and untoned pels arranged in a pattern.

image data
Rectangular arrays of raster information that define an image.

imagesetter
A high resolution (1270–3600+ dpi) printer that uses an Argon (green) laser to write to film using
digital input. Imagesetting is the step before Cromalin proofing and platemaking.

imposition
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The process of arranging pages on a press sheet to ensure the correct order during final cutting,
folding, and binding. Electronic imposition builds press sheets automatically during the RIP and
outputs film formatted for immediate use in platemaking.

InfoPrint
A solution of software and hardware products that can supplement or replace the offset presses and
copiers in print shops with high-quality, non-impact, black and white or process color printers.
InfoPrint takes documents from creation to the published, kitted, and shipped product.

In InfoPrint software publications, InfoPrint Manager for AIX or any of its components.

InfoPrint Manager for AIX
The software component of InfoPrint. InfoPrint Manager for AIX handles the scheduling, archiving,
retrieving, and assembly of a print job and its related resource files. It also tracks the finishing and
packaging of the printed product.

InfoPrint Manager for AIX is based on Palladium technology developed at MIT/Project Athena. It
conforms to the ISO DPA and POSIX standards.

InfoPrint Network
The local area network running TCP/IP protocol that InfoPrint uses to communicate among servers,
clients, and output devices.

InfoPrint Select
The component of InfoPrint Manager for AIX that lets you submit jobs from a Windows workstation.

InfoPrint Submit Express
The component of InfoPrint Manager that lets you submit jobs with a job ticket from a Windows or
Macintosh workstation.

InfoPrint 20
A black and white, large-format, cut-sheet, workgroup laser printer with optional duplexing and
600-dpi resolution.

InfoPrint 60
A duplex, black and white, cut-sheet printer with 600-dpi resolution.

InfoPrint 62
A non-impact, continuous-forms printer that runs at a maximum of 62 impressions-per-minute
(depending on forms size), and is factory set to run at either 240 or 300 dpi on a maximum paper
size of 370.8 mm (14.6 in.).

InfoPrint 4000
A duplex, black and white, continuous-forms printer with 600-dpi resolution.

initial value document
Synonym for default document.

initial value job
Synonym for default job.

initial value object
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Synonym for default object.

initially settable attribute
An attribute whose value can be established when an object is created but cannot be subsequently
set or modified. See also resettable attribute; contrast with non-settable attribute.

input focus
The area of a window where user interaction is possible from either the keyboard or the mouse.

input tray
For a printer device, the container that holds the medium upon which the printer prints its output.

Intelligent Printer Data Stream (IPDS)
An all-points-addressable data stream that enables users to position text, images, and graphics at
any defined point on a printed page.

Information that the host sends to IPDS printers. This information generally contains basic formatting,
error recovery, and character data and enables the printers to make decisions.

An architected host-to-printer data stream that contains both data (text, image, graphics, and bar
codes) and controls defining how the data is to be presented. IPDS provides a device-independent
interface for controlling and managing all-points-addressable (APA) printers.

International Organization for Standardization (ISO)
An organization of national standards bodies from various countries established to promote
development standards to facilitate international exchange of goods and services, and develop
cooperation in intellectual, scientific, technological, and economic activity.

Internet
A wide area network connecting thousands of disparate networks in industry, education,
government, and research. The Internet network uses TCP/IP as the protocol for sending
information.

Internet Protocol
The set of rules that determines how to route data from its source to its destination in an internet
environment.

intervening jobs
In InfoPrint, the number of jobs in a queue that are scheduled to print before the job in question.

IOCA
Image object content architecture.

IP address
The IPv4 or IPv6 address.

IPDS
Intelligent Printer Data Stream.

ISO
International Organization for Standardization.
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J

job
In InfoPrint, an object that represents a request to print or send one or more documents together in a
single session. A job includes the data to be printed or sent and resources such as fonts, images,
and overlays. Depending on how it was submitted, it can also include a job ticket. Synonymous with
job bundle and print job.

job bundle
Synonym for job.

job data
The page descriptions, merge data, and embellishments that compose a document in a job, either
directly or by reference.

job ID
A local or a global identifier that identifies a job to a job submitter, administrator, operator, or
InfoPrint. See local job identifier, global job identifier.

job-priority
In InfoPrint, a queuing technique where the next job assigned to the first position in the queue is the
one with the highest priority. Contrast with deadline, FIFO (first-in-first-out), longest-job-first, and
shortest-job-first.

job submitter
In InfoPrint, the person who submits jobs for printing. Often, this person is an application
programmer who maintains applications that generate data to be printed.

job ticket
The customer's hardcopy or electronic instructions listing all the variables describing a print job,
either directly or by reference. The print shop can add specifications to the job ticket and can print
the job ticket.

Joint Photographic Experts Group (JPEG)
A compressed graphics format widely used on the Internet.

JPEG
Joint Photographic Experts Group.

K

kerning
In typesetting, adjusting the relative spacing of two characters to improve their appearance and
readability. Kerning pairs are specific sets of characters with built-in relative spacing. Some
typefaces have as many as 100 kerning pairs.

keyword
A name or symbol that identifies a parameter.

Part of a command operand that consists of a specific character string, such as DSNAME=.

kitting
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In a print shop, packaging the completed published work with attendant binders, tabs, diskettes,
and other equipment or information, before shipping the finished product.

L

LAN
Local Area Network.

laser (light amplification by stimulated emission of radiation)
In InfoPrint printers, a device that emits a beam of coherent light that forms the image on the
photoconductor that is subsequently transferred to the paper.

late binding
In InfoPrint, waiting to assign a job to an actual destination until it is about to be processed. Late
binding permits InfoPrint to route a job to the first suitable actual destination that becomes available.
Contrast with early binding.

LDAP
Lightweight Directory Access Protocol is the network security implementation for InfoPrint Manager.
It uses an LDAP or Active Directory server for user credentials, and it offers a unified security
implementation in a customer environment.

LED
Light-emitting diode.

light-emitting diode (LED)
The imaging device element for electrophotographic print units.

lines per inch (lpi)
A measure of the density of the grid used to space halftone dots. Typical grid spacings are 85 lpi
(newspaper), 133 lpi (low end), 150 lpi (midrange), and 175+ lpi (high quality).

Linux
Linux is an open-source operating system modeled on UNIX. There are multiple distributions
available, InfoPrint Manager is only supported on Red Hat Enterprise Linux (RHEL) and SUSE Linux
Enterprise Server (SLES).

Local Area Network (LAN)
A computer network at one location that consisting of devices connected to one another and
communicating. This network can also be connected to a larger network.

local ID
Local job identifier.

local job identifier
In InfoPrint, a job identifier automatically generated by the server, identifying the job to the person
who submitted it. InfoPrint maps a local job ID to a global job ID.

locale
The human language and character set of information presented to a user.
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In InfoPrint, the language InfoPrint uses when sending notification and error messages or displaying
the InfoPrint graphical user interfaces.

log
A collection of messages or message segments added to a file for accounting or data collection
purposes.

To record messages in a file.

logical destination
In InfoPrint, an object to which users submit their jobs. The logical destination routes jobs to one or
more actual destinations representing output devices such as printers, or electronic mail systems. See
also logical printer; contrast with actual destination.

logical printer
In InfoPrint, a type of logical destination. The logical printer routes jobs to one or more physical
printers representing printing devices.

logical unit (LU)
A type of network accessible unit that enables end users to gain access to network resources and
communicate with each other.

logical unit (LU) 6.2
A type of logical unit that supports general communication between programs in a distributed
processing environment. LU 6.2 is characterized by (a) a peer relationship between session
partners, (b) efficient utilization of a session for multiple transactions, (c) comprehensive end-to-end
error processing, and (d) a generic application program interface (API) consisting of structured
verbs that are mapped into a product implementation.

longest-job-first
In InfoPrint, a queuing technique where the next job assigned to the first position in the queue is the
longest job in the queue. Contrast with deadline, FIFO (first-in-first-out), job-priority, and shortest-job-first.

lpi
Lines per inch.

LU
Logical unit.

M

magnetic ink character recognition (MICR)
Identification of characters printed with ink that contains particles of magnetic material.

mainframe processor
A functional unit that interprets and executes instructions in a large computer to which other
computers are connected so that they can share the facilities the mainframe provides.

makeready
All the setup work involved in preparing a press for a print run.
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manage
In the InfoPrint GUI, the action used to put an object into a mode where its icon reflects changes of
status.

mechanical
A camera-ready layout. The mechanical can consist of multiple sheets or overlays for each spot or
process color used. Final images, if not stripped in later, should be at final size, cropped and
screened to the correct line frequency.

medium
In InfoPrint, an object representing the physical material upon which a job is printed.

merge data
Data that is unique to each copy of a document and that customizes the document; for example,
serial numbers or mailing information. Merge data is typically a small percentage of the total data
in the document.

message catalog
A file of all the possible messages than can display during the processing of an application.

MICR
Magnetic ink character recognition.

Mixed Object Document Content Architecture (MO:DCA)
An architected, device-independent data stream for interchanging documents.

MO:DCA-P
Mixed Object Document Content Architecture Presentation.

modify
In InfoPrint, an action used to modify the values of attributes in the object attributes notebook.

moire
Undesirable interference patterns caused by two overprinting halftone screens with incorrect
halftone dot angles.

monospaced
In typesetting, pertaining to a typeface in which all the characters have equal widths. Monospaced
typefaces are useful for tabulating figures.

Multiple Virtual Storage (MVS)
An operating system developed by IBM. The design of MVS incorporates an addressing
architecture that provides a unique address space to each job in the system.

MVS
Multiple Virtual Storage.

N

N_UP
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Pertaining to the number of forms placed together in a layout. Typical layouts are 2_UP, 4_UP, 8_
UP, 16_UP, and so on. N_UP printing is done to use the maximum area of the print sheet.

namespace
A global name repository available to all utilities and API procedures. The namespace contains
mappings of object names to other related objects. For example, the namespace provides the
mapping of a logical destination to the server in which it is located.

Network File System (NFS)
A protocol developed by Sun Microsystems that uses Internet Protocol to allow a set of cooperating
computers to access each other's file systems as if they were local.

newline options
The different ways in which the printer determines how lines are delimited in a document data
stream.

NFS
Network File System.

non-process-runout (NPRO)
A printer function that moves the last printed sheet to the stacker of the printer device.

non-settable attribute
An attribute that is neither initially settable nor resettable. The values for these attributes are
controlled by InfoPrint. Contrast with initially settable attribute and resettable attribute.

notification
The act of reporting the occurrence of events.

In InfoPrint, notification of events appears as messages in event logs or messages sent to
administrators, operators, and job submitters. In the InfoPrint GUI, notification of events also
appears as changes to the appearance of icons.

notification-profile
In InfoPrint, an attribute associated with an object that contains information designating the people
to whom InfoPrint sends notification about events for that object, which event information it sends,
and how it sends the information.

NPRO
Non-process-runout.

O

object
A collection of attributes that represent a physical or logical entity in the print system. For example, a
specific printer device is represented by an actual destination (physical printer) object. An object is
identified by its object name. Objects are grouped into classes. See also object class.

object class
A group of objects that share a common definition and therefore share common properties,
operations, and behavior as defined by their attributes. For example, all InfoPrint queue objects are
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in the same object class and each queue has the same set of queue attributes. However, the values
for those attributes can differ for each queue in the queue object class.

Object Identifier (OID)
In architecture, a notation that assigns a globally unambiguous identifier to an object or a document
component. The notation is defined in international standard ISO.IEC 8824(E).

object name
The alphanumeric term that identifies an object.

object state
The state of an object indicates its availability and readiness for performing its functions. An object
can be in one of a number of states such as ready, busy, or unknown.

OCR
Optical character recognition.

octet
A byte that consists of eight binary digits (bits).

offset stacking
In certain printer devices, a function that allows the printer to offset the printed output pages for easy
separation of the jobs.

OID
Object Identifier.

open destinations window
In the InfoPrint GUI, the action used to open a new application window displaying the logical and
actual destinations associated with a queue.

Open Prepress Interface (OPI)
An industry standard for replacing low-resolution images in review documents with high-resolution
images needed for high-quality final output.

Open Software Foundation (OSF)
A nonprofit research and development organization created by a consortium of companies that
work together to develop software in the open systems market.

OpenType font (OTF)
An extension of the TrueType font format that adds:

• Support for PostScript outlines
• Better support for international character sets
• Broader support for advanced typographic control

open window
In the InfoPrint GUI, the action used to open a new application window representing one or more
objects displayed in the currently open application window.

operation
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An action performed on one or more data items.

operator
In InfoPrint, the person responsible for printer devices. Also, this person performs a subset of tasks
for InfoPrint queues and actual destinations and performs some job-related tasks.

OPI
Open Prepress Interface.

optical character recognition (OCR)
Conversion of scanned text to editable ASCII characters.

option
A modifier of a command that specifies the action of the command. A dash usually precedes an
option. Synonymous with flag. See also keyword.

orphan logical destination
In the InfoPrint GUI, an object that represents a logical destination that is not associated with an
existing queue.

orphan logical printer
In the InfoPrint GUI, an object that represents a logical printer that is not associated with an existing
queue.

OSF
Open Software Foundation.

overlay
A collection of constant data, such as lines, shading, text, boxes, or logos, that is electronically
composed in the host processor and stored in a library, and that can be merged with variable data
during printing.

OTF
OpenType font.

P

PAC
Privilege Attribute Certificate.

page definition
A resource that contains the formatting controls for line data.

In InfoPrint, a resource that defines the rules of transforming line data into composed pages and text
controls.

page segment
A resource that contains composed text and images, which are prepared before formatting and
included during printing.

Palladium
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A distributed print system developed at MIT/Project Athena with participation from Digital
Equipment Corporation (DEC), International Business Machines (IBM), and Hewlett-Packard (HP). It
is a reference implementation for the OSI Document Printing Architecture (DPA) standard, ISO/IEC
10175.

pane
In the Work Area of the InfoPrint Manager Administration GUI, an area containing a group of
objects of a specific type, such as an actual destinations pane.

parent/child relationship
In InfoPrint, servers, queues, and destinations are related to one another in a parent/child
relationship. For example, a server is the parent of all the queues that reside in that server, and these
queues are its children.

pass through
In InfoPrint, referring to options submitted with a job that are used by the device driver, but not
InfoPrint. InfoPrint does not process or validate this information; it passes it along to the device
driver. See printer driver.

path
The route used to locate files; the storage location of a file. A fully qualified path lists the drive
identifier (if any), directory name, subdirectory name (if any), and file name with the associated
extension.

pause
In InfoPrint, the action used to temporarily halt the printing or transmission of jobs on actual
destinations or the distribution of jobs from servers or queues.

pdcreate
In InfoPrint, the command used to create a new object and set its attributes to specified values.

PDF
Portable Document Format.

Printer description file.

pdmsg
In InfoPrint, a utility used to display information about a message.

pdpr
In InfoPrint, the command used to create and submit a job, consisting of one or more documents, to
a server for printing or transmission.

perfect binding
A type of book binding in which the pages are held together with flexible adhesive. Contrast with
edition binding, spiral binding, and wire-o binding.

permissions
In AIX, codes that determine who can access a file and what operations they can perform on the
file.

physical printer
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In InfoPrint, a type of actual destination that represents a printer device. See also printer device.

piobe
The standard printer input/output backend program used by AIX for printing. See also ainbe.

pipe-pull
In InfoPrint, a document transfer method where InfoPrint saves the documents in a file and transfers
the address of the file to the server. InfoPrint transfers the file to the server upon the request from the
server. This is an efficient transfer method for large jobs and is the default transfer method at job
submission. Contrast with with-request.

plex
A document or actual destination attribute used to define the placement of output images on the
page. See the plex values simplex and tumble.

Portable Document Format (PDF)
An Adobe PostScript data format that can be viewed or printed.

Portable Operating System Interface for Computer Environments (POSIX)
An Institute of Electrical and Electronics Engineers (IEEE) standard for computer operating systems.

POSIX
Portable Operating System Interface for Computer Environments.

PostScript
Adobe's page description language. PostScript has become a standard for graphic design and
layout software. PostScript files can contain both vector and raster data. Fonts are described using
PostScript coding. Many desktop publishing systems produce PostScript data as their output data
stream.

PostScript printer description (PPD)
A file that contains options for printing PostScript data on various printer devices.

PPD
PostScript printer description.

Prefix lengths
Identify a range of IPv6 addresses that are on the same network.

preflight
To assess all resources for a job before the actual print run.

prepress
Work done in the print shop before printing a job, such as preparing data and art, page imposition,
color retouching, electronic editing, and page layout.

print database
The set of files on disk that provide a permanent repository for the attributes of all print objects, such
as logical destinations, queues, and actual destinations.

print job
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Synonym for job.

Print Quality Enhancement (PQE)
A printer facility that provides edge smoothing along diagonal lines, fine fidelity protection, and
independent boldness control.

Print Services Facility (PSF)
Any of several programs, including PSF for AIX, PSF/MVS, PSF/VM, and PSF/VSE, that produce
printer commands from the data sent to them.

print system
A group of one or more print servers and one or more printing devices, which might or might not be
located in the same geographical area. The components of a print system are assumed to be
interconnected in some manner, providing at least one network interface to print clients, and acting
synergistically to supply the defined document print service. (D)

printable document
In InfoPrint, an object that represents text or data to be printed by a job. Contrast with resource
document.

printer description file (PDF)
A file that contains options for printing PostScript data on a specific printer device.

printer device
The physical output device that performs the printing function. See also physical printer.

printer driver
A file that describes the physical characteristics of a printer or other peripheral device. This file is
used to convert graphics and text into device-specific data at the time of printing or plotting.
Synonymous with device driver.

priority
In InfoPrint, a number assigned to a job that determines its precedence in being printed. Jobs with
higher priority numbers are handled before jobs with lower priority numbers.

process color
Color made up of CMYK links simulating a specified color. This is the traditional method of
reproducing continuous tone color images (color separations). Because of the nature of color inks,
certain inks do not reproduce well.

processor
In a computer, a functional unit that interprets and executes instructions. A processor consists of at
least an instruction control unit and an arithmetic and logic unit. (T)

promote
In InfoPrint, the action used to move a job to the beginning of the queue so that it will print on the
next available printer that can handle that job.

protocol
A set of semantic and syntactic rules that determines the behavior of functional units in achieving
communication.
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pSeries
A family of workstations and servers based on IBM's POWER architecture. They are primarily
designed for running multi-user numerical computing applications that use the AIX operating system.

PSF
Print Services Facility.

PSF destination support system
In InfoPrint, the destination support system that communicates with PSF for AIX to print jobs.

PSF physical printer
In InfoPrint, the object representing a printer device that uses the PSF destination support system.

Q

QuarkXpress
A desktop publishing system produced by Quark, Incorporated.

queue
In InfoPrint, an object that manages a collection of jobs that are waiting to print. A queue receives
jobs from one or more logical destinations and sends jobs to one or more actual destinations.

A line or list formed by items waiting for processing.

R

raster
A pattern of dots defined at varying data depths. Black and white images are one-bit (on/off);
grayscale images are 8-bit (256 levels); RGB images are 24-bit; CMYK images are 32-bit.

raster image processor (RIP)
A processor in which a PostScript data stream is converted into dot patterns that are transferred to
the final print medium. InfoPrint uses an Adobe RIP to convert PostScript to IPDS for such printers as
the InfoPrint 4000 and InfoPrint 60.

rc.pd
In InfoPrint, a utility used to start the InfoPrint servers listed in the /etc/pd.servers file.

read-only
In InfoPrint, describes an attribute value that cannot be set by the user but can change based on
other activity.

ready
A state in which an object is ready and able to perform tasks.

An available resource, such as a value of the media-ready attribute. Contrast with supported.

red, green, blue (RGB)
The colors of CRT display phosphors. RGB images are for screen display only. They must be
converted to CMYK images before printing.

registration
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The accuracy of printing on paper relative to the edges of the paper.

The accuracy of printing a single color (cyan, magenta, or yellow) relative to black.

The accuracy of printing on one side of a page relative to printing on the reverse side of the page.

reprographics
The process of copying or duplicating documents or information.

requested
In InfoPrint, pertaining to the specific values of attributes requested by a job when it is submitted. The
requested attribute values of a job are validated against supported attribute values for an actual
destination to determine if the printer can handle that job. Contrast with supported.

resettable attribute
An attribute whose value can be set or modified after an object has been created, assuming the
object is in an appropriate state to be modified. See also initially settable attribute; contrast with non-
settable attribute.

resource
In AFP, a file containing a collection of printing instructions used when printing a job. Resources
include fonts, overlays, form definitions, page definitions, and page segments.

resource context
In InfoPrint, an object that contains directory path information that helps the print system locate
resources needed for printing a job. The resources include fonts, overlays, form definitions, page
definitions, and page segments.

resource document
In InfoPrint, an object that represents a resource, such as graphics or fonts, used by a job to print a
printable document. Contrast with printable document.

resubmit
In InfoPrint, an action used to reroute pending or retained jobs to a different logical destination than
the one through which the job was originally submitted.

resume
In InfoPrint, the action used to resume the printing of paused jobs or resume the distribution of jobs
from paused servers or queues.

retained job
In InfoPrint, an object that represents a job that is being stored in the print system for a specified
amount of time, normally after the completion of printing the job. A retained job does not reside in a
queue.

retention
The process of storing data after completion of a process for a certain length of time.

retrieval
The process of bringing digital archived data out of storage and into online memory for reuse. See
also archiving.
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RGB
Red, green, blue.

RIP
Raster image processor.

To convert data to dot patterns using a raster image processor.

root user
In the AIX environment, the system user with the most authority who can log in and execute restricted
commands, shut down the system, and edit or delete protected files. Synonymous with superuser.

RPC
Remote Procedure Call.

RPM
Red Hat Package Management is the baseline package format of the Linux Standard Base
distribution.

S

scanner
A device that converts hardcopy source data into digital format (halftone dots) to avoid retyping the
data.

scheduler
In InfoPrint, the scheduling method that the queue uses when assigning a job to an actual
destination.

separator sheet
The sheet of paper, blank or otherwise, that separates documents in a job. See also auxiliary sheet.

server
In InfoPrint, the object that accepts configuration, management, and printing requests, performs the
requested operations, and sends responses back as a result of the operation.

settable attribute
See initially settable attribute, resettable attribute.

severity
An indication of how serious an error condition is.

shell
In the AIX operating system, a command interpreter that acts as an interface between the user and
the operating system. In InfoPrint documentation, all shell examples use the Korn shell.

shift-out, shift-in code
Control characters used to indicate the beginning and end of a string of double-byte, ideographic
characters.

shortest-job-first
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In InfoPrint, a queuing technique where the next job assigned to the first position in the queue is the
shortest job in the queue. Contrast with deadline, FIFO (first-in-first-out), job-priority, and longest-job-first.

shut down
In InfoPrint, the action used to halt all server or actual destination processes without deleting the
server or actual destination.

signature
A group of pages that are printed, folded, cut, and bound together. Manual placement of pages in
the signature is determined using a folding dummy.

simplex
In InfoPrint, the value of the document or actual destination plex attribute indicating that output
images are placed on the media in a head-to-head format, so that the top of one image is at the
same edge as the top of the next image. Depending on the value of the document or actual
destination sides attribute, the document can be printed on one or both sides of the paper.
Contrast with tumble; see also simplex printing and duplex printing.

simplex printing
Printing on only one side of the paper. Contrast with duplex printing (1).

Printing on one or both sides of the paper, placing output images on the media in a head-to-head
format, so that the top of one image is at the same edge as the top of the next image. Contrast with
tumble duplex printing; see also duplex printing (2).

SMIT
System Management Interface Tool.

SNA
Systems Network Architecture.

spiral binding
A type of book binding in which wire or plastic coils are threaded through a series of holes or slots
in the binding edge. Contrast with edition binding, perfect binding, and wire-o binding.

spot color
Individual colored inks formulated to exactly match a specified color. Spot color is used when
CMYK process color cannot produce a reasonable facsimile of the color or when vivid color is
needed. Spot color is also used when fluorescent or metallic colors are needed.

spread
In color printing, an area whose dimensions have been enlarged to eliminate white space between
it and another color. Contrast with choke.

start sheet
The sheet of paper, blank or otherwise, that can precede a job. See also auxiliary sheet.

state
Synonym for object state.

stripping
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The process of mechanically assembling film into plate layouts. Page imposition takes place during
stripping.

subnet mask
Identify a range of IPv4 addresses that are on the same network.

subnetwork
Any group of nodes that have a set of common characteristics, such as the same network ID.

In the AIX operating system, one of a group of multiple logical divisions of another network, such as
can be created by TCP/IP.

subtractive color system
A system that reproduces an image by mixing (adding) appropriate quantities of cyan, magenta,
and yellow paints on white paper. These paints reflect certain colors and absorb—or subtract—
others. Contrast with additive color system.

superuser
Synonym for root user.

supported
In InfoPrint, pertaining to the specific job attribute values that the actual destination can accept
during job validation. InfoPrint validates the requested attribute values of the job against the
supported attribute values of the actual destination to determine whether the actual destination can
handle that job. Contrast with requested.

synchronous
Occurring with a regular or predictable time relationship to a specified action. Contrast with
asynchronous.

system administrator
Synonym for administrator.

System Management Interface Tool (SMIT)
In the AIX operating system, an interface tool for installation, maintenance, configuration, and
diagnostic tasks. SMIT lets you perform tasks without entering any commands.

Systems Network Architecture (SNA)
The description of IBM's logical structure, formats, protocols, and operational sequences for sending
units through, and controlling the configuration and operation of, networks.

T

table reference character (TRC)
An optional control character in a print data set. The TRC identifies the font used to print the record
and can be used to select a font during printing.

Tagged Image File Format (TIFF)
A digital format for storing scanned images. TIFF files are also referred to as raster format files (as
opposed to vector format files). When used in desktop publishing, TIFF files produce only a low-
resolution FPO image; the high-resolution data remains on the hard disk.
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task help
A type of online help that provides a list of tasks that can be completed with a selected object.
When you select a task, the help provides step-by-step information about how to complete the task.

TCP/IP
Transmission Control Protocol/Internet Protocol.

TCP/IP-attached printer
A printer device attached to an pSeries computer through telecommunication lines using the TCP/IP
protocol.

In InfoPrint, a PSF physical printer that represents a TCP/IP-attached printer device. See also AIX-
attached printer, direct-attached printer, and upload-TCP/IP-attached printer.

template
In the InfoPrint Manager Administration GUI, an object that represents a set of default attribute
values that has been defined for creating a particular type of object, such as an actual destination.

ticket
See job ticket.

TIFF
Tagged Image File Format.

Transmission Control Protocol/Internet Protocol (TCP/IP)
A set of communication rules used in the Internet and in any network that follows the U.S.
Department of Defense standards for inter-network protocol. TCP provides a reliable host-to-host
protocol between hosts in packet-switched communications networks and in interconnected systems
of such networks. It assumes that the Internet Protocol (IP) is the underlying protocol. See also Internet
Protocol.

trapping
In desktop publishing, the amount of overlap in overprinting colors. Trapping prevents white paper
showing through gaps caused by normal errors in registration. On sheet-fed presses, trapping is
usually 0.25 point. See also choke and spread.

TRC
Table Reference Character.

TrueType font (TTF)
A font format based on scalable outline technology with flexible hinting. Glyph shapes are based
on quadratic curves. The font is described with a set of tables contained in a TrueType Font File.

TTF
TrueType font.

tumble
In InfoPrint, the value of the document or actual destination plex attribute indicating that output
images are placed on the media in a head-to-toe format, so that the top of one image is at the same
edge as the bottom of the next image. The document must be printed on both sides of the paper.
Contrast with simplex.
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tumble duplex printing
Printing on both sides of the paper, placing output images on the media in a head-to-toe format, so
that the top of one image is at the same edge as the bottom of the next image. Contrast with simplex
printing (2), duplex printing (2).

U

UCR
Under color removal.

under color removal (UCR)
Conversion of neutral color areas to black ink that reduces use of CMY inks, improves trapping, and
reduces setup time. Generally, UCR is performed during image scanning, but some RIPs perform it
during processing. Synonymous with gray component replacement (GCR).

unmanage
In the InfoPrint Manager Administration GUI, the action used to put an object into a mode where its
icon does not reflect the changes of status for the object.

upload printer
See upload-TCP/IP-attached printer.

upload-TCP/IP-attached printer
In InfoPrint, a PSF physical printer that represents a printer device attached through an MVS system
and managed by PSF/MVS. InfoPrint communicates with the MVS system through the TCP/IP
network. See also AIX-attached printer, direct-attached printer, and TCP/IP-attached printer.

V

validate
In InfoPrint, to compare the attribute values requested by a job with the supported attribute values of
the actual destinations in the system and to determine whether there is an actual destination capable
of printing or sending the job.

value
A specific characteristic of an attribute.

variable
A name used to represent a data item whose value can change while the program is running.

variable data
Data that can be changed between copies of a document. For example, a form letter (constant
data) can be merged with variable data, such as a customer's name and address to produce
personalized documents.

varnish
A protective layer applied to a finished sheet, usually for photos, but sometimes used as a design
element because of its reflective qualities. Varnishes can be tinted.

vector
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An absolute coordinate point and line in space. PostScript files can contain vector artwork. Vector
files are converted to rasters during the RIP process.

velox
A black and white photographic print made from a halftone negative, to be used as a proof copy.

vignette
An image with soft, fade-away edges.

Virtual Machine (VM)
An IBM licensed product that manages the resources of a single computer so that multiple
computing systems appear to exist.

A virtual data processing system that appears to be at the exclusive disposal of a particular user, but
whose functions are accomplished by sharing the resources of a real data processing system. (T)

Virtual Storage Extended (VSE)
An IBM licensed program whose full name is the Virtual Storage Extended/Advanced Function. It is
a software operating system controlling the execution of programs.

Visual Systems Management (VSM)
In AIX, a type of graphical user interface that allows system management through the direct
manipulation of objects.

VM
Virtual Machine.

VSE
Virtual Storage Extended.

VSM
Visual Systems Management.

W

web
A roll of paper used in web or rotary printing.

well
In the InfoPrint Manager Administration GUI, an area in a pane that contains a group of objects
related to the objects in the pane; for example, a queues well in a servers pane.

what you see is what you get (WYSIWYG)
Refers to the fact that the composite image displayed on the screen at a computer workstation has
the appearance of the final printed image.

window
A rectangular area of the screen that you can move about, place on top of, or pull under other
windows, or reduce to an icon.

wire-o binding
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A continuous double series of wire loops run through punched slots along the binding side of a
booklet. Contrast with edition binding, perfect binding, and spiral binding.

with-request
In InfoPrint, a document transfer method where the client transfers the documents directly to the
server. Contrast with pipe-pull.

workstation
A terminal or microcomputer, usually one that is connected to a mainframe or to a network, at
which a user can use applications.

write access
A level of authorization that grants the ability to modify data.

WYSIWYG
What you see is what you get.

X

X-Windows
A network-transparent windowing system developed by MIT. It is the basis for Enhanced X-
Windows, which runs on the AIX Operating System.

xerography
A dry printing process using corona-charged photoconductive surfaces to hold latent images that
are developed with a dry toner and then transferred to paper and fused with heat.

Xstation
A terminal that is connected through a network to an pSeries computer, from which a user can
perform command-line functions and run X-Windows based applications.
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